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Preface

This book is aimed at the reader who wishes to gain a working knowledge of time
series and forecasting methods as applied in economics, engineering and the natural
and social sciences. Unlike our earlier book, Time Series: Theory and Methods, re-
ferred to in the text as TSTM, this one requires only a knowledge of basic calculus,
matrix algebra and elementary statistics at the level (for example) of Mendenhall,
Wackerly and Scheaffer (1990). It isintended for upper-level undergraduate students
and beginning graduate students.

The emphasis is on methods and the analysis of data sets. The student version
of the time series package I TSM 2000, enabling the reader to reproduce most of the
calculationsin thetext (and to analyze further data sets of the reader’s own choosing),
isincluded on the CD-ROM which accompanies the book. The data sets used in the
book are alsoincluded. The package requiresan | BM-compatible PC operating under
Windows 95, NT version 4.0, or alater version of either of these operating systems.
The program ITSM can berun directly from the CD-ROM or installed on ahard disk
as described at the beginning of Appendix D, where a detailed introduction to the
package is provided.

Very littleprior familiarity with computingisreguiredin order to usethe computer
package. Detailed instructions for its use are found in the on-line help files which
are accessed, when the program ITSM is running, by selecting the menu option
Help>Contents and selecting the topic of interest. Under the heading Data you
will find information concerning the data sets stored on the CD-ROM. The book can
also be used in conjunction with other computer packages for handling time series.
Chapter 14 of the book by Venables and Ripley (1994) describes how to perform
many of the calculations using S-plus.

There are numerous problems at the end of each chapter, many of which involve
use of the programs to study the data sets provided.

To make the underlying theory accessible to a wider audience, we have stated
some of the key mathematical results without proof, but have attempted to ensure
that the logical structure of the development is otherwise complete. (References to
proofs are provided for the interested reader.)
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Preface

Since the upgrade to ITSM2000 occurred after the first edition of this book
appeared, we have taken the opportunity, in this edition, to coordinate the text with
the new software, to make a number of corrections pointed out by readers of thefirst
edition and to expand on several of the topics treated only briefly in the first edition.

Appendix D, the software tutorial, has been rewritten in order to be compatible
with the new version of the software.

Some of the other extensive changes occur in (i) Section 6.6, which highlights
the role of the innovations algorithm in generalized least squares and maximum
likelihood estimation of regression models with time series errors, (ii) Section 6.4,
where the treatment of forecast functions for ARIMA processes has been expanded
and (iii) Section 10.3, which now includes GARCH modeling and simulation, topics
of considerable importance in the analysis of financial time series. The new material
has been incorporated into the accompanying software, to which we have also added
the option Autofit. This streamlines the modeling of time series data by fitting
maximum likelihood ARMA(p, g) modelsfor a specified range of (p, ¢) valuesand
automatically selecting the model with smallest AICC value.

Thereissufficient material herefor afull-year introduction to univariate and mul-
tivariate time series and forecasting. Chapters 1 through 6 have been used for severa
yearsin introductory one-semester coursesin univariate time seriesat Colorado State
University and Royal Melbourne Institute of Technology. The chapter on spectral
analysis can be excluded without loss of continuity by readers who are so inclined.

Wearegreatly indebted to thereadersof thefirst edition and especially to Matthew
Calder, coauthor of the new computer package, and Anthony Brockwell for their
many valuable comments and suggestions. We also wish to thank Colorado State
University, the National Science Foundation, Springer-Verlag and our families for
their continuing support during the preparation of this second edition.

Fort Collins, Colorado Peter J. Brockwell
August 2001 Richard A. Davis
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Examples of Time Series

Objectives of Time Series Analysis

Some Simple Time Series Models

Stationary Models and the Autocorrelation Function

Estimation and Elimination of Trend and Seasonal Components
Testing the Estimated Noise Sequence
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In this chapter we introduce some basic ideas of time series analysis and stochastic
processes. Of particul arimportancearethe conceptsof stationarity and theautocovari-
ance and sample autocovariance functions. Some standard techniques are described
for the estimation and removal of trend and seasonality (of known period) from an
observed time series. These are illustrated with reference to the data setsin Section
1.1. Thecalculationsin all the examples can be carried out using the time series pack-
age| TSM, the student version of whichissupplied on the enclosed CD. The data sets
are contained in files with names ending in .TSM. For example, the Australian red
wine sales are filed as WINE.TSM. Most of the topics covered in this chapter will
be developed more fully in later sections of the book. The reader who is not already
familiar with random variables and random vectors should first read Appendix A,
where a concise account of the required background is given.

1.1 Examples of Time Series

A timeseriesisaset of observations x,, each one being recorded at a specific time:.
A discrete-time time series (the type to which this book is primarily devoted) is one
in which the set Ty of times at which observations are made is adiscrete set, asisthe
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Figure 1-1
The Australian red wine
sales, Jan. ‘80 — Oct. ‘91.

Example 1.1.1

Example 1.1.2

25

2.0

(thousands)

15

1.0

0.5
T

1980 1982 1984 1986 1988 1990 1992

case, for example, when observations are made at fixed time intervals. Continuous-
timetime series are obtained when observations are recorded continuously over some
timeinterval, e.g., when 7, = [0, 1].

Australian red wine sales; WINE.TSM

Figure 1.1 showsthe monthly sales (in kiloliters) of red wine by Australian winemak-
ers from January 1980 through October 1991. In this case the set T, consists of the
142 times {(Jan. 1980), (Feb. 1980), ...,(Oct. 1991)}. Given a set of n observations
made at uniformly spaced time intervals, it is often convenient to rescale the time
axis in such a way that T becomes the set of integers {1, 2, ..., n}. In the present
exampl e thisamounts to measuring timein monthswith (Jan. 1980) asmonth 1. Then
Toistheset {1, 2, ..., 142}. It appears from the graph that the sales have an upward
trend and a seasonal pattern with a peak in July and atrough in January. To plot the
data using ITSM, run the program by double-clicking on the ITSM icon and then
select the option File>Project>0pen>Univariate, click OK, and select the file
WINE.TSM. The graph of the data will then appear on your screen. O

All-star baseball games, 1933-1995

Figure 1.2 shows the results of the all-star games by plotting x;, where

1 if theNational League won inyear ¢,
X, =
t —1 if the American Leaguewon in year z.
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Figure 1-2
Results of the
all-star baseball
games, 1933-1995.

Example 1.1.3

Example 1.1.4

| I
1L

1 | | | | | | | | | | | |
1940 1950 1960 1970 1980 1990

Thisis a series with only two possible values, 1. It a'so has some missing values,
since no game was played in 1945, and two games were scheduled for each of the
years 1959-1962. 0

Accidental deaths, U.S.A., 1973-1978; DEATHS.TSM

Like the red wine sales, the monthly accidental death figures show a strong seasonal
pattern, with the maximum for each year occurring in July and the minimum for each
year occurring in February. The presence of atrendin Figure 1.3 ismuch less apparent
than in the wine sales. In Section 1.5 we shall consider the problem of representing
the data as the sum of atrend, a seasonal component, and aresidual term. O

A signal detection problem; SIGNAL.TSM

Figure 1.4 shows simulated values of the series

X, = cos<1t—0> +N,, t=12,...,200,
where {N,} is a sequence of independent normal random variables, with mean 0
and variance 0.25. Such a series is often referred to as signal plus noise, the signal
being the smooth function, S, = cos(+5) in this case. Given only the data X,, how
can we determine the unknown signal component? There are many approaches to
this general problem under varying assumptions about the signal and the noise. One
simple approach is to smooth the data by expressing X, as a sum of sine waves of
variousfrequencies(see Section 4.2) and eliminating the high-frequency components.
If we do this to the values of {X,} shown in Figure 1.4 and retain only the lowest
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3.5% of the frequency components, we obtain the estimate of the signal also shown
in Figure 1.4. The waveform of the signal is quite close to that of the true signal in
this case, although its amplitude is somewhat smaller. O

Example 1.1.5  Population of the U.S.A., 1790-1990; USPOP.TSM

The population of the U.S.A., measured at ten-year intervals, is shown in Figure 1.5.
The graph suggests the possibility of fitting a quadratic or exponential trend to the
data. We shall explore this further in Section 1.3. O

Example 1.1.6  Number of strikes per year in the U.S.A., 1951-1980; STRIKES.TSM

The annual numbers of strikes in the U.S.A. for the years 1951-1980 are shown in
Figure 1.6. They appear to fluctuate erratically about a slowly changing level. O

1.2 Obijectives of Time Series Analysis

The examples considered in Section 1.1 are an extremely small sample from the
multitude of time series encountered in the fields of engineering, science, sociology,
and economics. Our purposein thisbook isto study techniquesfor drawing inferences
fromsuch series. Beforewecandothis, however, itisnecessary to set up ahypothetical
probability model to represent the data. After an appropriate family of models has
been chosen, it is then possible to estimate parameters, check for goodness of fit to
the data, and possibly to use the fitted model to enhance our understanding of the
mechanism generating the series. Once a satisfactory model has been developed, it
may be used in avariety of ways depending on the particular field of application.
The model may be used simply to provide a compact description of the data. We
may, for example, be able to represent the accidental deaths data of Example 1.1.3 as
the sum of a specified trend, and seasonal and random terms. For the interpretation
of economic statistics such as unemployment figures, it isimportant to recognize the
presence of seasonal components and to remove them so as not to confuse them with
long-term trends. This processis known as seasonal adj ustment. Other applications
of time series models include separation (or filtering) of noise from signals as in
Example 1.1.4, prediction of future values of a series such as the red wine sales in
Example 1.1.1 or the population data in Example 1.1.5, testing hypotheses such as
globa warming using recorded temperature data, predicting one series from obser-
vations of another, e.g., predicting future sales using advertising expenditure data,
and controlling future values of a series by adjusting parameters. Time series models
are also useful in simulation studies. For example, the performance of a reservoir
depends heavily on the random daily inputs of water to the system. If these are mod-
eled as a time series, then we can use the fitted model to simulate a large number
of independent sequences of daily inputs. Knowing the size and mode of operation
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of the reservoir, we can determine the fraction of the simulated input sequences that
cause the reservoir to run out of water in agiven time period. This fraction will then
be an estimate of the probability of emptiness of the reservoir at some time in the
given period.

1.3 Some Simple Time Series Models

Definition 1.3.1

An important part of the analysis of atime seriesis the selection of a suitable proba-
bility model (or class of models) for the data. To allow for the possibly unpredictable
nature of future observations it is natural to suppose that each observation x, is a
realized value of a certain random variable X, .

A time series model for the observed data {x;} is a specification of the joint
distributions (or possibly only the meansand covariances) of asequence of random
variables {X,} of which {x;} is postulated to be arealization.

Remark. We shall frequently use the term time series to mean both the data and
the process of which it isarealization. O

A complete probabilistic time series model for the sequence of random vari-
ables{X,, X,, ...} would specify al of thejoint distributions of the random vectors
(X1,....X,)),n=12,..., orequivaently al of the probabilities

PlXi<x1,...,X, <x;], —00<x1,....,x, <00, n=12,....

Such aspecificationisrarely used intime seriesanalysis (unlessthe dataare generated
by some well-understood simple mechanism), sincein genera it will contain far too
many parametersto be estimated from the available data. Instead we specify only the
first- and second-order moments of the joint distributions, i.e., the expected values
E X, and the expected products E(X, ., X,),t =1,2,...,h =0,1,2,..., focusing
on properties of the sequence { X, } that depend only on these. Such properties of {X,}
arereferred to as second-order properties. In the particular case where al the joint
distributions are multivariate normal, the second-order properties of {X;} completely
determine the joint distributions and hence give a complete probabilistic characteri-
zation of the sequence. In general we shall lose a certain amount of information by
looking at time series “through second-order spectacles’; however, as we shall see
in Chapter 2, the theory of minimum mean squared error linear prediction depends
only on the second-order properties, thus providing further justification for the use
of the second-order characterization of time series models.

Figure 1.7 showsone of many possiblerealizationsof {S,,r = 1, ..., 200}, where
{S;} is a sequence of random variables specified in Example 1.3.3 below. In most
practical problems involving time series we see only one redlization. For example,
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Example 1.3.1

Example 1.3.2

there is only one available redlization of Fort Collins's annual rainfall for the years
1900-1996, but we imagine it to be one of the many sequences that might have
occurred. In the following examples we introduce some simple time series models.
One of our goalswill beto expand this repertoire so asto have at our disposal abroad
range of models with which to try to match the observed behavior of given data sets.

1.3.1 Some Zero-Mean Models

iid noise

Perhaps the simplest model for a time series is one in which there is no trend or
seasonal component and in which the observations are simply independent and iden-
tically distributed (iid) random variableswith zero mean. Werefer to such asequence
of random variables X1, X», ... as iid noise. By definition we can write, for any
positive integer n and real numbers x4, . .., x,,

P[le-xl,c--vxn an]:P[Xlsxl]"'P[Xn S-xn]:F(-xl)"'F(xn)7

where F(-) is the cumulative distribution function (see Section A.1) of each of
the identically distributed random variables X, X, .... In this model there is no
dependence between observations. In particular, for all 2 > 1and al x, x4, ..., x,,

P X, <x|X1=2x1,..., X, =x,] = P[ X, < x],

showing that knowledge of X4, ..., X, is of no value for predicting the behavior
of X,.,. Given the values of X4, ..., X, the function f that minimizes the mean
squared error E[(X,4n — f(X1, ..., X,))?] isin fact identically zero (see Problem
1.2). Although this meansthat iid noise is arather uninteresting process for forecast-
ers, it plays an important role as a building block for more complicated time series
models. O

A binary process

As an example of iid noise, consider the sequence of iid random variables {X,, r =
1,2,...,}with

P[Xlzl]:pa P[Xz:_l]zl—p,

where p = % The time series obtained by tossing a penny repeatedly and scoring
+1 for each head and —1 for each tail is usually modeled as a realization of this
process. A priori we might well consider the same process asamodé for the all-star
baseball games in Example 1.1.2. However, even a cursory inspection of the results
from 1963-1982, which show the National League winning 19 of 20 games, casts
serious doubt on the hypothesis P[X, = 1] = 1. O
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Example 1.3.3

Figure 1-7

One realization of a
simple random walk
{S,t=0,1,2,...,200}

Random walk

Therandom walk {S;,r = 0, 1, 2,...} (starting at zero) is obtained by cumulatively
summing (or “integrating”) iid random variables. Thusarandom walk with zero mean
is obtained by defining S, = 0 and

S=X1+Xo+---+X,, forr=12...,

where {X,} isiid noise. If {X,} isthe binary process of Example 1.3.2, then {S;, t =
0,12, ...,}iscdled asimple symmetric random walk. Thiswalk can be viewed
as the location of a pedestrian who starts at position zero at time zero and at each
integer timetosses afair coin, stepping one unit to the right each time a head appears
and oneunit to theleft for each tail. A realization of length 200 of asimple symmetric
random walk is shown in Figure 1.7. Notice that the outcomes of the coin tosses can
be recovered from {S;,r = 0, 1, ...} by differencing. Thus the result of the rth toss
can befound from S, — S,_1 = X,. O

1.3.2 Models with Trend and Seasonality

In several of the time series examples of Section 1.1 thereisaclear trend in the data.
An increasing trend is apparent in both the Australian red wine sales (Figure 1.1)
and the population of the U.S.A. (Figure 1.5). In both cases a zero-mean model for
the datais clearly inappropriate. The graph of the population data, which contains no
apparent periodic component, suggests trying amodel of the form

Xi=m; +7Y,,
il II"'H L] nn nn
== n ni I'l‘ll n n H‘!‘H L) ll"‘\l
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where m, is a slowly changing function known as the trend component and Y, has
zero mean. A useful technique for estimating m, isthe method of least squares (some
other methods are considered in Section 1.5).
In the least squares procedure we attempt to fit a parametric family of functions,
eg.,
m, = ag + ait + ast?, (1.3.2)

tothedata{xy, ..., x,} by choosing the parameters, inthisillustration ag, a1, and a,, to
minimize "), (x, —m,)?. Thismethod of curvefittingiscalled |east squaresregres-
sion and can be carried out using the program ITSM and selecting the Regression
option.

Population of the U.S.A., 1790-1990

To fit a function of the form (1.3.1) to the population data shown in Figure 1.5 we
relabel the time axis so that ¢+ = 1 corresponds to 1790 and ¢+ = 21 corresponds to
1990. Run ITSM, select File>Project>0pen>Univariate, and open the file US-
POPTSM. Then select Regression>Specify, choose Polynomial Regression
with order equal to 2, and click OK. Then select Regression>Estimation>Least
Squares, and you will obtain the following estimated parameter values in the model
(1.3.2):

o = 6.9579 x 10,

a; = —2.1599 x 10°,
and

dp = 6.5063 x 10°.

A graph of the fitted function is shown with the origina data in Figure 1.8. The
estimated values of the noise process Y;, 1 < ¢ < 21, are the residuals obtained by
subtraction of /i, = ao + ast + a,t? from x,.

The estimated trend component 7z, furnishes uswith anatural predictor of future
values of X,. For example, if we estimate the noise Y, by its mean value, i.e., zero,
then (1.3.1) gives the estimated U.S. population for the year 2000 as

My = 6.9579 x 10° — 2.1599 x 108 x 22 + 6.5063 x 10° x 22% = 274.35 x 10°.

However, if theresiduals {Y,} arehighly correlated, we may be ableto usetheir values
to give abetter estimate of Y, and hence of the population X, intheyear 2000. O

Level of Lake Huron 1875-1972; LAKE.DAT

A graph of thelevel in feet of Lake Huron (reduced by 570) in the years 1875-1972
isdisplayed in Figure 1.9. Since the lake level appears to decline at aroughly linear
rate, ITSM was used to fit amodel of the form

X, =ao+ay+Y, t=1...,098 (1.32)
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showing the quadratic trend
fitted by least squares.

Figure 1-9

Level of Lake Huron
1875-1972 showing the
line fitted by least squares.

1800 1820 1840 1860 1880 1900 1920 1940 1960 1980

(with thetime axis relabeled asin Example 1.3.4). The least squares estimates of the
parameter values are

ap=10.202 and a; = —.0242.

(The resulting least squares line, ao + at, is aso displayed in Figure 1.9.) The
estimatesof thenoise, Y;,inthemodel (1.3.2) aretheresidual sobtained by subtracting
the least squareslinefrom x, and are plotted in Figure 1.10. There are two interesting
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Figure 1-10
Residuals from fitting a
line to the Lake Huron

data in Figure 1.9.
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features of the graph of theresiduals. Thefirst isthe absence of any discernibletrend.
The second is the smoothness of the graph. (In particular, there are long stretches of
residual sthat havethe same sign. Thiswould be very unlikely to occur if theresiduals
were observations of iid noise with zero mean.) Smoothness of the graph of atime
seriesisgeneraly indicative of the existence of some form of dependence among the
observations.

Such dependence can be used to advantage in forecasting future values of the
series. If wewereto assumethevalidity of thefitted model withiid residuals{Y,}, then
the minimum mean squared error predictor of the next residual (Yge) would be zero
(by Problem 1.2). However, Figure 1.10 strongly suggests that Yq9 Will be positive.

How then do we quantify dependence, and how do we construct modelsfor fore-
casting that incorporate dependence of aparticular type? To deal withthese questions,
Section 1.4 introduces the autocorrel ation function as a measure of dependence, and
stationary processes as afamily of useful models exhibiting awide variety of depen-
dence structures. O

Harmonic Regression

Many time seriesareinfluenced by seasonally varying factors such asthe weather, the
effect of which can be modeled by aperiodic component with fixed known period. For
example, the accidental deaths series (Figure 1.3) shows a repeating annual pattern
with peaks in July and troughs in February, strongly suggesting a seasonal factor
with period 12. In order to represent such a seasonal effect, allowing for noise but
assuming no trend, we can use the simple model,

X =s5+Y;,



1.3

Some Simple Time Series Models 13

Example 1.3.6

Figure 1-11

The estimated harmonic
component of the
accidental deaths

data from ITSM.

wheres, isaperiodic function of ¢ with period d (s,_; = s,). A convenient choicefor
s, isasum of harmonics (or sine waves) given by

k
si=ao+ Y _(a;COS(A;t) + b; SiN(;1)), (1.3.3)
j=1
whereag, ay, ..., a; and by, . .., by are unknown parametersand A4, ..., A, arefixed

frequencies, each being some integer multiple of 2 /d. To carry out harmonic re-
gressionusing I TSM, select Regression>Specify and check Include intercept
term and Harmonic Regression. Then specify the number of harmonics (k in
(1.3.3)) and enter k integer-valued Fourier indices f1, ..., fi. For a sine wave with
period d, set f; = n/d, where n isthe number of observationsin the time series. (If
n/d isnot an integer, you will need to delete afew observations from the beginning
of the seriesto makeit so.) The other k — 1 Fourier indices should be positiveinteger
multiples of the first, corresponding to harmonics of the fundamental sine wave with
period d. Thusto fit asingle sine wave with period 365 to 365 daily observations we
would choosek = 1and f; = 1. Tofit alinear combination of sinewaveswith periods
365/j,j=1,...,4, wewouldchoosek =4and f; = j, j =1,...,4. Oncek and
f1, ..., fi have been specified, click OK and then select Regression>Estimation
>Least Squares to obtain the required regression coefficients. To see how well the
fitted function matches the data, select Regression>Show fit.

Accidental deaths

To fit a sum of two harmonics with periods twelve months and six months to the
monthly accidental deaths data x1, ..., x, withn = 72, wechoose k = 2, f1 =

10 11
T

(thousands)

1 1 1 1 1 1
1973 1974 1975 1976 1977 1978
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n/12=6,and f, = n/6 = 12. Using ITSM as described above, we obtain the fitted
function shownin Figure 1.11. Ascan be seen from the figure, the periodic character
of the seriesis captured reasonably well by thisfitted function. In practice, it isworth
experimenting with several different combinations of harmonicsin order to find asat-
isfactory estimate of the seasonal component. The program ITSM also alowsfitting
alinear combination of harmonicsand polynomial trend by checking both Harmonic
Regression and Polynomial Regression in the Regression>Specification
dialog box. Other methods for dealing with seasonal variation in the presence of
trend are described in Section 1.5. O

1.3.3 A General Approach to Time Series Modeling

The examples of the previous section illustrate a general approach to time series
analysis that will form the basis for much of what is done in this book. Before
introducing the ideas of dependence and stationarity, we outline this approach to
provide the reader with an overview of the way in which the various ideas of this
chapter fit together.

e Plot the series and examine the main features of the graph, checking in particular
whether thereis
(a) atrend,
(b) a seasona component,
(c) any apparent sharp changesin behavior,
(d) any outlying observations.

o Removethetrend and seasonal componentsto get stationary residual s (as defined
in Section 1.4). To achieve this goal it may sometimes be necessary to apply a
preliminary transformation to the data. For example, if the magnitude of the
fluctuations appears to grow roughly linearly with the level of the series, then
thetransformed series {In X4, ..., In X,,} will have fluctuations of more constant
magnitude. See, for example, Figures 1.1 and 1.17. (If some of the data are
negative, add a positive constant to each of the data values to ensure that all
values are positive before taking logarithms.) There are several ways in which
trend and seasonal ity can beremoved (see Section 1.5), someinvol ving estimating
the components and subtracting them from the data, and others depending on
differencing the data, i.e., replacing the original series{X,} by {Y; .= X, — X,_4}
for some positive integer 4. Whichever method is used, the aim is to produce a
stationary series, whose values we shall refer to as residuals.

e Choose a mode to fit the residuals, making use of various sample statistics in-
cluding the sample autocorrelation function to be defined in Section 1.4.

e Forecasting will be achieved by forecasting the residuals and then inverting the
transformations described above to arrive at forecasts of the original series {X,}.
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e An extremely useful alternative approach touched on only briefly in this book is
to express the series in terms of its Fourier components, which are sinusoidal
waves of different frequencies (cf. Example 1.1.4). This approach is especially
important in engineering applications such as signal processing and structural
design. It isimportant, for example, to ensure that the resonant frequency of a
structure does not coincide with afrequency at which the loading forces on the
structure have a particularly large component.

1.4 Stationary Models and the Autocorrelation Function

L oosely speaking, atimeseries{X,,t = 0, 1, ...} issaidto bestationary if it has sta-
tistical properties similar to those of the “time-shifted” series{X,.,,t =0, £1, ...},
for each integer &. Restricting attention to those properties that depend only on the
first- and second-order moments of {X,}, we can make this idea precise with the
following definitions.

Definition 1.4.1 Let {X,} beatime serieswith E(X?) < oo. The mean function of {X,} is
px(t) = E(X,).

The covariance function of {X,} is
yx(r,s) = Cov(X,, X;) = E[(X, — ux(r)(X; — pnx(s))]

for al integersr and s.

Definition 1.4.2 {X,} is(weakly) stationary if
(i) ux () isindependent of z,
and

(i) yx(¢t + h, r) isindependent of ¢ for each h.

Remark 1. Strict stationarity of atime series {X,,t = 0, &1, ...} isdefined by the
condition that (X4, ..., X,) and (X1,4, ..., X,4;) have the same joint distributions
for al integers h and n > 0. It is easy to check that if {X,} is strictly stationary and
EX? < oo for dl ¢, then {X,} is also weakly stationary (Problem 1.3). Whenever we
usetheterm stationary we shall mean weakly stationary asin Definition 1.4.2, unless
we specifically indicate otherwise. O

Remark 2. Inview of condition (ii), whenever we use the term covariance function
with reference to a stationary time series { X;} we shall mean the function yx of one
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variable, defined by
yx(h) = yx(h,0) = yx(t + h,1).

Thefunction yx () will be referred to as the autocovariance function and yy (k) asits
value at lag h. O

Let {X,} be a stationary time series. The autocovariance function (ACVF) of
{X,}alaghis

yx(h) = Cov(X, 4, Xo).
The autocorrelation function (ACF) of {X,} atlagh is

vx (h)
vx(0)

px(h) = = Cor(X; s, X;).

In the following examples we shall frequently usethe easily verified linearity prop-
erty of covariances, that if EX? < 0o, EY? < 00, EZ2 < oo and a, b, and ¢ are any
real constants, then

Cov(aX +bY +c¢,Z) =aCov(X, Z)+ bCov(Y, Z).
iid noise
If {X,}isiid noiseand E(X?) = o2 < oo, then the first requirement of Definition
1.4.2isobvioudy satisfied, since E(X,) = Ofor all ¢. By the assumed independence,
o, ifh=0,
Vx(f + h’ [) -
0, ifn#£0,

which does not depend on z. Henceiid noise with finite second moment is stationary.
We shall use the notation

{X;} ~ 11D (0, 0?)

to indicate that the random variables X, are independent and identically distributed
random variables, each with mean 0 and variance o2 O

White noise

If {X,} is a sequence of uncorrelated random variables, each with zero mean and
variance o2, then clearly {X,} is stationary with the same covariance function as the
iid noise in Example 1.4.1. Such asequence isreferred to as white noise (with mean
0 and variance o2). Thisisindicated by the notation

{X;} ~WN (0,0?).
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Example 1.4.4

Example 1.4.5

Clearly, every 11D(0, o'2) sequenceis WN(0, o'2) but not conversely (see Problem 1.8
and the ARCH(1) process of Section 10.3). O
The random walk

If {S,} isthe random walk defined in Example 1.3.3 with {X,} asin Example 1.4.1,
then ES, = 0, E(S?) = to? < oo for al ¢, and, for h > 0,

ys(t + h, 1) = CoV(Si1n, Sr)
=Cov(S; + Xip1+ -+ X, S)
= COV(S,, S
2

=to".

Since ys(t + h, t) depends on ¢, the series {S;} is not stationary. O

First-order moving average or MA(1) process
Consider the series defined by the equation
X, =272,4607Z,1, t=041,..., (14.1)

where {Z,} ~ WN (0, 0?) and ¢ is a real-valued constant. From (1.4.1) we see that
EX,=0,EX?= 0?1+ 6% < oo, and

02(1+92), if h =0,
yx(@t +h, 1) =1 0%, if h = 41,
0, if |h] > 1.

Thus the requirements of Definition 1.4.2 are satisfied, and {X,} is stationary. The
autocorrelation function of {X,} is

1, if h =0,
px(h)y =16/ (1+6%), ifh==1 i
0, if 7] > 1.

First-order autoregression or AR(1) process
Let usassume now that {X,} is a stationary series satisfying the equations
X, =¢X, 1+ 7Z;,, t=0,%1,..., (1.4.2)

where{Z,} ~ WN(O, 0?), |¢| < 1,and Z, isuncorrelated with X for eachs < ¢. (We
shall show in Section 2.2 that there isin fact exactly one such solution of (1.4.2).) By
taking expectations on each side of (1.4.2) and using the fact that EZ, = 0, we see
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at once that
EX, =0.

To find the autocorrelation function of {X,} we multiply each side of (1.4.2) by X,_,
(h > 0) and then take expectations to get

yx(h) = Cov(X,, X,_p)
= Cov(p X, 1, X, ) + Cov(Z,, X; )
= ¢yx(h—1) +0=-..=¢"y,(0).

Observing that y (h) = y (—h) and using Definition 1.4.3, we find that

h
ey = X gy 0 1,

vx(0)

It follows from the linearity of the covariance function in each of its arguments and
the fact that Z, is uncorrelated with X,_; that

VX(O) = Cov(X,, X;,) = Cov(¢X, 1+ Z;,¢X, .1+ Z,) = ¢2VX(0) + o?

and hence that yx (0) = 02/ (1 — ¢?). |

1.4.1 The Sample Autocorrelation Function

Although we have just seen how to compute the autocorrelation function for a few
simple time series models, in practical problems we do not start with a model, but
with observed data {x1, x», ..., x,}. To assess the degree of dependence in the data
and to select a model for the data that reflects this, one of the important tools we
use isthe sample autocorrelation function (sample ACF) of the data. If we believe
that the data are realized values of a stationary time series {X,}, then the sample
ACF will provide us with an estimate of the ACF of {X,}. This estimate may suggest
which of the many possible stationary time series models is a suitable candidate for
representing the dependence in the data. For example, a sample ACF that is close
to zero for al nonzero lags suggests that an appropriate model for the data might
beiid noise. The following definitions are natural sample analogues of those for the
autocovariance and autocorrelation functions given earlier for stationary time series
models.
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Definition 1.4.4

Figure 1-12
200 simulated values
of iid N(0,1) noise.

Let x4, ..., x, beobservations of atime series. Thesamplemean of x4, ..., x, is

The sample autocovariance function is

n—|h|
PR i=n""Y " (o — )5, —X), —n<h<n.
=1

The sample autocor relation function is

_ 9
7O

—n < h <n.

p(h)

Remark 3. For 2 > 0, y(h) is approximately equal to the sample covariance of
the n — h pairs of observations (x1, x1.1), (x2, X241), . . ., (X,—p, x,). The difference
arises from use of the divisor n instead of n — h and the subtraction of the overall
mean, x, from each factor of the summands. Use of the divisor n ensures that the
sample covariance matrix [, = [}(i — DI} ;=1 s nonnegative definite (see Section
2.4.2). O

Remark 4. Like Athe sample covariance matrix defined in Remark 3, the sample
correlation matrix R, = [p(i — j)]} ;_; is nonnegative definite. Each of its diagonal
elementsisequal to 1, since p(0) = 1. O
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Figure 1-13

The sample autocorrelation
function for the data of
Figure 1.12 showing

the bounds 4:1.96/./n.

Figure 1.12 shows 200 simulated values of normally distributed iid (0, 1), denoted
by 11D N(O, 1), noise. Figure 1.13 shows the corresponding sample autocorrelation
function at lags 0, 1, ..., 40. Since p(h) = 0 for 2 > 0, one would also expect the
corresponding sampleautocorrel ationsto benear 0. It can be shown, infact, that foriid
noisewith finite variance, the sample autocorrelations p (h), h > 0, areapproximately
IID N(O, 1/n) for n large (see TSTM p. 222). Hence, approximately 95% of the
sample autocorrelations should fall between the bounds 4+1.96/,/n (since 1.96 is
the .975 quantile of the standard normal distribution). Therefore, in Figure 1.13 we
would expect roughly 40(.05) = 2 valuesto fall outside the bounds. To simulate 200
values of 11D N(O, 1) noise using ITSM, select File>Project>New>Univariate
thenModel>Simulate. Intheresulting diaog box, enter 200 for the required Number
of Observations. (The remaining entriesin the dialog box can be left asthey are,
since the model assumed by ITSM, until you enter another, is 11D N(0O, 1) noise. If
you wish to reproduce exactly the same sequence at a later date, record the Random
Number Seed for later use. By specifying different values for the random number
seed you can generate independent realizations of your time series.) Click on 0K and
you will see the graph of your simulated series. To see its sample autocorrelation
function together with the autocorrelation function of the model that generated it,
click on the third yellow button at the top of the screen and you will see the two
graphs superimposed (with the latter in red.) The horizontal lines on the graph are
the bounds +£1.96//n. O

Remark 5. The sample autocovariance and autocorrel ation functions can be com-
puted for any data set {x4, ..., x,} and are not restricted to observations from a
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Figure 1-14
The sample autocorrelation A
function for the Australian [ | | | |

red wine sales showing
the bounds +1.96//n.

Lag

stationary time series. For data containing atrend, |o (k)| will exhibit slow decay as
h increases, and for data with a substantial deterministic periodic component, |o(h)|
will exhibit similar behavior with the same periodicity. (See the sasmple ACF of the
Australian red wine sales in Figure 1.14 and Problem 1.9.) Thus p(-) can be useful
as anindicator of nonstationarity (see also Section 6.1). O

1.4.2 A Model for the Lake Huron Data

Asnoted earlier, aniid noise modd for theresiduals{y, ..., yss} Obtained by fitting
astraight line to the Lake Huron data in Example 1.3.5 appears to be inappropriate.
Thisconclusionisconfirmed by the sample ACF of theresiduals (Figure 1.15), which
has three of the first forty values well outside the bounds +1.96/+/98.

The roughly geometric decay of the first few sample autocorrelations (with
p(h +1)/p(h) ~ 0.7) suggests that an AR(1) series (with ¢ ~ 0.7) might pro-
vide a reasonable model for these residuals. (The form of the ACF for an AR(1)
process was computed in Example 1.4.5.)

To explore the appropriateness of such a model, consider the points (y1, y»),
(¥2, ¥3), . . ., (¥o7, yeg) plotted in Figure 1.16. The graph does indeed suggest alinear
relationship between y, and y,_;. Using simpleleast squares estimation tofit astraight
line of the form y, = ay, 1, we obtain the model

Y, = .791Y,_1 + Z,, (1.4.3)

where (Z,} isiid noise with variance Y%, (y, — .791y, 1)?/97 = .5024. The sample
ACF of the estimated noise sequence z;, = y, — .791y,_1,¢t = 2,..., 98, isdightly
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Figure 1-15

The sample autocorrelation
function for the Lake
Huron residuals of

Figure 1.10 showing

the bounds +1.96//n.

Figure 1-16

Scatter plot of

Yecr, ye), t=2,...,98,
for the data in Figure 1.10
showing the least squares
regression line y = .791x.
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outside the bounds +1.96/+/97 at lag 1 (p(1) = .216), but it isinside the bounds for
all other lags up to 40. This check that the estimated noi se sequenceis consistent with
theiid assumption of (1.4.3) reinforces our belief in the fitted model. M ore goodness
of fit tests for iid noise sequences are described in Section 1.6. The estimated noise
sequence {z,} in thisexample passesthem all, providing further support for the model
(1.4.3).
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A better fit to the residuals in equation (1.3.2) is provided by the second-order
autoregression

Yi=¢1Y 1+ Y, 2+ Z,, (1.4.4)

where {Z,} is iid noise with variance o2. This is analogous to a linear model in
which Y; isregressed on the previoustwo values Y,_; and Y,_, of thetime seri&e The
least squares estimates of the parameters P and ¢,, found by minimizing Zt 3(y, -
qblyt 1 — ¢>2y, 2)2, are qbl = 1.002 and ¢2 = —.2834. The estimate of 62 is 62 =
Zt 3O — ¢1yt 1 — ¢2y, 2)?/96 = .4460, which is approximately 11% smaller than
the estimate of the noise variance for the AR(1) model (1.4.3). The improved fit is
indicated by the sample ACF of the estimated residuals, y, — ¢1y,_1 — ¢2y,_», Which
fallswell within the bounds +1.96/+/96 for all lags up to 40.

1.5 Estimation and Elimination of Trend and Seasonal Components

The first step in the analysis of any time series is to plot the data. If there are any
apparent discontinuities in the series, such as a sudden change of level, it may be
advisable to analyze the series by first breaking it into homogeneous segments. If
there are outlying observations, they should be studied carefully to check whether
there is any justification for discarding them (as for example if an observation has
been incorrectly recorded). Inspection of a graph may also suggest the possibility
of representing the data as arealization of the process (the classical decomposition
model)

Xe=mi+s+Y, (151

wherem;, isaslowly changing function known asatrend component, s, isafunction
with known period d referred to as aseasonal component, and ¥, isarandom noise
component that isstationary in the sense of Definition 1.4.2. If the seasonal and noise
fluctuations appear to increase with the level of the process, then apreliminary trans-
formation of the data is often used to make the transformed data more compatible
with the model (1.5.1). Compare, for example, the red wine salesin Figure 1.1 with
thetransformed data, Figure 1.17, obtai ned by applying alogarithmic transformation.
The transformed data do not exhibit the increasing fluctuation with increasing level
that was apparent in the original data. This suggests that the model (1.5.1) is more
appropriate for the transformed than for the original series. In this section we shall
assume that the model (1.5.1) is appropriate (possibly after a preliminary transfor-
mation of the data) and examine some techniques for estimating the components m;,
s;, and Y, in the model.

Our am is to estimate and extract the deterministic components m, and s, in
the hope that the residual or noise component ¥, will turn out to be a stationary time
series. We can then use the theory of such processesto find a satisfactory probabilistic
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Figure 1-17
The natural logarithms
of the red wine data.

75
T

7.0
T

6.5
T

|
1980 1982 1984 1986 1988 1990 1992

model for the process Y;, to analyze its properties, and to use it in conjunction with
m, and s, for purposes of prediction and simulation of {X,}.

Another approach, devel oped extensively by Box and Jenkins (1976), isto apply
differencing operators repeatedly to the series { X, } until the differenced observations
resemblearealization of some stationary time series {W;}. We can then usethetheory
of stationary processes for the modeling, analysis, and prediction of {W,} and hence
of theoriginal process. The various stages of thisprocedurewill be discussed in detail
in Chapters 5 and 6.

The two approaches to trend and seasonality removal, (1) by estimation of m;,
and s, in (1.5.1) and (2) by differencing the series {X,}, will now beillustrated with
reference to the dataintroduced in Section 1.1.

1.5.1 Estimation and Elimination of Trend in the Absence of Seasonality

In the absence of a seasonal component the model (1.5.1) becomes the following.

Nonseasonal M odel with Trend:
X, =m,+Y, t=1,...,n, (1.5.2

where EY, = 0.

(If EY, # 0, then we can replace m; and Y; in (1.5.2) withm, + EY, and Y, — EY;,
respectively.)
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Example 1.5.1

Method 1: Trend Estimation

Moving average and spectral smoothing are essentially nonparametric methods for
trend (or signal) estimation and not for model building. Special smoothing filters can
al so bedesigned to remove periodic componentsas described under Method S1 bel ow.
The choice of smoothing filter requires a certain amount of subjective judgment, and
it is recommended that a variety of filters be tried in order to get a good idea of the
underlying trend. Exponential smoothing, since it is based on a moving average of
past values only, is often used for forecasting, the smoothed value at the present time
being used as the forecast of the next value.

To construct a model for the data (with no seasonality) there are two general
approaches, both availablein ITSM. Oneistofit apolynomial trend (by least squares)
as described in Method 1(d) below, then to subtract the fitted trend from the data and
to find an appropriate stationary time series model for the residuals. The other is
to eliminate the trend by differencing as described in Method 2 and then to find an
appropriate stationary model for the differenced series. The latter method has the
advantage that it usually requires the estimation of fewer parameters and does not
rest on the assumption of atrend that remainsfixed throughout the observation period.
The study of the residuals (or of the differenced series) istaken up in Section 1.6.

(8 Smoothing with a finite moving average filter. Let ¢ be a nonnegative
integer and consider the two-sided moving average

q
Wo=2+D7" ) X, (1.5.3)

j=—q

of the process {X,} defined by (1.5.2). Thenforg +1 <t <n —gq,

q q
Wi=Q2+D7 ) mj+q+D Y Y ~m, (1.5.4)
j==q j==q
assuming that m, is approximately linear over theinterval [t — ¢, t + ¢] and that the
average of the error terms over thisinterval is close to zero (see Problem 1.11).
The moving average thus provides us with the estimates

q
myo=2q+D" ) X g+1l<t<n—gq. (1.5.5)
Jj=—q
Since X, is not observed for ¢+ < 0 or ¢+ > n, we cannot use (1.5.5) fort < ¢ or
t > n — ¢q. The program ITSM deals with this problem by defining X, := X; for
t<land X, =X, forr > n.

Theresult of applying the moving-averagefilter (1.5.5) withg = 2tothestrikedataof
Figure 1.6 isshownin Figure 1.18. The estimated noiseterms ¥, = X, —in, areshown
in Figure 1.19. As expected, they show no apparent trend. To apply thisfilter using
ITSM, open the project STRIKES.TSM, select Smooth>Moving Average, Specify
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Figure 1-18

Simple 5-term moving
average m; of the strike
data from Figure 1.6.

Figure 1-19
Residuals ¥, = X, — Ay,
after subtracting the
5-term moving average
from the strike data
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2 for thefilter order, and enter the weights 1,1,1 for Theta(0), Theta(1), and Theta(2)
(these are automatically normalized so that the sum of theweightsisone). Then click
OK. O

Itisuseful tothink of {1,}in(1.5.5) asaprocessobtainedfrom { X, } by application
of alinear operator or linear filter iz, = 3°%  a; X, ; with weightsa; = (2q +
1)1 —q < j < q.Thisparticularfilterisalow-passfilter inthe sensethat it takesthe
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{mt} {Tﬁt = Z ajxt_j}
- Linear Filter
Figure 1-20

Smoothing with a
low-pass linear filter.

data {X,} and removes from it the rapidly fluctuating (or high frequency) component
{¥,} to leave the slowly varying estimated trend term {s71,} (see Figure 1.20).

The particular filter (1.5.5) isonly one of many that could be used for smoothing.
For large ¢, provided that (2¢ + 1)=*>>%___ v, ; ~ 0, it not only will attenuate
noise but at the same time will allow linear trend functions m, = ¢q + c1t to pass
without distortion (see Problem 1.11). However, we must beware of choosing g to
betoo large, since if m, is not linear, the filtered process, although smooth, will not
be a good estimate of m,. By clever choice of the weights {a;} it is possible (see
Problems 1.12-1.14 and Section 4.3) to design afilter that will not only be effective
in attenuating noisein the data, but that will also allow alarger classof trend functions
(for exampleall polynomialsof degreelessthan or equal to 3) to passthrough without
distortion. The Spencer 15-point moving average is afilter that passes polynomials
of degree 3 without distortion. Itsweights are

a; =0, |j|>7,
with

aj=a_;, |jl=<7,
and

1
[a0. ax..... ar) = 755[74.67. 46,21, 3, =5, -6, 3. (1.5.6)

Applied to the process (1.5.2) with m, = cq + c1t + cot? + cat3, it gives

7 7 7 7
E ant7j= E ajm,,j—l— E antij: E ajnm;_; = Ny,

= = = =

wherethelast step depends on the assumed form of m:, (Problem 1.12). Further details
regarding this and other smoothing filters can be found in Kendall and Stuart (1976),

Chapter 46.
(b) Exponential smoothing. For any fixed « € [0, 1], the one-sided moving
averagesm,,t = 1, ..., n, defined by the recursions
m,=aX, +(1l—a)m,_,, t=2,...,n, (1.5.7)
and

my = X (1.5.8)
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Figure 1-21
Exponentially smoothed
strike data with « = 0.4.

can be computed using ITSM by selecting Smooth>Exponential and specifying
the value of «. Application of (1.5.7) and (1.5.8) is often referred to as exponential
smaoothing, since the recursions imply that for r > 2, m, = th_:%a(l —a) X,_; +
(1 — a)'~'X,, aweighted moving average of X,, X,_1, ..., with weights decreasing
exponentialy (except for the last one).

(c) Smoothing by elimination of high-frequency components. The option
Smooth>FFT in the program ITSM alows us to smooth an arbitrary series by elimi-
nation of the high-frequency components of its Fourier series expansion (see Section
4.2). This option was used in Example 1.1.4, where we chose to retain the fraction
f = .035of thefreguency componentsof theseriesin order to estimatetheunderlying
signal. (The choice f = 1 would have left the series unchanged.)

In Figures 1.21 and 1.22 we show the results of smoothing the strike data by ex-
ponential smoothing with parameter « = 0.4 (see (1.5.7)) and by high-frequency
elimination with f = 0.4, i.e.,, by eliminating a fraction 0.6 of the Fourier compo-
nents at the top of the frequency range. These should be compared with the simple
5-term moving average smoothing shown in Figure 1.18. Experimentation with dif-
ferent smoothing parameters can easily be carried out using the program ITSM. The
exponentially smoothed value of the last observation is frequently used to forecast
the next data value. The program automatically selects an optimal value of « for this
purposeif « is specified as —1 in the exponential smoothing dialog box. O

(d) Polynomial fitting. In Section 1.3.2 we showed how a trend of the form
m; = ap+ ast + a,t? can befittedtothedata{xy, . .., x,} by choosing the parameters
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Figure 1-22

Strike data smoothed

by elimination of high
frequencies with f = 0.4.
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ao, a1, and a, to minimize the sum of squares, >, (x, — m,)? (see Example 1.3.4).
The method of least sguares estimation can also be used to estimate higher-order
polynomial trends in the same way. The Regression option of ITSM alows least
squares fitting of polynomial trends of order up to 10 (together with up to four har-
monic terms; see Example 1.3.6). It also allows generalized |east squares estimation
(see Section 6.6), in which correlation between the residual s is taken into account.

Method 2: Trend Elimination by Differencing

Instead of attempting to remove the noise by smoothing as in Method 1, we now
attempt to eliminate the trend term by differencing. We define the lag-1 difference
operator V by

VX, =X, — X,.1=1-B)X,, (1.5.9)
where B isthe backward shift operator,
BX, =X, 1. (1.5.10)

Powers of the operators B and V are defined in the obviousway, i.e., B/ (X,) = X,_;
and V/(X,) = V(V/7(X))), j > 1, with VO(X,) = X,. Polynomialsin B and V are
manipulated in precisely the same way as polynomial functions of real variables. For
example,

V2X, =V(V(X,)) = (1- BY1— B)X, = (1- 2B + B)X,

=X, —2X, 1+ X, _».
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Figure 1-23

The twice-differenced series
derived from the population
data of Figure 1.5.

If the operator V isapplied to alinear trend functionm, = cq+ c1t, thenwe obtain the
constant function Vim, = m, — m,_1 = cg + c1t — (co + c1(t — 1)) = c¢1. Inthe same
way any polynomial trend of degree k can be reduced to a constant by application of
the operator V* (Problem 1.10). For example, if X, = m, +Y,, wherem, = Zl;:o c;t!
and Y, is stationary with mean zero, application of V* gives

VX, = kleg + VFY,,

a stationary process with mean k!c,. These considerations suggest the possibility,
given any sequence {x,} of data, of applying the operator V repeatedly until we find
a sequence {V*x,} that can plausibly be modeled as a redlization of a stationary
process. It is often found in practice that the order k of differencing required is quite
small, frequently one or two. (This relies on the fact that many functions can be
well approximated, on an interval of finitelength, by apolynomial of reasonably low
degree.)

Applying theoperator V tothepopulationvalues{x;,r = 1, ..., 20} of Figure 1.5, we
find that two differencing operati ons are sufficient to produce aserieswith no apparent
trend. (To carry out the differencing using ITSM, select Transform>Difference,
enter the value 1 for the differencing lag, and click 0K.) This replaces the original
series {x,} by the once-differenced series {x, — x,_1}. Repetition of these steps gives
the twice-differenced series V2x, = x, — 2x,_1 + x,_», plotted in Figure 1.23. Notice
that the magnitude of thefluctuationsin V2x, increaseswith thevalueof x,. Thiseffect
can be suppressed by first taking natural logarithms, y, = Inx,, and then applying the
operator V2 to the series {y,}. (See also Figures 1.1 and 1.17.) O
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1.5.2 Estimation and Elimination of Both Trend and Seasonality

The methods described for the estimation and elimination of trend can be adapted in
anatural way to eliminate both trend and seasonality in the general model, specified
asfollows.

Classical Decomposition M odel
X, =m+s,+Y, t=1...,n, (1.5.11)

where EY, =0, s.4q0=3s, and Zlesj =0.

We shall illustrate these methods with reference to the accidental deaths data of
Example 1.1.3, for which the period d of the seasonal component is clearly 12.

Method S1: Estimation of Trend and Seasonal Components
The method we are about to describe is used in the Transform>Classical option
of ITSM.

Suppose we have observations {xi, ..., x,}. The trend is first estimated by ap-
plying a moving average filter specially chosen to eliminate the seasonal component
and to dampen the noise. If the period d iseven, say d = 2¢, then we use

my = (0.5x,_, +x_gi1+ -+ x44-1+05x,,)/d, qg<t<n-—gq. (1512)

If the period isodd, say d = 2¢ + 1, then we use the simple moving average (1.5.5).

The second stepisto estimate the seasonal component. Foreachk =1, ..., d,we
computetheaverage w, of thedeviations{(xi+ ja — i+ a), g < k+jd < n—q}.Since
these average deviations do not necessarily sum to zero, we estimate the seasonal
component s; as

d
S=we—d Y w, k=1....d. (1.5.13)
i=1

and §k = §k—da k>d.
Thedeseasonalized dataisthen defined to bethe original serieswiththeestimated
seasonal component removed, i.e.,

dt:xt_:g\[, t:].,...,n. (1.5.14)

Finally, we reestimate the trend from the deseasonalized data {d,} using one of
the methods already described. The program ITSM alows you to fit aleast squares
polynomial trend 7/ to the deseasonalized series. In terms of this reestimated trend
and the estimated seasonal component, the estimated noise seriesis then given by

A

Y, =x,—m,—5, t=1,...,n.
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Figure 1-24

The deseasonalized
accidental deaths
data from ITSM.

The reestimation of the trend is donein order to have aparametric form for the trend
that can be extrapolated for the purposes of prediction and simulation.

Figure 1.24 shows the deseasonalized accidental deaths data obtained from ITSM
by reading in the series DEATHS.TSM, selecting Transform>Classical, check-
ing only the box marked Seasonal Fit, entering 12 for the period, and clicking
OK. The estimated seasonal component s,, shown in Figure 1.25, is obtained by se-
lecting Transform>Show Classical Fit. (Except for having amean of zero, this
estimate is very similar to the harmonic regression function with frequencies 2 /12
and 2 /6 displayed in Figure 1.11.) The graph of the deseasonalized data suggests
the presence of an additional quadratic trend function. In order to fit such atrend to
the deseasonalized data, select Transform>Undo Classical toretrievetheorigina
data and then select Transform>Classical and check the boxes marked Seasonal
Fit and Polynomial Trend, entering 12 for the period and selecting Quadratic
for the trend. Then click OK and you will obtain the trend function

i, = 9952 — 71.82¢ 4 0.8260r%, 1<t <72
At this point the data stored in ITSM consists of the estimated noise
Vi=x =i, —5, t=1,...,72,

obtained by subtracting the estimated seasonal and trend componentsfromtheoriginal
data O
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data from ITSM.

Example 1.5.5

Method S2: Elimination of Trend and Seasonal Components by Differencing
The technique of differencing that we applied earlier to nonseasonal data can be
adapted to deal with seasonality of period d by introducing the lag-d differencing
operator V, defined by

VaXi =X, — X;_g = (1 - B)X,. (1.5.15)

(This operator should not be confused with the operator V¢ = (1 — B)“ defined
earlier)
Applying the operator V, to the model

Xi=m; +s+ Y,
where {s,} has period d, we abtain
VaXi =my —my_yg+ Y, — Y4,

which gives a decomposition of the difference V,; X, into atrend component (m, —
m,_yq) andanoiseterm (Y, —Y,_,). Thetrend, m, —m;,_,, canthen be eliminated using
the methods aready described, in particular by applying a power of the operator V.

Figure 1.26 shows the result of applying the operator Vi, to the accidental deaths
data. The graphisobtained from ITSM by opening DEATHS. TSM, selecting Trans-
form>Difference, enteringlag 12, and clicking 0K. The seasonal component evident
in Figure 1.3 is absent from the graph of Vi,x;, 13 < r < 72. However, there still
appears to be a nondecreasing trend. If we now apply the operator V to {Vy,x;} by
again selecting Transform>Difference, thistimewith lag one, we obtain the graph
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Figure 1-26

The differenced series
(Viox, t =13,...,72)
derived from the monthly
accidental deaths

X, t=1,...,72).

Figure 1-27

The differenced series
(VVix, t=14,...,72}
derived from the monthly
accidental deaths

(X, t=1,...,72).
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of VVix,, 14 <t < 72, shown in Figure 1.27, which has no apparent trend or sea
sona component. In Chapter 5 we shall show that this doubly differenced series can
in fact be well represented by a stationary time series model.

O

In this section we have discussed a variety of methods for estimating and/or
removing trend and seasonality. The particular method chosen for any given data
set will depend on a number of factors including whether or not estimates of the
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components of the series are required and whether or not it appears that the data
contain a seasonal component that does not vary with time. The program ITSM
allows two options under the Transform menu:

1. “classical decomposition,” in which trend and/or seasonal components are esti-
mated and subtracted from the data to generate a noise sequence, and

2. “differencing,” in which trend and/or seasonal components are removed from the
data by repeated differencing at one or more lags in order to generate a noise
sequence.

A third option is to use the Regression menu, possibly after applying a Box—Cox
transformation. Using this option we can (see Example 1.3.6)

3. fit asum of harmonics and a polynomial trend to generate a noise sequence that
consists of the residuals from the regression.

In the next section we shall examine some techniquesfor deciding whether or not the
noise sequence so generated differs significantly fromiid noise. If the noise sequence
does have sampl e autocorrel ations significantly different from zero, then we can take
advantage of this serial dependence to forecast future noise values in terms of past
values by modeling the noise as a stationary time series.

1.6 Testing the Estimated Noise Sequence

The objective of the data transformations described in Section 1.5 is to produce a
serieswith no apparent deviationsfrom stationarity, and in particular with no apparent
trend or seasonality. Assuming that this has been done, the next step isto model the
estimated noise sequence (i.e., theresiduals obtained either by differencing the data
or by estimating and subtracting the trend and seasonal components). If thereis no
dependence among between these residua's, then we can regard them as observations
of independent random variables, and thereisno further modeling to be done except to
estimate their mean and variance. However, if there is significant dependence among
the residuals, then we need to look for a more complex stationary time series model
for the noise that accounts for the dependence. This will be to our advantage, since
dependence meansin particul ar that past observations of the noise sequence can assist
in predicting future values.

In this section we examine some simple tests for checking the hypothesis that
the residuals from Section 1.5 are observed values of independent and identically
distributed random variables. If they are, then our work is done. If not, then we must
use the theory of stationary processesto be developed in later chaptersto find amore
appropriate model.
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(& The sample autocorrelation function. For large n, the sample autocorre-
lations of an iid sequence Y1, .. ., ¥, with finite variance are approximately iid with
distribution N(0, 1/n) (see TSTM p. 222). Hence, if y4, ..., y, is aredization of
such an iid sequence, about 95% of the sample autocorrelations should fall between
the bounds +1.96/ /. If we compute the sample autocorrelations up to lag 40 and
find that more than two or three valuesfall outside the bounds, or that one valuefalls
far outside the bounds, we therefore reject theiid hypothesis. The bounds 4-1.96/ /n
are automatically plotted when the sample autocorrelation function is computed by
the program I TSM.

(b) The portmanteau test. Instead of checking to see whether each sample
autocorrelation p(j) fals inside the bounds defined in (a) above, it is aso possible
to consider the single statistic

h
Q=n) ()
j=1

If Yq, ..., Y, isafinite-varianceiid sequence, then by the sameresult usedin (a), Q is
approximately distributed as the sum of squares of the independent N(O, 1) random
variables, \/np(j), j = 1,..., h, i.e, as chi-squared with 4 degrees of freedom. A
largevalue of O suggeststhat the sample autocorrelations of the dataaretoo largefor
the data to be a sample from an iid sequence. We therefore reject the iid hypothesis
alevel o if Q > x% ,(h), where x? ,(h) isthe 1 — o quantile of the chi-squared
distribution with i degrees of freedom. The program ITSM conducts a refinement of
thistest, formulated by Ljung and Box (1978), in which Q isreplaced by

h
Qs =n(n+2) Y p*()/(n—j),
j=1

whose distribution is better approximated by the chi-squared distribution with &
degrees of freedom.

Another portmanteau test, formulated by McLeod and Li (1983), can be used as
afurther test for the iid hypothesis, sinceif the dataareiid, then the squared dataare
alsoiid. It is based on the same statistic used for the Ljung—Box test, except that the
sample autocorrelations of the data are replaced by the sample autocorrelations of
the squared data, pww (1), giving

h
OuL =n(n+2) Y phy(k)/(n — k).
k=1

The hypothesis of iid datais then rejected at level « if the observed value of Q. is
larger than the 1 — « quantile of the x (k) distribution.

(c) The turning point test. 1If yq, ..., v, isasequence of observations, we say
that thereisaturning point at timei,1 < i < n,if y;_1 < y; and y; > y;q Orif
yic1 > yi and y; < y;.q. If T isthe number of turning points of an iid sequence of
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length n, then, since the probability of aturning point at time i is % the expected
valueof T is

ur = E(T) =2(n —2)/3.
It can also be shown for an iid sequence that the variance of T is
of = Var(T) = (16n — 29)/90.

A large value of T — ur indicates that the series is fluctuating more rapidly than
expected for an iid sequence. On the other hand, a value of T — wy much smaller
than zero indicates a positive correlation between neighboring observations. For an
iid sequence with n large, it can be shown that

T isapproximately N(uz, o7).

This means we can carry out a test of the iid hypothesis, rejecting it at level « if
IT — prl/or > P1_q2, Where ®y_, 5 isthe 1 — /2 quantile of the standard normal
distribution. (A commonly used value of « is .05, for which the corresponding value
of ®1_,/2151.96.)

(d) The difference-sign test. For thistest we count the number S of valuesof i
suchthaty; > yi_1,i = 2, ..., n, or equivalently the number of timesthe differenced
series y; — y;_1 ispositive. For aniid sequenceit is clear that

=ES= 1( 1
Mg = = 50— ).
It can also be shown, under the same assumption, that
o =Va(S) = (n+1)/12,
and that for large n,
S is approximately N(ps, o).

A large positive (or negative) value of S — u g indicates the presence of anincreasing
(or decreasing) trend in the data. We therefore reject the assumption of no trend in
the dataif |S — ps|/os > P1_q/2.

Thedifference-sign test must be used with caution. A set of observations exhibit-
ing astrong cyclic component will passthe difference-sign test for randomness, since
roughly half of the observations will be points of increase.

(e) The rank test. Therank test isparticularly useful for detecting alinear trend
in the data. Define P to be the number of pairs (i, j) such that y; > y; and j > i,
i=1,...,n— 1 Thereisatotal of (}) = 3n(n — 1) pairs (i, j) suchthat j > i. For
an iid sequence {Y1, ..., ¥,}, each event {Y; > Y;} has probability % and the mean
of P istherefore

1
Mp = Zn(n — 1)
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It can also be shown for an iid sequence that the variance of P is
o =n(n—1)(2n +5)/72

and that for large n,
P isapproximately N(up, o5)

(see Kendall and Stuart, 1976). A large positive (negative) value of P — up indicates
the presence of an increasing (decreasing) trend in the data. The assumption that
{y;} is a sample from an iid sequence is therefore rejected at level « = 0.05 if
|P — ppl/op > ®1_qp2 = 1.96.

(f) Fitting an autoregressive model. A further test that can becarried out using
the program I TSM isto fit an autoregressive model to the data using the Yule-Walker
algorithm (discussed in Section 5.1.1) and choosing the order which minimizes the
AICC datistic (see Section 5.5). A selected order equal to zero suggeststhat the data
iswhite noise.

(9) Checking for normality. If the noise processis Gaussian, i.e., if al of its
joint distributions are normal, then stronger conclusions can be drawn when amodel
is fitted to the data. The following test enables us to check whether it is reasonable
to assume that observations from an iid sequence are also Gaussian.

Let Y < Y < -+ < Y, betheorder statistics of arandom sample Y1, ..., Y,
from the distribution N(u, 02). If X3 < X < --- < X, are the order statistics
from aN(0, 1) sample of sizen, then

EY(]') :M—i—amj,

wherem; = EX(;), j = 1,...,n. Thegraph of the points (m1, Y1), ..., (m,, Yi))
iscalled aGaussian qq plot) and can bedisplayedin ITSM by clicking on theyellow
button labeled QQ. If the normal assumptionis correct, the Gaussian qq plot should be
approximately linear. Consequently, the squared correlation of the points (m;, Y)),
i =1,...,n,shouldbenear 1. Theassumption of normality isthereforerejectedif the
squared correlation R? issufficiently small. If we approximatem; by ®=1((i —.5)/n)
(see Mage, 1982 for some alternative approximations), then R? reduces to

XYy -Vt (%—’))2
n E72 n i 2’
Zi:l(Y(i) - Y)2 Zi:l ((I)*l ( n5))
whereY = n~1(Y1+---+Y,). Percentage points for the distribution of R?, assuming
normality of the sample values, are given by Shapiro and Francia (1972) for sample

sizesn < 100. For n = 200, P(R? < .987) = .05 and P(R? < .989) = .10. For
larger values of n the Jarque-Beratest for normality can be used (see Section 5.3.3).

R? =

If we did not know in advance how the signal plus noise data of Example 1.1.4 were
generated, we might suspect that they came from an iid sequence. We can check this
hypothesis with the aid of the tests (a)—(f) introduced above.
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Figure 1-28

The sample autocorrelation
function for the data of
Example 1.1.4 showing

the bounds 4:1.96/./n.

ACF

(a) The sample autocorrelation function (Figure 1.28) is obtained from ITSM by
opening the project SIGNAL.TSM and clicking on the second yellow button at the
top of the ITSM window. Observing that 25% of the autocorrelations are outside the
bounds +1.96/+/200, we reject the hypothesis that the seriesisiid.

The remaining tests (b), (c), (d), (e), and (f) are performed by choosing the option
Statistics>Residual Analysis>Tests of Randomness. (Since no model has
been fitted to the data, the residuals are the same as the data themselves.)

(b) The samplevalue of the Ljung—Box statistic 0, g withs = 20is51.84. Since
the corresponding p-value (displayed by ITSM) is .00012 < .05, we regject the iid
hypothesis at level .05. The p-value for the McLeod-Li statistic Q. is0.717. The
McLeod-Li statistic does therefore not provide sufficient evidence to reject the iid
hypothesis at level .05.

(c) The sample value of the turning-point statistic 7' is 138, and the asymptotic
distribution under theiid hypothesis(with samplesizen = 200) isN(132, 35.3). Thus
|T — ur|/or = 1.01, corresponding to a computed p-value of .312. On the basis of
the value of T thereistherefore not sufficient evidence to reject the iid hypothesis at
level .05.

(d) The sample value of the difference-sign statistic S is 101, and the asymptotic
distribution under the iid hypothesis (with sample size n = 200) is N(99.5, 16.7).
Thus|S—us|/os = 0.38, corresponding to acomputed p-valueof 0.714. Onthebasis
of thevalue of S thereistherefore not sufficient evidence to reject the iid hypothesis
at level .05.
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Problems

(e) The sample value of the rank statistic P is 10310, and the asymptotic dis-
tribution under the iid hypothesis (with n = 200) is N(9950, 2.239 x 10°). Thus
|P — upl|/op = 0.76, corresponding to acomputed p-value of 0.447. On the basis of
the value of P thereistherefore not sufficient evidence to reject theiid hypothesis at
level .05.

(f) The minimum-AlCC Yule-Walker autoregressive model for the data is of
order seven, supporting the evidence provided by the sample ACF and Ljung—Box
tests against the iid hypothesis.

Thus, although not all of the tests detect significant deviation from iid behavior,
the sample autocorrelation, the Ljung—Box statistic, and thefitted autoregression pro-
videstrong evidenceagainst it, causing ustoreject it (correctly) inthisexample,. O

The general strategy in applying the tests described in this section is to check
them all and to proceed with caution if any of them suggests a serious deviation
from the iid hypothesis. (Remember that as you increase the number of tests, the
probability that at least one rejects the null hypothesis when it istrue increases. You
should therefore not necessarily reject the null hypothesis on the basis of one test
result only.)

1.1. Let X and Y betwo random variableswith E(Y) = p and EY? < cc.
a. Show that the constant ¢ that minimizes E(Y — ¢)?isc = p.
b. Deduce that the random variable f(X) that minimizes E[(Y — f(X))?X] is

f(X) = E[Y|X].
c. Deduce that the random variable f(X) that minimizes E(Y — f(X))? isaso
f(X) = E[Y|X].
1.2. (Generdization of Problem 1.1.) Supposethat X, X, ... isasequence of ran-
dom variableswith E(X?) < oo and E(X,) = u.

a. Show that the random variable f (X4, ..., X,,) that minimizes E[(X,IH —
FX1 oo X)X, ... X, ] is

f(le sy Xn) = E[Xn+l|le sy Xn]

b. Deduce that the random variable f (X1, ..., X,) that minimizes E[ (X,+1 —
f(X1, ..., X,))? isdso

f(X1, ..., X)) = E[ X0l X1, ..., X,].

c. If Xy, Xo, ... isiidwith E(X?) < oo and EX; = p, where n isknown, what
istheminimum mean squared error predictor of X, ; intermsof X, ..., X,,?



Problems 41

13.
14.

15

1.6.

1.7.

d. Under the conditions of part (c) show that the best linear unbiased estimator
of wintermsof Xi,..., X, isX = 3(X; + .- + X,). (i said to be an
unbiased estimator of w if Eg = u for all )

e. Under the conditions of part (c) show that X is the best linear predictor of
X, that isunbiased for u.

f. If X1, Xo, ... isiid with E(X?) < oo and EX; = u, andif S =0, S, =
X1+ -+ X,,n = 1,2, ..., wha is the minimum mean squared error
predictor of S,.; intermsof Sy, ..., S,?

Show that a strictly stationary process with E(X?) < oo isweakly stationary.

Let {Z,} be a sequence of independent normal random variables, each with
mean 0 and variance o2, and let a, b, and ¢ be constants. Which, if any, of
the following processes are stationary? For each stationary process specify the
mean and autocovariance function.

a X, =a+bZ +cZ,_»

b. X, = Z,cos(ct) + Z>sin(cr)
C. X, = Z,cos(ct) + Z,_,Sin(ct)
d X, =a+bZy

e. X, = Zycos(cr)

f. X,=Z,7Z,_4

Let {X,} be the moving-average process of order 2 given by
X =7Z + 92[—25

where {Z,} isWN(O, 1).

a. Find the autocovariance and autocorrelation functions for this process when
0 =.8

b. Compute the variance of the sample mean (X; + X> + X3 + X4)/4 when
6 =.8.

C. Repesat (b) when 6 = —.8 and compare your answer with the result obtained
in(b).

Let {X,} bethe AR(1) process defined in Example 1.4.5.

a. Compute the variance of the sample mean (X; + X, + X3 + X4)/4 when
¢=.9ando? =1

b. Repeat (a) when ¢ = —.9 and compare your answer with the result obtained
in (a).

If {X,} and {Y;} are uncorrelated stationary sequences, i.e., if X, and Y, are
uncorrelated for every r and s, show that {X; + Y,} is stationary with autoco-
variance function equal to the sum of the autocovariance functions of {X,} and

{Y:}.
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1.8. Let{Z,} bellD N(0, 1) noise and define

Z,, if r iseven,

(22, —1)/v2, ifrisodd.

a. Show that {X,} isWN(O, 1) but not iid(0, 1) noise.

b. Find E(X,,1|X1, ..., X,) for n odd and n even and compare the results.

X, =

1.9. Let {x4,...,x,} be observed values of atime seriesat times 1, ..., n, and let
o(h) bethe sample ACF at lag  asin Definition 1.4.4.

a If x;, = a + bt, wherea and b are constants and » # 0, show that for each
fixedh > 1,

p(h) > lasn — oo.

b. If x; = ccos(wt), where ¢ and w are constants (¢ # 0 and w € (-, 7)),
show that for each fixed #,

p(h) — coS(wh) asn — oo.

110.1f m, = Y p_yct*, t = 0,£1, ..., show that Vm, is a polynomia of degree
p — 1int and hence that V7*im, = 0.

1.11. Consider thesimplemoving-averagefilter withweightsa; = (29 +1)~%, —¢ <
J=q.
a If m, = co + c1#, show that Z?:_q aim,_; =m;.

b.1fZ,t =0,41, £2, ..., areindependent random variableswith mean 0 and
variance o2, show that the moving average A, = Z(f?q a;Z,_; is"“small”
for large g inthe sensethat EA, = O and Var(A,) = 02/(2q + 1).

112 a Show that a linear filter {a;} passes an arbitrary polynomia of degree k
without distortion, i.e., that

m; = Zajm,_j
j
for all kth-degree polynomialsm; = co + c1t + - - - + ¢;t*, if and only if
Zaj = l and
j
Y jlaj=0, forr=1... .k
j

b. Deduce that the Spencer 15-point moving-average filter {a;} defined by
(1.5.6) passes arbitrary third-degree polynomial trends without distortion.
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1.13. Find a filter of the form 1 + «B + BB? + y B3 (i.e, find «, B, and y) that
passes linear trends without distortion and that eliminates arbitrary seasonal
components of period 2.

1.14. Show that the filter with coefficients [a_2, a_1, ao, a1, az] = %[—1, 4,3,4,-1]
passes third-degree polynomials and eliminates seasonal components with pe-
riod 3.

1.15. Let {Y,} be a stationary process with mean zero and let @ and b be constants.

alf X, =a+bt +s +Y, wheres, is a seasona component with period
12, show that VV,X, = (1 — B)(1 — B¥)X, is Stationary and express its
autocovariance function in terms of that of {,}.

b. If X, = (a + bt)s, + Y;, where s, is a seasonal component with period 12,
show that VZ, X, = (1— B'?)2X, isstationary and expressits autocovariance
function in terms of that of {Y,}.

1.16. (Using ITSM to smooth the strikesdata.) Double-click onthe I TSM icon, select
File>Project>Open>Univariate, click OK, and open the file STRIKES.
TSM. The graph of the data will then appear on your screen. To smooth the
dataselect Smooth>Moving Ave, Smooth>Exponential, OF Smooth>FFT. Try
using each of these to reproduce the results shown in Figures 1.18, 1.21, and
1.22.

1.17. (Using ITSM to plot the deaths data.) In ITSM select File>Project>0pen>
Univariate, click OK, and open the project DEATHS.TSM. The graph of
the data will then appear on your screen. To see a histogram of the data, click
on the sixth yellow button at the top of the ITSM window. To see the sample
autocorrelation function, click on the second yellow button. The presence of a
strong seasonal component with period 12 is evident in the graph of the data
and in the sample autocorrelation function.

1.18. (Using ITSM to analyze the deaths data.) Open the file DEATHS. TSM, select
Transform>Classical, check the box marked Seasonal Fit, and enter 12
for the period. Make surethat the box labeled Polynomial Fit isnot checked,
and click, OK. You will then see the graph (Figure 1.24) of the deseasonalized
data. Thisgraph suggeststhe presence of an additional quadratic trend function.
To fit such atrend to the deseasonalized data, select Transform>Undo Clas-
sical to retrieve the original data. Then select Transform>Classical and
check the boxes marked Seasonal Fit and Polynomial Trend, entering 12
for the period and Quadratic for the trend. Click 0K and you will obtain the
trend function

i, = 9952 — 71.82 + 0.8260r%, 1<t < 72.
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At this point the data stored in ITSM consists of the estimated noise
Yo=x —m,—5, t=1,...,72

obtained by subtracting the estimated seasonal and trend components from the
original data. The sample autocorrelation function can be plotted by clicking
on the second yellow button at the top of the ITSM window. Further tests for
dependence can be carried out by selecting theoptionsStatistics>Residual
Analysis>Tests of Randomness. Itisclear from thesethat thereis substan-
tial dependencein the series {Y;}.

Toforecast the datawithout allowing for this dependence, select theoptionFore-
casting>ARMA. Specify 24 for the number of values to be forecast, and the program
will compute forecasts based on the assumption that the estimated seasonal and trend
components are true values and that {Y,} is a white noise sequence with zero mean.
(This is the default model assumed by ITSM until a more complicated stationary
model is estimated or specified.) The original data are plotted with the forecasts
appended.

Later we shall see how to improve on these forecasts by taking into account the
dependencein the series {Y,}.

1.19. Use a text editor, e.g., WORDPAD or NOTEPAD, to construct and save a
text file named TEST.TSM, which consists of a single column of 30 numbers,
{x1, ..., x30}, defined by

X1, ..., X10 - 486, 474, 434, 441, 435, 401, 414, 414, 386, 405;
X1, ..., Xz - 411, 389, 414, 426, 410, 441, 459, 449, 486, 510;
X1, ..., X3 - 506, 549, 579, 581, 630, 666, 674, 729, 771, 785.

This seriesisin fact the sum of a quadratic trend and a period-three seasonal
component. Use the program ITSM to apply the filter in Problem 1.14 to this
time series and discuss the results.
(Once the data have been typed, they can be imported directly into ITSM by
coping and pasting to theclipboard, andthenin I TSM selectingFile>Project>New>
Univariate, clicking on OK and selecting File>Import Clipboard.)
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2.1 Basic Properties

2.2 Linear Processes

2.3 Introduction to ARMA Processes

2.4 Properties of the Sample Mean and Autocorrelation Function
2.5 Forecasting Stationary Time Series

2.6 The Wold Decomposition

A key rolein time series analysisis played by processes whose properties, or some
of them, do not vary with time. If we wish to make predictions, then clearly we
must assume that something does not vary with time. In extrapolating deterministic
functionsit is common practice to assume that either the function itself or one of its
derivatives is constant. The assumption of a constant first derivative leads to linear
extrapolation as a means of prediction. In time series analysis our goal isto predict
a series that typically is not deterministic but contains a random component. If this
random component is stationary, in the sense of Definition 1.4.2, then we can develop
powerful techniquesto forecast itsfuture values. These techniqueswill be devel oped
and discussed in this and subsequent chapters.

2.1 Basic Properties

In Section 1.4 we introduced the concept of stationarity and defined the autocovari-
ance function (ACVF) of astationary time series { X;} as

y(h) = CoV(X, 1, X)), h=0,£1+£2 ...
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Theautocorrelation function (ACF) of {X,} wasdefined similarly asthefunction o (-)
whosevalueatlag i is

R0)
y ()’

The ACVF and ACF provide a useful measure of the degree of dependence among

the values of atime series at different times and for this reason play an important

role when we consider the prediction of future values of the series in terms of the

past and present values. They can be estimated from observations of X4, ..., X, by

computing the sample ACVF and ACF as described in Section 1.4.1.

The role of the autocorrelation function in prediction is illustrated by the fol-
lowing simple example. Suppose that {X;} is a stationary Gaussian time series (see
Definition A.3.2) and that we have observed X,,. We would like to find the function
of X, that gives us the best predictor of X,_,, the value of the series after another i
time units have elapsed. To define the problem we must first say what we mean by
“best.” A natural and computationally convenient definition isto specify our required
predictor to be the function of X, with minimum mean squared error. In thisillus-
tration, and indeed throughout the remainder of this book, we shall use this as our
criterion for “best.” Now by Proposition A.3.1 the conditional distribution of X,
giventhat X, = x, is

N(u + p(h)(x, — p), o?(1— p(h)?)),

where 1 and o2 are the mean and variance of {X,}. It was shown in Problem 1.1 that
the value of the constant ¢ that minimizes E (X, — ¢)? isc = E(X,,) and that the
function m of X, that minimizes E(X,,, — m(X,))? isthe conditional mean

p(h)

m(X,) = E(X, 411 X,) =+ p(h) (X, — ). (2.11)
The corresponding mean squared error is
EXun —m(X,)? = 0%(1— p(h)?). (212

This calculation showsthat at least for stationary Gaussian time series, prediction of
X,.» interms of X, is more accurate as | p (h)| becomes closer to 1, and in the limit
as p — +1the best predictor approaches 1 + (X, — 1) and the corresponding mean
squared error approaches 0.

In the preceding calculation the assumption of joint normality of X, ., and X,
played a crucia role. For time series with nonnormal joint distributions the corre-
sponding calculations are in general much more complicated. However, if instead of
looking for the best function of X, for predicting X,,.,, we look for the best linear
predictor, i.e., the best predictor of the form £(X,) = aX, + b, then our problem
becomes that of finding a and b to minimize E(X,,, — aX, — b)?. An elementary
calculation (Problem 2.1), shows that the best predictor of thisformis

0X,) = A+ p(h) (X, — 1) (2.1.3)



2.1

Basic Properties 47

Proof

Definition 2.1.1

with corresponding mean squared error
E(Xpn — U(X,)? = 021 = p(h)?). (2.1.4)

Comparison with (2.1.1) and (2.1.3) shows that for Gaussian processes, ¢(X,) and
m(X,) are the same. In generd, of course, m(X,) will give smaller mean squared
error than £(X,,), sinceit isthe best of alarger class of predictors (see Problem 1.8).
However, thefact that the best linear predictor depends only on the mean and ACF of
the series{ X, } meansthat it can be cal culated without more detailed knowledge of the
joint distributions. Thisis extremely important in practice because of the difficulty
of estimating all of the joint distributions and because of the difficulty of computing
the required conditional expectations even if the distributions were known.

Aswe shall seelater inthis chapter, similar conclusions apply when we consider
the more general problem of predicting X, ., asafunction not only of X,,, but also of
X,_1, X._2, ... . Before pursuing this question we need to examine in more detail the
properties of the autocovariance and autocorrelation functions of a stationary time
series.

Basic Properties of ~(-):

y(0) =0,

ly(h)| < y(0) fordl h,
and y(-) iseven,i.e,

y(h) = y(—h) for dl h.

Thefirst property issimply the statement that Var(X,) > 0, thesecondisanimmediate
consequence of the fact that correlations are less than or equal to 1 in absolute value
(or the Cauchy—Schwarz inequality), and the third is established by observing that

y(h) = Cov(X,4n, X;) = Cov(X;, X, 14) = y(=h). u

Autocovariance functions have another fundamental property, namely that of
nonnegative definiteness.

A real-valued function « defined on the integers is nonnegative definite if

> aix(i — j)a; = 0 (2.1.5)
i,j=1

for all positive integers n and vectorsa = (ay, .. ., a,)’ with real-valued compo-
nentsa; .




48

Chapter 2

Stationary Processes

Theorem 2.1.1
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Example 2.1.1

A real-valued function defined on the integers is the autocovariance function of a
stationary time seriesif and only if it is even and nonnegative definite.

To show that the autocovariance function y (-) of any stationary time series {X,} is
nonnegative definite, let a be any n x 1 vector with real componentsas, ..., a, and
let X, = (X,, ..., X1)'. Then by equation (A.2.5) and the nonnegativity of variances,

Var@X,) =ar,a= Y ay(i— ja; =0,
i,j=1
where T, is the covariance matrix of the random vector X,. The last inequality,
however, is precisely the statement that y () is nonnegative definite. The converse
result, that there exists a stationary time series with autocovariance function « if « is
even, real-valued, and nonnegative definite, is more difficult to establish (see TSTM,
Theorem 1.5.1 for aproof). A dightly stronger statement can be made, namely, that
under the specified conditionsthere exists a stationary Gaussian time series{ X, } with
mean 0 and autocovariance function « (-). [ |

Remark 1. Anautocorrelation function o (-) hasall the properties of an autocovari-
ance function and satisfies the additiona condition p(0) = 1. In particular, we can
say that p(-) isthe autocorrelation function of a stationary processif and only if p(-)
isan ACVF with p(0) = 1. O

Remark 2. To verify that agiven function isnonnegative definiteit is often smpler
to find a stationary process that has the given function asits ACVF than to verify the
conditions (2.1.5) directly. For example, the function « () =cos(wh) is nonnegative
definite, since (see Problem 2.2) it isthe ACVF of the stationary process

X, = Acos(wr) + B sSin(wt),
where A and B are uncorrelated random variables, both with mean 0 and variance 1.
Another illustration is provided by the following example. O
We shall show now that the function defined on the integers by
1, ifh=0,
kh)y =1 p, ifh==%1,
0, otherwise,
1

isthe ACVF of astationary time seriesif andonly if | o| < 3. Inspection of the ACVF

of the MA(2) process of Example 1.4.4 shows that « isthe ACVF of such a process
if we can find real & and nonnegative o2 such that

o?(1+6% =1
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Definition 2.1.2

Proof

and
o0 = p.

If [p] < 3, these equations give solutions 6 = (2p)~*(1+ \/1—4p?) and 62 =
(1+ 92)71. However, if |p| > 3, thereisno real solution for 6 and hence no MA(1)
process with ACVF «. To show that there is no stationary process with ACVF «,
we need to show that « is not nonnegative definite. We shall do this directly from
the definition (2.1.5). First, if p > 3, K = [x(i — j)]};_,, and a is the n-component
vectora= (1,-1,1, -1,...), then

aKa=n—-2n—1p <0forn > 2p/(2p — 1),

showing that « (-) is hot nonnegative definite and therefore, by Theorem 2.1.1, is not
an autocovariance function. If p < —%, the sameargument witha=(1,1,1,1,...)
again shows that « (-) is not nonnegative definite.

If {X,}isa(weakly) stationary time series, then the vector (X, ..., X,) andthe
time-shifted vector (X1,, ..., X,4+,)" have the same mean vectors and covariance
matrices for every integer i and positive integer n. A strictly stationary sequence is
one in which the joint distributions of these two vectors (and not just the means and
covariances) are the same. The precise definition is given below. O

{X,} isadtrictly stationary time series if
/ d /
(Xla -'-7Xn) = (X1+I1,---7Xn+h)

for al al integersh and n > 1. (Here £ is used to indicate that the two random
vectors have the same joint distribution function.)

For reference, we record some of the el ementary properties of strictly stationary
time series.

Propertiesof a Strictly Stationary Time Series {X,}:
a. Therandom variables X, are identically distributed.
b. (X,, X,11) < (X1, X1,,,) for al integers and A.
c. {X,} isweskly stationary if E(X?) < oo for all z.
d. Weak stationarity does not imply strict stationarity.
e. Aniid sequenceis strictly stationary.

Properties (a) and (b) follow at once from Definition 2.1.2. If EX? < oo, then by ()
and (b) E X, isindependent of + and Cov(X,, X,,,) = Cov(X1, X1,1), Wwhichisaso
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independent of ¢, proving (c). For (d) see Problem 1.8. If {X,} isan iid sequence of
random variables with common distribution function F, then the joint distribution
function of (X144, ..., X,4) evauated at (x1, ..., x,) iSF(xy)--- F(x,), whichis
independent of 4. u

One of the simplest waysto construct atime series { X, } that is strictly stationary
(and hence stationary if EX? < oo) isto “filter” aniid sequence of random variables.
Let {Z,} be aniid sequence, which by (€) is strictly stationary, and define

Xi=8Zi,Zi-1,..., Zi—y) (2.1.6)

for some real-valued function g(-,...,-). Then {X,} is drictly stationary, since

(Zisns s Zisn—g) < (Z,,...,Z,_,) for @l integers k. It follows also from the
defining equation (2.1.6) that {X,} is g-dependent, i.e, that X, and X, are inde-
pendent whenever |t — s| > ¢. (Aniid sequence is 0-dependent.) In the same way,
adopting asecond-order viewpoint, we say that astationary timeseriesisg-correlated
if y(h) = 0 whenever |h| > q. A white noise sequence is then O-correlated, while
the MA(1) process of Example 1.4.4 is 1-correlated. The moving-average process of
order ¢ defined below is g-correlated, and perhaps surprisingly, the converseis also
true (Proposition 2.1.1).

The MA(g) Process:

{X,} isamoving-aver age process of order ¢ if

X, =Z,+61Zi1+---+6,Z,_,, (2.1.7)

where {Z,} ~ WN(0, ¢2) and 61, ... ., 6, are constants.

Itisasimple matter to check that (2.1.7) definesa stationary time seriesthat isstrictly
stationary if {Z,} isiid noise. Inthelatter case, (2.1.7) isaspecial case of (2.1.6) with
g alinear function.

Theimportance of MA(g) processes derivesfrom thefact that every g-correlated
processisan MA(g) process. Thisisthe content of the following proposition, whose
proof can be found in TSTM, Section 3.2. The extension of this result to the case
g = oo isessentially Wold's decomposition (see Section 2.6).

If {X,} isastationary ¢g-correlated time serieswith mean O, then it can be represented
asthe MA(q) processin (2.1.7).
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2.2 Linear Processes

Definition 2.2.1

The class of linear time series models, which includes the class of autoregressive
moving-average (ARMA) models, provides a general framework for studying sta-
tionary processes. In fact, every second-order stationary process is either a linear
process or can be transformed to alinear process by subtracting a deter ministic com-
ponent. Thisresult isknown asWold's decomposition and isdiscussed in Section 2.6.

Thetime series {X,} isalinear processif it has the representation
X = Z szt—j, (221)
Jj=—00

for al 7, where {Z,} ~ WN(0,0?) and {y;} is a sequence of constants with
Y Il < o0,

In terms of the backward shift operator B, (2.2.1) can be written more compactly as
X, =v(B)Z, (2.2.2)

wherey (B) = > y;B’.Alinear processiscalledamovingaver ageor M A(oo)

j=—00

if y, =0foral j <O0,i.e,if
X, = V,Z,.
j=0

Remark 1. Thecondition}"7>  [v;| < oo ensuresthat theinfinitesumin (2.2.1)
converges (with probability one), since E|Z,| < ¢ and

EIX,| < Y (WIEIZ)) < ( > w) o < oo.
j=—00 j=—00
It also ensuresthat Zj;oo Wf < oo and hence (see Appendix C, Example C.1.1) that
the seriesin (2.2.1) converges in mean square, i.e., that X, is the mean sguare limit
of thepartial sums » __, ¥;Z, ;. Thecondition y_"__ || < oo a@so ensurescon-
vergence in both senses of the more general series (2.2.3) considered in Proposition
2.2.1 below. In Section 10.5 we consider amore general class of linear processes, the
fractionally integrated ARMA processes, for which the coefficents are not absol utely

summable but only square summable. O

The operator (B) can be thought of as a linear filter, which when applied to
the white noise “input” series {Z,} produces the “output” {X,} (see Section 4.3). As
established in thefollowing proposition, alinear filter, when applied to any stationary
input series, produces a stationary output series.
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Proposition 2.2.1

Proof

Let {Y;} be a stationary time series with mean O and covariance function yy. If
3% ¥l < oo, thenthetime series

j=—00

Xo= Y Y =y (B)Y, (2.23)

j=—0

is stationary with mean 0 and autocovariance function

yx() = D > Uivyy(h+k— j). (2.2.4)
j=—00 k=—00
In the special case where {X,} isalinear process,
yx(h) = Y Vim0’ (2.2.5)
j=—00

The argument used in Remark 1, with o replaced by /yy (0), shows that the seriesin
(2.2.3) isconvergent. Since EY, = 0, we have

E(X)=E ( > Wl_]) = Y VE(Y, ;) =0

j=—00 j=—00

and

EXi X)) =E |:< Z 1//jYz+hj> ( Z katk):|
Jj=—00

k=—00

= Z Z ijkE(YH-h_th_k)

Jj=—00 k=—00

=D > V(= j+ k.
Jj=—00 k=—00
which showsthat { X, } isstationary with covariancefunction (2.2.4). (Theinterchange
of summation and expectation operations in the above calculations can be justified
by the absolute summability of ;.) Finaly, if {Y;} is the white noise sequence {Z, }
in(2.2.1), thenyy (h — j + k) = 02 if k = j — h and O otherwise, from which (2.2.5)
follows. ]

Remark 2. Theabsolute convergenceof (2.2.3) implies(Problem 2.6) that filters of
theforma(B) = 3>°72 ;B and B(B) = 3 72 B;B’ with absolutely summable

coefficients can be applied successively to a stationary series {Y,} to generate a new
stationary series

W, = i 1/ijzfj,

j=—00
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where
v = Z Pk = Z Broj i (2.2.6)
k=—00 k=—o00
These relations can be expressed in the equivalent form
W, =y (B)Y,
where
V¥ (B) = a(B)B(B) = B(B)a(B), (22.7)

Example 2.2.1

and the products are defined by (2.2.6) or equivalently by multiplying the series
> ea;Bland 7 | B;B/ term by term and collecting powers of B. It is clear
from (2.2.6) and (2.2.7) that the order of application of the filters «(B) and 8(B) is
immaterial. O

An AR(1) process

In Example 1.4.5, an AR(1) process was defined as a stationary solution {X,} of the
equations

X, —¢X, 1= 2, (2.2.8)

where {Z,} ~ WN(0, 6?), |¢| < 1, and Z, isuncorrelated with X, for each s < . To
show that such a solution exists and is the unique stationary solution of (2.2.8), we
consider the linear process defined by

oo

X, = Z 7. (2.2.9)

j=0

(The coefficients ¢/ for j > 0 are absolutely summable, since |¢| < 1.) It is easy
to verify directly that the process (2.2.9) is a solution of (2.2.8), and by Proposition
2.2.1itisaso stationary with mean 0 and ACVF

02¢h

1— ¢

yx(h) =) ¢/¢/"o? =
=0

forh > 0.
To show that (2.2.9) is the only stationary solution of (2.2.8) let {Y,} be any
stationary solution. Then, iterating (2.2.8), we obtain
Yi=9¢Y, 1+ Z

=Z +¢Z 1+ ¢%Y, 5

= Zt + ¢szl + -+ qkaFk + ¢k+1Yt7k71'
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If {Y,} is stationary, then E'Y? isfinite and independent of ¢, so that

k

EY, =) ¢'2 ) =™ PEY, 1)
j=0

— 0ask — oo.

Thisimpliesthat ¥, isequal to the mean squarelimit 372, ¢/ Z,_; and hencethat the
process defined by (2.2.9) is the unique stationary solution of the equations (2.2.8).

It the case |¢| > 1, the seriesin (2.2.9) does not converge. However, we can
rewrite (2.2.8) in the form

X, == Zia+¢ X (2.2.10)
Iterating (2.2.10) gives

X, =—¢'Zii1— ¢ °Zija+ ¢ Xis2

=—¢ ' Zip1— = T Zpa + 07 T Xk,
which shows, by the same arguments used above, that

X, =— Z ¢*J' Zl+j (2211)
=

isthe unique stationary solution of (2.2.8). This solution should not be confused with
the nonstationary solution {X,} of (2.2.8) obtained when X is any specified random
variable that is uncorrelated with {Z,}.

The solution (2.2.11) isfrequently regarded as unnatural, since X, as defined by
(2.2.11) is correlated with future values of Z,, contrasting with the solution (2.2.9),
which has the property that X, is uncorrelated with Z; for all s > . It is customary
therefore in modeling stationary time series to restrict attention to AR(1) processes
with |¢| < 1. Then X, hasthe representation (2.2.8) interms of {Z,, s < ¢}, and we
say that {X,} isacausal or future-independent function of {Z,}, or more concisely
that {X,} is a causal autoregressive process. It should be noted that every AR(1)
processwith |¢| > 1 can be reexpressed as an AR(1) processwith |¢| < 1 and anew
white noise sequence (Problem 3.8). From a second-order point of view, therefore,
nothing islost by eliminating AR(1) processes with |¢| > 1 from consideration.

If ¢ = +1, thereisno stationary solution of (2.2.8) (see Problem 2.8). O

Remark 3. Itisworth remarking that when |¢| < 1 the unique stationary solution
(2.2.9) can befound immediately withtheaid of (2.2.7). Todothislet¢(B) = 1—¢B
and 7 (B) = %, ¢/ B/. Then

Y(B) :=¢(B)m(B) = 1.
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Applying the operator 7 (B) to both sides of (2.2.8), we obtain

[e¢]

X, =nB)Z =) ¢'Z,

=0

as claimed. O

2.3 Introduction to ARMA Processes

In this section we introduce, through an example, some of the key properties of an
important classof linear processesknownasARMA (autoregressive moving average)
processes. These are defined by linear difference equationswith constant coefficients.
As our example we shall consider the ARMA(1,1) process. Higher-order ARMA
processes will be discussed in Chapter 3.

Definition 2.3.1 Thetimeseries {X,} isan ARMA(1, 1) processif it is stationary and satisfies (for
every t)

X, —¢X, 1=2Z, +0Z, 1, (2.3.1)
where {Z,} ~WN(0,0?) and ¢ + 6 # 0.

Using the backward shift operator B, (2.3.1) can be written more concisely as
¢(B)X, =0(B)Z,, (2.3.2)
where ¢ (B) and 8(B) are the linear filters
$(B)=1—¢Band6(B) =1+ 6B,

respectively.

Wefirst investigate the range of values of ¢ and 6 for which a stationary solution
of (2.3.1) exists. If || < 1, let x(z) denote the power series expansion of 1/¢(z),
e, Y720 ¢’z/, which has absolutely summable coefficients. Then from (2.2.7) we
concludethat x (B)¢(B) = 1. Applying x (B) to each side of (2.3.2) therefore gives

X, = x(B)0(B)Z; = ¥ (B)Z,,

where
W(B) =Y ;B = (1+¢B+¢*B*+--) (1+0B).
j=0

By multiplying out the right-hand side or using (2.2.6), we find that
Yo=1landy; = (¢ +0)¢’ *for j > 1.
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Asin Example 2.2.1, we conclude that the MA (o) process
X;=Z+@+60)) ¢/ 7, (2.3.3)
j=1

is the unique stationary solution of (2.3.1).

Now supposethat |¢| > 1. Wefirst represent 1/¢ (z) asaseriesof powersof z with
absolutely summable coefficients by expanding in powers of z~1, giving (Problem
2.7)

1 > o
- =i,
() j;") -

Then we can apply the same argument as in the case where |¢| < 1 to obtain the
unique stationary solution of (2.3.1). Welet x (B) = — >_72, ¢~/ B~/ and apply x (B)
to each side of (2.3.2) to obtain

o0

X, = x(B)O(B)Z = —0¢""Z, — O +¢)Y ¢ Z,. (2.3.4)

j=1

If ¢ = %1, thereis no stationary solution of (2.3.1). Consequently, there is no
such thing as an ARMA(1,1) process with ¢ = £1 according to our definition.

We can now summarize our findings about the existence and nature of the sta-
tionary solutions of the ARMA(1,1) recursions (2.3.2) asfollows:

e A stationary solution of the ARMA(1,1) equations exists if and only if ¢ # £1.

o If |¢| < 1, then the unique stationary solution is given by (2.3.3). In this case we
say that {X,} iscausal or acausal function of {Z,}, since X, can be expressed in
terms of the current and past values Z,, s < t.

e If |¢| > 1, then the unique stationary solution is given by (2.3.4). The solution is
noncausal, since X, isthen afunction of Z,, s > t.

Just as causality meansthat X, isexpressibleintermsof Z,, s < ¢, the dual con-
cept of invertibility meansthat Z, isexpressibleintermsof X,, s < r. We show now
that the ARMA(1,1) process defined by (2.3.1) isinvertible if |§| < 1. To demon-
strate this, let £(z) denote the power series expansion of 1/6(z), i.e., Zj‘;o(—e)fzj,
which has absolutely summable coefficients. From (2.2.7) it therefore follows that
£(B)9(B) = 1, and applying &£(B) to each side of (2.3.2) gives

Z, =§(B)p(B)X; =n(B)X,,

where

7(B)=Y 7B = (1- 6B+ (=6)2B2+---) (1 - ¢B).
j=0
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By multiplying out the right-hand side or using (2.2.6), we find that
Z =X, —(@+0)> (07X, (2.3.5)
j=1

Thusthe ARMA(1,1) processisinvertible, since Z, can be expressed in terms of the
present and past values of the process X,, s < ¢t. An argument like the one used to
show noncausality when|¢| > 1 showsthat the ARMA(1,1) processisnoninvertible
when |0] > 1, since then

Zo=—¢07 X, + O+ )Y (—0)7 X,y (2.3.6)
j=1
We summarize these results as follows:

o If 8] < 1,thenthe ARMA(1,1) processisinvertible, and Z, isexpressed interms
of X,,s <r, by (2.3.5).

e If 0] > 1, thenthe ARMA(1,1) processisnoninvertible, and Z, isexpressed in
termsof X,, s > r, by (2.3.6).

Remark 1. Inthecasest = +1, the ARMA(1,1) processisinvertible in the more
general sensethat Z, isamean square limit of finitelinear combinationsof X;, s <1,
although it cannot be expressed explicitly asan infinitelinear combination of X, s <
t (see Section 4.4 of TSTM). In this book the term invertible will always be used in
the more restricted sensethat Z, = )7y 7, X,_;, where 37 || < oo. O

Remark 2. If the ARMA(1,1) process {X,} is noncausal or noninvertible with
|#] > 1, then it is possible to find a new white noise sequence {W,} such that {X,}
is a causal and noninvertible ARMA(1,1) process relative to {W,} (Problem 4.10).
Therefore, from asecond-order point of view, nothingislost by restricting attention to
causal and invertible ARMA(1,1) models. Thislast sentenceisaso valid for higher-
order ARMA models. O

2.4 Properties of the Sample Mean and Autocorrelation Function

A stationary process { X, } is characterized, at |east from a second-order point of view,
by its mean u and its autocovariance function y (). The estimation of w, y (-), and the
autocorrelation function p(-) = y(-)/y(0) from observations X1, ..., X, therefore
plays a crucial role in problems of inference and in particular in the problem of
constructing an appropriate model for the data. In this section we examine some of
the properties of the sample estimates x and p(-) of w and p(-), respectively.
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Proposition 2.4.1

2.4.1 Estimation of p

The moment estimator of the mean . of a stationary process is the sample mean

X, =n" X1+ Xo 4+ X,). (2.4.2)
It is an unbiased estimator of 1, since

E(X,)=n"YEX1+---+EX,) = u
The mean squared error of X, is

E(X, — p)* = Var(X,)

n2 Z Z Cov(X;, X;)

i=1 j=

=n? Y (n—li—jhyl—j)

i—j=—n

nt Z (1— —> (). (24.2)

h=—n

Now if y(h) — 0 ash — oo, the right-hand side of (2.4.2) converges to zero,
so that X, converges in mean square to u. If 30° |y (k)| < oo, then (2.4.2)
gives lim,_ . nVar(X,) = Z\h\ml/(h)- We record these results in the following
proposition.

If {X,} isa stationary time series with mean p and autocovariance function y ( - ),
thenasn — oo,
Var(X,) = E(X, — n)?>— 0 if y(n) — 0,

nEX,—p?— Yy i Yy < oo

[h]<o0 h=—00

To make inferences about . using the sample mean X, ,_it is necessary to know
the distribution or an approximation to the distribution of X,,. If the time series is
Gaussian (see Definition A.3.2), then by Remark 2 of Section A.3 and (2.4.2),

n2(X, — ) ~ N (o, > (1 - 'h—') <h>)
|h|<n

It is easy to construct exact confidence bounds for v using this result if y () is
known, and approximate confidence bounds if it is necessary to estimate y (-) from
the observations.
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Example 2.4.1

For many time series, in particular for linear and ARMA models, X,, is approxi-
mately normal with mean .. and variance n—! > nj<oo ¥ (h) fOr largen (see TSTM, p.
219). An approximate 95% confidence interval for  isthen

(X, — 19602/ /n, X, + 19602/ /), (2.4.3)

wherev =}, _ v (h). Of course, v isnot generally known, so it must be estimated
from the data. The estimator computed in the program ITSM is? = Zlh\<ﬁ(1 —
|h|/n)7 (k). For ARMA processes this is agood approximation to v for large n.

An AR(1) model
Let {X,} bean AR(1) process with mean ., defined by the equations

X, —pn=¢X,1— )+ 7,

where |¢| < 1 and {Z,} ~ WN(0,¢?). From Example 2.2.1 we have y(h) =
p"o?/(1—¢? andhencev = (1+2) ;. ¢")o?/(1— ¢?) = 02/(1— ¢)%. Approx-
imate 95% confidence bounds for . are therefore given by x, + 1.960n"2/(1 — ¢).
Since ¢ and o are unknown in practice, they must be replaced in these bounds by
estimated values. O

2.4.2 Estimation of 4(-) and p(-)

Recall from Section 1.4.1 that the sample autocovariance and autocorrel ation func-

tions are defined by
n—|h| _ _
Py =0ty (X — Xa) (X0 = X,) (2.4.4)
=1
and
R y (h)
h) = . 245
p(h) 5(0) ( )

Boththeestimatorsy (k) and p (h) arebiased evenif thefactor n—1in (2.4.4) isreplaced
by (n — h)~*. Nevertheless, under general assumptions they are nearly unbiased for
large sample sizes. The sample ACVF has the desirable property that for eachk > 1
the k-dimensional sample covariance matrix

y(0) YD e pk=1)
. v (1 v (0 e y(k=2
B, = J/(: ) J/(:) 7( | ) (2.4.6)
yk=1 pk—-=2) --- 9

is nonnegative definite. To see this, first note that if I, is nonnegative definite, then
'y is nonnegative definite for all k£ < m. So assume k > n and write

[y =ntTT,
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where T isthek x 2k matrix

0 0 0 Y]_ YZ Yk
0 0 n »rn Yo O

T = s
0 v, Y, - Y 0--- 0

Yi=X—X,,i=1,...,n,andY; =0fori =n+1,..., k. Thenforany rea k x 1
vector a we have

al,a=n"Y@7)(T'a) >0, (2.4.7)

and consequently the sample autocovariance matrix I'; and sample autocorrelation
matrix

are nonnegative definite. Sometimes the factor n~! is replaced by (n — h)~ Lin the
definition of 7 (h), but the resulting covariance and correlation matrices ', and R,
may not then be nonnegative definite. We shall therefore use the definitions (2.4.4)
and (2.4.5) of p(h) and p(h).

Remark 1. Thematrices {’;, and R, arein fact nonsi ngular if thereis at least one
nonzero Y;, or equivalently if  (0) > 0. To establish thisresult, supposethat 7 (0) > 0
and I, issingular. Thenthereisequality in (2.4.7) for somenonzero vector a,implying
that @ T = 0 and hence that the rank of T islessthan k. Let ¥; be the first nonzero
vaueof Y1, Y», ..., Y, and consider the k x k submatrix of T' consisting of columns
(i + 1) through (i + k). Since this matrix islower right triangular with each diagonal
element equal to Y;, its determinant has absolute value |Y;|* # 0. Consequently, the
submatrix is nonsingular, and T must have rank k, a contradiction. O

Without further information beyond the observed data X4, ..., X,, it isimpos-
sible to give reasonable estimates of y (k) and p(h) for h > n. Even for i dlightly
smaller than n, the estimates 7 () and p (k) areunreliable, sincethere are so few pairs
(X, 44, X,) available (only oneif h = n — 1). A useful guideis provided by Box and
Jenkins (1976), p. 33, who suggest that » should be at least about 50 and & < n /4.

The sample ACF plays an important role in the selection of suitable models for
the data. We have already seen in Example 1.4.6 and Section 1.6 how the sample
ACF can be used to test for iid noise. For systematic inference concerning p (),
we need the sampling distribution of the estimator p (7). Although the distribution
of p(h) isintractable for samples from even the simplest time series models, it can
usually be well approximated by a normal distribution for large sample sizes. For
linear models and in particular for ARMA models (see Theorem 7.2.2 of TSTM for
exact conditions) p, = (p(1), ..., p(k)) isapproximately distributed for large n as
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Example 2.4.2

Example 2.4.3

N(pi,n W), i.e,

p =~ N(p, n_lW), (2.4.9)
where p = (p(Q), ..., p(k))’, and W is the covariance matrix whose (i, j) element
isgiven by Bartlett's formula

]

wy= Y Aok + Dok + j) + ptk — Dptk + )+ 20()p()p?k)

k=—00
—2ppk)pk + j) — 20(Hpk)pk +i)}.
Simple algebra shows that

wj = ; {ptk + i)+ plk — i) — 2p(i)p(k)}

x {plk+ ) + ok — ) = 20())p(K)}, (2.4.10)

which is amore convenient form of w;; for computational purposes.

iid Noise
If {X,} ~ 11D(0, o), then p(h) = Ofor |k > 0, so from (2.4.10) we obtain
{ 1 ifi=j,
w,»j =
0 otherwise.

For largen, therefore, p(), ..., p(h) are approximately independent and identically
distributed normal random variables with mean 0 and variance n~1. This result is
the basis for the test that data are generated from iid noise using the sample ACF
described in Section 1.6. (See also Example 1.4.6.) O
An MA(T) process
If {X,}isthe MA(1) process of Example 1.4.4,i.e,, if
X, =272, +60Z,_,, t=0+1,...,

where {Z,} ~ WN(O, ¢?), then from (2.4.10)

1-3p%(1) +40*), ifi=1,

1+ 2p3%(1), ifi > 1,

is the approximate variance of n=2(p(i) — p(i)) for large n. In Figure 2.1 we have
plotted the sample autocorrelation function p(k), k = 0, . .., 40, for 200 observations
from the MA (1) model

X, =Z — 874, (2.4.11)

where {Z,} isa sequence of iid N(0O, 1) random variables. Here p(1) = —.8/1.64 =
—.4878 and p(h) = Ofor h > 1. The lag-one sample ACF is found to be p(1) =

Wi =
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Figure 2-1

The sample autocorrelation
function of n = 200
observations of the MA(1)
process in Example 2.4.3,
showing the bounds
+1.96n7"2(1 4 2p2(1))"/2.

Example 2.4.4

1.0

0.4 0.6

ACF

Lag

—.4333 = —6.128n Y2, whichwould cause us (in the absence of our prior knowledge
of {X,}) to rgect the hypothesisthat the data are asample from an iid noise sequence.
Thefact that |p(h)| < 1.96n=Y2forh = 2, ..., 40 strongly suggeststhat the dataare
from amodel in which observations are uncorrelated past lag 1. In Figure 2.1 we have
plotted the bounds £1.96n ~/2(1+2p2(1))/?, indicating the compatibility of the data
with the model (2.4.11). Since, however, p (1) isnot normally known in advance, the
autocorrelationsp(2), . . ., p(40) wouldin practice havebeen compared withthemore
stringent bounds 4-1.96xn /2 or with the bounds +1.96n~2(14252(1))*? in order to
check the hypothesisthat the data are generated by amoving-average process of order
1. Finaly, itisworth noting that the lag-one correlation —.4878 iswell inside the 95%
confidence bounds for p(1) given by p(1) & 1.96n=Y2(1 — 3p%(1) + 4p*(1)¥? =
—.4333 + .1053. This further supports the compatibility of the data with the model
X, =27 —0.8Z_;. |

An AR(1) process
For the AR(1) process of Example 2.2.1,
X, =¢Xi a1+ 7,
where {Z,} isiid noiseand |¢| < 1, we have, from (2.4.10) with p(h) = ¢,
wi =Y % (0 =)+ Y 6% (¢ — o)
k=1 k=i+1

= (1-¢¥)(1+¢)(1—¢)) " —2i¢p?, (2.4.12)
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The sample autocorrelation ~f S
function of the Lake Huron i
residuals of Figure 1.10 <
showing the bounds °[. , 1 , |
p()+1.96n""2w,/? and the 0 10 20 30 40
model ACF p(i) = (.791)". Lag
i = 1,2,....In Figure 2.2 we have plotted the sample ACF of the Lake Huron
residuals yi, ..., yeg from Figure 1.10 together with 95% confidence bounds for

p@), i =1,...,40, assuming that data are generated from the AR(1) model

Y, = .791Y, 1 + Z, (2.4.13)

(see equation (1.4.3)). The confidence bounds are computed from 5 (i) £+ 1.96n~%2
w;/?, where w;; isgivenin (2.4.12) with ¢ = .791. The model ACF, p(i) = (.791),
is aso plotted in Figure 2.2. Notice that the model ACF lies just outside the confi-
dence bounds at lags 2—6. This suggests some incompatibility of the data with the
model (2.4.13). A much better fit to the residuals is provided by the second-order
autoregression defined by (1.4.4). O

2.5 Forecasting Stationary Time Series

We now consider the problem of predicting the values X,,,, # > 0, of a station-
ary time series with known mean n and autocovariance function y in terms of the

vaues {X,, ..., X1}, up to time n. Our godl is to find the linear combination of
1 X,,X,_1,..., X1, that forecasts X,,,, with minimum mean squared error. The best
linear predictor intermsof 1, X,,, ..., X, will bedenoted by P, X, ., and clearly has
the form

P.X, . =a0+a1X,+- -+ a,X1. (251)
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It remains only to determine the coefficients ag, as, . . ., a,, by finding the values that
minimize
S(ao, ey Cln) = E(Xn+h — dpg — aan — e = (1,,X1)2. (252)

(We aready know from Problem 1.1 that PoY = E(Y).) Since S is a quadratic
function of ay, ..., a, and is bounded below by zero, it is clear that thereis at least

onevaueof (aq, ..., a,) that minimizes S and that theminimum (ao, . . . , a,,) satisfies
the equations
dS(ag, ..., a, .
9o d) _ 5 0 n. (2.5.3)
Baj

Evauation of the derivativesin equations (2.5.3) gives the equivalent equations

E |:Xn+h —ao — Zaixn+l—i:| =0, (2.5.9)

i=1

E |:(Xn+h —ao— Zaan+l—i)Xn+l—j:| =0, j=1...,n (2.5.5)

i=1

These equations can be written more neatly in vector notation as

ag= <1 — Xn:a,) (2.5.6)
i=1

and
[,a, = v, (h), (2.5.7)
where
&, = (a1, ..., a,), VA
and
Yolh) = (y (W), y(h+1),....,y(h+n—1)).
Hence,

P, Xn+h =un+ ai(Xn+l—i - M)’ (258)

i=1
where a, satisfies (2.5.7). From (2.5.8) the expected value of the prediction error
X,in — P, X4, 1S zero, and the mean sguare prediction error is therefore

n n

EXupn = PiXun)* =v(0) =2) aiy(h+i—D+ > Y ayli—ja;
i=1

i=1 j=1
=y(0) —a7.(h), (2.5.9)
where the last line follows from (2.5.7).
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Remark 1. To show that equations (2.5.4) and (2.5.5) determine P, X, uniquely,
let {at¥,j =0,....n} and {a?, j = 0,...,n} betwo solutions and let Z be the
difference between the corresponding predictors, i.e.,

Z=a —d? + Z ( @ _ <2>) .
Then
72 _ ( W _ @y Z ( @ _ (2)) n+1_,-> .
Butfrom (2.5.4) and (2.5.5) wehave EZ = 0and E(ZX,+1-;) =0forj =1,...,n
Consequently, E(Z?) = 0 and hence Z = 0. O
Propertiesof P, X,41:
L P Xpin = u+Y i ai(Xpp1-i—p), wherea, = (ag, ..., a,) satisfies(2.5.7).
2. E(Xuin — PuXyin)? = v (0) — &7, (h), where~, (h) = (y(h), ..., y(h+n—
1)).
3. E(Xn+h - PnX11+h) =0
4. E[(Xn+h - PanJrh)Xj] = O’ ] = 17 R
Remark 2. Notice that properties 3 and 4 are exactly equivalent to (2.5.4) and
(2.5.5). They can be written more succinctly in the form
E[(Error) x (PredictorVariable)] = 0. (2.5.10)
Equations (2.5.10), one for each predictor variable, therefore uniquely determine
PnX11+h- O
Example 2.5.1  One-step prediction of an AR(1) series

Consider now the stationary time series defined in Example 2.2.1 by the equations
Xt:¢Xt—1+Ztv IZO,:I::I.,...,

where [¢| < 1 and {Z,} ~ WN(0, ¢?). From (2.5.7) and (2.5.8), the best linear
predictor of X,,; intermsof {1, X,,, ..., X }is(forn > 1)

PanJrl = a;,xns
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where X,, = (X,,, ..., X1)’ and
S S ANE
: : : : .2 - ¢ ’ (2511)
ot e ¢ 1 ||a, 5"
A solution of (2.5.11) isclearly
a, =(¢,0,...,0)/,
and hence the best linear predictor of X, intermsof {X,, ..., X,.} is

PanJrl = a;,xn = ¢Xnv

with mean squared error
02

1—¢2
A simpler approach to this problem isto guess, by inspection of the equation defining
X1, that thebest predictor is¢ X,,. Thento verify this conjecture, it sufficesto check
(2.5.10) for each of the predictor variables 1, X,,, ..., X1. The prediction error of the
predictor ¢ X, isclearly X, ;1 — ¢X, = Z,,1. But E(Z,.1Y) = 0for Y = 1 and for
Y =X;,j=1,...,n Hence by (2.5.10), X, isthe required best linear predictor
intermsof 1, X4, ..., X,. O

E(Xp41— P X)) =y (0) — &7, (1) = — ¢y (1) = o>

Prediction of Second-Order Random Variables

Suppose now that ¥ and W,, ..., W, are any random variables with finite second
moments and that the means © = EY, u; = EW,; and covariances Cov(Y,7Y),
Cov(Y, W;), and Cov(W;, W;) aredl known. It is convenient to introduce the random
vector W = (W, ..., Wy)’, the corresponding vector of means py = (i, ..., 41),
the vector of covariances

~ = Cov(Y, W) = (Cov(Y, W,), Cov(Y, W,_1), ..., Cov(Y, Wy)),

and the covariance matrix

I = Cov(W, W) = [COV(Wis1-is Wass- )]} ,_; -
Then by the same arguments used in the calculation of P, X, the best linear pre-
dictor of Y intermsof {1, W,, ..., Wy} isfound to be

PY|W) = py +a (W — py), (2.5.12)

wherea = (ay, ..., a,) isany solution of

ra=-. (2.5.13)
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The mean squared error of the predictor is
E[(Y — P(YIW))?] = Var(Y) — a~. (2.5.14)
Example 2.5.2  Estimation of a missing value

Consider again the stationary series defined in Example 2.2.1 by the equations
Xt:¢Xt—1+Ztv tzo,:tl,...,

where |¢| < 1and {Z,} ~ WN(O, o'2). Suppose that we observe the series at times
1 and 3 and wish to use these observations to find the linear combination of 1, X1,
and X3 that estimates X, with minimum mean squared error. The solution to this
problem can be obtained directly from (2.5.12) and (2.5.13) by setting Y = X, and
W = (X, X3)'. This givesthe equations

: 1)1

with solution

_ 1 |9

The best estimator of X5 isthus

_®
1+ ¢2

with mean squared error

P(X2|W) = (X1+ X3),

$o?
2 2
E[(Xz — P(X2|W))2] = 1i¢2 —a 1(]5_0'?2 - 1_T_¢2 .
1—¢2

The Prediction Operator P(-|W)

For any given W = (W,, ..., Wy)’ and Y with finite second moments, we have seen
how to compute the best linear predictor P(Y|W) of Y intermsof 1, W,, ..., W
from (2.5.12) and (2.5.13). The function P(-|W), which converts Y into P(Y|W),
is called a prediction operator. (The operator P, defined by equations (2.5.7) and
(2.5.8) is an example with W = (X,,, X,._1, ..., X1)".) Prediction operators have a
number of useful properties that can sometimes be used to simplify the calculation
of best linear predictors. We list some of these below.
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Example 2.5.3

Example 2.5.4

Properties of the Prediction Operator P(-|W):

Suppose that EU? < oo, EV? < oo, T' = cov(W, W), and 8, s, ..., a, are
constants.

1. PUIW)=EU+a(W — EW),wherel"'a = cov(U, W).

E[(U — P(UW)W] =0and E[U — P(U|W)] = 0.

E[(U — P(UIW))?] = var(U) — a'cov(U, W).

P(onU + a2V + BIW) = s P(U|W) + . P(V|W) + B.

P(Yl oW+ BIW) = Y7 i W; + B.

P(U|W) = EU if cov(U,W) = 0.

P(U|W) = P(P(UIW, V)|W) if V isarandom vector such that the compo-

N o g bk~ DN

nents of E(VV’) aredl finite.

One-step prediction of an AR(p) series
Suppose now that {X,} is a stationary time series satisfying the equations
X =01 X, 1+ +¢,X,_p,+2Z,, t=0%£1...,

where {Z,} ~ WN(0, 0?) and Z, is uncorrelated with X, for each s < r. Then if
n > p,wecan apply the prediction operator P, to each side of the defining equations,
using properties (4), (5), and (6) to get

P Xu1= ¢1Xn +-F ¢an+17p, O

An AR(1) series with nonzero mean

Thetime series {Y,} issaid to be an AR(1) processwithmean i if {X, =Y, — u}isa
zero-mean AR(1) process. Defining { X, } asin Example2.5.1and letting Y, = X, 4+,
we see that Y, satisfies the equation

YVi—pu=¢Y,-1— )+ Z. (2.5.19)

If P,Y,., isthe best linear predictor of Y,,, interms of {1, Y,, ..., Y1}, then appli-
cation of P, to (25.15) withr =n + 1,n + 2, ... givesthe recursions

PnYnJrh_M:q‘)(PnYnJrhfl_M’)’ h=1’29

Noting that P,Y, = Y,, we can solve these equations recursively for P,Y, .,
h=1,2,...,toobtan

PnYn+h =M+¢h(Yn_M) (2516)
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The corresponding mean squared error is (from (2.5.14))
EYyin — PYoi)? = v (O[1 - &,p,(W)]. (2.5.17)

From Example 2.2.1 we know that y(0) = 02/(1 — ¢?) and p(h) = ¢",h > 0.
Hence, substituting a, = (¢”, 0, ..., 0)" (from (2.5.16)) into (2.5.17) gives

EYpin — PYou)? = 02(1 - ¢7)/(1 - ¢7). (25.18)
O

Remark 3. Ingenerd, if {Y,} isastationary time serieswith mean p and if {X,} is
the zero-mean series defined by X, = Y, — u, then since the collection of all linear
combinationsof 1, Y, ..., Y; isthesameasthecollection of al linear combinationsof
1, X,,..., X1, thelinear predictor of any randomvariable W intermsof 1, Y,,, ..., Y3
isthe same asthe linear predictor intermsof 1, X,,, ..., X;. Denoting this predictor
by P,W and applying P, to theequation Y,,,, = X,.,» + 1 gives

PnYnJrh = + Pan+h- (2519)

Thus the best linear predictor of Y,., can be determined by finding the best linear
predictor of X, andthen adding . Notefrom (2.5.8) that since E(X;) = 0, P, X .4
isthe same as the best linear predictor of X,,,, intermsof X,,, ..., X; only. O

2.5.1 The Durbin-Levinson Algorithm

In view of Remark 3 above, we can restrict attention from now on to zero-mean
stationary time series, making the necessary adjustments for the mean if we wish
to predict a stationary series with nonzero mean. If {X,} is a zero-mean stationary
series with autocovariance function y (-), then in principle the equations (2.5.12)
and (2.5.13) completely solve the problem of determining the best linear predictor
P, X, of X, intermsof {X,, ..., X1}. However, the direct approach requiresthe
determination of a solution of a system of » linear equations, which for large n may
be difficult and time-consuming. In cases where the process is defined by a system
of linear equations (as in Examples 2.5.2 and 2.5.3) we have seen how the linearity
of P, can be used to great advantage. For more general stationary processesit would
be helpful if the one-step predictor P, X, .1 based on n previous observations could
be used to simplify the calculation of P, 1X,,», the one-step predictor based on
n + 1 previous observations. Prediction algorithmsthat utilize thisideaare said to be
recur sive. Two important examples are the Durbin—-Levinson algorithm, discussed
in this section, and the innovations algorithm, discussed in Section 2.5.2 below.
We know from (2.5.12) and (2.5.13) that if the matrix I'",, is nonsingular, then

PanH—l = ¢;Xn = d)ann +-F ¢nnXl»
where

¢n = Fn_l’Yna
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Y, = (¥ (), ..., y(n)), and the corresponding mean squared error is
v, = E(Xn+1 - Pl1Xn+l)2 = )/(0) - ¢;:’Y"

A useful sufficient condition for nonsingularity of all the autocovariance matrices
[, Ty ...i1sy(0) > 0and y(h) — 0ash — oo. (For a proof of this result see
TSTM, Proposition 5.1.1.)

The Durbin—L evinson Algorithm:
The coefficients ¢,.1, . . . , ¢,,, can be computed recursively from the equations
B n—1
Gun = | v (n) — Z@,fl,jy(n - j)} vk (2.5.20)
L j=1
n1 ] Pn-11 Pn1n-1
: = : — G : (2.5.21)
d)n,n—l ] ¢n—l,n—l ¢n—l,1
and
Uy = Va1 — ¢fn], (2.5.22)
where ¢1; = y(1)/y(0) and vo = y (0).

Proof  The definition of ¢, ensures that the equation
R,y = pu (2523)

(where p, = (D), ..., p(n))) issatisfied for n = 1. Thefirst step in the proof isto
show that ¢,,, defined recursively by (2.5.20) and (2.5.21), satisfies (2.5.23) for al n.
Suppose thisistruefor n = k. Then, partitioning R, ; and defining

pl) = (p(k), pk — D), ..., p(L)Y
and

r) .
w = (ks k-1, - - i1,

we see that the recursions imply

| Rk o || ox — drrrniao)’
Riy1®rr=1| ) 1
Pk

Drt1k41

r)r 4 (r)

(f)k — Gerrir1py + Brripiap)
- r
Py bk — brrriipy O + brerrirt

= Pi+1>
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as required. Here we have used the fact that if R ¢ = py, then Rio\” = p!”. This
is easily checked by writing out the component equations in reverse order. Since
(2.5.23) is satisfied for n = 1, it follows by induction that the coefficient vectors ¢,
defined recursively by (2.5.20) and (2.5.21) satisfy (2.5.23) for al n.

It remains only to establish that the mean squared errors

U, = E(Xn+l - d);,xn)z

satisfy vy = y(0) and (2.5.22). Thefact that vy = y (0) isan immediate consequence
of the definition PoX; := E(X;) = 0. Since we have shown that ¢/ X, is the best
linear predictor of X, ,, we can write, from (2.5.9) and (2.5.21),

v =70 — B, vs =70 — &, _1Vu1 + G, Va1 — Gun¥ ().
Applying (2.5.9) again gives

Un = Vp-1+ Gun <¢ff_)/nn_1 - )/(n)) ,
and hence, by (2.5.20),

On = Va1 = 85, (¥ (0) = &%) = vaea (1= 95, .

Remark 4. Under the conditions of the proposition, the function defined by «:(0) =
land a(n) = ¢,,, n = 1,2, ..., isknown as the partial autocorrelation function
(PACF) of {X,}. It will be discussed further in Section 3.2. Of particular interest is
equation (2.5.22), which shows the relation between «(n) and the reduction in the
one-step mean squared error as the number of predictors is increased fromn — 1
ton. O

2.5.2 The Innovations Algorithm

The recursive algorithm to be discussed in this section is applicable to all series
with finite second moments, regardless of whether they are stationary or not. Its
application, however, can be simplified in certain special cases.

Suppose then that {X,} is azero-mean serieswith E|X,|? < oo for each ¢ and

E(X;X;) =k, j). (2.5.24)

It will be convenient to introduce the following notation for the best one-step predic-
tors and their mean squared errors:

0, ifn=1,
X, = ]
P,_1X,, |f7’l:2, 3,...,
and
U, = E(Xn+1 - PanH—l)Z'
We shall also introduce the innovations, or one-step prediction errors,

U, =X, — X,.
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Intermsof thevectorsU,, = (Ui, ..., U,) and X, = (X1, ..., X,) thelast equations
can be written as

Un = Anxnv (2525)
where A, hasthe form
[ 1 0 0 0]
aln 1 0 0
A, =| a= az 1 0
0
ap—1n-1 GAp-1p-2 Ap-1,-3 e 1

(If {X,} is stationary, then a;; = —a; with a; asin (2.5.7) with » = 1.) Thisimplies
that A, isnonsingular, with inverse C, of the form

1 0 0
611 1 0
C, = ) 01 1

RO OO0OO

Gn—l,n—l 011—1,;1—2 9n—1,n—3

The vector of one-step predictors Xn = (X1, P1X>, ..., P,_1X,) can therefore be
expressed as

X, =X, U, =CU, -U, = 0O, (xn - x) , (2.5.26)
where
[ 0o 0 0 . 0]
O 0 0 .0
e, = 022 021 0 -0
: : 0
911—1,11—1 911—1,11—2 9n—1,n—3 O_

and X, itself satisfies

X, = C, (xn . x) : (2.5.27)
Equation (2.5.26) can be rewritten as
0, ifn=0,
Xnt = Z@u <Xn+l—j — )}n-&-l—j) , ifn=212,..., (2:5.28)
j=1

from which the one-step predictors X1, X5, ... can be computed recursively once
the coefficients 6;; have been determined. The following algorithm generates these
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coefficients and the mean squared errors v; = E(X;11 — f(i+1)2, starting from the
covariancesx (i, j).

The Innovations Algorithm:
The coefficients 6,1, . . ., 6, can be computed recursively from the equations

vo=«(1,1),

j=0

k-1
Opn—i = Uk_l (K(n +1Lk+1) — Zek,k_je,,’n_jvj) , O0<k<n,
and

n—1
v, =k(n+1ln+1) — Ze,fyn_jvj.
j=0
(Itisatrivial matter to solvefirst for vg, then successively for 611, vi; 62,021, v2; a3,
032, 031, V35 . . ..)

Proof See TSTM, Proposition 5.2.2. [ |

Remark 5. While the Durbin-Levinson recursion gives the coefficients of
X,, ..., X1 in the representation X,,; = Z’}Zl &0 X,41-j, the innovations ago-
rithm gives the coefficients of (X, — X,), ..., (X1 — X1), inthe expansion X,,,1 =

A

> 160 (Xns1-j — Xny1-;). Thelatter expansion has anumber of advantages deriv-
ing from the fact that the innovations are uncorrel ated (see Problem 2.20). It can also
be greatly simplified in the case of ARMA(p, ¢) series, as we shall see in Section
3.3. Animmediate consequence of (2.5.28) isthe innovations representation of X, ;
itself. Thus (defining 6,0 := 1),

Xn+l = Xn+l - )/\(nJrl + &nJrl = Zgnj (XnJrlfj - XnJrlfj) s n = 07 1, 21 e O
=0

Example 2.5.5 Recursive prediction of an MA(1)
If {X,} isthetime series defined by
X, =Z,4+0Z_1,{Z} ~WN(0,07),

then k@i, j) = Ofor |i — j| > 1, k(i,i) = 0?(1+6?), and k(i,i + 1) = 652
Application of the innovations algorithm leads at once to the recursions

9}1‘/:0?25‘]'5”’
60,1 = vn__11902,



74

Chapter 2

Stationary Processes

and
v, = [l+ 0% — vn__llé’zaz] o2
For the particular case
X, =2,-09Z,_1, {Z)}~WN(Q,1),

the mean sguared errors v, of )A(,IH and coefficientsd,;, 1 < j < n,intheinnovations
representation

},\(I’l-‘rl = Zenj (Xn+1—_j - Xn-&-l—j) = Un1 (Xn - ),\(n)
=1

are found from the recursions to be as follows:

vo = 1.8100,

91]_ = —4972, V1 = 13625,

921 = —6606, 922 = O, Uy = 12155,

931 = —.7404, 932 = O, 933 = 0, V3 = 11436,

941 = —7870, 042 = O, 043 = O, 944 = O, Vg = 1.1017.

If we apply the Durbin—L evinson algorithm to the same problem, wefind that the
mean squared errors v, of X,,, and coefficients ¢,;, 1 < j < n, inthe representation

n
Xn-‘rl:E (Pann-‘rl—j
j=1

are as follows:

vo = 1.8100,

¢ = —.4972, v, = 1.3625,

¢ = —.6606, ¢ =—.3285 v, = 1.2155,

P31 = —. 7404, ¢Pap = —.4892, P33 = —.2433, vz = 1.1436,

¢s1 = —. 7870, ¢pgp = —.5828, ¢4z = —.3850, sy = —.1914, v, =1.1017.

Noticethat asn increases, v, approaches the white noise variance and 6,,; approaches
0. Theseresults hold for any MA(1) processwith |9| < 1. Theinnovations algorithm
is particularly well suited to forecasting MA(g) processes, since for them 6,; = 0
forn — j > ¢. For AR(p) processes the Durbin-L evinson algorithm is usually more
convenient, since ¢,; = 0forn — j > p. O

Recursive Calculation of the h-Step Predictors
For h-step prediction we use the result

Pll(Xn+k - PnJrklenJrk) = 0, k > 1 (2529)
Thisfollows from (2.5.10) and the fact that

E[(Xn+k - Pn+k,1Xn+k - O)XH+J71] == 0, ] = 1, e, N,
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Hence,
Pn Xn+h - Pn Pn+h—1Xil+h
= Pan+h

n+h—1 R
- Pn < Z 6n+h—l,j (Xn+h—j - Xn+h—j>> .
=1

Applying (2.5.29) again and using the linearity of P, we find that

n+h—1

Pan+h = Z 9n+h—1,j (Xil+]1—j - ),\(n-&-h—j) B (2530)
j=h

where the coefficients 6,; are determined as before by the innovations agorithm.
Moreover, the mean squared error can be expressed as

E(Xpin — PuXoin)? = EXZ, — E(P,Xp10)*

n+h—1
=km+hn+h) = Y 02, 4 Vonj1. (2531)

j=h

2.5.3 Prediction of a Stationary Process in Terms of Infinitely Many Past
Values

It is often useful, when many past observations X,,,, ..., Xo, X1,..., X, (m < Q)
are available, to evaluate the best linear predictor of X, intermsof 1, X,,., ..., Xo,
..., X,,. This predictor, which we shall denoteby P, ,X,.,, can easily be evaluated
by the methods described above. If |m| is large, this predictor can be approximated
by the sometimes more easily calculated mean square limit
Pan+h - mimoo Pm,an-'rh-

We shall refer to P, as the prediction operator based on the infinite past, {X,,
— oo < t < n}. Analogously we shall refer to P, asthe prediction operator based
on thefinite past, {X1, ..., X,}. (Mean sguare convergence of random variablesis
discussed in Appendix C.)

Determination of P, X, .
Like P, X, the best linear predictor P, X,,, when {X,} is a zero-mean stationary
process with autocovariance function y (-) is characterized by the equations

E [(X,Hh - an,,+,,> X,Hl,,»] —0, i=12....

If we can find asolution to these equations, it will necessarily bethe uniquely defined
predictor P, X, ,. An approach to this problem that is often effective is to assume
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that f’,,Xn+h can be expressed in the form
~ o0
Pan+h = Zann+l—ja
j=1

in which case the preceding equations reduce to

)
E|:<Xn+h_2ajxn+lj) Xn+1i:| =07 i =11 27‘--7
=1

or equivalently,

[e0]

Y oyli—jpaj=yh+i-1, i=12....

j=1

'I:hi sisaninfiniteset of linear equationsfor the unknown coefficientsq; that determine
P, X1, provided that the resulting series converges.

Properties of P,:
Supposethat EU? < 00, EV? < 00,a, b,andc areconstants, and I' = Cov(W, W).
1. E[(U - P,(U)X,;1=0,, <n.

2. P,(aU +bV +¢) =aP,(U) + bP,(V) +c.

3. P,(U) = U if U isalimit of linear combinations of X;,j <n.

4. P,(U) = EU if Cov(U, X,;) = Ofordl j < n.

_ These properties can sometimes be used to simplify the calculation of
P, X, ., notably when the process {X,} isan ARMA process.

Example 2.5.7  Consider the causal invertible ARMA(1,1) process {X,} defined by
X —¢Xi1=2Z,+0Z_1, {Z}~WN(0,0?).

We know from (2.3.3) and (2.3.5) that we have the representations

(o]
Xpi1=Zu1+ (@ +0) Y ¢/ Zua
j=1

and

oo

Znsr = Xps1 — @ +0) Y _(=0) X1,

j=1
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Applying the operator P, to the second equation and using the properties of P, gives

o]

PXpa=(@+0) ) (=0) X1 .
j=1

Applying the operator P, to the first equation and using the properties of P, gives
PXya=@+0) ) ¢/ Zua .
j=1

Hence,
Xp1— P X1 =2,41,

and so the mean squared error of the predictor P, X1 iS EZ? , =02 O

2.6 The Wold Decomposition

Consider the stationary process
X, = Acos(wt) + B Sin(wt),

wherew € (0, ) isconstant and A, B are uncorrelated random variables with mean
0 and variance 2. Notice that

X, =QRcosw)X,.1— X, »=P,_1X,, n=0,%1,...,

sothat X, — P,_1X, = Ofor al n. Processes with the |atter property are said to be
deterministic.

The Wold Decomposition:

If {X,} isanondeterministic stationary time series, then
X, =Y Y Zij+ Vi, (2.6.1)
j=0

where

Yo=1land Y 7 ¢? < oo,
{Z:} ~ WN (0, 0?),

Cov(Z,, V) =0foradl s andr,
Z, = Pz foradlt,

V, = P,V, forall s and ¢, and

© u b~ 0w D P

{V,} isdeterministic.
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Example 2.6.1

Problems

Here asin Section 2.5, P,Y denotes the best predictor of Y in terms of linear com-
binations, or limits of linear combinations of 1, X,, —oc < s < r. The sequences
{Z,}, {y;}, and {V,} are unique and can be written explicitly as Z, = X, — P_1X,,
v, = E(X,Z,_;)/E(Z?),and V, = X, — > o¥iZi—j- (See TSTM, p. 188.) For
most of the zero-mean stationary time series dealt with in this book (in particular for
all ARMA processes) the deterministic component V; is O for all ¢, and the seriesis
then said to be purely nondeter ministic.

If X, = U, +Y, where {U,} ~ WN (0,v?), E(U,Y) = Ofor al r, and Y has mean
0 and variance 72, then P,_1X, = Y, since Y isthe mean square limit ass — oo of
[X,1+- -+ X,.]/s,and E[(X; — Y)X,] = Oforal s < r— 1. Hence the sequences
in the Wold decomposition of {X,} aregivenby Z, = U,, yo = 1, ¢; = 0for j > O,
andV, =Y. O

2.1. Supposethat X;, X, ..., isastationary time serieswith mean u and ACF p ().
Show that the best predictor of X, of theforma X, + b isobtained by choosing
a=ph)andb = u(l— p(h)).

2.2. Show that the process
X, = Acos(wt) + BsSin(wt), t=0,+£1,...

(where A and B are uncorrelated random variables with mean 0 and variance 1
and w isafixed frequency in theinterval [0, ]), is stationary and find its mean
and autocovariance function. Deduce that the function « (k) = cos(wh), h =
0, £1, ..., isnonnegative definite.

2.3. a Findthe ACVF of thetimeseries X, = Z, + .3Z,_1 — .4Z,_,, where {Z,} ~
WN(O, 1).

b. Find the ACVF of the time series ¥, = Z, — 127, 1 — 1.6Z, ,, where
{Z;} ~ WN(O, .25). Compare with the answer found in (a).

2.4. It isclear that the function (k) = 1,h = 0,41, ..., is an autocovariance
function, since it is the autocovariance function of the process X, = Z,r =
0, £1, ..., where Z isarandom variable with mean 0 and variance 1. By iden-
tifying appropriate sequences of random variables, show that the following
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2.5.

2.6.
2.7.

2.8.

29.

functions are al so autocovariance functions;
@ Kk(h) = (="

wh wh
(b) k() =1+ cos(7> 4 cos (T)

1, if h =0,
© «xth)=1{04, ifh==1,
0, otherwise.

Suppose that {X,,r = 0, £1, ...} is stationary and that |#| < 1. Show that for
each fixed n the sequence

Sm == Xm: QJXH,J
j=1

is convergent absolutely and in mean square (see Appendix C) asm — oo.
Verify equations (2.2.6).
Show, using the geometric series1/(1 —x) = » 7", x/ for x| < 1, that 1/(1—
¢pz) =— 219z for|p| > Land |z| > 1.
Show that the autoregressive equations

X, =X, 1+ 2Z, t=0=%1,...,

where {Z,} ~ WN(0,6?) and |¢| = 1, have no stationary solution. HINT:
Suppose there does exist a stationary solution {X,} and use the autoregressive
equation to derive an expression for the variance of X, — ¢/ * X, , 4 that con-
tradicts the stationarity assumption.

Let {Y,} bethe AR(1) plus noise time series defined by
Y, =X+ W,

where {W,} ~ WN(O, 02), {X,} isthe AR(1) process of Example 2.2.1, i.e,,
X, —¢X,-1=Z,,{Z,} ~WN (0,07),

and E(W,Z,) = Ofor al s and z.

a. Show that {,} is stationary and find its autocovariance function.

b. Show that the time series U, = Y, — ¢Y,_; is 1-correlated and hence, by
Proposition 2.1.1, isan MA(1) process.

c. Conclude from (b) that {Y;} isan ARMA(1,1) process and express the three
parameters of thismodel in terms of ¢, 02, and o 2.

s Y
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2.10. Usethe program I TSM to compute the coefficientsy; and z;, j = 1,...,5,in
the expansions

X=> 7,
j=0

and

00
Z, = Z]Tth_j
=0

for the ARMA(1,1) process defined by the equations
X, —05X,.1=2Z,+05Z,_1, {Z}~WN(0,07).

(SelectFile>Project>New>Univariate, thenModel>Specify. Intheresult-
ing dialog box enter 1 for the AR and MA orders, specify ¢ (1) = 6(1) = 0.5,
and click 0K. Finally, select Mode1>AR/MA Infinity>Default lag and the
values of y; and r; will appear on the screen.) Check the results with those
obtained in Section 2.3.

2.11. Suppose that in a sample of size 100 from an AR(1) process with mean w,
¢ = .6, and 02 = 2 we obtain X100 = .271. Construct an approximate 95%
confidence interval for . Are the data compatible with the hypothesis that
u=07?

2.12. Suppose that in a sample of size 100 from an MA(1) process with mean w,
6 = —.6,and 02 = 1 we obtain X100 = .157. Construct an approximate 95%
confidence interval for u. Are the data compatible with the hypothesis that
u = 0?

2.13. Suppose that in a sample of size 100, we obtain p(1) = .438 and p(2) = .145.

a. Assuming that the data were generated from an AR(1) model, construct
approximate 95% confidence intervals for both o (1) and p(2). Based on
these two confidence intervals, are the data consistent with an AR(1) model
with ¢ = .8?

b. Assuming that the data were generated from an MA(1) model, construct
approximate 95% confidence intervals for both p(1) and p(2). Based on
these two confidence intervals, are the data consistent with an MA(1) model
withg = .6?

2.14. Let {X,} bethe process defined in Problem 2.2.

a. Find P; X, and its mean squared error.

b. Find P,X3 and its mean squared error.

c. Find P,X,.1 and its mean squared error.
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2.15.

2.16.

2.17.

2.18.

Supposethat {X,,t = 0, &1, ...} isastationary process sati sfying the equations
X, = ¢1Xt—l +-F ¢17Xt—p + Z;,

where {Z,} ~ WN(0, 0?) and Z, is uncorrelated with X, for each s < 7. Show
that thebest linear predictor P, X, 1 Of X, intermsof 1, X4, ..., X, assuming
n>p,is

Pan+l = ¢1Xn +-F ¢pxn+lfp'
What is the mean squared error of P, X, 1?

Use the program I TSM to plot the sample ACF and PACF up to lag 40 of the
sunspot series D,,t = 1, 100, contained in the ITSM file SUNSPOTS. TSM.
(Open the project SUNSPOTS. TSM and click on the second yellow button at
the top of the screen to see the graphs. Repeated clicking on this button will
toggle between graphs of the sample ACF, sample PACF, and both. To see the
numerical values, right-click on the graph and select Info.) Fit an AR(2) model
to the mean-corrected data by selecting Model>Estimation>Preliminary
and click Yes to subtract the sample mean from the data. In the dialog box that
follows, enter 2 for the AR order and make sure that the MA order is zero and
that the Yule-Walker agorithmis selected without AICC minimization. Click
0K and you will obtain amodel of the form

X, =p1 X1+ 92X, 0+ 7y, where{Z,} ~ WN (07 52) s

for the mean-corrected series X, = D, — 46.93. Record the values of the es-
timated parameters ¢, ¢,, and o2. Compare the model and sample ACF and
PACF by selecting the third yellow button at the top of the screen. Print the
graphs by right-clicking and selecting Print.

Without exiting from ITSM, use the model found in the preceding problem to
compute forecasts of the next ten values of the sunspot series. (Select Fore-
casting>ARMA, make sure that the number of forecastsis set to 10 and the box
Add the mean to the forecasts is checked, and then click 0K. You will
see agraph of the original data with the ten forecasts appended. Right-click on
the graph and then on Info to get the numerical values of the forecasts. Print
the graph as described in Problem 2.16.) The details of the calculations will be
taken up in Chapter 3 when we discuss ARMA modelsin detail.

Let {X,} be the stationary process defined by the equations

X, =Z,—-07Z,_41, t=0,41, ...,
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where [6] < 1 and {Z;} ~ WN(0,o?). Show that the best linear predictor
P,X,+10f X, 1 basedon {X;, —oco < j <n}is

o0
Pan+1 = - Z 0an+1—j-
=1

What is the mean squared error of the predictor P, X,,.1?

2.19.If {X,} isdefined asin Problem 2.18 and 0 = 1, find the best linear predictor
P, X,.10f X, pintermsof X4, ..., X,. Whatisthe corresponding mean squared
error?

2.20. Inthe innovations algorithm, show that for eachn > 2, theinnovation X,, — f(,,
isuncorrelated with X, ..., X,,_1. Concludethat X, — X, isuncorrelated with
theinnovations X; — X4, ..., X,_1 — X, _1.

2.21. Let X4, X5, X4, X5 be observations from the MA (1) model
X, =Z+0Z_1, {Z}~WN(0,0?.
a. Find the best linear estimate of the missing value Xz interms of X; and X».

b. Find the best linear estimate of the missing value X3 in terms of X, and Xs.
c. Find the best linear estimate of the missing value X3 intermsof X, X, X4,
and Xs.
d. Compute the mean squared errors for each of the estimatesin (a), (b), and
(©).
2.22. Repeat parts (a)—d) of Problem 2.21 assuming now that the observations X,
X2, X4, X5 are from the causal AR(1) model

X, =¢X, 1+ Z, {Z}~WN(0,0?).



ARMA Models

3.1  ARMA(p, q) Processes
3.2 The ACF and PACF of an ARMA(p, q) Process
3.3 Forecasting ARMA Processes

In this chapter we introduce an important parametric family of stationary time series,
the autoregressive moving-average, or ARMA, processes. For alarge class of autoco-
variancefunctionsy (-) itispossibleto find an ARMA process{X,} with ACVF yx ()
such that y (-) is well approximated by yx (-). In particular, for any positive integer
K, there existsan ARMA process {X,} suchthat yx(h) = y(h) forh =0,1,..., K.
For this (and other) reasons, the family of ARMA processes plays a key role in the
modeling of time series data. The linear structure of ARMA processes aso leads
to a substantial simplification of the general methods for linear prediction discussed
earlier in Section 2.5.

3.1 ARMA(p, q) Processes

Definition 3.1.1

In Section 2.3 we introduced an ARMA(1,1) process and discussed some of its key
properties. These included existence and uniqueness of stationary solutions of the
defining equations and the concepts of causality and invertibility. In this section we
extend these notions to the general ARMA((p, g) process.

{X,}isan ARMA(p, q) processif {X,} isstationary and if for every ¢,
Xe—p1Xe 1 — o —pXe =2, +01Z; 1+ -+ 0,7, (3.1.1)

where {Z,} ~ WN(0, o2) and the polynomials (1 — ¢1z — ... — ¢,z") and (1 +
61z + ... + 6,z7) have no common factors.
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Theprocess{X;} issaidto bean ARMA(@p, q) processwith mean p if {X, — u}
isan ARMA(p, g) process.
It is convenient to use the more concise form of (3.1.1)

¢(B)X: =0(B)Z, (312
where ¢ () and 6(-) are the pth and gth-degree polynomials

¢@)=1—rz—--—¢pz"

and
0(z) =1+61z+---+0,2%,

and B isthe backward shift operator (B’ X, = X,_;, B/'Z, = Z,_;, j =0,+£1,...).
Thetime series {X,} is said to be an autoregressive process of order p (or AR(p))
if 6(z) = 1, and amoving-aver age process of order ¢ (or MA(q)) if ¢(z) = 1.

An important part of Definition 3.1.1 is the requirement that {X,} be stationary.
In Section 2.3 we showed, for the ARMA(1,1) equations (2.3.1), that a stationary
solution exists (and is unique) if and only if ¢; # +1. The latter is equivalent to the
condition that the autoregressive polynomial ¢(z) = 1 — ¢1z # Ofor z = £1. The
analogous condition for the general ARMA(p, g) processis¢(z) =1— ¢z — -+ —
¢,z # Ofor al complex z with |z] = 1. (Complex z is used here, since the zeros of
apolynomial of degree p > 1 may be either real or complex. The region defined by
the set of complex z such that |z| = 1isreferred to asthe unit circle.) If ¢ (z) # Ofor
al z on the unit circle, then there exists § > 0 such that

1 G :
i x;iz! forl—48 < |z| <146,
¢ (2) j;oo !

andy 7 x| < oo. Wecanthen define 1/¢ (B) asthelinear filter with absolutely
summable coefficients

i: i x;B’.
oB) ="

Applying the operator x (B) := 1/¢(B) to both sides of (3.1.2), we abtain

X, =x(B)¢(B)X, = x(B)O(B)Z, = ¥ (B)Z, = Z ViZi-j, (3.13)

j==s0

where ¥ (z) = x(2)6(z) = Y72, ¥;z/. Using the argument given in Section 2.3
for the ARMA(1,1) process, it followsthat v (B)Z, is the unique stationary solution
of (3.1.1).
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Existence and Uniqueness:

A stationary solution {X,} of equations (3.1.1) exists (and is also the unigque sta-
tionary solution) if and only if

p)=1—¢z—---—¢,2" #0 fordl|z] =1 (31.4)

In Section 2.3 we saw that the ARMA(1,1) processiscausd, i.e., that X, can be
expressed interms of Z;, s < r, if and only if |¢1| < 1. For ageneral ARMA(p, q)
process the analogous condition is that ¢ (z) # 0 for |z] < 1, i.e., the zeros of the
autoregressive polynomial must all be greater than 1 in absolute value.

Causality:

An ARMA(p, q) process {X,} is causal, or a causal function of {Z,}, if there
exist constants {y;} such that Zj‘;o || < oo and

X, =) v;Z_;foral s, (3.1.5)
j=0
Causality is equivalent to the condition
p(@)=1—¢1z—---— ¢z’ #0foral |z] < 1. (3.1.6)

The proof of the equivalence between causality and (3.1.6) follows from ele-
mentary properties of power series. From (3.1.3) we see that {X,} is causal if and
only if x(z) '=1/¢(z) = 372 x,;2’ (assuming that ¢ (z) and 6(z) have no common
factors). But this, in turn, is equivalent to (3.1.6).

The sequence {y;} in (3.1.5) is determined by therelation v (z) = Y7, ¥,/ =
0(z)/¢(z), or equivalently by the identity

(L= oz — - —¢p2") o+ vz +--) = L+ 61z + - +6,2.
Equating coefficientsof z/, j = 0, 1, ..., wefind that

1= o,

01 = Y1 — Yoo,

O = V2 — Y1¢1 — Yoo,

or equivalently,

)4
V=Y ¢ipa=0; j=01.., (3.1.7)

k=1
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where 6, := 1,6, :=0for j > g, and y; :=0for j <O.
Invertibility, which allows Z, to be expressed interms of X,, s < r, hasasimilar
characterization in terms of the moving-average polynomial.

Invertibility:
AnARMA(p, q) process {X,} isinvertibleif there exist constants {;} such that
> olmjl < oo and
Z,=Y X, forallr.
j=0

Invertibility is equivalent to the condition

Q(Z) :1+912+...—|—9qu #Ofora” |Z| = 1

Interchanging theroles of the AR and MA polynomials, wefind from (3.1.7) that
the sequence {x;} is determined by the equations

q
7Tj+29k7rj—k:_¢jv ]:0, 1,..., (318)
k=1

where ¢ .= —1,¢; :=0for j > p,andz; :==0for j <O.

An ARMA(1,1) process
Consider the ARMA(1,1) process { X,} satisfying the equations
X, — 5X,.1=Z +.4Z,_1, {Z,} ~WN(0,07). (3.1.9)

Since the autoregressive polynomial ¢(z) = 1 — .5z hasa zero a z = 2, which is
located outside the unit circle, we conclude from (3.1.4) and (3.1.6) that there exists
aunique ARMA process satisfying (3.1.9) that is also causal. The coefficients {y;}
in the MA (c0) representation of {X,} are found directly from (3.1.7):

Yo =1,
Yr= .4+ 5,
Yo = .54+ .5),

v, =5"14+5), j=12....

The MA polynomia 6(z) = 1+ .4z hasazeroat z = —1/.4 = —2.5, which isalso
located outside the unit circle. This implies that {X,} is invertible with coefficients
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Example 3.1.2

Example 3.1.3

{r;} given by (see (3.1.8))
g = 1,
T = —(4+ 5),

my = —(44 .5 (-.4),

i =—(4+ 54 j=12 ...
(A direct derivation of these formulas for {y;} and {;} was given in Section 2.3
without appealing to the recursions (3.1.7) and (3.1.8).) O
An AR(2) process
Let {X,} bethe AR(2) process

X, =7X,1—1X,2+Z, {Z}~WN(0,0?).

Theautoregressive polynomial for thisprocess hasthefactorization¢(z) = 1— .7z +
172 = (1 — .52)(1 — .27), and is therefore zero at z = 2 and z = 5. Since these
zeroslie outside the unit circle, we concludethat {X,} isacausal AR(2) processwith
coefficients {y;} given by

Yo =1,
Y1 =7,
Vo = .77 — 1,

Vi=TY 1 — Y j=2.3....

While it is a simple matter to calculate y; numerically for any j, it is possible also
to give an explicit solution of these difference equations using the theory of linear
difference equations (see TSTM, Section 3.6). O

The option Model>Specify of the program ITSM allowsthe entry of any causal
ARMA(p, g) model with p < 28 and ¢ < 28. This option contains a causality check
and will immediately let you know if the entered model isnoncausal. (A causal model
can be obtained by setting all the AR coefficients equal to .001.) Once acausal model
has been entered, the coefficients /; in the MA (co) representation of the process can
be computed by selecting Mode1>AR/MA Infinity. Thisoption will also compute
the AR(o0) coefficients r;, provided that the model isinvertible.

An ARMA(2,1) process
Consider the ARMA(2,1) process defined by the equations

X, — .75X,_1+ .5625X, , = Z, + 1.25Z,_1, {Z} ~WN(0,07).
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The AR polynomial ¢(z) = 1 — .75z + .5625z2 has zeros at z = 2(1 £ i+/3)/3,
which lie outside the unit circle. The processis therefore causal. On the other hand,
the MA polynomial 6(z) = 1+ 1.257 hasa zero at z = —.8, and hence {X,} is not
invertible. ]

Remark 1. It should be noted that causality and invertibility are properties not of
{X,} aone, but rather of the relationship between the two processes {X,} and {Z;}
appearing in the defining ARMA equations (3.1.1). O

Remark 2. If {X,} is an ARMA process defined by ¢(B)X, = 6(B)Z,, where
0(z) # 0if |z] = 1, thenitisalwayspossible (see TSTM, p. 127) to find polynomials
$(z) and 6(z) and awhite noise sequence {W,} such that ¢(B)X, = 6(B)W, and 6 (z)
and ¢(z) are nonzero for |z| < 1. However, if the original white noise sequence {Z,}
isiid, then the new white noise sequencewill not beiidunless{Z;} isGaussian. O

Inview of the preceding remark, we will focus our attention principally on causal
and invertible ARMA processes.

3.2 The ACF and PACF of an ARMA(p. q) Process

In this section we discuss three methods for computing the autocovariance function
y (-) of acausa ARMA process {X,}. The autocorrelation function is readily found
from the ACVF on dividing by y (0). The partial autocorrelation function (PACF) is
also found from the function y (-).

3.2.1 Calculation of the ACVF
First we determine the ACVF y (-) of the causal ARMA(p, gq) process defined by

$(B)X, =0(B)Z;, {Z;} ~WN (0, 02) ) (321)
where¢(z) =1 — 1z — - —¢ppz” and0(z) = 1+ 61z + - - - + 6,z%. The causality
assumption implies that

X = Z ViZi_j, (322)
=0

where 3% 2/ = 6(2)/#(2), |z| < 1. The calculation of the sequence {y;} was
discussed in Section 3.1.
First Method. From Proposition 2.2.1 and the representation (3.2.2), we obtain

y(h) = E(X;44X;) = 0? Z Yivisn- (3.2.3)
i=0
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Example 3.2.1  The ARMA(1,1) process

Substituting from (2.3.3) into (3.2.3), we find that the ACVF of the process defined
by

X, —¢Xi1=2,+0Z_1, {Z}~WN(0,0%), (3.2.4)
with |¢| < lisgiven by

y(@ =0 v

j=0

=0’ [1+ ® +¢)2i¢2’]
j=0

2
:JZ[1+(9+¢) ]

1—¢2

yD) =02 vjav;
j=0

=02 [9 +o+@© +¢)2¢Z¢2f}
j=0

By 0 + ¢)%
=0 [0+¢+—l_¢2 }
and
y(h) =¢" vy, h=>2 0

Example 3.2.2  The MA(q) process

For the process
X, =Z4+60Z 1+ +0,Z_,, {Z}~WN(0,0?),
equation (3.2.3) immediately gives the result
=l _
() = o ; 0,0+, 1 1Rl <q,
0, if |nl > ¢,

where 6, is defined to be 1. The ACVF of the MA(g) process thus has the distinctive
feature of vanishing at lags greater than ¢. Data for which the sample ACVF is
small for lags greater than ¢ therefore suggest that an appropriate model might be a
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moving average of order ¢ (or less). Recall from Proposition 2.1.1 that every zero-
mean stationary process with correlations vanishing at lags greater than ¢ can be
represented as a moving-average process of order g or less. O

Second Method. 1f we multiply each side of the equations
X — ¢1Xr—1 - ¢sz—p =Z + elzz—l +-+ Gth—qa

by X,_;,k=0,1,2,..., and take expectations on each side, we find that

(o]

y) —drytk—=1) — - —,y(k—p)=0°) 6is;¥y;, O0<k<m, (325
j=0

and

y(k)y —dryk =1 —---—¢pyk —p) =0, k=m, (3.2.6)

wherem = max(p, ¢+1), vy, := 0for j < 0,6y := 1,andd; := O0for j ¢ {0, ..., g}.
In calculating theright-hand side of (3.2.5) we have made use of theexpansion (3.2.2).
Equations (3.2.6) are aset of homogeneous linear difference equations with constant
coefficients, for which the solution is well known (see, e.g., TSTM, Section 3.6) to
be of the form

y(h) = aréy" ok, 4 g h=m—p, (327)

whereé,, ..., &, aretheroots (assumed to be distinct) of the equation ¢ (z) = 0, and
a1, ..., ap arearbitrary constants. (For further details, and for thetreatment of the case
wheretherootsare not distinct, see TSTM, Section 3.6.) Of course, we arelooking for
the solution of (3.2.6) that also satisfies (3.2.5). We therefore substitute the solution
(3.2.7) into (3.2.5) to obtain a set of m linear equations that then uniquely determine
the constants oy, . . ., «, and them — p autocovariances y (h),0 < h < m — p.

The ARMA(1,1) process
For the causal ARMA(1,1) process defined in Example 3.2.1, equations (3.2.5) are

y(0) — ¢y (1) = 0*(146(0 + ) (3.2.8)
and

y(1) — ¢y (0) = 0%6. (3.2.9)
Equation (3.2.6) takes the form

yk) —¢yk—-1) =0, k=2 (3.2.10)

The solution of (3.2.10) is
y(h) =ag", h=1
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Substituting this expression for y (k) into the two preceding equations (3.2.8) and
(3.2.9) givestwo linear equations for « and the unknown autocovariance y (0). These
equations are easily solved, giving the autocovariances already found for this process
in Example 3.2.1. O

Example 3.2.4  The general AR(2) process
For the causal AR(2) process defined by
(1-&"B)(1-&'B) X, = Z:, &l |5l >1&#&,
we easily find from (3.2.7) and (3.2.5) using the relations
pr=6"+&"
and
2= —£'6"
that
R 1 B 1 B 1 S I CEXE)
(6162 — (62— &)
Figures 3.1-3.4 illustrate some of the possible formsof y (-) for different values of &;
and &,. Notice that in the case of complex conjugate roots &, = re’ and & = re=?,
0 < 0 < 7, we can write (3.2.11) in the more illuminating form
o?r* . rsin(hé + )
h) = — 3212
v #2 =1 (r*—2r2cos20 + 1)sing ( )
where
2
1
tany = = * 2 tane (3.2.13)
re—1
and cosyr hasthe same sign ascosé. Thusin thiscase y (-) hasthe form of adamped
sinusoidal function with damping factor »—* and period 27 /6. If the roots are close
to the unit circle, then r is close to 1, the damping is slow, and we obtain a nearly
sinusoidal autocovariance function. O
Third Method. The autocovariances can also be found by solving the first p + 1
equations of (3.2.5) and (3.2.6) for ¥(0)..., y(p) and then using the subsequent
equations to solve successively for y(p + 1), y(p + 2), .... Thisis an especially
convenient method for numerical determination of the autocovariances y (k) and is
used in the option Mode1>ACF/PACF>Model of the program ITSM.
Example 3.2.5  Consider again the causal ARMA(1,1) process of Example 3.2.1. To apply the third

method we simply solve (3.2.8) and (3.2.9) for y(0) and y (1). Then y (2), ¥ (3), ...
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can be found successively from (3.2.10). It is easy to check that this procedure gives
the same results as those obtained in Examples 3.2.1 and 3.2.3. O

3.2.2 The Autocorrelation Function

Recadll that the ACF of an ARMA process {X,} isthefunction p(-) found immediately
fromthe ACVF y(-) as

y (h)

h) = “——.

p(h) 20
Likewise, for any set of observations {x, ..., x,}, the sample ACF p(-) is computed

as

R y(h)

h) = = .

p(h) 50

The Sample ACF of an MA(g) Series. Given observations {xi, ..., x,} of atime
series, one approach to the fitting of amodel to the datais to match the sasmple ACF
of the data with the ACF of the model. In particular, if the sample ACF p(h) issig-
nificantly different from zero for 0 < h < ¢ and negligible for » > ¢, Example
3.2.2 suggeststhat an MA(¢) model might provide a good representation of the data.
In order to apply this criterion we need to take into account the random variation
expected in the sample autocorrelation function before we can classify ACF values
as “negligible” To resolve this problem we can use Bartlett’s formula (Section 2.4),
which implies that for a large sample of size n from an MA(g) process, the sample
ACF values at lags greater than g are approximately normally distributed with means
Oandvarianceswy,,/n = (1+2p%(1)+- - -+2p?(q))/n. Thismeansthat if the sample
isfrom an MA(q) process and if & > ¢, then p(h) should fall between the bounds
+1.96./wy,;, /n with probability approximately 0.95. In practice we frequently usethe
more stringent values +-1.96/./n as the bounds between which sample autocovari-
ances are considered “negligible” A more effective and systematic approach to the
problem of model selection, which aso appliesto ARMA(p, ¢) modelswith p > 0
and g > 0, will be discussed in Section 5.5.

3.2.3 The Partial Autocorrelation Function

The partial autocorrelation function (PACF) of an ARMA process {X,} is the
function «(-) defined by the equations

a0 =1
and

ah) =¢p, h =1,
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where ¢,,, isthe last component of
& =T, (3.2.14)
Ty =[yi = DI} opandy, = [y(D).yQ2),....yh)].
For any set of observations{xy, ..., x,} withx; # x; for somei and j, thesample
PACF &a(h) isgiven by
a(0) =1
and
a(h) = . h =1,
where ¢, isthe last component of
&n =T (3.2.15)
We show in the next exampl e that the PACF of acausal AR(p) processiszerofor
lags greater than p. Both sample and model partial autocorrelation functions can be
computed numerically using the program ITSM. Algebraic calculation of the PACF
is quite complicated except when g is zero or p and g are both small.
It can be shown (TSTM, p. 171) that ¢,,;, isthe correlation between the prediction
errors X, — P(Xu|X1, ..., Xu_1) @ad Xo — P(Xo| X1, ..., Xu_1).
Example 3.2.6  The PACF of an AR(p) process

For the causal AR(p) process defined by
Xz_¢er—l_"‘_¢sz—p =27, {Z})~WN (0, 0_2)’

we know (Problem 2.15) that for # > p the best linear predictor of X, interms of
1,X1,...,Xh is

X1 =01 Xn + G2 Xp1 + -+ GpXni1-p-

Since the coefficient ¢y, of X1 is¢, if h = pand 0if h > p, we conclude that the
PACF «(-) of the process {X;} has the properties

a(p) :¢p
and
a(h) =0for h > p.

For h < p the values of «(#) can easily be computed from (3.2.14). For any
specified ARMA model the PACF can be evaluated numerically using the option
Model>ACF/PACF>Model of the program ITSM. O
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Example 3.2.7

Example 3.2.8

The PACF of an MA(1) process

For the MA(1) process, it can be shown from (3.2.14) (see Problem 3.12) that the
PACFatlaghis

a(h) = g = —(—0)"/ (1+ 67+ - +6%). 0

The Sample PACF of an AR(p) Series. If {X,} isan AR(p) series, then the sample
PACF based on abservations {x1, . . ., x,,} should reflect (with sampling variation) the
properties of the PACF itself. In particular, if the sample PACF & (k) is significantly
different from zerofor 0 < 4 < p and negligible for 4 > p, Example 3.2.6 suggests
that an AR(p) model might provide agood representation of the data. To decidewhat
ismeant by “negligible” we can use the result that for an AR(p) process the sample
PACF valuesat lags greater than p are approximately independent N (0, 1/x) random
variables. This means that roughly 95% of the sample PACF values beyond lag p
should fall within the bounds +1.96/./n. If we observe a sample PACF satisfying
la(h)| > 1.96//nfor0 < h < pand|&(h)| < 1.96//n for h > p, this suggests an
AR(p) model for the data. For a more systematic approach to model selection, see
Section 5.5.

3.2.4 Examples

Thetime seriesplotted in Figure 3.5 consists of 57 consecutive daily overshortsfrom
an underground gasoline tank at afilling station in Colorado. If y, is the measured
amount of fuel in the tank at the end of the rth day and «, is the measured amount
sold minus the amount delivered during the course of the rth day, then the overshort
at the end of day ¢ isdefined as x;, = y, — y,_1 + a,. Due to the error in measuring
the current amount of fuel in the tank, the amount sold, and the amount delivered
to the station, we view y,, a,, and x; as observed values from some set of random
variables Y, A,,and X, forr = 1, ..., 57. (In the absence of any measurement error
and any leak in the tank, each x, would be zero.) The data and their ACF are plotted
in Figures 3.5 and 3.6. To check the plausibility of an MA(1) model, the bounds
+1.96(1 + 2,62(1))1/2/nl/2 are also plotted in Figure 3.6. Since p(h) iswell within
these bounds for 4 > 1, the data appear to be compatible with the model

X, =pn+Z +0Z_1, {(Z}~WN(00?). (3.2.16)

The mean 1 may be estimated by the sample mean xs5; = —4.035, and the parameters
6, o2 may be estimated by equating the sample ACVF with the model ACVF at lags
0 and 1, and solving the resulting equations for 6 and o2. This estimation procedure
is known as the method of moments, and in this case gives the equations

(14 6%0?% = p(0) = 3415.72,
0o = (1) = —1719.95.
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Using the approximate solution § = —1 and o2 = 1708, we obtain the noninvertible
MA (1) model

ACF

X, =-4035+ 7, — Z,-1, {Z:} ~WN(O, 1708).

Typically, intimeseriesmodeling wehavelittleor no knowledgeof theunderlying
physical mechanism generating the data, and the choice of a suitable class of models
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is entirely data driven. For the time series of overshorts, the data, through the graph
of the ACF, lead us to the MA(1) moddl. Alternatively, we can attempt to model the
mechanism generating the time series of overshorts using a structural model. Aswe
will see, the structural model formulation leads us again to the MA(1) model. In the
structural model setup, write Y;, the observed amount of fuel in the tank at time ¢, as

Y, = y* + U, (3.2.17)

where y* isthetrue (or actual) amount of fuel in the tank at time (not to be confused
with y, above) and U, is the resulting measurement error. The variable y; is an ide-
alized quantity that in principle cannot be observed even with the most sophisticated
measurement devices. Similarly, we assume that

A =ar+V, (3.2.18)

where a* isthe actual amount of fuel sold minus the actual amount delivered during
day ¢, and V; is the associated measurement error. We further assume that {U,} ~
WN(0, 63), {V;} ~ WN(O, 0%), and that the two sequences {U,} and {V,} are uncor-
related with one another (E (U, V,) = O for al s and ¢). If the change of level per day
dueto leakageis u gallons (1 < 0 indicates leakage), then

yi=wntyi—a (3.219)

This equation relates the actual amounts of fuel in the tank at the end of days ¢ and
t — 1, adjusted for the actual amounts that have been sold and delivered during the
day. Using (3.2.17)—3.2.19), the model for the time series of overshortsis given by

X, =Y, =Y 14+ A =pu+U —-U_1+V,.
This modél is stationary and 1-correlated, since
EX,=E(u+U, —-U_1+V)=pn
and
y(h) = E[(X;4n — ) (X, — w)]
= E[(Usn — U1+ Vi) (U, — U1 + V)]
202 +of, ifh=0,
=1 —o2, if |h| = 1,
0, otherwise.
It follows from Proposition 2.1.1 that {X,} isthe MA(1) model (3.2.16) with

91 —(72
1) = = v,
rA 1+912 205—}—05

From this equation we see that the measurement error associated with the adjustment
{A;} iszero (i.e, 02 = 0) if and only if p(1) = —.5 or, equivalently, if and only
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Example 3.2.9

Figure 3-7

The sample PACF of the
sunspot numbers with the
bounds £1.96/4/100.

if 9, = —1. From the analysis above, the moment estimator of 6, for the overshort
dataisinfact —1, so that we conclude that thereisrelatively little measurement error
associated with the amount of fuel sold and delivered.

We shall return to a more general discussion of structural models in Chap-
ter 8. ]

The sunspot numbers

Figure 3.7 shows the sample PACF of the sunspot numbers Sy, ..., Sio0 (for theyears
1770 — 1869) as obtained from ITSM by opening the project SUNSPOTS.TSM and
clicking on the second yellow button at thetop of the screen. The graph also showsthe
bounds+1.96,/+/100. Thefact that all of the PACF values beyond lag 2 fall within the
bounds suggests the possible suitability of an AR(2) model for the mean-corrected
dataset X, = S, — 46.93. One simple way to estimate the parameters ¢4, ¢, and o2
of such amodel isto require that the ACVF of the model at lags 0, 1, and 2 should
match the sample ACVF at those lags. Substituting the sample ACVF values

7(0) = 13822, (1) = 11144, 7(2) = 591.73,

for y (0), v (1), and y (2) in thefirst three equations of (3.2.5) and (3.2.6) and solving
for ¢4, ¢, and o2 gives the fitted model

X, —1318X,_,+0.634X,_, = Z,, {Z,} ~WN(0, 289.2). (3.2.20)
(Thismethod of model fitting iscalled Yule-Walker estimation and will be discussed
more fully in Section 5.1.1.) O
o I'[T T
e o | LI 1, | | .

) T T T T
| | | | |
0 10 20 30 40

Lag
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3.3 Forecasting ARMA Processes

The innovations algorithm (see Section 2.5.2) provided us with a recursive method
for forecasting second-order zero-mean processes that are not necessarily stationary.
For the causal ARMA process

$(B)X, =6(B)Z:, {Z)~WN(0,0?),

it is possible to simplify the application of the algorithm drastically. The ideais to
apply it not to the process { X, } itself, but to the transformed process (cf. Ansley, 1979)

Wf:O_1Xf, t:].,...,m,
(3.3.1)
W, :Uil(]b(B)Xta t>m,
where
m = max(p, q). (332

For notational convenience we define 6 := 1and 6, := O for j > ¢. We shall also
assumethat p > 1and ¢ > 1. (Thereis no loss of generality in these assumptions,
since in the analysis that follows we may take any of the coefficients ¢; and 6; to be
Zero.)

The autocovariance function yy () of {X,} can easily be computed using any of
the methods described in Section 3.2.1. The autocovariances « (i, j) = E(W;W;),
i, j > 1, arethen found from

o yx(i — ), 1<i, j<m

P
a*Pw—ﬁ—zﬁmm—u—m} minGi, j) <m < max(, j) < 2m,
r=1

k(, j) = (3.3.3)
q
> 08, ming, j) > m,
r=0
0, otherwise.
Applying the innovations a gorithm to the process {W,} we obtain
WnJrl = Zenj(WnJrlfj - WnJrlfj), 1 <n<m,
j=1
! (3.3.4)

q
WnJrl = E an(WnJrlfj - WnJrlfj)’ n=>m,
=1

A

2
where the coefficients 6,; and the mean squared errorsr, = E (Wn+1 - Wn+1) are

found recursively from the innovations algorithm with « defined as in (3.3.3). The
notable feature of the predictors (3.3.4) is the vanishing of 6,; when bothn > m and
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~

J > g. Thisisaconsequence of theinnovationsa gorithmand thefactthat« (r, s) = 0
ifr >mand|r —s| > q.

Observe now that equations(3.3.1) allow each X,,, n > 1, to bewritten asalinear
combination of W;, 1 < j < n, and, conversely, each W,, n > 1, to be written asa
linear combination of X;, 1 < j < n. Thismeansthat the best linear predictor of any
randomvariableY intermsof {1, X4, ..., X,} isthe same asthe best linear predictor
of Yintermsof {1, Wy, ..., W, }. Weshall denotethispredictor by P,Y. Inparticular,
the one-step predictors of W, ; and X, are given by

Wn+1 - Pn Wn+1

and

A

Xn+l = Pan+1-

Using the linearity of P, and equations (3.3.1) we see that

W, = o 1X,, t=1...,m,
W, =0t [5(, Xy — - ¢,,Xt_,,] . > m, (335
which, together with (3.3.1), shows that
X, —X =0 [W, - W] forals> 1. (3.3.6)

Replacing (W; — W;) by o~*(X; — X;) in (3.3.3) and then substituting into (3.3.4),
we finally obtain

Zenj (Xn+1—,i - 5(n+1—j> > l1<n<m,
j=1

XnJrl == (3.3.7)

q
¢1Xn + 4+ ¢an+1—p + Zenj (Xn+1—j - Xn+l—j> , hzm,
j=1

and
~ 2 n 2
E (Xn+1 _ Xn+1> — o2E (W,,+1 . W,,+1) — o2, (3.3.8)

where 6,; and r, are found from the innovations qlgorjthm with ¢ as in (3.3.3).
Equations (3.3.7) determine the one-step predictors X,, X3, ... recursively.

Remark 1. It can beshown (see TSTM, Problem 5.6) that if {X,} isinvertible, then
asn — oo,

R 2
E(Xn—Xn—Z,,> -0,

O, —>0;, j=1....q,



102

Chapter 3

ARMA Models

Example 3.3.1

Example 3.3.2

Example 3.3.3

and
r, — 1.

Algebraic calculation of the coefficients6,; and r,, isnot feasible except for very sm-
ple models, such asthose considered in the following examples. However, numerical
implementation of the recursions is quite straightforward and is used to compute
predictorsin the program ITSM. O

Prediction of an AR(p) process

Applying (3.3.7) to the ARMA(p, 1) process with 6, = 0, we easily find that

}A(I’H-l - ¢1Xn —'I_ tt + (Pan-l»l—pa n 2 P D

Prediction of an MA(q) process
Applying (3.3.7) to the ARMA(1, g) process with ¢, = 0 gives

min(n,q)

Xn-‘rl — Z 9}1' <Xn+l—j - X;H—l—j) 5 n= 17
j=1

where the coefficients 6,; are found by applying the innovations algorithm to the co-
variances (i, j) definedin (3.3.3). Sincein this case the processes { X, } and {o ~1W,}
areidentical, these covariances are smply

q—li—j

|
kG, ) =0yx(i =)= Y 08 j. O
r=0

Prediction of an ARMA(1,1) process

If
X, —¢X;.1=Z,+0Z_1, {Z,}~WN(0,0?),

and |¢| < 1, then equations (3.3.7) reduce to the single equation
Xpp1=¢X, +00(X, — X,), n>1

Tocomputed,; wefirstuseExample3.2.1tofindthat yx (0) =02 (1 + 20¢ + 6?) /(1—
$?). Substituting in (3.3.3) then gives, for i, j > 1,
(14200 +06%)/(1—¢%), i=j=1
- 1+62, i=j>=2
k(i j) =
0, li—jl=1i>1,

0, otherwise.
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Example 3.3.4

With these values of « (i, j), the recursions of the innovations algorithm reduce to
ro=(1+20¢ +6%) /(1 —¢%),
Opr = 0/ry_1, (3.3.9
ra=146"—0%/r, 1,

which can be solved quite explicitly (see Problem 3.13). O

Numerical prediction of an ARMA(2,3) process

In this example we illustrate the steps involved in numerical prediction of an
ARMA(2,3) process. Of course, these stepsare shown for illustration only. The calcu-
lationsareall carried out automatically by ITSM inthecourse of computing predictors
for any specified data set and ARMA model. The process we shall consider is the
ARMA process defined by the equations

X, —-X,_1+024X, »,=7,+04Z,_,+02Z,_,+0.1Z,_3, (3.3.10)

where {Z,} ~ WN(O0, 1). Tenvaluesof X1, ..., X0 Simulated by the program ITSM
are shown in Table 3.1. (These were produced using the option Model>Specify to
specify the order and parameters of the model and then Model>Simulate to generate
the series from the specified model.)

Thefirst step isto compute the covariances yx (h), h = 0, 1, 2, which are easily
found from eguations (3.2.5) withk = 0, 1, 2 to be

yx(0) = 7.17133, yx(1) =6.44139, and yx(2) = 5.0603.
From (3.3.3) we find that the symmetric matrix K = [k (i, j)]; j=1.2.. iSgiven by

[ 7.1713

6.4414 7.1713

5.0603 6.4414 7.1713
010 034 0816 121

K = 0 0.10 034 050 121
0 0 010 024 050 121
0 0 010 024 050 121

0 0 010 024 050 121

The next step is to solve the recursions of the innovations algorithm for 6,; and
r, using these values for « (i, j). Then

Zenj (XnJrlfj - )A(n+1fj> , n=12,
j=1

X1 = 3
Xn — O.24Xn_1 + Z@nj (Xn+l—j - j\(n-fl—j) . n = 3, 4, ceey

j=1
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and

A

2
E (Xn+1 - Xn+1> = Uzrn =7,.
The results are shown in Table 3.1. O

h-Step Prediction of an ARMA(p, q) Process

Asin Section 2.5, we use P,Y to denote the best linear predictor of Y in terms of
X1, ..., X, (which, aspointed out after (3.3.4), isthe same asthe best linear predictor
of Y intermsof Wy, ..., W,). Then from (2.5.30) we have

n+h—-1 n+h—-1
R 5 N
P,Wyn = E Ontrn—1,j (Wn+h—j — n+h—j) =0 E Ontn—1,j (Xn+h—j - Xn+h—j) .
i i=h

Using this result and applying the operator P, to each side of equations (3.3.1), we
conclude that the i-step predictors P, X, satisfy

n+h—1 .
Z 911+h—1,j (Xn-ﬁ-h—j - Xn+h—_j) s 1 = h =m-—n,
j=h
PanJrh = (3311)
)4 n+h—1 R
quiPanJrhfi + Z 9n+hfl,j (XnJrhfj - Xn+h7j) s h>m—n.
i=1 Jj=h

If, asisamost alwaysthe case, n > m = max(p, q), thenforal h > 1,
)4 q R
X = D i PuXueni + D Onon 1y (Xowns — Xoins) - (3312)
i=1 j=h

Oncethepredictors X1, . .. X,, havebeen computed from (3.3.7), itisastraightforward
calculation, with n fixed, to determine the predictors P, X, 11, P, X412, PuXn43, - .-

Table 3.1 5(n+1 for the ARMA(2,3) Process of Example 3.3.4.

n Xn+1 I'n 9n1 0n2 0n3 Xn+1

0 1.704 71713 0

1 0.527 1.3856 0.8982 1.5305

2 1.041 1.0057 1.3685 0.7056 —0.1710

3 0.942 1.0019 0.4008 0.1806 0.0139 1.2428

4 0.555 1.0019 0.3998 0.2020 0.0732 0.7443

5 —1.002 1.0005 0.3992 0.1995 0.0994 0.3138

6 —0.585 1.0000 0.4000 0.1997 0.0998 —1.7293

7 0.010 1.0000 0.4000 0.2000 0.0998 —0.1688

8 —0.638 1.0000 0.4000 0.2000 0.0999 0.3193

9 0.525 1.0000 0.4000 0.2000 0.1000 —0.8731
10 1.0000 0.4000 0.2000 0.1000 1.0638

11 1.0000 0.4000 0.2000 0.1000
12 1.0000 0.4000 0.2000 0.1000
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Example 3.3.5

Table 3.2

recursively from (3.3.12) (or (3.3.11) if » < m). The calculations are performed
automatically inthe Forecasting>ARMA option of the program ITSM.

h-step prediction of an ARMA(2,3) process

To compute h-step predictors, » = 1,..., 10, for the data of Example 3.3.4 and
the model (3.3.10), open the project E334.TSM in ITSM and enter the model using
the option Model>Specify. Then select Forecasting>ARMA and specify 10 for the
number of forecasts required. You will notice that the white noise variance is au-
tomatically set by ITSM to an estimate based on the sample. To retain the model
value of 1, you must reset the white noise variance to this value. Then click 0k and
you will see a graph of the original series with the ten predicted values appended.
If you right-click on the graph and select Info, you will see the numerical results
shown in the following table as well as prediction bounds based on the assumption
that the seriesis Gaussian. (Prediction bounds are discussed in the last paragraph of
this chapter.) The mean squared errors are cal cul ated as described below. Notice how
the predictors convergefairly rapidly to the mean of the process(i.e., zero) asthelead
time & increases. Correspondingly, the one-step mean squared error increases from
the white noise variance (i.e., 1) at # = 1 to the variance of X, (i.e., 7.1713), which
isvirtualy reached at 4 = 10. O

The Mean Squared Error of P, X,
The mean squared error of P, X, iseasily computed by ITSM from the formula

. 2
h—1 J
Gylz(h) = E(Xn+h - P11Xn+h)2 = Z (Z Xr9n+h—r—l,j—r> Unth—j—1, (3313)

j=0 \r=0

h-step predictors for the ARMA(2,3)
Series of Example 3.3.4.

>

ProXio+h MSE

1.0638 1.0000
1.1217 1.7205
1.0062 2.1931
0.7370 2.4643
0.4955 2.5902
0.3186 2.6434
0.1997 2.6648
0.1232 2.6730
0.0753 2.6761
0.0457 2.6773

OO ONOOUTh WK =

—_
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Example 3.3.6

where the coefficients y,; are computed recursively from the equations xo = 1 and

min(p, j)

Xi= Y. B J=L12.... (3.3.14)

k=1

h-step prediction of an ARMA(2,3) process

We now illustrate the use of (3.3.12) and (3.3.13) for the k-step predictors and their
mean squared errors by manually reproducing the output of ITSM shown in Table
3.2. From (3.3.12) and Table 3.1 we obtain

2 3
PpX1p = ZQSiPlOXlZﬂ‘ + 2911./' <X127j — XlZ—j)
i—1 =2

= 1 X1 + $2X10+0.2 (Xlo — f(lo) +0.1 (Xg — 5(9>
=1.1217

and
2

3
PpX13 = Zd’i P1oX13; + 2912,/‘ <X137j — 5(137/'>
i—1 =

= $1PioX12 + $2X11 + 0.1 (Xlo - 5(10>
= 1.0062.
For k > 13, PipX; iseasily found recursively from
P1oXy = ¢p1P1oXi—1 + @2 ProXy—2.

To find the mean sguared errors we use (3.3.13) with xo = 1, y1 = ¢1 = 1, and
X2 = $1x1+ ¢2 = 0.76. Using the values of 6,; and v, (= r;) in Table 3.1, we obtain

02(2) = E(X12 — ProX12)? = 2.960
and
02(3) = E(X13 — PoX15)? = 4.810,
in accordance with the results shown in Table 3.2. 0O

Large-Sample Approximations
Assuming as usua that the ARMA(p, ¢) process defined by ¢ (B)X, = 9(B)Z;,
{Z,} ~ WN (0, 0?), is causal and invertible, we have the representations

Xuen = Y Vi Zun, (3.3.15)
i=0
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and
[o.¢]
Zush = Xusn + )7 Xnin—j, (3.3.16)
j=1

where{y;} and {z;} areuniquely determined by equations(3.1.7) and (3.1.8), respec-
tively. Let P,Y denotethe best (i.e., minimum mean squared error) approximation to
Y that is alinear combination or limit of linear combinations of X,, —oco < t < n,
or equivalently (by (3.3.15) and (3.3.16)) of Z;, —oo < t < n. The properties of the
operator P, were discussed in Section 2.5.3. Applying P, to each side of equations
(3.3.15) and (3.3.16) gives

ﬁanJrh = Z vszn+h7j (3317)
J=h
and
P Xyn ==Y 7P Xosn ). (3.3.18)
j=1

For h = 1 the jth term on the right of (3.3.18) is just X,.1—,;. Once 13,1X,,+1 has
been evaluated, P, X,,.., can then be computed from (3.3.18). The predictors P, X .,
P, X, 14, . .. canthen be computed successively in the sameway. Subtracting (3.3.17)
from (3.3.15) gives the h-step prediction error as

h—1
Xppn — PuXpyn = E YiZnsn—j
=0

from which we see that the mean sgquared error is

h-1
&2(h) = o) Y2 (3.3.19)
j=0
The predictors obtained in this way have the form
i)an-ﬁ-h - Z Can—_/" (3320)
j=0
In practice, of course, we have only observations X4, ..., X, available, so we must

truncate the series (3.3.20) after n terms. The resulting predictor is a useful approx-
imation to P, X, if n islarge and the coefficients c¢; converge to zero rapidly as j
increases. It can be shown that the mean squared error (3.3.19) of P, X,.., can aso
be obtained by letting n — oo in the expression (3.3.13) for the mean squared error
of P, X, 4, SOthat 62(h) isan easily calculated approximation to o2(h) for large n.
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Prediction Bounds for Gaussian Processes
If the ARMA process {X,} is driven by Gaussian white noise (i.e, if {Z,} ~
11D N(0O, 0%)), then for each i > 1 the prediction error X, — P, X,.1s is normally
distributed with mean 0 and variance o2(h) given by (3.3.19).

Consequently, if ®;_,/, denotesthe (1—«/2) quantile of the standard normal dis-

tribution function, it followsthat X, , liesbetween thebounds P, X, £ ®1_4/20, (h)
with probability (1 — ). These bounds are therefore called (1 — «) prediction bounds
for X4

Problems

3.1. Determine which of the following ARMA processes are causal and which of
them are invertible. (In each case {Z,} denotes white noise.)

a X, +0.2x,_1—048X, ., = Z,.

b. X, +19X, 1 +088X, ,=2,+02Z,_1+0.7Z,_,.
c. X,+06X,_1=2,+12Z,_,.

d X, +18X,,+081X, , = Z,.

e X, +16X,_.1,=2,—047,_1+0.04Z,_,.

3.2. For those processes in Problem 3.1 that are causal, compute and graph their
ACF and PACF using the program ITSM.

3.3. For those processes in Problem 3.1 that are causal, compute the first six co-
efficients o, Y1, ..., ¥s in the causal representation X, = > 72, v, Z,; of
{X:}.

3.4. Compute the ACF and PACF of the AR(2) process
X, =.8X,2+Z, {Z}~WN(0,0%.

3.5. Let{Y,} bethe ARMA plus noise time series defined by
Y, =X, + W,
where {W,} ~ WN (0, 02), {X,} isthe ARMA(p, ¢) process satisfying
¢(B)X, =0(B)Z,, {Z}~WN(0,0?),

and E(W,Z,) = 0foral s and .

a Show that {Y,} is stationary and find its autocovariance in terms of o2 and
the ACVF of {X,}.

b. Show that the process U, := ¢ (B)Y, is r-correlated, where r = max(p, q)
and hence, by Proposition 2.1.1, isan MA(r) process. Conclude that {Y;} is
an ARMA(p, r) process.
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3.6.

3.7.

3.8.

3.9.

Show that the two MA(1) processes
X, =2 +0Z,_1, {Z})~WN (0, 02)

Y, =7 + 932,_1, {Z,} ~WN (0, 5%?),
where 0 < |0] < 1, have the same autocovariance functions.
Suppose that {X,} isthe noninvertible MA (1) process

X, =Z +0Z_, {Z}~WN(0, 02,

where |0| > 1. Define anew process {W,} as
W= (-0)7X,_;
j=0

and show that {W,} ~ WN (0, 03 ). Express o2 in terms of 6 and o2 and show
that {X,} hastheinvertible representation (in terms of {W,})

1
X, =W, + th_l.

Let {X,} denote the unique stationary solution of the autoregressive equations
X, =¢X, 1+ Z, t=0=1,...,
where {Z,} ~ WN(0,0?) and |¢| > 1. Then X, is given by the expression
(2.2.11). Define the new sequence
W, =X, — EX,_l,
¢

show that {W,} ~ WN (0,02 ), and express o2, in terms of o2 and ¢. These
calculations show that { X,} isthe (unique stationary) solution of the causal AR
equations

1
X[=$X[71+W[, t:O,:l:l,....

a. Calculate the autocovariance function y (-) of the stationary time series
Yi=p+2Z,+0Z 146017, 15, {Z;}~WN (O, 0'2) .

b. Use the program ITSM to compute the sample mean and sample autoco-
variances y (h), 0 < h < 20, of {VV,X,}, where {X;,t =1, ..., 72} isthe
accidental deaths series DEATHS.TSM of Example 1.1.3.

c. By equating y (1), y(11), and y (12) from part (b) to ¥ (1), ¥ (11), and y (12),
respectively, from part (a), find amodel of theform defined in (@) to represent
{vvlzxz}-
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3.10. By matching the autocovariances and sample autocovariances at lags 0 and 1,
fit amodel of the form

X —p=¢Xi1— W +7Z, {Z)~WN(0,0?),

to the data STRIKES.TSM of Example 1.1.6. Use the fitted model to compute
the best predictor of the number of strikesin 1981. Estimate the mean squared
error of your predictor and construct 95% prediction bounds for the number of
strikesin 1981 assuming that {Z,} ~ iid N(0, 62).

3.11. Show that the value at lag 2 of the partial ACF of the MA(1) process
X, =Z,+60Z,_,, t=0,41, ...,
where {Z,} ~ WN(0, o?), is
a(2) = —0%/ (1467 +06%).
3.12. For the MA (1) process of Problem 3.11, the best linear predictor of X, ; based
onXq,...,X,Iis
Xus1 = GuaXo 4+ + buaXa,

where ¢, = (¢u1, ..., du) Saisfies R,¢p, = p, (equation (2.5.23)). By sub-
stituting the appropriate correlations into R, and p, and solving the resulting
equations (starting with the last and working up), show that for 1 < j < n,
Gun-j = (=) (L+ 6%+ --- + 06%)¢,, and hence that the PACF «a(n) :=
Gun = —(—=0)"/(1+ 02+ +6%).
3.13. Thecoefficients6,; and one-step mean squared errors v, = r,o2 for the general
causal ARMA(1,1) process in Example 3.3.3 can be found as follows:
a. Show that if y, := r,/(r, — 1), then the last of equations (3.3.9) can be
rewritten in the form
Yn = 972)%—1 +1, n>1
b. Deducethat y, = 6~ yo+)_i_, 6~V and hencedeterminer, and6,1, n =
1,2,....

c. Evauate the limitsasn — oo of r, and 6,1 in the two cases |0] < 1 and
o] > 1.



Spectral Analysis

4.1 Spectral Densities

4.2 The Periodogram

4.3 Time-Invariant Linear Filters

4.4 The Spectral Density of an ARMA Process

This chapter can be omitted without any loss of continuity. The reader with no back-
ground in Fourier or complex analysis should go straight to Chapter 5. The spectral
representation of a stationary time series {X,} essentially decomposes {X,} into a
sum of sinusoidal components with uncorrelated random coefficients. In conjunction
with this decomposition there is a corresponding decomposition into sinusoids of the
autocovariance function of {X,}. The spectral decomposition is thus an analogue for
stationary processes of the morefamiliar Fourier representation of deterministic func-
tions. Theanalysisof stationary processes by means of their spectral representationis
often referred to asthe “frequency domain analysis’ of time seriesor “ spectral analy-
sis” Itisequivaent to “time domain” analysis based on the autocovariance function,
but provides an aternative way of viewing the process, which for some applications
may be more illuminating. For example, in the design of a structure subject to a
randomly fluctuating load, it is important to be aware of the presence in the loading
force of alarge sinusoidal component with a particular frequency to ensure that this
isnot aresonant frequency of the structure. The spectral point of view isal so particu-
larly useful in the analysis of multivariate stationary processes and in the analysis of
linear filters. In Section 4.1 we introduce the spectral density of a stationary process
{X,}, which specifies the frequency decomposition of the autocovariance function,
and the closely related spectral representation (or frequency decomposition) of the
process { X, } itself. Section 4.2 deals with the periodogram, a sample-based function
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from which we obtain estimators of the spectral density. In Section 4.3 we discuss
time-invariant linear filters from a spectral point of view and in Section 4.4 we use
the results to derive the spectral density of an arbitrary ARMA process.

Spectral Densities

Supposethat {X,} isazero-mean stationary time series with autocovariance function
y () satisfying } > |y (h)| < co. Thespectral density of {X,} isthefunction 1 (-)
defined by

1 & .

f) = Eh;me*’“y(h), —00 < A < 00, (4.1.1)
where e* = cos(1) + i sin(x) andi = +/—1. The summability of |y (-)| implies that
the seriesin (4.1.1) converges absolutely (since |e’“|2 = coF(hr) + Sinf(hr) = 1).
Since cos and sin have period 27, so also does f, and it suffices to confine attention
tothevaluesof f, ontheinterval (—x, ].

Basic Propertiesof f:
(@ fiseven,i.e, f(A) = f(=1), 4.1.2)
(b) f(A) >0fordl x € (—m, ], (4.1.3)

and

b T

e* (V) dr = / cos(kr) f (L) dx. (4.1.4)

-7

(© v = /

-7

Proof Sincesin(-) isan odd function and cos(-) and y (-) are even functions, we have

[e¢]

1 .
FO)=5- Y (Costhi) —isin(in)y (h)

h=—o00

= % > cos(—hA)y(h) +0

h=—00

= f(=M).
For each positive integer N define

)

1 N :
fv() = > E (‘Z X, e "
r=1
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Definition 4.1.1

Proposition 4.1.1

an (Z X —irk Z X etsk)

Z (N — ke "y (h),

|h|<N

where 'y = [y( — ])]N . Clearly, the function fy is nonnegative for each N,
and since fy(A) — Zh*—oo “ihhy(h) = f(A) a8 N — oo, f must also be
nonnegative. This proves (4.1.3). Turning to (4.1.4),

/7‘[ [k)hf()\.)d)\.—/ Z i(k—h)X (I’l)d)\.

b4 h——oo
1 < T ki
=5 Yoy | e d
7T h=—00 -

=y (k),

since the only nonzero summand in the second line is the one for which 2 = k (see
Problem 4.1). ]

Equation (4.1.4) expresses the autocovariances of a stationary time series with
absolutely summable ACVF asthe Fourier coefficients of the nonnegative even func-
tion on (—x, ] defined by (4.1.1). However, evenif Y7 |y (h)| = oo, there may
exist a corresponding spectral density defined as follows.

A function f isthe spectral density of a stationary time series {X,} with ACVF
y () if
(i) f(A) = 0fordl A e (0, 7],

(i) y(h) = /” e £ (1) dx for al integers h.

Remark 1. Spectra densities are essentially unique. That is, if £ and g are two
spectral densities corresponding to the autocovariance function y (-, i.e., y(h) =
[T oM fydr = [T e™g(r)d for al integers h, then f and g have the same
Fourier coefficientsand hence areequal (see, for example, TSTM, Section2.8). O

The following proposition characterizes spectral densities.

A real-valued function f defined on ( — 7,7] isthe spectral density of a stationary
processif and only if

i) fR)=rf(=n,
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Proof

Corollary 4.1.1

Proof

Example 4.1.1

(i) f() =0, and

@iy [T f)dr < oo.

If y(-) is absolutely summable, then (i)(iii) follow from the basic properties of f,
(4.1.2)4.1.4). For the argument in the general case, see TSTM, Section 4.3.

Conversealy, suppose f satisfies (i)—(iii). Then it is easy to check, using (i), that
the function defined by

y(h) = / " () da

T

iseven. Moreover, ifa, e R,r =1, ..., n, then

Y aye-sa=| Y aaer o) dn

rs=1 T rs=1

bd n
— / § arelkr
-

r=1
>0,

2
F(R)dr

so that y (+) is aso nonnegative definite and therefore, by Theorem 2.1.1, is an auto-
covariance function. ]

An absolutely summable function y (- ) isthe autocovariance function of a stationary
time seriesif and only if it is even and

o0

f) = % Z e""y(h) >0, forallxe (—m, 7], (4.1.5)

h=—00

inwhich case f(-) isthe spectral density of (- ).

We have already established the necessity of (4.1.5). Now suppose (4.1.5) holds.
Applying Proposition 4.1.1 (the assumptions are easily checked) we concludethat f
isthe spectral density of some autocovariance function. But thisACVF must be y (+),
sincey (k) = [7_e™** f() dx for al integers k. [}

Using Corollary 4.1.1, it is a simple matter to show that the function defined by
1, ifh=0,
khy =1 p, ifh==%1,
0, otherwise,

isthe ACVF of a stationary time series if and only if |p| < % (see Example 2.1.1).

Since « (+) is even and nonzero only at lags 0, &1, it follows from the corollary that



4.1

Spectral Densities 115

Theorem 4.1.1

x isan ACVFif and only if the function

1 & 1
FOy =52 3 ey = 5 [1+ 20 c0sh]

h=—00

is nonnegative for all A € [—, 7r]. But this occursif and only if |p| < % O

Asillustratedinthe previousexample, Corollary 4.1.1 providesuswith apowerful
tool for checking whether or not an absolutely summable function on the integers
is an autocovariance function. It is much simpler and much more informative than
direct verification of nonnegative definiteness as required in Theorem 2.1.1.

Not all autocovariance functions have a spectral density. For example, the sta-
tionary time series

X, = Acos(wt) + B Sin(wt), (4.1.6)
where A and B are uncorrelated random variables with mean 0 and variance 1, has
ACVF y (h) = cos(wh) (Problem 2.2), which is not expressible as [ ¢ f(1)d,

with f afunction on (—m, 7]. Nevertheless, y () can be written as the Fourier trans-
form of the discrete distribution function

0 if A < —w,
FO) =105 if —w<i <o,
10 ifx>w,

cos(wh) = / eMdF (L),
(=m,m]

wheretheintegral is as defined in Section A.1. Asthe following theorem states (see
TSTM, p. 117), every ACVF isthe Fourier transform of a (generalized) distribution
functionon[—m, 7]. Thisrepresentation is called the spectral representation of the
ACVF.

(Spectral Representation of the ACVF) A function y (- ) defined on the integersis
the ACVF of a stationary time series if and only if there exists a right-continuous,
nondecreasing, bounded function F on [ — w,7] with F( — 7) = 0 such that

y(h) = / " dF (%) (4.1.7)
(—m,7]

for all integers h. (For real-valued time series, F is symmetric in the sense that
f(a,b] dF(x) = f[_b’_a) dF(x) forallaand b suchthat 0 < a < b.)

Remark 2. Thefunction F isageneralized distribution function on [—zx, ] in
the sensethat G(1) = F())/F (rr) isaprobability distribution function on [—, 7].
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Example 4.1.2

Notethat since F () = y(0) =Var(X,), the ACF of {X,} has spectral representation
po(h) = / e"dG(M).
(=]

Thefunction F in (4.1.7) iscalled the spectral distribution function of y (). If F())
can be expressed as F (1) = f_*ﬂ f(dy fordl x € [, 7], then f isthe spectral
density function and the time seriesis said to have a continuous spectrum. If F is
adiscrete distribution (i.e., if G isadiscrete probability distribution), then the time
series is said to have a discrete spectrum. The time series (4.1.6) has a discrete
spectrum. O

Linear combination of sinusoids

Consider now the process obtained by adding uncorrelated processes of the type
defined in (4.1.6), i.e.,

k

X, =) (A;cos(w;t) + BjSin(w;1)), O<wi<- <o <m (418)

j=1
where Ay, By, ..., Ay, By are uncorrelated random variables with E(A;) = 0 and
Var(A;) = Var(B;) = o7, j = 1,..., k. By Problem 4.5, the ACVF of this time
seriesisy (h) = Z’;zl o]? cos(w;h) and its spectral distribution function is F (1) =

> 02F;(3), where

A sample path of thistime serieswithk = 2, w; = 7/4, w, = 7/6, 02 = 9, and
o2 = lisplottedinFigure4.1. Not surprisingly, the sample path closely approximates
asinusoid with frequency w; = 7 /4 (and period 27 /w, = 8). The general features of
this sample path could have been deduced from the spectral distribution function (see
Figure 4.2), which places 90% of itstotal mass at the frequencies £ /4. This means
that 90% of the variance of X; is contributed by the term A; cos(w1t) + B COS(w;f),
which isasinusoid with period 8. O

Theremarkable feature of Example 4.1.2 isthat every zero-mean stationary pro-
cess can be expressed as a superposition of uncorrelated sinusoids with frequencies
w € [0, ]. In general, however, a stationary process is a superposition of infinitely
many sinusoids rather than afinite number asin (4.1.8). The required generalization
of (4.1.8) that allows for thisis called a stochastic integral, written as

X, = / emdz(n), (4.1.9
(=7,7]
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Figure 4-1

A sample path of size
100 from the time series
in Example 4.1.2.

Figure 4-2

The spectral distribution
function FA), —m < A <,
of the time series

in Example 4.1.2.

0 20 40 60 80 100

where {Z()), —7 < A < m} is acomplex-valued process with orthogonal (or un-
correlated) increments. The representation (4.1.9) of azero-mean stationary process
{X,} is called the spectral representation of the process and should be compared
with the corresponding spectral representation (4.1.7) of the autocovariance function
v (+). The underlying technical aspects of stochastic integration are beyond the scope
of this book; however, in the simple case of the process (4.1.8) it is not difficult to

10

1 1
-3 -2 -1 0

Frequency

[y
N
w
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Example 4.1.3

Example 4.1.4

seethat it can be reexpressed in the form (4.1.9) by choosing

A;+iB; .
]‘;l L, ifa=—w;andje(l,... k},
dZ(A\) =13 A, —iB; .
() - 7 21 j, |f)\:(,l)jandj€{1’--'ak}s
0, otherwise.

For this example it isalso clear that

crjz _
EdZ(M\dZ (V) = H o if A = to;,

0, otherwise.

In general, the connection between d Z (i) and the spectral distribution function of
the process can be expressed symbolically as

F() — F(A—), foradiscrete spectrum,
E(dZ(MWdZ(V)) = _ (4.1.10)
fF)dx, for a continuous spectrum.

These relations show that a large jump in the spectral distribution function (or a
large peak in the spectral density) at frequency +w indicates the presencein thetime
series of strong sinusoidal components at (or near) w. The period of a sinusoid with
frequency o radians per unit timeis 2/ w.

White noise

If {X,} ~WN (0, 0?), theny(0) = 62 and y(h) = Oforall |a| > 0. This process
has aflat spectral density (see Problem 4.2)

0'2
fQO)=—, —-rm<i<m
2

A processwith this spectral density is called white noise, since each frequency inthe
spectrum contributes equally to the variance of the process. O

The spectral density of an AR(1) process
If

X, = <l')Xzfl + Z;,
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Example 4.1.5

Figure 4-3

The spectral density
fA),0 <A <mof

Xy = .7X,_1 + Z;, where
(Z) ~ WN(O, 02).

where {Z,} ~ WN(O, 02), then from (4.1.1), {X,} has spectral density
7lh)\. lhA
fo) = (1 7 <1+ qu ))

2 i\ —iA
? (1+ et | _%e )

" 27 (1-¢?) 1= ger ' 1—ge
0’2 -1
=—(1-2 A 2
o= ( ¢ cosA + ¢°)
Graphsof f(1),0 <A <, aredisplayed in Figures 4.3 and 4.4 for ¢ = .7 and
¢ = —.7. Observe that for ¢ = .7 the density islarge for low frequencies and small

for high frequencies. This is not unexpected, since when ¢ = .7 the process has a
positive ACF with alarge value at l1ag one (see Figure 4.5), making the series smooth
with relatively few high-frequency components. On the other hand, for ¢ = —.7 the
ACF has a large negative value at lag one (see Figure 4.6), producing a series that
fluctuates rapidly about its mean value. In this case the series has alarge contribution
from high-frequency components as reflected by the size of the spectral density near
frequency . O

Spectral density of an MA(1) process

If
X;=72;,+027Z,_4,

ol

—

ol

—

n

2k

g_ I I I I I I !

0.0 0.5 1.0 1.5 2.0 25 3.0
Frequency
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Figure 4-4
The spectral density ‘ | |
f(),0 < & < 7, of S : I L . .
Xi = —.7X_1 + Z;, where 0 5 10 15 20
(Z) ~ WN(O, 02>. Lag

where {Z,} ~ WN(0, 52), then from (4.1.1),

o2 A ' o2
- — (1 2 —iA i\ = — (1 2 2 .
FO)=5— (140746 (7" + ")) = o— (1420 cosi. +67)
ThisfunctionisshowninFigures4.7 and 4.8 for thevaluesé = .9and6 = —.9. Inter-

pretations of the graphsanalogoustothosein Example4.1.4canagainbemade. O

<
—

ACF

0.4

0.2
T

0.0

Figure 4-5
The ACF of the AR(1) 0 5 10 15 20
process X; = .7 X,—1 + Z;. Lag
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ol
—
|
o
[T
o
) ‘ |
o | I
b= ‘ ‘ | T
0
Sk
Figure 4-6 , . ! | !
The ACF of the AR(1) 0 5 10 15 20
process X; = —.7X,_1 + Z;. Lag

4.2 The Periodogram

If {X,} isastationary timeseries {X,} with ACVF y (-) and spectral density f(-), then
just as the sample ACVF 7 (-) of the observations {x, ..., x,} can be regarded as a
sample analogue of y (-), so also can the periodogram I, (-) of the observations be
regarded as a sample analogue of 27 1 (-).

ol
o
<
o
ol
w— O
ol
o
-
. o
Figure 4-7
The spectral density
f0), 0 < & < 7, of g | | | | | | |

X, = Z; + .97,_1 where 0.0 0.5 1.0 15 2.0 2.5 3.0
{Z;} ~ WN (O, 02>. Frequency
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Figure 4-8
The spectral density
f()\)/of)‘-fn/()f g | | L | | | |
Xt = Zy — .9Z,_4 where 0.0 0.5 1.0 15 2.0 2.5 3.0
{Z:} ~ WN (O, 02>. Frequency

To introduce the periodogram, we consider the vector of complex numbers

X = e C",

where C" denotes the set of all column vectors with complex-valued components.
Now let w; = 2k/n, wherek isany integer between —(n —1)/2and n/2 (inclusive),
i.e,

o = ZK k=—[”;1},...,[g], (4.2.1)

n

where[y] denotesthelargest integer lessthan or equal to y. We shall refer tothe set F,
of these values asthe Fourier freguencies associated with sample size n, noting that
F, isasubset of theinterval (—m, 7]. Correspondingly, we introduce the n vectors

iwy
ek

ekz% ezzwk , k:—[”_l},...,[f]. (4.2.2)

niw,
e k
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Definition 4.2.1

Now ey, ..., e, areorthonormal in the sense that
1, ifj=k,
e’e = _ (4.2.3)
0, ifj+#k,

where e;* denotes the row vector whose kth component is the complex conjugate of
the kth component of e; (see Problem 4.3). Thisimpliesthat {e,, ..., e,} isabasis
for C", so that any x € C" can be expressed as the sum of n components,

[n/2]
X = Z akek. (424)
k=—[(n—1)/2]

The coefficients a, are easily found by multiplying (4.2.4) ontheleft by e,* and using
(4.2.3). Thus,

1 < .
ay =€ X=—>Y xe ", (4.2.5)
Vn ; t

The sequence {g;} is called the discrete Fourier transform of the sequence

{x].? cc xl’l}'

Remark 1. The rth component of (4.2.4) can be written as

[n/2]
X, = Z ai[cos(wit) +isin(axt)], t=1,...,n, (4.2.6)
k=—[(n-1)/2]

showing that (4.2.4) isjust away of representing x; as alinear combination of sine
waves with frequencies w; € F,. O

The periodogram of {x, ..., x,} isthefunction

n
E xte—ltk
=1

2
(L) = r_]l‘ (4.2.7)

Remark 2. If A isone of the Fourier frequencies wy, then I, (w) = |ax|?, and so
from (4.2.4) and (4.2.3) we find at once that the squared length of x is

n [n/2] [n/2]
YollP=xx= Y al= ) L.
=1 k=—[(n—1)/2] k=—[(n-1)/2]

The value of the periodogram at frequency w;, is thus the contribution to this sum of
squares from the “frequency w,” term a; €, in (4.2.4). O
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Proposition 4.2.1

Proof

The next proposition shows that 7,(1) can be regarded as a sample analogue of
27 f (). Recall that if 3°°° |y (k)| < oo, then

(o]

2nf(h) = Y y(e ™, ie(-m m]. (4.2.8)

h=—o00

If x1,...,x, are any real numbers and w, is any of the nonzero Fourier frequencies
27k /nin ( — ], then

L(w) =Y p(hye ™, (4.2.9)
|h|<n

where 7 (k) isthe sample ACVF of x4, ... ,x,.

Since ) e = 0if o, # 0, we can subtract the sample mean x from x, in the
defining equation (4.2.7) of I,(w;). Hence,

In(wk) = n—l Z Z(XS _ )_C)(X[ _ )-C)e—i(s—t)a),<

s=1 r=1

= > Phye " n

|h|<n

In view of the similarity between (4.2.8) and (4.2.9), a natural estimate of the
spectral density f (1) is I,(A)/(27). For avery large class of stationary time series
{X,} with strictly positive spectral density, it can be shown that for any fixed frequen-
cieshy, ..., A, suchthat 0 < A; < -+ < A, < m, thejoint distribution function
F,(x1, ..., x,) of theperiodogramvaues (1,, (A1), ..., I,(1,)) converges, asn — oo,
to F(x4, ..., x,), where

1-— ! , ifxe, ..., x, >0,
F(x ... 2m) = l_!( @(p{zjrf(m}) Tt =5 42 10)

0, otherwise.

Thus for large n the periodogram ordinates (1,(A1), ..., I,(A,,)) are approximately
distributed as independent exponential random variables with means 2z f (11), ...,
21 f (A, respectively. In particular, for each fixed A € (0, 7) and e > O,

PlIL,(A) —2nf(A)| > €] > p >0, asn — oo,

so the probability of an estimation error larger than ¢ cannot be made arbitrarily
small by choosing a sufficiently large sample size n. Thus, 1, (1) is not a consistent
estimator of 27 f (A).

Sincefor largen the periodogram ordinatesat fixed frequenciesareapproximately
independent with variances changing only slightly over small frequency intervals, we
might hope to construct aconsistent estimator of f (1) by averaging the periodogram
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Definition 4.2.2

estimates in a small frequency interval containing A, provided that we can choose
the interval in such a way that its width decreases to zero while at the same time
the number of Fourier frequencies in the interval increasesto co asn — oo. This
can indeed be done, since the number of Fourier frequencies in any fixed frequency
interval increases approximately linearly with n. Consider, for example, the estimator

1

fO) =

> @m+ DML, 1) + 27j/n), (4.2.11)

[jl<m

where m = /n and g(n, 1) is the multiple of 27 /n closest to A. The number of
periodogram ordinates being averaged is approximately 2,/#, and the width of the
frequency interval over which the averageistaken isapproximately 4r /. /n. It can be
shown (see TSTM, Section 10.4) that this estimator is consistent for the spectral den-
sity f. Theargument in fact establishesthe consistency of awhole class of estimators
defined as follows.

A discrete spectral average estimator of the spectral density f (1) hasthe form
1

fO) = o

Y WalDLu(g(n, W) + 2j/n), (4.2.12)

ljl<mn
where the bandwidths m,, satisfy
m, — oo andm,/n - 0asn — oo, (4.2.13)

and the weight functions W, (-) satisfy

W (j) = W, (=), W,(j) = Oforal j, (4.2.14)
Yo W =1, (4.2.15)
[j1<m,
and
> W2(j) - 0asn — oo. (4.2.16)
[jl<my

Remark 3. The conditions imposed on the sequences {m,} and {W,(-)} ensure
consistency of (i) for f (1) for avery large classof stationary processes (see TSTM,
Theorem 10.4.1) including all the ARMA processes considered in this book. The
conditions (4.2.13) simply mean that the number of terms in the weighted average
(4.2.12) goesto co asn — oo while at the same time the width of the frequency
interval over which the average is taken goes to zero. The conditions on {W,(-)}
ensure that the mean and variance of (i) converge asn — oo to (i) and 0,
respectively. Under the conditions of TSTM, Theorem 10.4.1, it can be shown, in
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Example 4.2.1

Figure 4-9

The spectral density
estimate, l10o(1)/(27),

0 < A < m, of the sunspot
numbers, 1770-1869.

fact, that
lim Ef (1) = f()
and
. 2f%(») ifa=v=0o0rmn,
lim ( > Wf(j)) Cov(f(), fo) =1 f2) if0<i=v<m,
0 if A £ v.

ljl<m,

O

For the simple moving average estimator with m, = /n and W,(j) = (2m, +
1L, |j| < m,, Remark 3 gives

2f%() ifa=0orm,

2J/n + 1) Var ( f(n
(ﬁ ) <f( ))_){fz(k) ifO<A<m.

O

In practice, when the sample size n is afixed finite number, the choice of m and
{W(-)} involves a compromise between achieving small bias and small variance for
the estimator f (1). A weight function that assigns roughly equal weights to a broad
band of frequencieswill producean estimateof f (i) that, although smooth, may have
alarge bias, since the estimate of f (1) depends on the values of I, at frequencies
distant from A. On the other hand, aweight function that assigns most of itsweight to
anarrow frequency band centered at zero will give an estimator with relatively small
bias, but with alarger variance. In practice it is advisable to experiment with arange

1500 2000

1000
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of weight functions and to select the one that appears to strike a satisfactory balance
between bias and variance.

The option Spectrum>Smoothed Periodogram in the program ITSM alows
the user to apply up to 50 successive discrete spectral average filters with weights
W()=1/2m+121), j=—-m,—m+1,..., m,totheperiodogram. The value of m
for each filter can be specified arbitrarily, and the weights of the filter corresponding
to the combined effect (the convolution of the component filters) is displayed by
the program. The program computes the corresponding discrete spectral average
estimators f(1),0 < A < .

Example 4.2.2  The sunspot numbers, 1770-1869

Figure 4.9 displays a plot of (27)~! times the periodogram of the annual sunspot
numbers (obtained by opening the project SUNSPOTS.TSM in ITSM and select-
ing Spectrum>Periodogram). Figure 4.10 shows the result of applying the discrete
spectral weights {3, 3. 3} (correspondingtom = 1, W(j) = 1/(2m+1), | j| < m). It
is obtained from ITSM by selecting Spectrum>Smoothed Periodogram, entering
1 for the number of Daniell filters, 1 for the order m, and clicking on Apply. As
expected, with such a small value of m, not much smoothing of the periodogram
occurs. If we change the number of Daniell filters to 2 and set the order of the first
filter to 1 and the order of the second filter to 2, we obtain a combined filter with a
more dispersed set of weights, W(0) = W(1) = =, W(2) = &, W(3) = 1. Click-
ing on Apply will then give the smoother spectral estimate shown in Figure 4.11.
When you are satisfied with the smoothed estimate click 0K, and the dialog box will
close. All three spectral density estimates show awell-defined peak at the frequency
w1o = 27 /10 radians per year, in keeping with the suggestion from the graph of the
data itself that the sunspot series contains an approximate cycle with period around
10 or 11 years. O

4.3 Time-Invariant Linear Filters

In Section 1.5 we saw the utility of time-invariant linear filtersfor smoothing the data,
estimating the trend, eliminating the seasonal and/or trend components of the data,
etc. A linear process is the output of atime-invariant linear filter (TLF) applied to a
white noise input series. More generally, we say that the process {Y,} isthe output of
alinear filter C = {c,4,t,k =0+ 1, ...} applied to an input process {X,} if

Yo=Y cuXe, t=0+41.... (4.3.1)

k=—00

Thefilter issaid to betime-invariant if theweightsc, ,_, areindependent of ¢, i.e., if

Cri—k = wk‘
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Figure 4-10

The spectral density
estimate, f(A), 0 < A < 7,
of the sunspot numbers,
1770-1869, with

weights [%, 33t

Figure 4-11

The spectral density
estimate, f(A), 0 < A < 7,
of the sunspot numbers,
1770-1869, with weights
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Example 4.3.1

Example 4.3.2

Proposition 4.3.1

Proof

s0 that the time-shifted process {Y,_,,t = 0, +1,...} is obtained from {X,_,,r =
0, £1,...} by application of the same linear filter ¥ = {v,;, j = 0,£1,...}. The
TLF ¥ issaid to be causal if

'WjZOforj<O,

sincethen Y, isexpressibleintermsonly of X, s <1t.

Thefilter defined by
Y, =aX_,, t=041,...,

is linear but not time-invariant, since ¢, ,_, = O except when 2t = k. Thus, ¢,
depends on the value of 7. O

The simple moving average

Thefilter
Y,=2¢+D*) X,
ljl<q
isaTLFwithy;, = 29+ 17, j =—¢,...,q,and ¢, = 0 otherwise. O

Spectral methods are particularly valuable in describing the behavior of time-
invariant linear filters as well as in designing filters for particular purposes such as
the suppression of high-frequency components. The following proposition shows
how the spectral density of the output of a TLF is related to the spectral density of
the input—a fundamental result in the study of time-invariant linear filters.

Let {X,} be a stationary time series with mean zero and spectral density fx(A).
Suppose that ¥ = {y;,j = 0, £ 1,...} is an absolutely summable TLF (i.e,
Y o 1¥j] < 00). Then the time series

j=—00
Yo=Y X
j=—00
is stationary with mean zero and spectral density
Fro0 = W (e[ £x () = w(e )W (e™) fr (1),
where W(e™) = 3% ;e " (Thefunction W(e~") iscalled thetransfer func-

tion of the filter, and the squared modulus |lIJ(e*"‘)|2 is referred to as the power
transfer function of the filter.)

Applying Proposition 2.2.1, we see that {Y,} is stationary with mean 0 and ACVF

y) = Y Yiteyx(h+k—j). (432)

Jok=—00



130 Chapter 4 Spectral Analysis

Since {X,} has spectral density fx (1), we have

yx(h+k—j) = / e MIH fe(A) d, (4.33)

-7

which, by substituting (4.3.3) into (4.3.2), gives

iy = > v / e IR £ (3)

Jk=—00 T

/n < i wje_ijx) ( i wkeikk) eih)»fx()\‘) di

j=—00 k=—00

b4
— / eihA
-

The last expression immediately identifies the spectral density function of {Y,} as

Fro = @ (e ) fx ) = w(e ™) W (™) fx (). ]

2

oo
> it

j=—00

Sx(A)dh.

Remark 1. Proposition 4.3.1 allows usto analyze the net effect of applying one or
morefiltersin succession. For example, if theinput process { X, } with spectral density
fx is operated on sequentialy by two absolutely summable TLFs ¥; and W5, then
the net effect is the same as that of a TLF with transfer function Wy (e=*) W (e~*)
and the spectral density of the output process

W, = W1(B)W2(B) X,
is|Wi(e ™) Wa(e i) |2fx (1). (See also Remark 2 of Section 2.2.) O

As we saw in Section 1.5, differencing at lag s is one method for removing a
seasonal component with period s from atime series. The transfer function for this
filteris1 — e~s*, whichis zero for all frequencies that are integer multiples of 27 /s
radians per unit time. Consequently, thisfilter has the desired effect of removing all
components with period s.

The simple moving-average filter in Example 4.3.2 has transfer function

V(e ™) =D,(),
where D, (1) isthe Dirichlet kernel
sin[(g + .5)1]
D,V =g +D") e =1 (2q+DsinG/2)’
lil=q 1, if A =0.

A graphof D, isgiveninFigure4.12. Noticethat | D, ()| isnear 1 in aneighborhood
of 0 and tapers off to O for large frequencies. Thisis an example of alow-passfilter.

if 1 0,
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Theideal low-pass filter would have atransfer function of the form

. 1, if Al <o,
llj(e—t)») — -
0, if Al > w.,
where w, isapredetermined cutoff value. To determinethe corresponding linear filter,
we expand W (e~*) as a Fourier series,

\y(e—i'\) = Z Ve (4.3.4)
Jj=—00
with coefficients
w,
=, if j =0,
v S / " et i !
j = — e = . .
27 J-o, SNG@) ity = 0.
JT

We can approxi matetheideal |ow-passfilter by truncating the seriesin (4.3.4) at some
large value ¢, which may depend on the length of the observed input series. In Figure
4.13 thetransfer function of theideal low-passfilter with w. = 7 /4 isplotted withthe
approximations W@ (e~*) = 3™1___;e”*forq = 2andgq = 10. Ascanbeseenin
the figure, the approximations do not mirror ¥ very well near the cutoff value w,. and
behavelikedamped sinusoidsfor frequenciesgreater than w,.. Thepoor approximation
intheneighborhood of w. istypical of Fourier seriesapproximationsto functionswith

discontinuities, an effect known asthe Gibbsphenomenon. Convergencefactorsmay
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Figure 4-13

The transfer function
for the ideal low-pass
filter and truncated
Fourier approximations
v@ for g = 2,10.
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be employed to help mitigate the overshoot problem at w,. and to improve the overall
approximation of W@ (e~"") to W(e"") (see Bloomfield, 2000).

4.4 The Spectral Density of an ARMA Process

Proof

In Section 4.1 the spectral density was computed for an MA(L1) and for an AR(1)
process. Asan application of Proposition 4.3.1, we can now easily derive the spectral
density of an arbitrary ARMA(p, ¢) process.

Spectral Density of an ARMA(p, q) Process:
If {X,}isacausa ARMA(p, q) process satisfying ¢ (B)X, = 6(B)Z,, then

W) =—"——=, —m=<Ai=m. (4.41)

Because the spectral density of an ARMA process is a ratio of trigonometric poly-
nomials, it is often called arational spectral density.

From (3.1.3), {X,} is obtained from {Z,} by application of the TLF with transfer
function
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Example 4.4.1

Figure 4-14

The spectral density
fx(A),0 < A < 7 of the
AR(2) model (3.2.20) fitted
to the mean-corrected
sunspot series.

Since{Z,} has spectral density £, (1) = o?/(2), theresult now follows from Propo-
sition 4.3.1. |

For any specified values of the parameters ¢4, ..., ¢,,64,...,6, and o2, the
Spectrum>Model option of ITSM can be used to plot the model spectral density.

The spectral density of an AR(2) process

For an AR(2) process (4.4.1) becomes

02

(1= o — o 27) (1 — rei* — poe??)

02

"~ 20 (1+ @2+ 2¢ + ¢ + 212 — $1) COSA — A COP 1)

Figure 4.14 shows the spectra density, found from the Spectrum>Model option of
ITSM, for the model (3.2.20) fitted to the mean-corrected sunspot series. Notice the
well-defined peak in the model spectral density. The frequency at which this peak
occurs can be found by differentiating the denominator of the spectral density with
respect to cos and setting the derivative equal to zero. This gives

cosi = 219271 _ a9

4>
The corresponding frequency is » = 0.556 radians per year, or equivalently
¢ = A/(2r) = 0.0885 cycles per year, and the corresponding period is therefore
1/0.0885 = 11.3 years. The model thus reflects the approximate cyclic behavior of

fx()») = -

800
T
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200
T

1 1 1 1 1 1 1
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Example 4.4.2

Problems

the data already pointed out in Example 4.2.2. The model spectral density in Figure
4.14 should be compared with the rescaled periodogram of the dataand the nonpara-
metric spectral density estimates of Figures 4.9-4.11. O

The ARMA(1,1) process

In this case the expression (4.4.1) becomes
o2(L+0eM) (A + 0e™)

27 (1 — pe*) (1 — pe='*)
o?(1+ 62 + 26 cosr)

2 (l+ ¢2 — 2¢ COSA)

fx) =

O

Rational Spectral Density Estimation

An dlternative to the spectral density estimator of Definition 4.2.2 is the estimator
obtained by fitting an ARMA model to the data and then computing the spectral
density of thefitted model. The spectral density shown in Figure 4.14 can beregarded
assuch an estimate, obtained by fitting an AR(2) model to the mean-corrected sunspot
data.

Provided that thereisan ARMA model that fitsthe data satisfactorily, this proce-
durehastheadvantagethat it can be made systematic by sel ecting themodel according
(for example) to the AICC criterion (see Section 5.5.2). For further information see
TSTM, Section 10.6.

4.1. Show that

/ﬂ ol k= gy — 2m, ifk=h,
- 0, otherwise.

4.2. 1f {Z,} ~ WN(O, o?), apply Corollary 4.1.1 to compute the spectral density of
{Z,}.
4.3. Show that the vectorsey, ..., e, are orthonormal in the sense of (4.2.3).

4.4. Use Corollary 4.1.1 to establish whether or not the following function is the
autocovariance function of a stationary process { X;}:

1 if h =0,

-05 ifh=42
y(h) = _

—0.25 if h =43,

0 otherwise,



Problems 135

4.5.

4.6.

4.7.

4.8.

If {X,} and {Y,} are uncorrelated stationary processes with autocovariance func-
tionsyyx () and yy (-) and spectral distribution functions Fx () and Fy (-), respec-
tively, show that the process {Z, = X, + Y,} is stationary with autocovariance
function y; = yx + yy and spectral distribution function F; = Fy + Fy.

Let {X,} be the process defined by
X, = Acos(wt/3) + Bsin(wt/3) + Y;,

where Y, = Z, + 2.5Z,_1, {Z;} ~ WN(0, %), A and B are uncorrelated with
mean 0 and variance v2, and Z, is uncorrelated with A and B for each ¢. Find
the autocovariance function and spectral distribution function of {X,}.

Let {X,} denote the sunspot seriesfiled as SUNSPOTS.TSM and let {Y;} denote
the mean-corrected series ¥, = X, —46.93,r =1, ..., 100. Use ITSM to find
the Yule-Walker AR(2) model

Y, =¢1Yi1+ ¢aY, o+ Zio {Z} ~WN(0,07),

i.e, find ¢1, ¢», and o2. Use ITSM to plot the spectral density of the fitted
model and find the frequency at which it achieves its maximum value. What is
the corresponding period?

a. Use ITSM to compute and plot the spectral density of the stationary series
{X,} satisfying

X, —0.99X, 3 = Z,, {Z}~WN(0,1).

b. Does the spectral density suggest that the sample paths of {X,} will exhibit
approximately oscillatory behavior? If so, then with what period?

c. UseITSM to simulate arealization of X4, ..., Xg and plot the redization.
Doesthe graph of the realization support the conclusion of part (b)? Savethe
generated series as X. TSM by clicking on the window displaying the graph,
then on the red EXP button near the top of the screen. Select Time Series
and File inthe resulting dialog box and click 0K. You will then be asked to
provide the file name, X.TSM.

d. Compute the spectral density of the filtered process

1
Yz = é(Xz—l + Xz + Xt+1)

and compare the numerical values of the spectral densities of {X,} and {Y;}
at frequency w = 27 /3 radians per unit time. What effect would you expect
the filter to have on the oscillations of {X,}?

e. Open the project X.TSM and use the option Smooth>Moving Ave. toapply
thefilter of part (d) to the realization generated in part (c). Comment on the
result.
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4.9.

4.10.

The spectral density of areal-valued time series {X,} isdefined on [0, 7] by

100, ifn/6—.01 <A < m/6+ .01,
f) = ]
0, otherwise,

andon[—m, 0] by f(A) = f(—A).
a. Evaluatethe ACVF of {X,} atlagsOand 1.
b. Find the spectral density of the process {Y;} defined by

Y, = VX, =X, — X;_1.

c. What isthe variance of Y,?

d. Sketch the power transfer function of the filter Vi, and use the sketch to
explain the effect of the filter on sinusoids with frequencies (i) near zero and
(ii) near /6.

Suppose that {X,} is the noncausal and noninvertible ARMA(1,1) process sat-
isfying

Xo—¢Xe1=2,+02Z,1, {Z}~WN (0702)1
where|¢| > 1and || > 1. Define¢(B) = 1— B and6(B) = 1+ 2B and et
{W,} be the process given by

W, :=60X(B)¢(B)X,.

a. Show that {W,} has a constant spectral density function.

b. Conclude that {W,} ~ WN(0, 02). Give an explicit formulafor o2 in terms
of ¢, 6, and o°.

c. Deduce that ¢(B)X, = 6(B)W,, so that {X,} is a causal and invertible
ARMA(1,1) process relative to the white noise sequence {W,}.



Modeling and Forecasting
with ARMA Processes

5.1 Preliminary Estimation

5.2 Maximum Likelihood Estimation
5.3 Diagnostic Checking

5.4 Forecasting

5.5 Order Selection

The determination of an appropriate ARMA(p, ¢) model to represent an observed
stationary time series involves a number of interrelated problems. These include
the choice of p and ¢ (order selection) and estimation of the mean, the coefficients
{¢ivi = 1,...,p}, {6;,i = 1,...,q}, and the white noise variance o2. Final se-
lection of the model depends on a variety of goodness of fit tests, although it can
be systematized to a large degree by use of criteria such as minimization of the
AICC gtatistic as discussed in Section 5.5. (A useful option in the program ITSM
iSModel>Estimation>Autofit, which automatically minimizesthe AICC statistic
over all ARMA(p, g) processes with p and ¢ in a specified range.)

This chapter is primarily devoted to the problem of estimating the parameters
¢ = (@i,...., )0, 0 = (6;,...,0,)h', and o> when p and ¢ are assumed to be
known, but the crucial issue of order selection is also considered. It will be assumed
throughout (unless the mean is believed a priori to be zero) that the data have been
“mean-corrected” by subtraction of the sample mean, so that it is appropriate to fit
a zero-mean ARMA model to the adjusted data x4, . . ., x,. If the modéd fitted to the
mean-corrected datais

$(BX, = 0(BYZ,. {Z)~WN (0,0?),
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then the corresponding model for the origina stationary series {Y,} is found on re-
placing X, foreacht by Y, — y, wherey = n~! Z’;Zl y; is the sample mean of the
original data, treated as a fixed constant.

When p and g are known, good estimators of ¢» and 6 can be found by imagining
the data to be observations of a stationary Gaussian time series and maximizing
the likelihood with respect to the p + ¢ + 1 parameters ¢4, ..., ¢,, 61, ...,6, and
o?. The estimators obtained by this procedure are known as maximum likelihood
(or maximum Gaussian likelihood) estimators. Maximum likelihood estimation is
discussed in Section 5.2 and can be carried out in practice using the ITSM option
Model>Estimation>Max likelihood, after first specifying apreliminary model to
initialize the maximization algorithm. Maximization of the likelihood and selection
of the minimum AICC model over a specified range of p and ¢ values can aso be
carried out using the option Model>Estimation>Autofit.

The maximization is nonlinear in the sense that the function to be maximized
is not a quadratic function of the unknown parameters, so the estimators cannot be
found by solving a system of linear equations. They are found instead by searching
numerically for the maximum of thelikelihood surface. The algorithm used in ITSM
requires the specification of initial parameter values with which to begin the search.
The closer the preliminary estimates are to the maximum likelihood estimates, the
faster the search will generally be.

To provide these initial values, a number of preliminary estimation algorithms
are available in the option Model>Estimation>Preliminary of ITSM. They are
described in Section 5.1. For pure autoregressive model s the choiceis between Yule—
Walker and Burg estimation, whilefor modelswithg > 0Oitisbetweentheinnovations
and Hannan—Rissanen algorithms. It is also possible to begin the search with an
arbitrary causal ARMA model by using the option Model>Specify and entering the
desired parameter values. The initial values are chosen automatically in the option
Model>Estimation>Autofit.

Calculation of the exact Gaussian likelihood for an ARMA model (and infact for
any second-order model) is greatly simplified by use of the innovations agorithm. In
Section 5.2 wetake advantage of thissimplificationin discussing maximumlikelihood
estimation and consider a so the construction of confidenceintervalsfor the estimated
coefficients.

Section 5.3 deals with goodness of fit tests for the chosen model and Section
5.4 with the use of the fitted model for forecasting. In Section 5.5 we discuss the
theoretical basis for some of the criteria used for order selection.

For an overview of the genera strategy for model -fitting see Section 6.2.

5.1 Preliminary Estimation

In this section we shall consider four techniques for preliminary estimation of the
parameterse = (¢1, ..., ¢,),0 = (6, ..., ¢p)/,andozfromobservationle, ey X
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of the causal ARMA(p, ¢g) process defined by
¢(B)X, =0(B)Z,, {Z;} ~WN(0,c?). (5.1.1)

The Yule-Walker and Burg procedures apply to the fitting of pure autoregressive
models. (Although the former can be adapted to modelswith g > 0, its performance
isless efficient than when ¢ = 0.) The innovation and Hannan—Rissanen algorithms
are used in ITSM to provide preliminary estimates of the ARMA parameters when
q > 0.

For pure autoregressive model s Burg’sa gorithm usually giveshigher likelihoods
than the Yule-Walker equations. For pure moving-average models the innovations
algorithm frequently gives dightly higher likelihoods than the Hannan—Rissanen
algorithm (weuse only thefirst two steps of thelatter for preliminary estimation). For
mixed models (i.e., those with p > 0 and ¢ > 0) the Hannan—Rissanen algorithm is
usually more successful infinding causal models (which arerequiredfor initialization
of the likelihood maximization).

5.1.1 Yule-Walker Estimation

For a pure autoregressive model the moving-average polynomial 9(z) isidentically
1, and the causality assumption in (5.1.1) allows usto write X, in the form

X, =) ¥iZ;. (5.1.2)
=0

where, from Section 3.1, ¥ (z) = 372, ¥,z/ = 1/¢(z). Multiplying each side of
(5.11)byX, ;,j=0,1,2,..., p,taking expectations, and using (5.1.2) to evaluate
the right-hand side of the first equation, we obtain the Yule-Walker equations

Iy =7, (5.1.3)
and

o?=y(0) — ¢y, (5.1.4)

where T, isthe covariance matrix [y (i — j)]{fj=1 andvy, = (y(1),...,y(p)). These
equations can be used to determine y (0), . .., ¥ (p) from o2 and ¢.

On the other hand, if we replace the covariances y (j), j =0, ..., p, appearing
in (5.1.3) and (5.1.4) by the corresponding sample covariances y (j), we obtain a set
of equations for the so-called Yule-Walker estimators ¢» and 62 of ¢ and o2, namely,

o=%, (5.1.5)
and

62=90) — ¢, (5.1.6)
where T, = [ — N andd, = (..., ().
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If (0) > 0, thenT",, isnonsingular for every m = 1, 2, ... (see TSTM, Problem
7.11), so we can rewrite equations (5.1.5) and (5.1.6) in the following form:

Sample Yule-Walker Equations:

(,i) = (‘%la ceey (%p) = kglﬁp (517)
and

5% =$(0) [1 - ;)’pie;l,s,,] : (5.1.8)

where p, = (p(D), ..., 2(p)) = 4,/7(0).

With ¢ as defined by (5.1.7), it can be shown that 1 — ¢z — - - - — $,z” # O for
|z| < 1(see TSTM, Problem 8.3). Hence the fitted model

X, —$1Xt_1—'-'—(z)pX,_p =2, {Z} NWN(O,OA’Z)

is causal. The autocovariances y, (h), h = O, ..., p, of the fitted model therefore
satisfy the p + 1 linear equations

0, h=1,...,p,
6%, h=0.

However, from (5.1.5) and (5.1.6) we see that the solution of these equations is
y.(h) = p(h),h =0,..., p, so that the autocovariances of the fitted model at lags
0, 1,..., p coincide with the corresponding sampl e autocovariances.

Theargument of the preceding paragraph showsthat for every nonsingular covari-
ance matrix of theformT',,, = [y (i — j)]{f;ll thereisan AR(p) process whose auto-
covariancesat lagso, ..., parey(0), ..., y(p). (Therequired coefficientsand white
noise variance are found from (5.1.7) and (5.1.8) on replacing o(j) by y(j)/v (0),
j=0,..., p,andy(0) by v (0).) There may not, however, bean MA(p) processwith
this property. For example, if y(0) = 1and y(1) = y(—1) = B, thematrix I'; isa
nonsingular covariance matrix for all 8 € (—1, 1). Consequently, thereis an AR(1)
process with autocovariances 1 and 8 at lags 0 and 1 for al 8 € (—1, 1). However,
thereisan MA(1) process with autocovariances 1 and 8 at lagsO and 1 if and only if
|B] < 3. (See Example2.1.1.)

It is often the case that moment estimators, i.e., estimators that (like ¢) are ob-
tained by equating theoretical and sample moments, have much higher variancesthan
estimators obtained by alternative methods such as maximum likelihood. However,
the Yule-Walker estimators of the coefficients ¢, . . ., ¢, of an AR(p) process have
approximately the same distribution for large samples as the corresponding maxi-
mum likelihood estimators. For a precise statement of thisresult see TSTM, Section
8.10. For our purposes it suffices to note the following:

Vo(h) — gy, (h—1) — - =y, (h — p) =
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L arge-Sample Distribution of Yule-Walker Estimators:

For alarge sample from an AR(p) process,

¢~ N (¢.n 0T, Y.

If we replace 2 and I, by their estimates 2 and I",, we can use this result to
find large-sample confidence regions for ¢ and each of its componentsasin (5.1.12)
and (5.1.13) below.

Order Selection

In practice we do not know the true order of the model generating the data. In fact,
it will usually be the case that there is no true AR model, in which case our goal
is simply to find one that represents the data optimally in some sense. Two useful
techniques for selecting an appropriate AR model are given below. The second is
more systematic and extends beyond the narrow class of pure autoregressive models.

e Some guidance in the choice of order is provided by a large-sample result (see
TSTM, Section 8.10), which statesthat if { X, } isthe causal AR(p) processdefined
by (5.1.1) with {Z,} ~ iid(0, o2) and if we fit a model with order m > p using
the Yule-Walker equations, i.e., if we fit amodel with coefficient vector

~ A 1A
d)m == Rm Pm s m > p,

then the last component, &,nm, of the vector &)m is apE)roximaIely normally dis-
tributed with mean 0 and variance 1/n. Notice that ¢,,,, is exactly the sasmple
partial autocorrelation at lag m as defined in Section 3.2.3.

Now, we aready know from Example 3.2.6 that for an AR(p), processthe partial
autocorrelations ¢,,,.,, m > p, are zero. By the result of the previous paragraph,
if an AR(p) model is appropriate for the data, then the values ¢, k > p, should
be compatible with observations from the distribution N(0, 1/#). In particular,
fork > p, ¢ will fall between the bounds £1.96rn /2 with probability close to
0.95. This suggests using as a preliminary estimator of p the smallest value m
such that |¢w | < 1.96n~Y2 for k > m.

The program ITSM plots the sample PACF {¢A>mm, m =12, ...} together with
the bounds +1.96/./n. From this graph it is easy to read off the preliminary
estimator of p defined above.

e A more systematic approach to order selection is to find the values of p and ¢,
that minimize the AICC statistic (see Section 5.5.2 below)

AICC = =2InL(¢,, S(pp)/n) +2(p + Dn/(n — p = 2),
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Definition 5.1.1.

where L isthe Gaussian likelihood defined in (5.2.9) and S isdefined in (5.2.11).
The Preliminary Estimation dialog box of ITSM (opened by pressing the
blue PRE button) allows you to search for the minimum AICC Yule-Walker (or
Burg) models by checking Find AR model with min AICC. This causes the
program to fit autoregressions of ordersO, 1, ..., 27 and to return the model with
smallest AICC value.

Thefitted Yule-Walker AR(m) model is

X, = GuaXi 1= = GunXem =Z, {Z}~WN(0,3,), (519
where

G = (Buts - Dun) = Ry (5.1.10)
and

B = 7(0) [1 — f;;nie,;lf)m] . (5.1.12)

For both approaches to order selection we need to fit AR models of gradually
increasing order to our given data. The problem of solving the Yule-Walker equations
with gradually increasing orders has already been encountered in adlightly different
context in Section 2.5.1, where we derived a recursive scheme for solving the equa
tions (5.1.3) and (5.1.4) with p successively taking thevalues 1, 2, .... Herewe can
use exactly the same scheme (the Durbin—Levinson agorithm) to solve the Yule-
Walker equations (5.1.5) and (5.1.6), the only difference being that the covariances
in(5.1.3) and (5.1.4) are replaced by their sample counterparts. Thisisthe algorithm
used by ITSM to perform the necessary calculations.

Confidence Regions for the Coefficients

Under the assumption that the order p of thefitted model isthe correct value, we can
use the asymptotic distribution of ¢ ,» to derive approximate |arge-sampl e confidence
regionsfor the true coefficient vector ¢, and for itsindividual components ¢,,;. Thus,
if 2 (p) denotesthe (1— o) quantile of the chi-squared distribution with p degrees
of freedom, then for large sample-size n the region

[#err:(d-8) £, (3~ 8) =n00xfu ()] (5.112)

contains ¢, with probability close to (1 — «). (This follows from Problem A.7 and
the fact that ﬁ(&),, — ¢,) is approximately normally distributed with mean 0 and
covariance matrix f),,l“;l.) Similarly, if ®;_, denotes the (1 — «) quantile of the
standard normal distribution and v;; isthe jth diagonal element of f)pf;l, then for
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Example 5.1.1

large n the interval bounded by
bpj £ Pr_gjon Y201 (5.1.13)

Ji

contains ¢,; with probability closeto (1 — «).

The Dow Jones Utilities Index, Aug. 28-Dec. 18, 1972; DOWJ.TSM

The very slowly decaying positive sample ACF of the time series contained in the
file DOWJ.TSM this time series suggests differencing at lag 1 before attempting to
fit astationary model. One application of the operator (1 — B) produces anew series
{Y,} with no obvious deviations from stationarity. We shall thereforetry fitting an AR
process to this new series

Y;=D; — D,

using the Yule-Walker equations. There are 77 values of Y,, which we shall denote
by Y1, ..., Y7. (We ignore the unequal spacing of the origina data resulting from
the five-day working week.) The sample autocovariances of the series yq, . .., y77 are
7(0) = 0.17992, (1) = 0.07590, y (2) = 0.04885, etc.

Applying the Durbin—Levinson algorithm to fit successively higher-order autore-
gressive processes to the data, we abtain

¢u = p(1) = 0.4219,
1= 9(0) [1 - p*(D)] = 0.1479,

b2 = |7 = dup @] /i = 0.0138,
¢ = P11 — prgz = 0.3739,
A, [1 - &32] = 0.1460.

The sample ACF and PACF of the data can be displayed by pressing the second
yellow button at the top of the ITSM window. They are shown in Figures 5.1 and 5.2,
respectively. Also plotted are the bounds +1.96/+/77. Since the PACF values at lags
greater than 1 al lie between the bounds, the first order-sel ection criterion described
aboveindicatesthat we should fit an AR(1) model to the dataset {Y,}. Unlesswewish
to assumethat {Y,} isazero-mean process, we should subtract the sample mean from
the data before attempting to fit a (zero-mean) AR(1) model. When the blue PRE
(preliminary estimation) button at the top of the ITSM window is pressed, you will
be given the option of subtracting the mean from the data. In this case (as in most)
click Yes to obtain the new series

X, =Y, —0.1336.

You will then see the Preliminary Estimation dialog box. Enter 1 for the AR
order, zero for the MA order, select Yule-Walker, and click OK. We have already
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Figure 5-1

The sample ACF of
the differenced series
{Y:} in Example 5.1.1.

computed ¢4, and 9, above using the Durbin—L evinson agorithm. The Yule-Walker
AR(1) model obtained by ITSM for {X,} istherefore (not surprisingly)

X; —0.4219X, 1 = Z,, {Z,} ~WN(O0, 0.1479), (5.2.14)
and the corresponding model for {Y;} is
Y, — 0.1336 — 0.4219(Y,_; — 0.1336) = Z,, {Z,} ~ WN(0, 0.1479). (5.1.15)

Assuming that our observed data really are generated by an AR process with
p = 1, (5.1.13) gives us approximate 95% confidence bounds for the autoregressive
coefficient ¢,

(1.96)(.1479)
(.17992)/77

Besides estimating the autoregressive coefficients, I TSM computes and printsout
theratio of each coefficient to 1.96 timesits estimated standard deviation. From these
numbers large-sampl e 95% confidenceintervalsfor each of the coefficientsare easily
obtained. Inthisparticular examplethereisjust onecoefficient estimate, ¢, = 0.4219,
with ratio of coefficient to 1.96x standard error equal to 2.0832. Hence the required
95% confidence bounds are 0.4219 + 0.4219/2.0832 = (0.2194, 0.6244), as found
above.

A useful technique for preliminary autoregressive estimation that incorporates
automatic model selection (i.e., choice of p) isto minimize the AICC (see equation
(5.5.4)) over al fitted autoregressions of orders O through 27. This is achieved by
selecting both Yule-Walker and Find AR model with min AICCinthePrelim-

0.4219 + = (0.2194, 0.6244).

1.0

0.6
T

ACF
0.4
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Example 5.1.2

inary Estimation dialog box. (The MA order must be set to zero, but the AR
order setting isimmaterial.) Click 0K, and the program will search through all the
Yule-Walker AR(p) models, p =0, 1, ..., 27, selecting the one with smallest AICC
value. The minimum-AICC Yule-Walker AR model turns out to be the one defined
by (5.1.14) with p = 1 and AICC value 74.541. O

Yule-Walker Estimation with g > 0; Moment Estimators

The Yule-Walker estimates for the parameters in an AR(p) model are examples
of moment estimators. The autocovariances at 1ags 0, 1, ..., p are replaced by the
corresponding sample estimates in the Yule-Walker equations (5.1.3), which are
then solved for the parameters ¢ = (¢4, .. ., ¢,)’ and o'2. The analogous procedure
for ARMA(p, g) models with ¢ > 0 is easily formulated, but the corresponding
eguations are nonlinear in the unknown coefficients, |eading to possible nonexistence
and nonuniqueness of solutions for the required estimators.

From (3.2.5), the equations to be solved for ¢4, ..., ¢,, 64, ..., 0, and ol are

q
p(k)—qslf/(k—l)—---—¢,,;>(k—p)=0229,1/f,-_k, O<k<p+gq, (5116)

j=k

where v; must first be expressed in terms of ¢ and @ using the identity ¢ (z) =
0(2)/¢(2) (bo:=1andb; = y; = 0for j < 0).

For the MA(1) model the equations (5.1.16) are equivalent to

7(0) = 6° (1 + éf) : (5.1.17)
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A

01
1+62

o) = (5.1.18)
If [5(1)| > .5, thereisnoreal solution, sowedefined; = p(1)/|p(D)]. If [p(D)] < .5,
then the solution of (5.1.17)—«(5.1.18) (with |9| < 1) is

b= (1- (1-4*)"*) / (26D),
62 =9(0)/ (1+ éf) .

For the overshort data of Example 3’;2.8, 0(1) = —0.5035 and 7 (0) = 3416, so the
fitted MA(1) model has parameters§; = —1.0 and 62 = 1708. O

Relative Efficiency of Estimators

The performance of two competing estimators is often measured by computing their
asymptotic relative efficiency. In ageneral statistics estimation problem, suppose é,ﬁ”
and 0@ are two estimates of the parameter 6 in the parameter space © based on the
observations X1, ..., X,.If 6% is approximately N(, 02(9)) for large n, i = 1,2,
then the asymptotic efficiency of 0 relative to 62 is defined to be

e (6.00,%) = 29
o1 @)

If e(0,6®,0@) < 1foral & € ©, then we say that §? is a more efficient
estimator of ¢ than 4* (strictly more efficient if in addition, e(6, 6®, §®) < 1 for
somed € ©). For theMA (1) processthe moment estimator 0 discussed in Example
5.1.2 is approximately N(6y, 02(61)/n) with

02(61) = (1462 + 467 + 68 + 69) /(1 — 62)°

(see TSTM, p. 254). On the other hand, the innovations estimator 2 discussed in
the next section is distributed approximately as N(61, n~*). Thus, e(61, 0P, 6@) =
01‘2(91) < 1foral |91] < 1, with strict inequality when 0 = 1. In particular,

82, 0, = .25
e(el,é<1>,é<2>): 37, 6, = 50,
06, 6, =.75.

gemonstr:ati ng the superiority, at least in terms of asymptotic relative effici ency, of
62 over 6V, On the other hand (Section 5.2), the maximum likelihood estimator 6
of 6 is approximately N(61, (1 — 62)/n). Hence,

94, 6, = .25
p (01, Fla) é<3>) =175 6, =50
44, ¢, = 75
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While §® is more efficient, 9 has reasonably good efficiency, except when |6, | is
closeto 1, and can serve as initial value for the nonlinear optimization procedurein
computing the maximum likelihood estimator.

While the method of moments is an effective procedure for fitting autoregres-
sive models, it does not perform as well for ARMA models with ¢ > 0. From a
computational point of view, it requires as much computing time as the more effi-
cient estimators based on either the innovations agorithm or the Hannan—Rissanen
procedure and is therefore rarely used except when g = 0.

5.1.2 Burg’s Algorithm

The Yule-Walker coefficients ¢,1, . . ., ¢,, are precisely the coefficients of the best
linear predictor of X, intermsof {X,, ..., X1} under the assumption that the ACF
of {X,} coincideswith thesample ACF atlags 1, ..., p.

Burg's agorithm estimates the PACF {¢11, ¢, . ..} by successively minimizing
sumsof squaresof forward and backward one-step prediction errorswith respect tothe
coefficients ¢;;. Given observations{x, . .., x,} of astationary zero-mean time series
{X,}wed€fineu; (), =i+1,...,n,0 <i < n,tobethedifferencebetweenx,  1,;_,
and the best linear estimate of x,,1,;_, in terms of the preceding i observations.
Similarly, we definev; (¢),t =i+ 1,...,n,0 < i < n, to be the difference between
Xny1-: andthebest linear estimate of x,,, 1, intermsof the subsequent i observations.
Then it can be shown (see Problem 5.6) that the forward and backward prediction
errors{u; ()} and {v; (¢)} satisfy the recursions

uo(t) = vo(t) = X111,
ui(t) =u;i1(t = 1) — ¢iiv;i_1(), (5.1.19)
and
vi (1) = vi_1(t) — Giiui—1(t — 1). (5.1.20)
Burg's estimate ¢\’ of ¢y, isfound by minimizing
of = 2(,1—1_1) 222 [ud) +v})]

with respect to ¢11. This gives corresponding numerical values for u1(¢) and vy ()
and o that can then be substituted into (5.1.19) and (5.1.20) with i = 2. Then we
minimize
l n
02 i=——— us(t) + va(t
: 2(n—2);[ 2(0) +v3(1)]
with respect to ¢», to obtain the Burg estimate ¢§§) of ¢, and corresponding values

of ux(t), v2(¢), and o2. This process can clearly be continued to obtain estimates ¢;§?
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and corresponding minimum values, a,gB>2, p < n — 1. Estimates of the coefficients
¢,.1<j < p—1,inthebest linear predictor
PﬂXzH—l = ¢p1Xp +eet ¢prl
arethenfound by substitutingtheestimates¢'”, i = 1,..., p,for ¢;; intherecursions
(2.5.20)—2.5.22). The resulting estimates of ¢,;, j = 1,..., p, are the coefficient
estimates of the Burg AR(p) model for the data {x1, ..., x,}. The Burg estimate of
the white noise variance is the minimum value o (** found in the determination of
¢'%. The calculation of the estimates of ¢, and o described above is equivalent
(Problem 5.7) to solving the following recursions:
Burg's Algorithm:
d() =) Wt — 1) + (1)),
=2
on = 2 Z vict(Dui_a(t — 1)
IO
di+1) = (1= %) (i) = v7(i + 1) - u(),
o™ =[(1-8?) )] /1200 — D).

Thelarge-sampledistribution of the estimated coefficientsfor the Burg estimators
of the coefficients of an AR(p) processisthe same asfor the Yule-Walker estimators,
namely, N(¢,n *oT",*). Approximate large-sample confidence intervals for the
coefficients can be found asin Section 5.1.1 by substituting estimated values for o2
andT,.

Example 5.1.3  The Dow Jones Utilities Index

Thefitting of AR models using Burg's algorithm in the program ITSM is completely
anaogous to the use of the Yule-Walker equations. Applying the same transfor-
mations as in Example 5.1.1 to the Dow Jones Utilities Index and selecting Burg
instead of Yule-Walker in the Preliminary Estimation dialog box, we obtain
the minimum AICC Burg model

X, —04371X,.1 = Z;, {Z.} ~WN(0, 0.1423), (5.1.212)

with AICC = 74.492. Thisis dightly different from the Yule-Walker AR(1) model
fitted in Example 5.1.1, and it has a larger likelihood L, i.e., a smaller value of
—2In L (see Section 5.2). Although the two methods give estimators with the same
large-sample distributions, for finite sample sizes the Burg model usually hassmaller
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Example 5.1.4

Figure 5-3
The sample ACF of the lake
data in Example 5.1.4.

estimated white noise variance and larger Gaussian likelihood. From the ratio of the
estimated coefficient to (1.96x standard error) displayed by ITSM, we obtain the
95% confidence bounds for ¢: 0.4371 4 0.4371/2.1668 = (0.2354, 0.6388). O

The lake data

This series {Y;,t = 1,..., 98} has adready been studied in Example 1.3.5. In this
example we shall consider the problem of fitting an AR process directly to the data
without first removing any trend component. A graph of the data was displayed in
Figure 1.9. The sample ACF and PACF areshown in Figures 5.3 and 5.4, respectively.

The sample PACF shown in Figure 5.4 strongly suggests fitting an AR(2) model
to the mean-corrected data X, = ¥, — 9.0041. After clicking on the blue preliminary
estimation button of ITSM select Yes to subtract the sample mean from {Y;}. Then
specify 2 for the AR order, O for the MA order, and Burg for estimation. Click OK
to obtain the model

X, — 1.0449X, ; + 0.2456X, , = Z;, {Z;} ~ WN(O0, 0.4706),
with AICC value 213.55 and 95% confidence bounds

¢1 1 1.0449 £+ 1.0449/5.5295 = (0.8559, 1.2339),

¢2 1 —0.2456 + 0.2456,/1.2997 = (—0.4346, —0.0566).
Selecting the Yule-Walker method for estimation, we obtain the model

X, —1.0538X,_; +0.2668X, , = Z,, {Z,} ~WN(O0, 0.4920),

1.0

0.6
T

ACF
0.4

0.2

0.0
T
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Lag
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Figure 5-4
The sample PACF of the
lake data in Example 5.1.4.
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with AICC value 213.57 and 95% confidence bounds
¢1 1 1.0538 4 1.0538/5.5227 = (0.8630, 1.2446),
¢» 1 —0.2668 4= 0.2668/1.3980 = (—0.4576, —.0760).

We notice, as in Example 5.1.3, that the Burg model again has smaller white noise
variance and larger Gaussian likelihood than the Yule-Walker model.

If we determine the minimum AICC Yule-Walker and Burg models, wefind that
they are both of order 2. Thus the order suggested by the sample PACF coincides
again with the order obtained by A1CC minimization. O

5.1.3 The Innovations Algorithm

Just as we can fit autoregressive models of orders 1, 2, ... tothedata{xy, ..., x,} by
applying the Durbin—L evinson algorithm to the sample autocovariances, we can also
fit moving average models

Xi=Zi+0mZiat - +0umZim, (Z)~WN(O,D,) (5.1.22)

of ordersm = 1, 2,... by means of the innovations algorithm (Section 2.5.2). The
estimated coefficient vectors 0,, ( hils - e 0,,,,”) and white noise variances v,,,
m=12,..., are specified in the following definition. (The justification for using
estimators defined in thisway is contained in Remark 1 following the definition.)
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Definition 5.1.2

Thefitted innovations M A(m) model is
Xt = Zt + életfl +---+ émmthma {Zt} ~ WN(O, i}m),

where 9,,, and v,, are obtained from the innovations algorithm with the ACVF
replaced by the sample ACVF.

Remark 1. It can be shown (see Brockwell and Davis, 1988) that if {X,} is an
invertible MA(g) process

X, =Z+6:.Z 1+ +6,Z_,, {Z}~1D(0,0?%,

with EZ} < oo, and if we definedy = 1 and 6; = O for j > ¢, then the innovation
estimates have the following large-sample properties. If n — oo and m(n) is any
sequence of positiveintegers such that m (n) — oo but n=3m(n) — 0, then for each
positive integer k the joint distribution function of

n'? (éml — 01, Oz — O, .., O — 9k>

converges to that of the multivariate normal distribution with mean 0 and covariance
matrix A = [a;;]} ,_,, where

min(i, j)

aj= Y 6,0, . (5.1.23)

r=1

This result enables us to find approximate large-sample confidence intervals for the
moving-average coefficients from the innovation estimates as described in the exam-
ples below. Moreover, the estimator v,, isconsistent for o2 in the sense that for every
e>0,P(|ﬁm—02|>e)—>OaSm—>oo. O

Remark 2. Although the recursive fitting of moving-average models using the
innovations algorithm is closely analogous to the recursive fitting of autoregressive
model s using the Durbin—Levinson algorithm, there is one important distinction. For
an AR(p) process the Yule-Walker and Burg estimators ¢ , areconsistent estimators
of (¢1,...,¢,)" asthe sample sizen — oo. However, for an MA(g) process the
estimator 6, = (6,1, ..., 6,,) iSnot consistent for (6., . .., 6,)'. For consistency it is
necessary to use the estimators (0,1, . . ., O,,4) With m(n) satisfying the conditions of
Remark 1. The choice of m for any fixed sample size can be made by increasing m
until the vector (0,1, . .., 6,,,)" Stabilizes. It is found in practice that there is alarge
range of values of m for which the fluctuations in 6,,; are small compared with the
estimated asymptotic standard deviation n=2(3"/- 62,)"? as found from (5.1.23)

i=0 Ymi

when the coefficients 6; are replaced by their estimated values 6,,; . O
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Order Selection

Three useful techniquesfor selecting an appropriate MA model are given below. The
third is more systematic and extends beyond the narrow class of pure moving-average
models.

We know from Section 3.2.2 that for an M A (¢) processthe autocorrelations p (m),

m > g, are zero. Moreover, we know from Bartlett’s formula (Section 2.4) that
the sample autocorrelation p(m), m > g, is approximately normally distributed
with mean p(m) = 0 and variance n*[1 + 2p%(1) + - - - + 2p?(¢)]. This result
enables us to use the graph of p(m), m = 1,2, ..., both to decide whether or
not a given data set can be plausibly modeled by a moving-average process and
also to obtain a preliminary estimate of the order ¢ as the smallest value of m
such that p(k) isnot significantly different from zero for all k > m. For practica
purposes “significantly different from zero” is often interpreted as “larger than
1.96/./n in absolute value” (cf. the corresponding approach to order selection
for AR models based on the sample PACF and described in Section 5.1.1).

Ifinadditiontoexamining p(m),m = 1, 2, . . ., weexaminethecoefficient vectors
6,,,m = 1,2, ... weareablenot only to assess the appropriateness of amoving-
average model and estimateitsorder ¢, but at the sametimeto obtain preliminary
eﬂlmateseml, .. émq of the coefficients. By inspecting the estimated coefficients

Onts v v O for m = 1,2, ... and the ratio of each coefficient estimate 9,,,, to
1.96 timesiits apprOX|matestandard deviation o; = n~Y2[ Y1-262,]"%, we can

see which of the coefficient estimates are most significantly different from zero,
estimate the order of the model to be fitted asthe largest lag j for which theratio
islarger than 1 in absolute value, and at the same time read off estimated values
for each of the coefficients. A default value of m is set by the program, but it may
be altered manually. As m is increased the values 6,1, . . . , 6., Stabilize in the
sense that the fluctuations in each component are of order n~%/2, the asymptotic
standard deviation of 6,,1.

As for autoregressive models, a more systematic approach to order selectlon for
moving-average models is to find the values of ¢ and 8, = = (01, .-, 0y) that
minimize the AICC statistic

AICC = -2InL(,, S,)/n) +2(q + Hn/(n — q — 2),

where L isthe Gaussian likelihood defined in (5.2.9) and S isdefined in (5.2.11).
(See Section 5.5 for further details.)

Confidence Regions for the Coefficients
Asymptotic confidence regions for the coefficient vector 6, and for its individual
components can be found with the aid of the large-sample distribution specified in
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Example 5.1.5

Remark 1. For example, approximate 95% confidence bounds for 6, are given by

-1 1/2
O,; + 1.96n7Y/2 (Z é,,z,,.) . (5.1.24)

i=0
The Dow Jones Ultilities Index

In Example 5.1.1 we fitted an AR(1) model to the differenced Dow Jones Utilities
Index. The sample ACF of the differenced data shown in Figure 5.1 suggests that
an MA(2) model might also provide a good fit to the data. To apply the innovation
technique for preliminary estimation, we proceed as in Example 5.1.1 to difference
the series DOWJ.TSM to obtain observations of the differenced series {Y,}. We then
select preliminary estimation by clicking on the blue PRE button and subtract the
mean of the differencesto obtain observations of the differenced and mean-corrected
series {X;}. Inthe Preliminary Estimation dialog box enter O for the AR order
and 2 for the MA order, and select Innovations asthe estimation method. We must
then specify avalue of m, which is set by default in this case to 17. If we accept the
default value, the program will compute 6171, ..., 61717 and print out the first two
values as the estimates of 6, and 6,, together with the ratios of the estimated values
to their estimated standard deviations. These are

MA COEFFICIENT
4269 2704
COEFFICIENT/(1.96*STANDARD ERROR)
1.9114 1.1133

The remaining parameter in the mode! isthe white noise variance, for which two
estimates are given:

WN VARIANCE ESTIMATE = (RESID SS)/N
.1470
INNOVATION WN VARIANCE ESTIMATE
1122

The first of these is the average of the squares of the rescaled one-step prediction
errorsunder thefitted MA(2) model, i.e., & 377 (X, — X;)*/r;_1. The second value
is the innovation estimate, v1;7. (By default ITSM retains the first value. If you wish
instead to use the innovation estimate, you must change the white noise variance by
selecting Model>Specify and setting the white noise value to the desired value.) The

fitted model for X,(= Y, — .1336) isthus
X, = Z, +0.4269Z, 1 + 0.2704Z,_,, {Z,} ~ WN(0, 0.1470),

with AICC = 77.467.

Toseedl 17 estimated coeffici entséﬂj, j =1 ..., 17, werepeat thepreliminary
estimation, thistimefittingan MA(17) model withm = 17. Thecoefficientsand ratios
for the resulting model are found to be as follows:
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MA COEFFICIENT

4269 2704 1183 .1589 1355 1568 1284 —.0060
.0148 —-.0017 .1974 —.0463 .2023 .1285 —.0213 —.2575
.0760
COEFFICIENT/(1.96*STANDARD ERROR)
1.9114 1.1133 4727 .6314 .5331 .6127 4969 —.0231
.0568 —.0064 .7594 —.1757 .7667 4801 —.0792 —.9563
.2760

The ratios indicate that the estimated coefficients most significantly different
from zero are the first and second, reinforcing our original intention of fitting an
MA(2) model to the data. Estimated coefficients 6, ; for other values of m can be
examined in the same way, and it isfound that the values obtained for m > 17 change
only dightly from the values tabulated above.

By fittingMA (¢) modelsof orders0, 1, 2, . . ., 26 using theinnovationsal gorithm
with the default settings for m, wefind that the minimum AICC model isthe onewith
g = 2 found above. Thus the model suggested by the sample ACF again coincides
with the more systematically chosen minimum AICC model. O

Innovations Algorithm Estimates when p > 0 and g > 0
The causality assumption (Section 3.1) ensures that

o0
X, = Z ]//jztfjv
j=0

where the coefficients ; satisfy

min(j, p)
vi=0+ Y ¢, j=01..., (5.1.25)
i=1
and we define 6y := 1and 6; := Ofor j > ¢. To estimate yry, ..., ¥,4, We can use

A

theinnovation estimatesé,, Lieees Om, p+q,» Whose large-sample behavior is specified in
Remark 1. Replacing v; by 6,,; in (5.1.25) and solving the resulting equations

min(j, p)

ém] = 0] + Z ¢iém,j—ia J - la LR P + q, (5126)

i=1

for ¢ and 6, we obtain initial parameter estimates ¢ and 6. To solve (5.1.26) wefirst
find ¢ from the last ¢ equations:

~ ~ ~

Qm.q-kl Aemq Qrf,q—l T ém.q-kl—p ¢1
0m.q+2 . Qm,q-‘rl Qm,q e 9m.q+2—p ¢2 (5 1 27)
0m,q+p 9m,q+p—l 9m,q+p—2 e Qm,q ¢p
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Example 5.1.6

Having solved (5.1.27) for ¢ (which may not be causal), we can easily determine the
estimate of 6 from

. . minGj,p)

szgmj_ Z ¢)i9m,j—is ]:1,,61

i=1

Finally, the white noise variance o2 is estimated by

n ~ \2
62:n_1Z<X,—Xt) /I"l_]_,
=1

where X, isthe one-step predictor of X, computed from the fitted coefficient vectors
¢ and 6, and r,_; is defined in (3.3.8).

Theabovecalculationscan all becarried out by selectingthel TSM optionModel>
Estimation>Preliminary. Thisoption also computes, if p = ¢, the ratio of each
estimated coefficient to 1.96 timesitsestimated standard deviation. Approximate 95%
confidence intervals can therefore easily be obtained in this case. If the fitted model
is noncausal, it cannot be used to initialize the search for the maximum likelihood
estimators, and so the autoregressive coefficients should be set to some causal values
(e.g., dl equal to .001) using the Mode1>Specify option. If both the innovation and
Hannan—Rissanen algorithms give noncausal models, it is an indication (but not a
conclusive one) that the assumed values of p and ¢ may not be appropriate for the
data.

Order Selection for Mixed Models

For modelswith p > Oandgq > 0, thesample ACF and PACF aredifficultto recognize
and are of far less value in order selection than in the special cases where p = 0 or
g = 0. A systematic approach, however, is still available through minimization of
the AICC statistic

AICC = -2InL(¢,,0,, S(¢,,0,)/n) +2(p +q +Dn/(n — p —q — 2),

which isdiscussed in more detail in Section 5.5. For fixed p and g itisclear fromthe
definition that the AICC value is minimized by the parameter values that maximize
the likelihood. Hence, final decisions regarding the orders p and ¢ that minimize
AICC must be based on maximum likelihood estimation as described in Section 5.2.

The lake data

In Example 5.1.4 we fitted AR(2) models to the mean corrected lake data using the
Yule-Walker equations and Burg's algorithm. If instead we fit an ARMA(1,1) model
using the innovations method in the option Model>Estimation>Preliminary of
ITSM (with the default value m = 17), we obtain the model

X, —0.7234X,_1 = Z, + 0.3596Z,_,, {Z,} ~WN(O0, 0.4757),
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for the mean-corrected series X, = Y, — 9.0041. The ratio of the two coefficient
estimates ¢ and 6 to 1.96 timestheir estimated standard deviationsare given by I TSM
as 3.2064 and 1.8513, respectively. The corresponding 95% confidence intervals are
therefore

¢ : 0.7234 £ 0.7234/3.2064 = (0.4978, 0.9490),

0 : 0.3596 £ 0.3596,/1.8513 = (0.1654, 0.5538).

It is interesting to note that the value of AICC for this model is 212.89, which is
smaller than the corresponding values for the Burg and Yule-Walker AR(2) mod-
elsin Example 5.1.4. This suggests that an ARMA(1,1) model may be superior to
a pure autoregressive model for these data. Preliminary estimation of a variety of
ARMA (p, ¢) models shows that the minimum AICC value does in fact occur when
p = q = 1. (Before committing ourselves to this model, however, we need to com-
pare AICC values for the corresponding maximum likelihood models. We shall do
thisin Section 5.2.) O

5.1.4 The Hannan-Rissanen Algorithm

The defining equationsfor acausal AR(p) model havetheform of alinear regression
model with coefficient vector ¢ = (¢1, ..., ¢,)". This suggests the use of simple
least squares regression for obtaining preliminary parameter estimates when g = 0.
Application of thistechnique when ¢ > 0is complicated by the fact that in the gen-
eral ARMA(p, ¢) equations X, isregressed not only on X,_4, ..., X,_,, but aso on
the unobserved quantities Z,_4, ..., Z,_,. Nevertheless, it is still possible to apply
least squares regression to the estimation of ¢ and 0 by first replacing the unobserved
quantities Z,_s, ..., Z,_, in (5.1.1) by estimated values Z, 1. ..., Z,_,A,. The parame-
ters ¢ and @ arethen estimated by regressing X, onto X,_1, ..., X;—p, Z;—1, ..., Zi—,.
These are the main steps in the Hannan—Rissanen estimation procedure, which we
now describe in more detail.

Step 1. A high-order AR(m) model (withm > max(p, ¢q)) isfittedtothedatausingthe
Yule-Walker estimates of Section 5.1.1. If (¢>m1, .. ¢>mm) isthe vector of estimated
coefficients, then the estimated residuals are computed from the equations

Zi=X,— ¢pmXi1— - — umXim» t=m+1....n

Step 2. Once the estimated residuals Zi,t=m+1,...,n, have been computed as
in Step 1, the vector of parameters, 8 = (¢', 0')' is estimated by least squares linear
regression of X, onto (X,—1, ..., Xi—p, Zy-1, ..., Zig)s t =m+1+gq,...,n, ie,
by minimizing the sum of squares

n N N 2
S@= Y (Xi—dXia— = @Xip =021~ 0,7,

t=m+1+q
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Example 5.1.7

with respect to 3. This gives the Hannan—Rissanen estimator
B=(Z'2)7*ZX,,
where X, = (Xyut144 - - .- X)) @nd Z isthe (n —m — g) x (p + ¢q) matrix

Xm+q Xerqfl e Xm+q+lfp Zm+q Zm+qfl Zm+1
7 Xm+q+1 Xm+q e Xm+q+2fp Zm+q+1 Zm+q Zm+2
Xn—l Xn—2 e Xn—p Zn—l Zn—2 te Zn—q

(If p = 0, Z contains only the last ¢ columns.) The Hannan—Rissanen estimate of
the white noise variance is

i S

L ———

The lake data

In Example 5.1.6 an ARMA(1,1) model was fitted to the mean corrected lake data
using the innovations algorithm. We can fit an ARMA(1,1) model to these datausing
the Hannan—Rissanen estimates by selecting Hannan-Rissanen in the Preliminary
Estimation dialog box of ITSM. The fitted model is

X, —0.6961X, 1 =Z, +03788Z,_;, {Z.,} ~WN(O,0.4774),

forthemean-corrected series X, = Y, —9.0041. (Two estimates of thewhite noisevari-
ance are computed in I TSM for the Hannan-Rissanen procedure, 65z and 3 (X, —

X,_1)?/n. The latter is the one retained by the program.) The ratios of the two co-
efficient estimates to 1.96 times their standard deviation are 4.5289 and 1.3120,
respectively. The corresponding 95% confidence bounds for ¢ and 6 are

¢ : 0.6961 £ 0.6961/4.5289 = (0.5424, 0.8498),
6 : 0.3788 £ 0.3788/1.3120 = (0.0901, 0.6675).

Clearly, there is little difference between this model and the one fitted using the
innovations method in Example 5.1.6. (The AICC values are 213.18 for the current
model and 212.89 for the model fitted in Example 5.1.6.) O

Hannan and Rissanen include a third step in their procedure to improve the
estimates.

Step 3. Using the estimate 3 = (1, .- ., ¢, 61, ..., 6,) from Step 2, set
0, if t <max(p, q),

7, = P 4 .
X, — Z Z if 1 > max(p, q).

j=1
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Now forr =1,...,n put
0, if r < max(p,q),
Vi=1& ~ ,
Y ¢V +Z,. ift>max(p.q)
j=1
and
0, if r < max(p,q),

W, = ay 5
=D Wi+ Z,, it > max(p, g).
j=1

(Observethat both V;, and W, satisfy theARrecursions¢(B)V, = Z, andd(B)W, = Z,

fort = 1,...,n) If B'isthe regression estimate of 3 found by regressing Z, on
Ve, ooy Viepy Weig, o, Wiy, ie, if BT minimizes

n

2
)4 q

'y =Y. (Zf—Zﬂ,-v,,-—Zﬂpr,k) :
j=1 k=1

t=max(p,q)+1

then the improved estimate of 3 is 3 = 3" + 3. The new estimator 3 then has the
same asymptotic efficiency asthe maximum likelihood estimator. In I TSM, however,
we eliminate Step 3, using the model produced by Step 2 as the initial model for the
calculation (by numerical maximization) of the maximum likelihood estimator itself.

5.2 Maximum Likelihood Estimation

Suppose that {X,} is a Gaussian time series with mean zero and autocovariance

function « (i, j) = E(X;X,). Let X, = (X1,..., X,) and let X, = (X1...., X,)',

where X; = 0and X; = E(X;|X1,..., X;_1) = P;_.1X;, j > 2. Let T, denote the

covariance matrix I', = E(X, X)), and assume that I, is nonsingular.
Thelikelihood of X, is

L(T,) = 2r)™"/?(det T,,)) Y2 exp (—%x;rn—lx,,) . (5.2.1)
As we shal now show, the direct calculation of detT", and I', ! can be avoided by
expressing this in terms of the one-step prediction errors X; — X ; and their vari-
ancesv,_1, j = 1,...,n, both of which are easily calculated recursively from the
innovations a gorithm (Section 2.5.2).
Leto,;,j = 1,...,i5i = 1,2, ..., denote the coefficients obtained when the
innovations algorithm is applied to the autocovariance function « of {X,}, and let C,
bethen x n lower triangular matrix defined in Section 2.5.2. From (2.5.27) we have
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the identity

Xo = Cy (Xu = X,). (5.2.2)

A

We aso know from Remark 5 of Section 2.5.2 that the comppnents of X, — X,
are uncorrelated. Consequently, by the definition of v;, X, — X,, has the diagonal
covariance matrix

D, = diag{vo, ..., v,_1}.
From (5.2.2) and (A.2.5) we conclude that

r,=C,D,C. (5.2.3)
From (5.2.2) and (5.2.3) we see that

A

X, T, = (X, — x) D (X = %) =3 (%, - X,-)z/v,-_1 (5.2.4)

and
detT", = (det C,)%(det D,) = vov1 - - - Uy_1. (5.2.5)
Thelikelihood (5.2.1) of the vector X, therefore reduces to

L(Fn) =

1 1 2
=52 \Xi—X;) /vjap. (528
(2)"vo -+ Vp1 EXP{ 2;( ! j> v 1} (5.2.6)

If T, is expressible in terms of a finite number of unknown parameters 4, ..., 8,
(as is the case when {X,} is an ARMA(p, ¢) process), the maximum likelihood
estimators of the parameters are those values that maximize L for the given data
set. When X4, X», ..., X, areiid, it is known, under mild assumptions and for n
large, that maximum likelihood estimators are approximately normally distributed
with variances that are at least as small as those of other asymptotically normally
distributed estimators (see, e.g., Lehmann, 1983).

Evenif {X,} isnot Gaussian, it still makes senseto regard (5.2.6) as ameasure of
goodnessof fit of themodel tothedata, and to choosethe parametersgs, . . ., 8, insuch
away asto maximize (5.2.6). Weshall alwaysrefer totheestimators Ay, . . ., 8, so ob-
tained as* maximum likelihood” estimators, even when { X, } isnot Gaussian. Regard-
less of the joint distribution of X4, ..., X,, we shal refer to (5.2.1) and its algebraic
equivalent (5.2.6) asthe“likelihood” (or “ Gaussianlikelihood”) of X3, ..., X,.Ajus
tification for using maximum Gaussian likelihood estimators of ARMA coefficientsis
that the large-sample distribution of the estimatorsisthe samefor {Z,} ~ 11D(0, 0'?),
regardless of whether or not {Z,} is Gaussian (see TSTM, Section 10.8).

The likelihood for data from an ARMA(p, ¢g) process is easily computed from
the innovations form of the likelihood (5.2.6) by evaluating the one-step predictors
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A

X; 11 and the corresponding mean squared errors v;. These can be found from the
recursions (Section 3.3)

Zan (Xn+1—j - )A(n+1—j> ; 1<n<m,
~ j=1
Xus1 = , (5.2.7)

¢1Xn +---+ ¢an+1—p + Zenj (Xil+l—j - Xn+l—j) , h=zm,

j=1
and
N2 N2
E (X,Hl _ X,Hl) — o2F <W,,+l - W,Hl) = o2, (5.2.8)

where 6,; and r,, are determined by the innovations algorithm with « as in (3.3.3)
and m = max(p, ¢q). Subgtituting in the general expression (5.2.6), we obtain the
following:

The Gaussian Likelihood for an ARM A Process:

1 - 1
P 202

L(¢,0,0%) =
( ) \/(27r02)n ro- - Tn_1 j=1 Fj-1

Differentiating In L (¢, 8, o) partially with respect to o and noting that X ; and r;
are independent of o2, we find that the maximum likelihood estimators ¢, 8, and 62
satisfy the following equations (Problem 5.8):

Maximum Likelihood Estimators:

62 =n1s (&s, i)) : (5.2.10)
where
S (&s, é) - Z (xj - )?j)z/r,-,l, (5.2.11)
j=1

and ¢, 6 are the values of ¢, 6 that minimize

0,0 =In(n"'S(¢,0)+n"" Z Inr;_;. (5.2.12)
j=1

Minimization of (¢, #) must be done numerically. Initial valuesfor ¢ and 6 can
be obtained from I TSM using the methods described in Section 5.1. Theprogram then
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searches systematically for the values of ¢ and 6 that minimize the reduced likelihood
(5.2.12) and computes the corresponding maximum likelihood estimate of o2 from
(5.2.10).

Least Squares Estimation for Mixed Models

Theleast squares estimates ¢ and 8 of ¢ and 8 are obtained by minimizing thefunction
S asdefined in (5.2.11) rather than ¢ as defined in (5.2.12), subject to the constraints
that the mode! be causal and invertible. The least squares estimate of o2 is

S(¢,0
6,2 — ( ) .

n—p-—q
Order Selection

In Section 5.1 weintroduced minimization of the AICC value asamajor criterion for
the selection of the orders p and ¢g. This criterion is applied as follows:

AICC Criterion:

Choose p, ¢, ¢,,, and 6, to minimize

AICC = —2InL(,, 8,, S($,,8,)/n) +2(p + ¢ + Ln/(n — p — g — 2).

For any fixed p and ¢ itis clear that the AICC is minimized when ¢, and 6, are
the vectorsthat minimize —21n L(¢,.0,,5(,,0,)/n), i.e., the maximum likelihood
estimators. Final decisionswith respect to order sel ection should therefore be made on
the basis of maximum likelihood estimators (rather than the preliminary estimators of
Section 5.1, which serve primarily asaguide). The AICC statistic and itsjustification
are discussed in detail in Section 5.5.

One of the options in the program ITSM isModel>Estimation>Autofit. Se-
lection of this option allows you to specify arange of values for both p and ¢, after
which the program will automatically fit maximum likelihood ARMA(p, ¢) values
for al p and ¢ in the specified range, and select from these the model with smallest
AICCvaue. Thismay beslow if alargerangeisselected (the maximumrangeisfrom
0 through 27 for both p and ¢), and once the model has been determined, it should
be checked by preliminary estimation followed by maximum likelihood estimation
to minimize the risk of the fitted model corresponding to alocal rather than a global
maximum of the likelihood. (For more details see Appendix D.3.1.)

Confidence Regions for the Coefficients

For large sample size the maximum likelihood estimator Bof B := (¢1,... by,
61, ...,0,) isapproximately normally distributed with mean 3 and covariance ma-
trix [n=V(B)] which can be approximated by 2H~*(3), where H is the Hessian
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matrix [92¢(8)/9B:0p ]]p " 1TSM prints out the approximate standard deviations
and correlations of the coeff|C| ent estimators based on the Hessian matrix evaluated
numerically at 3 unlessthismatrix isnot positive definite, inwhich case | TSM instead
computes the theoretical asymptotic covariance matrix in Section 8.8 of TSTM. The
resulting covariances can be used to compute confidence bounds for the parameters.
Large-Sample Distribution of Maximum Likelihood Estimators:
For alarge sample from an ARMA(p, ¢) process,
BAN(B V().
The genera form of V(3) can be found in TSTM, Section 8.8. The following are
several special cases.
Example 5.2.1  An AR(p) model

The asymptotic covariance matrix in this caseisthe same asthat for the Yule-Walker
estimates given by

V(¢) =oT,%
In the special cases p = 1 and p = 2, we have

AR®) :V(¢) = (1-¢3),

1-¢;  —hu(1+¢2)
AR(2) :V(¢) = 2 . O
@ Ve [—¢1<1+ ) 193
Example 5.2.2  An MA(g) model

Let ry bethecovariancematrix of Y1, .. ., Y,, where{Y,} isthe autoregressive process

with autoregressive polynomial 6(z), i.e.,
Y, +60Y 1+ +6,Y, =Z, {Z}~WN(Q,1).
Then it can be shown that
V(@) =T,
Inspection of the results of Example 5.2.1 and replacement of ¢; by —6,) yields

MA(1) :V(8) = (1-67),

162 1-
MA(2) :V () = [01(1 _922) 915_@?2)}
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Example 5.2.3

Example 5.2.4

Example 5.2.5

An ARMA(T, 1) model
For a causal and invertible ARMA(1,1) process with coefficients ¢ and 6.

1+¢6 [ 1-¢D)A+90) —(1—0)(1—¢? ]

Vi$.0) = [

T (@402 —(1-09)1—-9¢>) (1-6%(1+¢0)

The Dow Jones Ultilities Index

For the Burg and Yule-Walker AR(1) models derived for the differenced and mean-
corrected seriesin Examples5.1.1and 5.1.3, theModel>Estimation>Preliminary
option of ITSM gives—2In(L) = 70.330 for the Burg model and —2In(L) = 70.378
for the Yule-Walker model. Since maximum likelihood estimation attempts to mini-
mize —21In L, the Burg estimate appears to be a slightly better initial estimate of ¢.
We therefore retain the Burg AR(1) model and then select Model>Estimation>Max
Likelihood and click OK. The Burg coefficient estimates provide initial parameter
values to start the search for the minimizing values. The model found on completion
of theminimization is

Y, — 0.4471Y, 1 = Z,, {Z,} ~ WN(0, 0.02117). (5.2.13)

This model is different again from the Burg and Yule-Walker models. It has
—2In(L) = 70.321, corresponding to a dlightly higher likelihood. The standard
error (or estimated standard deviation) of the estimator ¢ is found from the pro-
gram to be 0.1050. Thisisin good agreement with the estimated standard deviation
V(1 — (4471)2)/77 = .1019, based on the large-sampl e approximation given in Ex-
ample 5.2.1. Using the value computed from ITSM, approximate 95% confidence
boundsfor ¢ are 0.4471 + 1.96 x 0.1050 = (0.2413, 0.6529). These are quite close
to the bounds based on the Yule-Walker and Burg estimates found in Examples 5.1.1
and 5.1.3. To find the minimum-AICC model for the series {Y,}, choose the option
Model>Estimation>Autofit. Usingthedefault rangefor both p and g, andclicking
on Start, we quickly find that the minimum AICC ARMA(p, ¢) moddl with p <5
and g < 5isthe AR(1) model defined by (5.2.13). The corresponding AICC valueis
74.483. If we increase the upper limitsfor p and ¢, we obtain the sameresult. O

The lake data

Using the option Mode1>Estimation>Autofit asin the previous example, we find
that the minimum-AlCC ARMA(p, ¢) model for the mean-corrected lake data, X, =
Y, — 9.0041, of Examples5.1.6 and 5.1.7 isthe ARMA(1,1) model

X, — 0.7446X, 1 = Z, + 0.3213Z, 1, {Z) ~ WN(0, 0.4750).  (5.2.14)

The estimated standard deviations of the two coefficient estimates ¢ and 6 are found
from ITSM to be0.0773 and 0.1123, respectively. (The respective estimated standard
deviationsbased on thelarge-sampl e approximation givenin Example5.2.3 are.0788
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and .1119.) The corresponding 95% confidence bounds are therefore
¢ :0.7446 + 1.96 x 0.0773 = (0.5941, 0.8961),

6 :0.3208 £+ 1.96 x 0.1123 = (0.1007, 0.5409).

Thevaue of AICC for thismodel is212.77, improving on the values for the prelim-
inary models of Examples 5.1.4, 5.1.6, and 5.1.7. O

5.3 Diagnostic Checking

Typically, the goodness of fit of a statisticadl model to a set of data is judged by
comparing the observed values with the corresponding predicted values obtained
from the fitted model. If the fitted moddl is appropriate, then the residuals should
behave in amanner that is consistent with the model.

Whenwefitan ARMA(p, ¢) model to agiven serieswe determine the maximum
likelihood estimators ¢, 6, and 62 of the parameters ¢, 6, and o'2. Inthe course of this
procedure the predicted values X, (¢, 8) of X, based on X1, ..., X,_, are computed
for the fitted model. Theresiduals are then defined, in the notation of Section 3.3, by

i, = (X~ % (.0)) / (ra (& a))”, f=1....n (5.3.1)

If wewereto assumethat themaximum likelihood ARMA (p, ¢g) model isthetruepro-
cess generating { X, }, then we could say that {W,} ~ WN (0, 62). However, to check
the appropriateness of an ARMA(p, ¢) model for the data we should assume only
that X4, ..., X, aregenerated by an ARMA(p, ¢g) process with unknown parameters
@, 6, and o2, whose maximum likelihood estimators are ¢, 6, and 62, respectively.
Then it is not true that {W,} is white noise. Nonetheless W,, t = 1, ..., n, should
have properties that are similar to those of the white noise sequence

Wi(, 0) = (X, — X, (¢, 0)) /(ri_1(, 0¥, t=1,....n.

Moreover, W, (¢, 0) approximatesthewhitenoiseterminthedefiningequation (5.1.1)
in the sense that E(W, (¢, 0) — Z,)> - 0ast — oo (TSTM, Section 8.11). Conse-
quently, the properties of the residuals | W, } should reflect those of the white noise
sequence {Z,} generating the underlying ARMA(p, ¢) process. In particular, the se-
quence {W,} should be approximately (i) uncorrelated if {Z,} ~ WN(0, ¢?), (ii)
independent if {Z,} ~ 11D(0, o%), and (iii) normally distributed if Z, ~ N(0, o).

Therescaled residuals R,,r = 1, ..., n, are obtained by dividing the residuals
W,.t =1,...,n, by theestimate 5 = (371 W2)/n of the white noise standard
deviation. Thus,

R, =W,/6. (5.3.2)
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Figure 5-5

The rescaled residuals after
fitting the ARMA(1,1)
model of Example

5.2.5 to the lake data.

If thefitted model isappropriate, the rescaled residual s should have properties similar
to those of a WN(0, 1) sequence or of an iid(0,1) sequence if we make the stronger
assumption that thewhite noise {Z,} driving the ARMA processisindependent white
noise.

The following diagnostic checks are al based on the expected properties of the
residuals or rescaled residuals under the assumption that the fitted model is correct
and that {Z,} ~ 11D(0, 6%). They are the same tests introduced in Section 1.6.

5.3.1 The Graph of {ﬁ’,, t=1,...,n}

If the fitted model is appropriate, then the graph of the rescaled residuals {i{,, =
1,..., n} should resembl e that of awhite noise sequencewithvariance one. Whileitis
difficult toidentify the correlation structure of {R, } (or any time seriesfor that matter)
from its graph, deviations of the mean from zero are sometimes clearly indicated by
atrend or cyclic component and nonconstancy of the variance by fluctuationsin &,
whose magnitude depends strongly on ¢.

The rescaled residuals abtained from the ARMA(1,1) model fitted to the mean-
corrected lake datain Example 5.2.5 are displayed in Figure 5.5. The graph gives no
indication of a nonzero mean or nonconstant variance, so on this basis there is no
reason to doubt the compatibility of R, ..., R, with unit-variance white noise.

The next step is to check that the sample autocorrelation function of {W,} (or
equivalently of { R, }) behaves asit should under the assumption that the fitted model
is appropriate.

100
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Figure 5-6

The sample ACF of
the residuals after
fitting the ARMA(1,1)
model of Example
5.2.5 to the lake data.
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5.3.2 The Sample ACF of the Residuals

We know from Section 1.6 that for large n the sample autocorrelations of aniid se-
guence Yi,...,Y, with finite variance are approximately iid with distribution
N(O, 1/n). We can therefore test whether or not the observed residuals are con-
sistent with iid noise by examining the sample autocorrelations of the residuals and
rejecting the iid noise hypothesis if more than two or three out of 40 fall outside the
bounds +1.96/./n or if one falls far outside the bounds. (As indicated above, our
estimated residuals will not be precisely iid even if the true model generating the
datais as assumed. To correct for this the bounds +1.96/,/» should be modified to
give amore precise test asin Box and Pierce (1970) and TSTM, Section 9.4.) The
sample ACF and PACF of the residuals and the bounds +1.96/./n can be viewed
by pressing the second green button (P1ot ACF/PACF of residuals) at thetop of
the ITSM window. Figure 5.6 shows the sample ACF of the residual s after fitting the
ARMA(1,1) of Example5.2.5 to the lake data. As can be seen from the graph, there
is no cause to reject the fitted model on the basis of these autocorrelations.

5.3.3 Tests for Randomness of the Residuals

The tests (b), (¢), (d), (e), and (f) of Section 1.6 can be carried out using the pro-
gram ITSM by selecting Statistics>Residual Analysis>Tests of Random-
ness.

Applying these tests to the residuals from the ARMA(1,1) modd for the mean-
corrected lake data (Example 5.2.5), and using the default value h = 22 suggested
for the portmanteau tests, we obtain the following results:
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5.4 Forecasting

Example 5.4.1

RANDOMNESS TEST STATISTICS
LJUNG-BOX PORTM. = 10.23 CHISQUR(20) p=.964
MCLEOD-LI PORTM. = 16.55 CHISQUR(22) p=.788
TURNING POINTS = 69 ANORMAL(64.0, 4.14%%2) p=.227
DIFFERENCE-SIGN = 50 ANORMAL(48.5, 2.87**2) p=.602
RANK TEST = 2083 ANORMAL(2376, 488.7**2) p=.072
JARQUE-BERA=.285 CHISQUR(2) p=.867

ORDER OF MIN AICC YW MODEL FOR RESIDUALS = 0

Thistable showsthe observed val ues of the statistics defined in Section 1.6, with each
followed by its large-sample distribution under the null hypothesis of iid residuas,
and the corresponding p-values. The observed values can thus be checked easily
for compatibility with their distributions under the null hypothesis. Since all of the
p-values are greater than .05, none of the test statistics leads us to reject the null
hypothesis at this level. The order of the minimum AICC autoregressive model for
the residuals al'so suggests the compatibility of the residuals with white noise.

A rough check for normality is provided by visua inspection of the histogram
of the rescaled residuals, obtained by selecting the third green button at the top of
the ITSM window. A Gaussian qg-plot of the residuals can a so be plotted by select-
ing Statistics > Residual Analysis > QQ-Plot (normal). No obvious deviation from
normality is apparent in either the histogram or the qg-plot. The Jarque-Bera statis-
tic, n[m3/(6m3) + (ma/m3 — 3)?/24], wherem, = 3 "_,(Y; — Y)"/n, is distributed
asymptoticaly as x2(2) if {¥;} ~ 1ID N(u, o?). This hypothesis is rejected if the
gtatistic is sufficiently large (at level « if the p-vaue of the test is less than «). In
this case the large p-value computed by I TSM provides no evidence for regjecting the
normality hypothesis.

Once amodel has been fitted to the data, forecasting future values of the time series
can becarried out using the method described in Section 3.3. Weillustrate this method
with one of the examples from Section 3.2.

For the overshort data { X, } of Example 3.2.8, selection of the ITSM option Model>
Estimation>Preliminary and the innovations algorithm, followed by Model>
Estimation>Max likelihood, leadsto the maximum likelihood MA(1) model for
{X:}

X, +4.035= 27, — 8187, 1, (Z)~ WN(O, 2040.75). (5.4.1)

To predict the next 7 days of overshorts, we treat (5.4.1) as the true model for the
data, and use the results of Example 3.3.3 with ¢ = 0. From (3.3.11), the predictors
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Table 5.1

are given by

1
Ps7 X570 = —4.035 4 2957+h—1,j <X57+h—j - X57+h—j)
=

{ —4.035 4 0571 (X57 - 5(57) , ifh=1,

—4.035, if h > 1,
with mean squared error

2040.75r57, if h =1,
2040.75(1 + (—.818)%), ifh > 1,

where 6571 and rs; are computed recursively from (3.3.9) with 6 = —.818,

These caculations are performed with ITSM by fitting the maximum likelihood
model (5.4.1), selecting Forecasting>ARMA, and specifying the number of forecasts
required. The 1-step, 2-step, ..., and 7-step forecasts of X, are shown in Table 5.1.
Notice that the predictor of X, for + > 59 is equal to the sample mean, since under
the MA(1) mode {X,, t > 59} isuncorrelated with {X,, t < 57}. O

E(Xs705 — Ps1Xs741)° = {

Assuming that theinnovations{Z,} arenormally distributed, an approximate 95%
prediction interval for X, is given by

—4.0351 £+ 1.96 x 58.3602 = (—118.42, 110.35).

The mean squared errors of prediction, ascomputed in Section 3.3 and the exam-
ple above, are based on the assumption that the fitted model isin fact the true model
for the data. As a result, they do not reflect the variability in the estimation of the
model parameters. Toillustrate this point, supposethedata X4, . . ., X, are generated
from the causal AR(1) model

X, =¢X, 1+ 2Z, ({(Z}~iid(0,0?).
Forecasts of the next 7 observations

of the overshort data of Example
3.2.8 using model (5.4.1).

# XHAT SQRT (MSE) XHAT + MEAN
58 1.0097 45.1753 —3.0254
59 0.0000 58.3602 —4.0351
60 0.0000 58.3602 —4.0351
61 0.0000 58.3602 —4.0351
62 0.0000 58.3602 —4.0351
63 0.0000 58.3602 —4.0351

64 0.0000 58.3602 —4.0351
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If <}> isthe maximum Iikelibood estimate of ¢, basedon X1, ..., X, thenthe one-step
ahead forecast of X, is¢X,,, which has mean squared error

E (x,Hl — &sxn>2 —E ((¢> - ¢3) X, + ZM)2 — E((¢p — D)X+ 0% (5.4.2)

The second eguality followsfrom theindependenceof Z, ., and (¢3 X,,>/. Toevaduate
thefirst termin (5.4.2), first condition on X,, and then use the approximations

E ((¢ -9) |Xn) ~E(6-8) ~(1-99)/m

where the second relation comes from the formula for the asymptotic variance of ¢
given by o?I';* = (1 — ¢?) (see Example 5.2.1). The one-step mean squared error
is then approximated by

E (¢ B &)ZEX,? + o2t (1 _ ¢2) (l . ¢2)_102 + o2 — #02.

Thus, the error in parameter estimation contributestheterm o2 /n to the mean squared
error of prediction. If the sample sizeislarge, thisfactor is negligible, and so for the
purpose of mean squared error computation, the estimated parameters can be treated
as the true model parameters. On the other hand, for small sample sizes, ignoring
parameter variability can lead to a severe underestimate of the actual mean squared

error of the forecast.

5.5 Order Selection

Once the data have been transformed (e.g., by some combination of Box—Cox and
differencing transformations or by removal of trend and seasonal components) to
the point where the transformed series {X,} can potentially be fitted by a zero-mean
ARMA model, we are faced with the problem of selecting appropriate values for the
orders p and q.

It is not advantageous from a forecasting point of view to choose p and ¢ arbi-
trarily large. Fitting avery high order model will generally result in asmall estimated
white noise variance, but when the fitted model is used for forecasting, the mean
squared error of the forecasts will depend not only on the white noise variance of the
fitted model but also on errors arising from estimation of the parameters of the model
(see the paragraphs following Example 5.4.1). These will be larger for higher-order
models. For this reason we need to introduce a “penalty factor” to discourage the
fitting of models with too many parameters.

Many criteriabased on such penalty factors have been proposed in the literature,
since the problem of model selection arises frequently in statistics, particularly in
regression analysis. We shall restrict attention here to a brief discussion of the FPE,
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AIC, and BIC criteria of Akaike and a bias-corrected version of the AIC known as
the AICC.

5.5.1 The FPE Criterion

The FPE criterion was developed by Akaike (1969) to select the appropriate order
of an AR processto fit to atime series { X, ..., X,,}. Instead of trying to choose the
order p to make the estimated white noise variance as small aspossible, theideaisto
choose the model for {X,} in such away as to minimize the one-step mean squared
error when the model fitted to {X,} is used to predict an independent realization {Y,}
of the same process that generated {X,}.

Suppose then that {X4, ..., X,,} isaredization of an AR(p) process with coef-
ficients ¢y, ..., ¢,, p < n,andthat {Y4, ..., Y,} isan independent realization of the
same process. If ¢1, ..., ¢,, are the maximum likelihood estimators of the coeffi-
cientsbased on {X1, ..., X,} and if we use these to compute the one-step predictor
élYn + -4 <§5,,Y,,+1_,, of Y,.1, then the mean square prediction error is

A ~ 2
E(Yoa=di¥a = = dyYassy)
=F [Yn+1 — 1Y, — =P Y1, — (<2>1 - ¢1> Y, —--— (&p - d’p) Yn+lfpi|2
=0’+E [(&p — ¢p>/ [Yn+1—iYn+1—j]5i:1 (QA"p - d’)] )

where ¢, = (¢1,...,4,), ¢, = (5&1, ...,<2>p>/, and o2 is the white noise variance
of the AR(p) model. Writing the last term in the preceding equation as the expecta

tion of the conditional expectation given X4, ..., X,, and using the independence of
{X1,..., X,}and {Y,,...,Y,}, weobtain
R R 2 R / R
E(feamdity =) =0+ [ (3, 0,) 7 (5, )]
where I', = E[an]{szl. We can approximate the last term by assuming that

n=12 (ﬁsp - ¢,,) has its large-sample distribution N(0, o°I", *) from Example 5.21.
Using Problem 5.13, this gives

E(Yia—du¥y = — &me_p)z ~o?(1+2). (55.1)

If 52 isthe maximum likelihood estimator of 2, thenfor largen, n62 /o2 isdistributed
approximately as chi-squared with (n — p) degrees of freedom (see TSTM, Section
8.9). We therefore replace o2 in (5.5.1) by the estimator n62/(n — p) to get the
estimated mean square prediction error of Y, 1,

FPE, — 62" 77, (55.2)
n—p
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Table 5.2 8/% and FPE,, for AR(p) models fitted
to the lake data.
p o? FPE,
0 1.7203  1.7203
1 0.5097  0.5202
2 0.4790  0.4989
3 0.4728  0.5027
4 0.4708  0.5109
5 0.4705  0.5211
6 0.4705  0.5318
7 0.4679  0.5399
8 0.4664  0.5493
9 0.4664  0.5607
10 0.4453  0.5465
To apply the FPE criterion for autoregressive order sel ection we therefore choose
the value of p that minimizes FPE, as defined in (5.5.2).
Example 5.5.1  FPE-based selection of an AR model for the lake data

In Example5.1.4 wefitted AR(2) modelsto the mean-corrected |ake data, the order 2
being suggested by the sample PACF shown in Figure 5.4. To use the FPE criterion to
select p, we have shown in Table 5.2 the values of FPE for values of p from 0 to 10.
Thesevalueswerefound using I TSM by fitting maximum likelihood AR modelswith
the option Model>Estimation>Max likelihood. Also shown in the table are the
values of the maximum likelihood estimates of o2 for the same values of p. Whereas
65 decreases steadily with p, the values of FPE, have a clear minimum at p = 2,
confirming our earlier choice of p = 2 asthe most appropriate for thisdataset. 0O

5.5.2 The AICC Criterion

A more generally applicable criterion for model selection than the FPE is the infor-
mation criterion of Akaike (1973), known as the AIC. This was designed to be an
approximately unbiased estimate of the Kullback—Leibler index of the fitted model
relative to the true model (defined below). Here we use a bias-corrected version of
the AIC, referred to as the AICC, suggested by Hurvich and Tsai (1989).

If X isan n-dimensional random vector whose probability density belongs to
thefamily { /1 (:; ¥), ¥ € W}, the Kullback—L eibler discrepancy between 1 (-; ¢) and
f(-; 0) isdefined as

d(y10) = A(p16) — A019),
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where
A(Y]0) = Eo(=2In f(X; ) = A” =2In(f (X; ¥)) f(X; ) dx

is the Kullback—Leibler index of f(-; ) relativeto f(-; #). (Note that in generd,
A(Y|9) # A(B|¥).) By Jensen’sinequality (see, e.g., Mood et al., 1974),

d(y|0) = A —2In (J;(();ZD £0x: 0) dx

f&xy
> —2In< e 7 0) f(x;0) dx)

= —2In<An SO dx)

=0,

with equality holding if and only if f(x; ¥) = f(X; 6).

Given observations X1, ..., X, of an ARMA process with unknown parameters
6 = (8, 0?), the true model could be identified if it were possible to compute the
Kullback—L eibler discrepancy between all candidate model sand thetruemodel. Since
thisis not possible, we estimate the Kullback—L eibler discrepancies and choose the
model whose estimated discrepancy (or index) is minimum. In order to do this,
we assume that the true model and the alternatives are al Gaussian. Then for any
given 6 = (8, 02), f(-; 6) is the probability density of (Y1, ..., Y,)’, where {Y,} is
aGaussian ARMA(p, q) process with coefficient vector 3 and white noise variance
o2. (The dependence of # on p and g isthrough the dimension of the autoregressive
and moving-average coefficientsin 3.)

Suppose, therefore, that our observations X4, . . ., X, arefromaGaussian ARMA
process with parameter vector 6 = (3, %) and assume for the moment that the true

order is (p, ¢). Let§ = (8, 6?) be the maximum likelihood estimator of 6 based on
Xi1,...,X,andlet Yy, ..., Y, beanindependent reaization of the true process (with
parameter ). Then

—2InLy (,é, &2) — _2InLy (ﬁ, &2) 6725, (ﬁ) —n,

where Ly, Ly, Sx, and Sy are defined asin (5.2.9) and (5.2.11). Hence,

Ey(A(B10)) = Eg 2 (—2'”LY (f” g 2))

— Ep,e (—ZInLX (B, &2)> + Ej o2 (Sy(2ﬁ>) —n. (553
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It can be shown using large-sample approximations (see TSTM, Section 9.3 for
details) that

g (SY <ﬂ>) 2P t+g+Dn

’

62 n—p—q-—2

from which we seethat —2In Ly (8, 62) +2(p + ¢ + Dn/(n — p — g — 2) isan ap-
proximately unbiased estimator of the expected Kullback—Leibler index E, (A (616))
in (5.5.3). Since the preceding cal culations (and the maximum likelihood estimators
3 and 62) are based on the assumption that the true order is (p, q), wetherefore select
the values of p and ¢ for our fitted model to be those that minimize AICC(3), where

AICC(B) == -2InLx(B,Sx(B)/n)+2(p+qg+Ln/n—p—qg—2). (554)
The AlIC statistic, defined as

AIC(B) :==2InLx(8, Sx(B)/n) + 2(p +q + 1),

can be used in the same way. Both AICC(3, o?) and AIC(83, %) can be defined
for arbitrary o2 by replacing Sx (3)/n in the preceding definitions by o2. The value
Sx(B)/n is used in (5.5.4), since AICC(83, o?) (like AIC(3, 0'2)) is minimized for
any given 3 by setting o2 = Sx(3)/n.

For fitting autoregressive models, Monte Carlo studies (Jones, 1975; Shibata,
1976) suggest that the AIC has a tendency to overestimate p. The penalty factors
2p+q+Dn/(n—p—q—2) and 2(p + g + 1) for the AICC and AIC statistics
are asymptotically equivalent asn — oo. The AICC statistic, however, has a more
extreme penalty for large-order models, which counteracts the overfitting tendency
of the AIC. The BIC isanother criterion that attemptsto correct the overfitting nature
of the AIC. For a zero-mean causal invertible ARMA(p, ¢) process, it is defined
(Akaike, 1978) to be

BIC = (n—p—q)ln[n62/(n—p—q)]+n(1+|n«/§)

+(p+q)|n[<ZX,2—n52> /(p+q)}, (5.5.5)
=1

where 62 is the maximum likelihood estimate of the white noise variance.

The BIC is a consistent order-selection criterion in the sense that if the data
{X1,..., X, } arein fact observations of an ARMA(p, ¢g) process, and if p and g are
the estimated orders found by minimizing the BIC, then p — p and § — ¢ with
probability 1 asn — oo (Hannan, 1980). This property is not shared by the AICC or
AIC. On the other hand, order selection by minimization of the AICC, AIC, or FPE
isasymptotically efficient for autoregressive processes, while order selection by BIC
minimization isnot (Shibata, 1980; Hurvich and Tsai, 1989). Efficiency isadesirable



174 Chapter 5

Modeling and Forecasting with ARMA Processes

Example 5.5.2

Problems

property defined in terms of the one-step mean square prediction error achieved by
the fitted model. For more details see TSTM, Section 9.3.

Inthe modeling of real datathereisrarely such athing asthe“true order.” For the
process X, = Zj‘;o V;Z,_; there may be many polynomials 6(z), ¢ (z) such that the
coefficients of z/ in 6(z)/¢(z) closely approximate v; for moderately small values
of j. Correspondingly, there may be many ARMA processes with properties similar
to {X,}. This problem of identifiability becomes much more serious for multivariate
processes. The AICC criterion does, however, provide uswith arational criterion for
choosing among competing models. It has been suggested (Duong, 1984) that models
with AIC values within ¢ of the minimum value should be considered competitive
(with ¢ = 2 as atypical value). Selection from among the competitive models can
then be based on such factors as whiteness of the residuals (Section 5.3) and model
simplicity.

We frequently have occasion, particularly in analyzing seasonal data, to fit
ARMA(p, g) models in which all except m(< p + ¢g) of the coefficients are con-
strained to be zero. In such cases the definition (5.5.4) is replaced by

AICC(B) := —=2InLx (8, Sx(B)/n) + 2(m + Ln/(n —m — 2). (5.5.6)

Models for the lake data

In Example 5.2.4 we found that the minimum-AICC ARMA(p, g) model for
the mean-corrected lake data is the ARMA(L,1) model (5.2.14). For this model
ITSM gives the values AICC = 212.77 and BIC = 216.86. A systematic check
on ARMA(p, g) models for other values of p and g shows that the model (5.2.14)
also minimizes the BIC statistic. The minimum-AICC AR(p) model is found to be
the AR(2) model satisfying

X, — 1.0441X, 1 + .2503X, , = Z,, {Z:) ~ WN(O, 0.4789),
with AICC = 213.54 and BIC = 217.63. Both the AR(2) and ARMA(L,1) models

passthe diagnostic checks of Section 5.3, and in view of the small difference between
the AICC valuesthereis no strong reason to prefer one model or the other. O

5.1. The sunspot numbers {X,,r = 1,..., 100}, filed as SUNSPOTS.TSM, have
sample autocovariances 7 (0) = 1382.2, y (1) = 1114.4, $(2) = 591.73, and
7(3) = 96.216. Use these values to find the Yule-Walker estimates of ¢1, ¢,
and o2 in the model

Y, =¢1Yt71+¢2Yt72+Zh {Zt} ~ WN (0,0'2),
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52

5.3.

5.4.

for the mean-corrected series ¥, = X, — 46.93,r = 1,...,100. Assuming
that the datareally are arealization of an AR(2) process, find 95% confidence
intervalsfor ¢1 and ¢,.

From the information given in the previous problem, use the Durbin-Levinson
algorithm to compute the sample partial autocorrelations ¢11, ¢, and ¢a3 of
the sunspot series. |s the value of ¢33 compatible with the hypothesis that the
data are generated by an AR(2) process? (Use significance level .05.)

Consider the AR(2) process {X,} satisfying
X, — X1 —¢°X,o=Z,, {Z}~WN(0,07).
a. For what values of ¢ isthisacausal process?
b. Thefollowing sample momentswere computed after observing X, . . ., X200:
7(0) =6.06, p(1) = .687.

Find estimates of ¢ and o2 by solving the Yule-Walker equations. (If you
find more than one solution, choose the one that is causal.)

Two hundred observations of atime series, X1, ..., X0, gave the following
sample statistics:

sample mean: X200 = 3.82;

samplevariance: 7 (0) = 1.15;

sample ACF: o) = .427;
0(2) = 475,
0(3) = .169.

a. Based on these sample statistics, is it reasonable to suppose that {X; — u} is
white noise?

b. Assuming that {X; — w} can be modeled as the AR(2) process
X;—p—d1(Xim1— ) — ¢o(Xs2 — ) = Zy,
where {Z,} ~ 11D(0, o), find estimates of 1, ¢1, ¢, and o'2.
¢. Would you conclude that .« = 0?

d. Construct 95% confidence intervalsfor ¢; and ¢».

e. Assuming that the data were generated from an AR(2) model, derive esti-
mates of the PACF for all lagsh > 1.
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5.5.

5.6.

5.7.
5.8.

5.9.

5.10.

Use the program I TSM to simulate and file 20 realizations of length 200 of the
Gaussian MA(1) process

X, =2, +0Z, 1, {Z)~WN(Q,1),

witho = 0.6.
a. For each series find the moment estimate of 6 as defined in Example 5.1.2.

b. For each series use the innovations agorithm in the ITSM option Model>
Estimation>Preliminary to find an estimate of 6. (Use the default value
of the parameter m.) As soon as you have found this preliminary estimate
for aparticular series, select Model>Estimation>Max likelihood tofind
the maximum likelihood estimate of 6 for the series.

¢. Compute the sample means and sample variances of your three sets of esti-
mates.

d. Use the asymptotic formulae given at the end of Section 5.1.1 (withn =
200) to compute the variances of the moment, innovation, and maximum
likelihood estimatorsof 6. Comparewith the corresponding samplevariances
found in (c).

e. What do the results of (c) suggest concerning the relative merits of the three
estimators?

Establish the recursions (5.1.19) and (5.1.20) for the forward and backward
prediction errors u; (r) and v; (¢) in Burg's algorithm.

Derive the recursions for the Burg estimates ¢’ and 0?2,

From theinnovation form of thelikelihood (5.2.9) derivethe equations (5.2.10),
(5.2.11), and (5.2.12) for the maximum likelihood estimators of the parameters
of an ARMA process.

Use equation (5.2.9) to show that for n > p, the likelihood of the observations
{X1,..., X,} of the causal AR(p) process defined by

X, =¢ X1+ +0,X—p+Z,, {Z}~WN(0,0?),

is
L(¢,0%) = (270%)""* (det G,) 2
l n
x exp {_F [X;G;lxp + ) X=X - ¢1’X"”)2} } |
t=p+1

where X, = (X1,...,X,) and G, =0T, =0 2E(X,X).

Use the result of Problem 5.9 to derive a pair of linear equations for the least
squares estimates of ¢, and ¢, for a causal AR(2) process (with mean zero).
Compare your equations with those for the Yule-Walker estimates. (Assume
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that the mean is known to be zero in writing down the latter equations, so that
the sample autocovariances are y (h) = % Z;:lh X, X, forh > 0)

5.11. Given two observations x; and x, from the causal AR(1) process satisfying
X, =¢X, 1+ Z,, {Zr}"’WN (0’02)7

and assuming that |x;1| # |x»|, find the maximum likelihood estimates of ¢
and o2

5.12. Derive a cubic equation for the maximum likelihood estimate of the coefficient
¢ of acausal AR(1) process based on the observations X3, ..., X,.

5.13. Use theresult of Problem A.7 and the approximate large-sample normal distri-
bution of the maximum likelihood estimator ¢, to establish the approximation
(5.5.2).



This page intentionally left blank



Nonstationary and Seasonal
Time Series Models

6.1 ARIMA Models for Nonstationary Time Series
6.2 Identification Techniques

6.3 Unit Roots in Time Series Models

6.4 Forecasting ARIMA Models

6.5 Seasonal ARIMA Models

6.6 Regression with ARMA Errors

In this chapter we shall examine the problem of finding an appropriate model for a
given set of observations{x, .. ., x, } that are not necessarily generated by astationary
time series. If the data (a) exhibit no apparent deviations from stationarity and (b)
have arapidly decreasing autocovariance function, we attempt to fit an ARMA model
to the mean-corrected data using the techniques developed in Chapter 5. Otherwise,
we look first for a transformation of the data that generates a new series with the
properties (a) and (b). This can frequently be achieved by differencing, leading us
to consider the class of ARIMA (autoregressive integrated moving-average) models,
defined in Section 6.1. We have in fact already encountered ARIMA processes. The
model fitted in Example5.1.1 to the Dow Jones Utilities Index was obtained by fitting
an AR model to the differenced data, thereby effectively fitting an ARIMA model to
the original series. In Section 6.1 we shall give a more systematic account of such
models.

In Section 6.2 wediscussthe problem of finding an appropriatetransformationfor
the data and identifying a satisfactory ARMA(p, ¢) model for the transformed data.
The latter can be handled using the techniques developed in Chapter 5. The sample
ACF and PACF and the preliminary estimators ¢,, and 6,, of Section 5.1 can provide
useful guidance in this choice. However, our prime criterion for model sel ection will
be the AICC statistic discussed in Section 5.5.2. To apply this criterion we compute
maximum likelihood estimators of ¢, 8, and o2 for a variety of competing p and ¢
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values and choose the fitted model with smallest AICC value. Other techniques, in
particular those that use the R and S arrays of Gray et al. (1978), are discussed in
the survey of model identification by de Gooijer et al. (1985). If the fitted model is
satisfactory, theresidual s (see Section 5.3) should resemblewhite noise. Testsfor this
were described in Section 5.3 and should be applied to the minimum AICC model
to make sure that the residuals are consistent with their expected behavior under
the model. If they are not, then competing models (models with AICC value close
to the minimum) should be checked until we find one that passes the goodness of
fit tests. In some cases a small difference in AICC value (say less than 2) between
two satisfactory models may be ignored in the interest of model simplicity. In Sec-
tion 6.3 we consider the problem of testing for aunit root of either the autoregressive
or moving-average polynomial. An autoregressive unit root suggests that the data
require differencing, and a moving-average unit root suggests that they have been
overdifferenced. Section 6.4 considers the prediction of ARIMA processes, which
can be carried out using an extension of the techniques developed for ARMA pro-
cesses in Sections 3.3 and 5.4. In Section 6.5 we examine the fitting and prediction
of seasonal ARIMA (SARIMA) models, whose analysis, except for certain aspects
of model identification, is quite analogous to that of ARIMA processes. Finaly, we
consider the problem of regression, allowing for dependence between successive
residuals from the regression. Such models are known as regression models with
time series residuals and often occur in practice as natural representations for data
containing both trend and serially dependent errors.

6.1 ARIMA Models for Nonstationary Time Series

Definition 6.1.1

We have already discussed the importance of the class of ARMA models for repre-
senting stationary series. A generalization of this class, which incorporates a wide
range of nonstationary series, is provided by the ARIMA processes, i.e., processes
that reduce to ARMA processes when differenced finitely many times.

If d is a nonnegative integer, then {X,} is an ARIMA(p,d, q) processif ¥, :=
(1- B)?X, isacausal ARMA(p, q) process.

This definition means that {X,} satisfies a difference equation of the form
¢*(B)X, = ¢(B)(L— B)'X, =0(B)Z,, {Z}~WN(0,0?), (6.1.1)

where ¢ (z) and 6(z) are polynomials of degrees p and g, respectively, and ¢ (z) # 0
for |z| < 1. The polynomia ¢*(z) hasazero of order d at z = 1. The process {X,} is
stationary if and only if 4 = 0, in which case it reducesto an ARMA(p, g) process.

Noticethat if d > 1, wecan add an arbitrary polynomial trend of degree (d — 1) to
{X,} without violating the difference equation (6.1.1). ARIMA models are therefore
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Example 6.1.1

Figure 6-1

200 observations of the
ARIMA(1,1,0) series

X; of Example 6.1.1.

useful for representing data with trend (see Sections 1.5 and 6.2). It should be noted,
however, that ARIMA processes can also be appropriate for modeling series with no
trend. Except when d = 0, the mean of {X,} is not determined by equation (6.1.1),
and it can in particular be zero (as in Example 1.3.3). Since for d > 1, equation
(6.1.1) determines the second-order properties of {(1 — B)?X,} but not those of {X,}
(Problem 6.1), estimation of ¢, 6, and 2 will be based on the observed differences
(1 - B)?X,. Additional assumptions are needed for prediction (see Section 6.4).

{X,} isan ARIMA(1,1,0) processif for some¢ € (-1, 1),
1-¢B)(1—B)X,=Z,, {Z}~WN(0,0?).

We can then write
t
X, =Xo+ ) ¥, t=1,
j=1
where
Yy=(1-B)X, =) ¢'Z;.
=0

A redlization of {X4, ..., Xo00)} With Xo = 0, ¢ = 0.8, and 02 = 1 is shown in
Figure 6.1, with the corresponding sampl e autocorrel ation and partial autocorrelation
functions in Figures 6.2 and 6.3, respectively. O

A digtinctive feature of the data that suggests the appropriateness of an ARIMA
model isthe slowly decaying positive sample autocorrelation function in Figure 6.2.

20

0 50 100 150 200
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Figure 6-2
The sample ACF of the
data in Figure 6.1.

Figure 6-3
The sample PACF of
the data in Figure 6.1.
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If, therefore, we were given only the data and wished to find an appropriate model, it
would be natural to apply the operator V = 1— B repeatedly inthe hopethat for some
7, {V/X,} will have arapidly decaying sample autocorrelation function compatible
withthat of an ARMA processwith no zeros of the autoregressive polynomial near the
unit circle. For this particular time series, one application of the operator V produces
the realization shown in Figure 6.4, whose sample ACF and PACF (Figures 6.5 and
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Figure 6-4

199 observations of the
series Y; = VX, with
{X¢} as in Figure 6.1.

6.6) suggest an AR(1) (or possibly AR(2)) model for {V X, }. Themaximum likelihood
estimates of ¢ and o2 obtained from ITSM under the assumption that £(VX,) =0
(found by not subtracting the mean after differencing the data) are .808 and .978,
respectively, giving the model

(1-0.808B)(1— B)X, = Z,, {Z,} ~WN(0,0.978), (6.1.2)
which bears a close resemblance to the true underlying process,
(1-08B)(1— B)X, =Z,, {Z}~WN(0,1). (6.1.3)

Instead of differencing the seriesin Figure 6.1 we could proceed more directly by
attempting to fit an AR(2) process as suggested by the sample PACF of the original
seriesin Figure 6.3. Maximum likelihood estimation, carried out using ITSM after
fitting a preliminary model with Burg's agorithm and assuming that EX, = 0, gives
the model

(1—-1.808B + 0.811B») X, = (1 — 0.825B)(1 — .983B)X, = Z,,
{Z,} ~ WN(0, 0.970), (6.1.9)

which, although stationary, has coefficients closely resembling those of the true non-
stationary process (6.1.3). (To obtain the model (6.1.4), two optimizations were
carried out using the Model>Estimation>Max likelihood option of ITSM, the
first with the default settings and the second after setting the accuracy parameter to
0.00001.)

From asampleof finitelengthit will be extremely difficult to distinguish between
a nonstationary process such as (6.1.3), for which ¢*(1) = 0, and a process such as
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Figure 6-5
The sample ACF of the
series {Y;} in Figure 6.4.

Figure 6-6
The sample PACF of the
series { Y} in Figure 6.4.
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(6.1.4), which hasvery similar coefficientsbut for which ¢* hasall of its zerosoutside
the unit circle. In either case, however, if it is possible by differencing to generate a
series with rapidly decaying sample ACF, then the differenced data set can be fitted
by alow-order ARMA process whose autoregressive polynomial ¢* has zeros that
are comfortably outside the unit circle. This means that the fitted parameters will
be well away from the boundary of the allowable parameter set. This is desirable
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Figure 6-7

200 observations of

the AR(2) process
defined by (6.1.6) with
r =1.005and w = 7/3.

for numerical computation of parameter estimates and can be quite critical for some
methods of estimation. For example, if we apply the Yule-Walker equationsto fit an
AR(2) model to the datain Figure 6.1, we obtain the model

(1-1.282B + 0.290B*>)X, = Z,, {Z,} ~ WN(0, 6.435), (6.1.5)

which bearslittle resemblance to either the maximum likelihood model (6.1.4) or the
true model (6.1.3). In this case the matrix R, appearing in (5.1.7) is nearly singular.

An obvious limitation in fitting an ARIMA(p, d, q) process {X,} to datais that
{X,} is permitted to be nonstationary only in avery specia way, i.e., by allowing the
polynomial ¢*(B) in the representation ¢*(B) X, = Z, to have a zero of multiplicity
d at the point 1 on the unit circle. Such models are appropriate when the sasmple ACF
isaslowly decaying positive function as in Figure 6.2, since sample autocorrelation
functions of this form are associated with models ¢*(B)X, = 6(B)Z; in which ¢*
has a zero either at or closeto 1.

Sample autocorrelations with slowly decaying oscillatory behavior asin Figure
6.8 are associated with models¢* (B) X, = 8(B)Z, inwhich ¢* hasazero closeto ¢/
for somew € (—x, 7] other than 0. Figure 6.8 isthe sample ACF of the series of 200
observationsin Figure 6.7, obtained from ITSM by simulating the AR(2) process

X, — (2r tcosw)X,_1 +r?X,_, = Z,, {Z,}~WN(Q,1), (6.1.6)
with r = 1.005 and w = /3, i.e,
X, —0.9950X,_; + 0.9901X, , = Z,, {Z,} ~WN(0,1).

10
T

B
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-10
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Figure 6-8
The sample ACF of the
data in Figure 6.7.
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The autocorrelation function of the model (6.1.6) can be derived by noting that

1- (Zr_l COSa)) B+r?B%*= (1 — r_le[“’B) (1 — r_le_i”’B) (6.1.7)
and using (3.2.12). This gives
_, SiN(hw + ¥)
hy=r"———= h>0, 6.1.8
p(h) =r SNy > (6.1.8)
where
2
1
tany = =~ tanw, (6.1.9)
r2—1
It is clear from these equations that
p(h) — cos(hw) asr | 1. (6.1.10)

With r = 1.005 and @ = 7/3 as in the model generating Figure 6.7, the model
ACF (6.1.8) is a damped sine wave with damping ratio 1/1.005 and period 6. These
properties arereflected in the sample ACF shownin Figure 6.8. For values of r closer
to 1, the damping will be even slower asthe model ACF approachesitslimiting form
(6.1.10).

If we were simply given the data shown in Figure 6.7, with no indication of
the model from which it was generated, the slowly damped sinusoidal sample ACF
with period 6 would suggest trying to make the sample ACF decay more rapidly
by applying the operator (6.1.7) with r = 1and v = 7/3,i.e, (1 — B + B?). If it
happens, as in this case, that the period 2 /w is close to some integer s (in this case
6), then the operator 1 — B* can a so be applied to produce a serieswith morerapidly
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6.2

Identification

Figure 6-9

The sample ACF of
(1 — B+ B2)X, with
{X¢} as in Figure 6.7.

decaying autocorrelation function (see also Section 6.5). Figures 6.9 and 6.10 show
the sampl e autocorrel ation functions obtained after applying the operators 1 — B + B2
and 1 — B®, respectively, to the data shown in Figure 6.7. For either one of these two
differenced series, it is then not difficult to fit an ARMA model ¢ (B)X, = 0(B)Z,
for which the zeros of ¢ are well outside the unit circle. Techniques for identifying
and determining such ARMA models have aready been introduced in Chapter 5. For
convenience we shall collect these together in the following sections with a number
of illustrative examples.

Techniques

(a) Preliminary Transformations. The estimation methods of Chapter 5 enable us to
find, for given values of p and ¢, an ARMA(p, ¢g) model to fit agiven series of data.
For this procedure to be meaningful it must be at least plausible that the dataare in
fact arealization of an ARMA process and in particular arealization of a stationary
process. |f the data display characteristics suggesting nonstationarity (e.g., trend and
seasonality), then it may be necessary to make a transformation so as to produce a
new series that is more compatible with the assumption of stationarity.

Deviations from stationarity may be suggested by the graph of the seriesitself or
by the sample autocorrelation function or both.

Inspection of the graph of the series will occasionally reveal a strong depen-
dence of variahility on the level of the series, in which case the data should first be
transformed to reduce or eliminate this dependence. For example, Figure 1.1 shows
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Figure 6-10

The sample ACF

of (1 — B®X; with
{X;} asin Figure 6.7.
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the Australian monthly red wine sales from January 1980 through October 1991,
and Figure 1.17 shows how the increasing variability with sales level is reduced
by taking natural logarithms of the original series. The logarithmic transformation
V, = InU, used hereisin fact appropriate whenever {U,} is a series whose standard
deviation increaseslinearly with the mean. For asystematic account of ageneral class
of variance-stabilizing transformations, we refer the reader to Box and Cox (1964).
The defining equation for the general Box—Cox transformation f; is

AN Ur-1, U =0,1>0,
f/\(Ut) =
InU,, U >0,12=0,

and the program ITSM provides the option (Transform>Box-Cox) of applying f;
(with 0 < A < 1.5) prior to the elimination of trend and/or seasonality from the data.
In practice, if a Box—Cox transformation is necessary, it is often the case that either
fo Or fos isadequate.

Trend and seasonality areusually detected by inspecting the graph of the (possibly
transformed) series. However, they areal so characterized by autocorrel ation functions
that are owly decaying and nearly periodic, respectively. The elimination of trend
and seasonality was discussed in Section 1.5, where we described two methods:

i. “classical decomposition” of the seriesinto atrend component, a seasonal com-
ponent, and a random residual component, and
ii. differencing.
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Figure 6-11

The Australian red
wine data after taking
natural logarithms and
removing a seasonal
component of period
12 and a linear trend.
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The program ITSM (in the Transform option) offers a choice between these tech-
niques. The results of applying methods (i) and (ii) to the transformed red wine data
V; = InU, in Figure 1.17 are shown in Figures 6.11 and 6.12, respectively. Figure
6.11 was obtained from ITSM by estimating and removing from {V,} alinear trend
component and a seasonal component with period 12. Figure 6.12 was obtained by
applying the operator (1 — Blz) to {V;}. Neither of the two resulting series displays
any apparent deviations from stationarity, nor do their sample autocorrelation func-
tions. The sample ACF and PACF of {(1 — B*)V,} are shown in Figures 6.13 and
6.14, respectively.

After the elimination of trend and seasonality, it is still possible that the sample
autocorrelation function may appear to be that of a nonstationary (or nearly nonsta-
tionary) process, in which case further differencing may be carried out.

In Section 1.5 we also mentioned a third possible approach:

iii. fitting a sum of harmonics and a polynomial trend to generate a noise sequence
that consists of the residual s from the regression.

In Section 6.6 we discussthe modificationsto classical |east squaresregression analy-
sisthat allow for dependenceamong theresidual sfromtheregression. Thesemodifica
tionsareimplementedinthe ITSM optionRegression>Estimation>Generalized
LS.

(b) Identification and Estimation. Let{X,} bethemean-corrected transformed
series found as described in (a). The problem now is to find the most satisfactory
ARMA(p, ¢g) model to represent {X,}. If p and ¢ were known in advance, thiswould
be a straightforward application of the estimation techniques described in Chapter 5.
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Figure 6-12

The Australian red
wine data after taking
natural logarithms and
differencing at lag 12.

Figure 6-13
The sample ACF of the
data in Figure 6.12.
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However, thisis usually not the case, so it becomes necessary aso to identify appro-
priate valuesfor p and g.

It might appear at first sight that the higher the values chosen for p and ¢, the
better the resulting fitted model will be. However, as pointed out in Section 5.5,
estimation of too large a number of parameters introduces estimation errors that
adversely affect the use of the fitted model for prediction asillustrated in Section 5.4.
We therefore minimize one of the model selection criteriadiscussed in Section5.5in
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order to choose the values of p and ¢. Each of these criteriaincludes a penalty term
to discourage the fitting of too many parameters. We shall base our choice of p and
g primarily on the minimization of the AICC statistic, defined as

AICC(¢,0) = -2InL(¢,0,5(¢,0)/n) +2(p+qg+Dn/(n—p—q—2), (62.1)

where L(¢, 0, o) isthelikelihood of the dataunder the Gaussian ARMA mode! with
parameters (¢, 0, 02), and S(¢, 0) istheresidual sum of squares definedin (5.2.11).
Once a model has been found that minimizes the AICC value, it is then necessary
to check the model for goodness of fit (essentially by checking that the residuals are
like white noise) as discussed in Section 5.3.

For any fixed values of p and ¢, the maximum likelihood estimates of ¢ and 6
are the values that minimize the AICC. Hence, the minimum AICC model (over any
given range of p and g values) can be found by computing the maximum likelihood
estimators for each fixed p and ¢ and choosing from these the maximum likelihood
model with the smallest value of AICC. This can be done with the program ITSM
by using the option Mode1>Estimation>Autofit. When thisoption is selected and
upper and lower bounds for p and g are specified, the program fits maximum like-
lihood models for each pair (p, ¢) in the range specified and selects the model with
smallest AICC value. If some of the coefficient estimates are small compared with
their estimated standard deviations, maximum likelihood subset models (with those
coefficients set to zero) can also be explored.

The steps in model identification and estimation can be summarized as follows:
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e After transforming the data (if necessary) to make the fitting of an ARMA(p, q)
model reasonable, examine the sasmple ACF and PACF to get someideaof poten-
tial p and g values. Preliminary estimation using the ITSM option Mode1>Esti-
mation>Preliminary isasouseful inthisrespect. Burg'salgorithmwith AICC
minimization rapidly fitsautoregressions of all ordersup to 27 and selectstheone
with minimum AICC value. For preliminary estimation of models with g > 0,
each pair (p, g) must be considered separately.

o Select the option Model>Estimation>Autofit of ITSM. Specify the required
limitsfor p and ¢, and the program will then use maximum likelihood estimation
to find the minimum AICC model with p and ¢ in the range specified.

e Examination of the fitted coefficients and their standard errors may suggest that
some of them can be set to zero. If this is the case, then a subset model can
be fitted by clicking on the button Constrain optimization in the Maximum
Likelihood Estimation diadlog box and setting the selected coefficients to
zero. Optimization will then give the maximum likelihood model with the cho-
sen coefficients constrained to be zero. The constrained model is assessed by
comparing its AICC value with those of the other candidate models.

e Check the candidate model(s) for goodness of fit as described in Section 5.3.
These tests can be performed by selecting the option Statistics>Residual
Analysis.

The Australian red wine data

Let{Xy, ..., X130} denotethe seriesobtained fromthered wine dataof Example 1.1.1
after taking natural logarithms, differencing at lag 12, and subtracting the mean
(0.0681) of the differences. The data prior to mean correction are shown in Fig-
ure 6.12. The sample PACF of {X,}, shown in Figure 6.14, suggests that an AR(12)
model might be appropriate for this series. To explore this possibility we use the
ITSM option Model>Estimation>Preliminary with Burg's algorithm and AICC
minimization. As anticipated, the fitted Burg models do indeed have minimum AICC
when p = 12. The fitted model is

(1—.245B — .069B* — .012B° — .021B* — .200B° + .025B° + .004B’
—.133B% 4 .010B° — .095B™ + .118B™ + .384B)X, = Z,,

with {Z,} ~ WN(O0, 0.0135) and AICC value —158.77. Selecting the option Model>
Estimation>Max likelihood then givesthe maximum likelihood AR(12) model,
whichisvery similar to the Burg model and has Al1CC value-158.87. Inspection of the
standard errors of the coefficient estimators suggeststhe possibility of setting those at
lags 2,3,4,6,7,9,10, and 11 equal to zero. If we do this by clicking on the Constrain
optimization button in the Maximum Likelihood Estimation dialog box and
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then reoptimize, we obtain the model,
(1—.270B — .224B° — .149B° + .099B" + .353B¥)X, = Z,,

with {Z,} ~ WN(0, 0.0138) and AICC value —172.49.

In order to check more general ARMA(p, g) models, select the option Model>
Estimation>Autofit and specify the minimum and maximum vaues of p and
q to be zero and 15, respectively. (The sample ACF and PACF suggest that these
limits should be more than adequate to include the minimum AICC model.) In a
few minutes (depending on the speed of your computer) the program selects an
ARMA(1,12) model with AICC value —172.74, which is dlightly better than the
subset AR(12) model just found. Inspection of the estimated standard deviations of
the MA coefficientsat lags 1, 3, 4, 6, 7, 9, and 11 suggests setting them equal to zero
and reestimating the values of the remaining coefficients. If we do thisby clicking on
the Constrain optimization button in the Maximum Likelihood Estimation
dialog box, setting the required coefficients to zero and then reoptimizing, we obtain
the model,

(1-.286B)X, = (1+ .127B* + .183B° + .177B% + .181B" — .554B%) Z,,

with {Z;} ~ WN(0, 0.0120) and AICC value —184.09.

The subset ARMA(1,12) model easily passes all the goodness of fit tests in the
Statistics>Residual Analysis option. Inview of thisanditssmall AICC value,
we accept it as a plausible model for the transformed red wine series. O

Example 6.2.2  The lake data

Let {Y,,r = 1,...,99} denote the lake data of Example 1.3.5. We have seen al-
ready in Example 5.2.5 that the ITSM option Mode1>Estimation>Autofit gives
the minimum-AlCC model

X, —0.7446X,_, = Z, + 0.3213Z,_1, {Z,} ~ WN(O, 0.4750),

for the mean-corrected series X, = Y, — 9.0041. The corresponding AICC value is
212.77. Sincethemodel passesall the goodness of fit tests, we accept it asareasonable
model for the data. O

6.3 Unit Roots in Time Series Models

The unit root problem in time series arises when either the autoregressive or moving-
average polynomia of an ARMA model has a root on or near the unit circle. A
unit root in either of these polynomials has important implications for modeling.
For example, aroot near 1 of the autoregressive polynomial suggests that the data
should be differenced before fitting an ARMA model, whereas a root near 1 of
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the moving-average polynomial indicates that the data were overdifferenced. In this
section, we consider inference procedures for detecting the presence of aunit root in
the autoregressive and moving-average polynomials.

6.3.1 Unit Roots in Autoregressions

In Section 6.1 we discussed the use of differencing to transform a nonstationary time
serieswith aslowly decaying sample ACF and valuesnear 1 at small lagsinto onewith
arapidly decreasing sample ACF. The degree of differencing of atimeseries{X,} was
largely determined by applying the difference operator repeatedly until the sample
ACFof {V“X,} decaysquickly. Thedifferenced time series could then be model ed by
alow-order ARMA(p, ¢g) process, and hence the resulting ARIMA (p, d, g) model
for the original datahas an autoregressive polynomial (1— ¢z —- - - — ¢,z”)(1—2)¢
(see (6.1.1)) with d roots on the unit circle. In this subsection we discuss a more
systematic approach to testing for the presence of a unit root of the autoregressive
polynomial in order to decide whether or not atime series should be differenced. This
approach was pioneered by Dickey and Fuller (1979).
Let X4, ..., X, beobservations from the AR(1) model

X —p=¢1(X;_1— ) + Z;, {Z,} ~ WN(O’ 02)’ (6.3.1)

where|¢:1| < land u = EX,. For largen, the maximum likelihood estimator 431 of ¢,
isapproximately N(¢1, (1—¢%)/n). For theunit root case, this normal approximation
is no longer applicable, even asymptotically, which precludes its use for testing the
unit root hypothesis Hy : ¢1 = 1vs. H; : ¢1 < 1. To construct atest of Hy, writethe
model (6.3.1) as

VX, =X, — X, 1=¢5 + i X, 1+ Z,, {Z,} ~WN(0,6%), (6.3.2)

where ¢f = (1 — ¢1) and ¢7 = ¢1 — 1. Now let 651‘ be the ordinary least squares
(OLYS) e':*:ti mator of ¢; found by regressing VX, on1and X,_;. Theestimated standard
error of ¢7 is

" —1/2
SE (&;) _s (Z (X1 — 5()2> ,
t=2
R R 2 _

where §2 = ", (VX, — o5 — ¢>IX,,1> /(n — 3) and X is the sample mean of
X1,...,X,_1. Dickey and Fuller derived the limit distribution asn — oo of the
t-ratio

£ =t /SE (@;) (6.3.3)

under the unit root assumption ¢; = 0, from which a test of the null hypothesis
Hy : ¢ = 1canbeconstructed. The.01, .05, and .10 quantilesof thelimit distribution
of 7, (see Table 8.5.2 of Fuller, 1976) are —3.43, —2.86, and —2.57, respectively.
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The augmented Dickey—Fuller test then rejects the null hypothesis of a unit root,
at say, level .05if 7, < —2.86. Notice that the cutoff value for this test statistic is
much smaller than the standard cutoff value of —1.645 obtained from the normal
approximation to the z-distribution, so that the unit root hypothesisis less likely to
be rejected using the correct limit distribution.

The above procedure can be extended to the case where { X, } follows the AR(p)
model with mean u given by

Xi—pn=¢p1(Xeca—p)+-+¢,(X,p — 1) + Z,, {Z,} ~WN (0,057).
This model can be rewritten as (see Problem 6.2)

VX, =g+ 01X 1+ &3 VX a1+ + VX + Zy, (6.3.4)

wherego = (1—pr—---—¢,), ¢5 =2 ¢ —Land gt = =3 . ¢, j =

2, ..., p.If theautoregressive polynomial hasaunit root at 1, then0 = ¢ (1) = —¢7,
and the differenced series {VX,} isan AR(p — 1) process. Consequently, testing the
hypothesis of aunit root at 1 of the autoregressive polynomial is equivalent to testing
¢; = 0. Asinthe AR(1) example, ¢; can be estimated as the coefficient of X,_; in
the OLSregressionof VX, onto 1, X,_1, VX, 1, ..., VX,_ ;1. Forlargen thez-ratio

%, = 91/ (7). (6.35)

where SE (&{) is the estimated standard error of ¢, has the same limit distribution
asthetest statisticin (6.3.3). The augmented Dickey—Fuller test in thiscaseisapplied
in exactly the same manner as for the AR(1) case using the test statistic (6.3.5) and
the cutoff values given above.

Consider testing the time series of Example 6.1.1 (see Figure 6.1) for the presence
of a unit root in the autoregressive operator. The sample PACF in Figure 6.3 sug-
gests fitting an AR(2) or possibly an AR(3) model to the data. Regressing VX, on
1, X,_1,VX,_1,VX, > fort =4,...,200 using OLS gives

VX, =.1503 — .0041X,_1 + .9335VX,_; — .1548VX, , + Z,,
(.1135) (.0028) (.0707) (.0708)

where {Z,} ~ WN(O0, .9639). The test statistic for testing the presence of a unit root
is

. —.0041

%= 008 = 1.464.
Since —1.464 > —2.57, the unit root hypothesis is not rejected at level .10. In
contrast, if we had mistakenly used the ¢-distribution with 193 degrees of freedom as
an approximation to 7,,, then we would have rejected the unit root hypothesis at the

.10level (p-valueis.074). Thet-ratiosfor the other coefficients, ¢§, ¢35, and ¢3, have
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an approximate ¢-distribution with 193 degrees of freedom. Based on these ¢-ratios,
the intercept should be 0, while the coefficient of VX,_, is barely significant. The
evidence is much stronger in favor of aunit root if the analysisis repeated without a
mean term. The fitted model without a mean termis

VX, =.0012X,_; + .9395VX,_ ; — .1585VX, , + Z,,
(.0018) (.0707) (.0709)

where{Z,} ~ WN(0, .9677). The.01, .05, and .10 cutoff valuesfor the corresponding
test statistic when a mean term is excluded from the model are —2.58, —1.95, and
—1.62 (see Table 8.5.2 of Fuller, 1976). In this example, the test stetisticis
—.0012
= —.667
.0018 667,
which is substantially larger than the .10 cutoff value of —1.62. O

T =

Further extensions of the above test to AR models with p = O(n'?) and to
ARMA (p, g) models can be found in Said and Dickey (1984). However, as reported
in Schwert (1987) and Pantula (1991), this test must be used with caution if the
underlying model orders are not correctly specified.

6.3.2 Unit Roots in Moving Averages

A unit root in the moving-average polynomial can have a number of interpretations
depending on the modeling application. For example, let {X,} be acausal and invert-
ible ARMA(p, ¢q) process satisfying the equations

¢(B)X, = 0(B)Z,, {Z,} ~WN (0,057).

Then the differenced series ¥, := VX, isanoninvertible ARMA(p, ¢ + 1) process
with moving-average polynomial 6(z)(1 — z). Conseguently, testing for aunit root in
the moving-average polynomial is equivalent to testing that the time series has been
overdifferenced.

As a second application, it is possible to distinguish between the competing
models

VX, =a+V,
and
X, =cot+ et +-+ ot + W,

where {V;} and {W,} are invertible ARMA processes. For the former model the dif-
ferenced series {V"X ,} has no moving-average unit roots, while for the latter model
{V¥X,} has a multiple moving-average unit root of order k. We can therefore distin-
guish between the two models by using the observed values of {V*X,} to test for the
presence of a moving-average unit root.
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We confineour discussion of unit root teststo first-order moving-average models,
the general case being considerably more complicated and not fully resolved. Let
X1, ..., X, be observations from the MA (1) model

X, =Z +6Z, 1, {Z,} ~1ID(0,07).

Davisand Dunsmuir (1996) showed that under theassumption6 = —1, n(6+1) (0 is
the maximum likelihood estimator) convergesin distribution. A test of Hy : 6 = —1
VS, H; : 6 > —1 can be fashioned on this limiting result by rejecting Hy when

6 > —1+cy/n,

where ¢, isthe (1 — a) quantile of the limit distribution of n(9 + 1). (From Table
3.2 of Davis, Chen, and Dunsmuir (1995), co; = 11.93, cgs = 6.80, and c 19 =
4.90.) In particular, if n = 50, then the null hypothesis is rejected at level .05 if
6 > —1+ 6.80/50 = —.864.

Thelikelihood ratio test can also be used for testing the unit root hypothesis. The
likelihood ratio for this problem is L(—1, S(=1)/n)/L (é, &2), where L (6, 02) is
the Gaussian likelihood of the data based on an MA(1) model, S(—1) is the sum of
squares given by (5.2.11) when 6 = —1, and 6 and 62 are the maximum likelihood
estimators of 6 and o2. The null hypothesisisrejected at level « if

A= =2In (L(_l’ S(—l)/n)) > CLRa

L (é,&2)

where the cutoff value is chosen such that P,—_;[A, > cLre] = «. The limit dis-
tribution of A, was derived by Davis et a. (1995), who also gave selected quantiles
of the limit. It was found that these quantiles provide a good approximation to their
finite-sample counterparts for time series of length n > 50. The limiting quantiles
for An under H, are CLR,.01 = 4.41, CLR,.05 = 1.94, and CLR,.10 = 1.00.

For the overshort data { X, } of Example 3.2.8, the maximum likelihood MA (1) model
for the mean corrected data {Y, = X, + 4.035} was (see Example 5.4.1)

Y, =27,—-0818Z,_1, {Z,} ~WN(0, 2040.75).

Inthestructural formulation of thismodel givenin Example3.2.8, themoving-average
parameter 6 was related to the measurement error variances o and o through the
eguation

2
0 -0

1+62 202402

(These error variances correspond to the daily measured amounts of fuel in the tank
and the daily measured adjustments due to sales and deliveries.) A valueof § = —1
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indicates that there is no appreciable measurement error due to sales and deliver-
ies (i.e., o2 = 0), and hence testing for a unit root in this case is equivaent to
testing that o7 = 0. Assuming that the mean is known, the unit root hypothe-
sisisregected at @ = .05, since —.818 > —1 + 6.80/57 = —.881. The evidence
against Hy is stronger using the likelihood ratio statistic. Using ITSM and entering
the MA(1) model # = —1 and 02 = 2203.12, we find that —2In L(—1, 2203.12) =
604.584, while —2In L(9, 62) = 597.267. Comparing the likelihood ratio statistic
A, = 604.584 — 597.267 = 7.317 with the cutoff value ¢ r o1, We reject Hy at level
a = .01 and conclude that the measurement error associated with salesand deliveries
iS nonzero.

In the above exampleit was assumed that the mean was known. In practice, these
tests should be adjusted for the fact that the mean is also being estimated.

Tanaka (1990) proposed alocally best invariant unbiased (LBIU) test for the unit
root hypothesis. It was found that the LBIU test has dightly greater power than the
likelihood ratiotest for alternativescloseto® = —1 but haslesspower for alternatives
further away from —1 (see Davis et a., 1995). The LBIU test has been extended to
cover more general models by Tanaka (1990) and Tam and Reinsel (1995). Similar
extensions to tests based on the maximum likelihood estimator and the likelihood
ratio statistic have been explored in Davis, Chen, and Dunsmuir (1996). O

6.4 Forecasting ARIMA Models

In this section we demonstrate how the methods of Section 3.3 and 5.4 can be adapted
to forecast the future values of an ARIMA(p, d, ¢) process {X,}. (The required nu-
merical calculations can all be carried out using the program ITSM.)

If d > 1, thefirst and second moments EX; and E(X,,,X,) are hot determined
by the difference equations (6.1.1). We cannot expect, therefore, to determine best
linear predictorsfor {X,} without further assumptions.

For example, suppose that {Y;} is a causal ARMA(p, g) process and that X, is
any random variable. Define

t
X,:XO+ZY_,-, t=1,2....

j=1

Then {X;,t > 0} isan ARIMA(p, 1, q) process with mean EX, = EX, and au-
tocovariances E (X, 1, X,) — (EXo)? that depend on Var(X,) and Cov(Xo, Y;), j =
1,2,.... Thebest linear predictor of X, based on {1, X, X4, ..., X,} isthe same
as the best linear predictor in terms of the set {1, X, Y1, ..., Y,}, since each linear
combination of the latter isalinear combination of the former and vice versa. Hence,
using P, to denote best linear predictor in terms of either set and using the linearity
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of P,, we can write
Pan+l = Pn(X0+ Yl+ et Yn+l) = Pn(Xn + Yn+1) = Xn + PnYn+1-

Toevaluate P, Y, itisnecessary (seeSection 2.5) toknow E (X,Y;), j=1,...,n+1,
and EX%. However, if we assume that Xg is uncorrdlated with {Y,,r > 1}, then
P,Y,,1 isthe same (Problem 6.5) asthe best linear predictor f/,,+1 of Y,,1 interms of
{1, Yy,...,7Y,}, which can be calculated as described in Section 3.3. The assumption
that X, isuncorrelated with Yy, Y», .. . therefore suffices to determine the best linear
predictor P, X, inthis case.

Turning now to the general case, we shall assume that our observed process { X}
satisfies the difference equations

1-B)¥X, =Y, t=12,...,

where {Y,} isacausal ARMA(p, ¢) process, and that the random vector (X, 4, ...,
Xo) isuncorrelated with Y,, ¢+ > 0. The difference equations can be rewritten in the
form

d

X, =Y - (j)(—l)th_,, r=12,.... (6.4.1)

j=1

It is convenient, by relabeling the time axis if necessary, to assume that we observe
X1-4,Xo_yg, ..., X,. (Theobserved values of {Y;} arethen Yy, ..., Y,.) Asusua, we
shall use P, to denote best linear prediction in terms of the observationsup to timer
(inthiscase 1, X1 4, ..., X, orequivdently 1, X1 4, ..., Xo, Y1, ..., Y,).

Our goal is to compute the best linear predictors P, X, . This can be done by
applying the operator P, to each sideof (6.4.1) (withr = n+h) and using thelinearity
of P, toobtan

d

d .
Pan+h = PnYn+h - Z <]>(_1)j PanJrhfj' (642)

j=1

Now the assumptionthat (X;_g4, ..., Xo) isuncorrelated with ¥;, r > 0, enablesusto
identify P,Y, ., withthe best linear predictor of Y, intermsof {1, Y4, ..., Y,}, and
this can be calculated as described in Section 3.3. The predictor P, X, is obtained
directly from (6.4.2) by noting that P, X, 11— ; = X,+1-; for each j > 1. The predictor
P,X,,» can then be found from (6.4.2) using the previously calculated value of
P,X,.1. Thepredictors P, X, 3, P, X, 14, . . . can be computed recursively in the same
way.

To find the mean squared error of prediction it is convenient to express P,Y, .,
intermsof {X;}. For n > 0 we denote the one-step predictors by f/,,+1 = P,Y,.;and
X141 = P,X,41. Then from (6.4.1) and (6.4.2) we have

A A

Xn+1 - Xn+1 = Yn+l - Yn+lv nz= 1,
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and hence from (3.3.12), if n > m = max(p, g) and A > 1, we can write

P q
PnYnJrh = Z¢l Pn Yn+h7i + Z 9n+h71,j (XnJrhfj - Xn+h7j> . (643)
i=1 j=h
Setting ¢*(z) = (1 - 2)"¢(z) = 1— ¢jz —--- — ¢7,,2"™, wefind from (6.4.2) and
(6.4.3) that
ptd q R
PanH—h = Zd’anXrH—h—j + Zen+ll—l,j <Xn+h—j - Xn+h—j) ) (644)
j=1 j=h

which is analogous to the /-step prediction formula (3.3.12) for an ARMA process.
Asin (3.3.13), the mean squared error of the h-step predictor is

_ ; 2
02(h) = E(Xpsn — P Xppn)? = hXi (Xj: Xr9n+h—r—1,j—r> Vnih—j-1, (6.4.5)
=0 \r=0
where g, = 1,
x(2) = i; 12 = =iz — = ¢h 2
and

A

2 . 2
Unth—j-1 = E (Xn+h—j - Xn+h—j) =E (Yn+h—j - Yn+h—j) .

The coefficients x; can be found from the recursions (3.3.14) with ¢7 replacing ¢;.
For large n we can approximate (6.4.5), provided that 6(-) isinvertible, by

h—1
o2(h) = Z w}?gz, (6.4.6)
j=0
where

V() =) ¥ = (") @)
j=0

6.4.1 The Forecast Function

Inspection of equation (6.4.4) shows that for fixed n > m = max(p, ¢q), the h-step
predictors

g(h) = Pan+hv
satisfy the homogeneous linear difference equations

gh) —pigth—1) —---—¢, ,8(h—p—d)=0, h>gq, (6.4.7)
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where ¢;, ..., ¢7,, arethe coefficientsof z, ..., z7*¢ in
" (@) = (1—2)%¢(2).

The solution of (6.4.7) iswell known from the theory of linear difference equations
(see TSTM, Section 3.6). If we assume that the zeros of ¢ (z) (denoted by &1, ..., §,)
are al distinct, then the solution is

gh) =ao+ath+ - +ah" ' +bi&" +- +bE" h>qg—p—d, (648)

where the coefficients ay, ..., a; and by, ..., b, can be determined from the p + d
equations abtained by equating the right-hand side of (6.4.8)forg —p—d <h <gq
with the corresponding value of g(h) computed numericaly (for h < 0, P, X, =
X,an,andforl < h <gq, P, X,, canbecomputed from (6.4.4) asalready described).
Once the constants a; and b; have been evaluated, the algebraic expression (6.4.8)
givesthe predictorsforall h > g — p — d. Inthecase ¢ = 0, the values of g(h) in
theequationsfor ag, ..., aq, b1, ..., b, aesimply the observed values g (h) = X, s,
—p —d < h <0, and the expression (6.4.6) for the mean squared error is exact.

The calculation of the forecast function is easily generalized to deal with more
complicated ARIMA processes. For example, if theobservations X _13, X_15, ..., X,
are differenced at lags 12 and 1, and (1 — B)(1 — B'?)X, is modeled as a causal
invertible ARMA(p, g) process with mean i and max(p, ¢) < n, then {X,} satisfies
an equation of the form

¢(B)[(1— B)(1—B¥)X, —u]l =6(B)Z,, {Z}~WN(0,6%), (6.4.9)
and the forecast function g(h) = P, X, satisfiesthe analogue of (6.4.7), namely,
¢(B)Y(L—B)(L— B®)gh) =¢Dp, h>q. (6.4.10)

To find the general solution of these inhomogeneous linear difference equations, it
suffices (see TSTM, Section 3.6) to find one particular solution of (6.4.10) and then
add to it the general solution of the same equations with the right-hand side set equal
to zero. A particular solution is easily found (by trial and error) to be

wh?

g(h) = z,

and the general solution istherefore

h? 11 . . i
g(h) = §+ao+a1h+zlzcje] /6+b1§lh+...+b[)é§ h
j=

h>qg—p—13 (6.4.11)
(Theterms aqg and aih correspond to the double root z = 1 of the equation ¢ (z)(1 —

2)(1—z*?) = 0, and the subsequent termsto each of the other roots, which we assume
tobedistinct.) For¢g — p—13 < h <0, g(h) = X, ., andfor 1 < h < ¢, thevalues



202

Chapter 6

Nonstationary and Seasonal Time Series Models

Example 6.4.1

of g(h) = P, X, can be determined resursively from the equations
Pan+h =M + annfl + PanfZI.Z - Pan,]_g + PnYn+h7

where {Y,} isthe ARMA process ¥, = (1 — B)(1 — B*?)X, — u. Substituting these
values of g(h) into (6.4.11), we obtain aset of p + 13 equations for the coefficients
a;, b;, and ¢,. Solving these equations then completes the determination of g(4).
The large-sample approximation to the mean squared error is again given by
(6.4.6), with v, redefined as the coefficient of z/ in the power series expansion of

0(2)/[(1—2)(1—z2)¢(2)].
An ARIMA(1,1,0) model

In Example 5.2.4 we found the maximum likelihood AR(1) model for the mean-
corrected differences X, of the Dow Jones Utilities Index (Aug. 28-Dec. 18, 1972).
The model was

X, — 0.4471X, 1 = Z,, {Z,) ~ WN(O, 0.1455), (6.4.12)

where X, = D, — D,_1—0.1336, r =1,...,77,and {D,,t =0,1,2,..., 77} isthe
original series. The model for {D,} isthus

(1 - 0.4471B)[(1 — B)D, — 0.1336] = Z,, {Z,} ~ WN(0, 0.1455).
Therecursions for g(h) therefore take the form
(1—-0.4471B)(1 — B)g(h) = 0.5529 x 0.1336 = 0.07387, h > 0. (6.4.13)
A particular solution of these equationsis g(#) = 0.1336#, so the general solutionis
g(h) = 0.1336h + a + b(44TD)", h > —2. (6.4.14)

Substituting g(—1) = D7 = 122 and g(0) = D7; = 121.23 in the equations with
h=—-1andh = 0, and solving for a and b gives

g(h) = 0.1366h + 120.50 + 0.7331(.4471)".
Setting s = 1and h = 2 gives
Pr;D7g = 120.97 and P7;D79 = 120.94.
From (6.4.5) we find that the corresponding mean squared errors are
0%(1) = v; = 0% = .1455
and
024(2) = vig + ¢Pvy = 0% (1 + 1.4471%) = .4502.

(Notice that the approximation (6.4.6) is exact in this case.) The predictors and their
mean squared errors are easily obtained from the program ITSM by opening the file
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DOWJ.TSM, differencing at lag 1, fitting a preliminary AR(1) model to the mean-
corrected data with Burg's algorithm, and then selecting Mode1l>Estimation>Max
likelihood tofind the maximum likelihood AR(1) model. The predicted values and
their mean squared errors are then found using the option Forecasting>ARMA. [0

6.5 Seasonal ARIMA Models

Definition 6.5.1

We have aready seen how differencing the series {X,} at lag s is a convenient way
of eliminating a seasonal component of period s. If we fit an ARMA(p, g) model
¢(B)Y, = 0(B)Z, to the differenced series ¥, = (1 — B*)X,, then the model for the
origina seriesis¢(B) (1 — B*) X, = 6(B)Z,. Thisis a specia case of the general
seasonal ARIMA (SARIMA) model defined as follows.

If d and D are nonnegative integers, then {X,} is aseasonal ARIMA(p,d,q) x
(P,D, Q), processwith periods if thedifferenced seriesY, = (1—-B)* (1 — B*)"X,
isacausal ARMA process defined by

¢(B)® (B*)Y, = 6(B)® (B*) Z,, {Z,} ~WN (0,07, (6.5.1)

where ¢p(z) = 1 — 1z — - —¢,2?, P(2) = 1 — Pz — -+ — Ppz?, 0(2) =
14+601z4 - +6,z9,andO(z) =1+ O1z+ - - + Opz?.

Remark 1. Notethat the process{Y,}iscausal if andonly if ¢(z) # 0and ®(z) # 0
for |z] < 1. Inapplications D israrely more than one, and P and Q aretypically less
than three. O

Remark 2. The equation (6.5.1) satisfied by the differenced process {Y,} can be
rewritten in the equivalent form

¢*(B)Y, = 0°(B)Z,, (6.5.2)

where ¢*(-), 6*(-) are polynomials of degree p +s P and g + s Q, respectively, whose
coefficients can al be expressed interms of ¢4, ..., ¢,, ®1,..., Pp, 04, ...,6,, and
©1,...,0,. Provided that p < s and g < s, the constraints on the coefficients of
¢*(-) and 6*(-) can all be expressed as multiplicative relations

¢;‘S+j:¢;‘s¢7, i=12...;j=1,...,s =1,
and
Oy =007, i=12..5j=1...,s—1

In Section 1.5 we discussed the classical decomposition model incorporating trend,
seasondlity, and random noise, namely, X, = m, + s, + Y;. In modeling real data
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Example 6.5.1

Example 6.5.2

Example 6.5.3

it might not be reasonable to assume, as in the classical decomposition model, that
the seasonal component s; repeats itself precisely in the same way cycle after cycle.
Seasonal ARIMA models allow for randomness in the seasonal pattern from one
cycleto the next. O

Suppose we have r years of monthly data, which we tabulate as follows:

Year/Month 1 2 .. 12
1 Y1 Y2 e Y]z
2 Y13 Y‘|4 e Y24
3 Yss Yo .. Y36
r Yigt20-1) Yar120—1) e Yiot120-1)

Each columninthistablemay itself beviewed asarealization of atime series. Suppose
that each one of these twelve time series is generated by the same ARMA(P, Q)
model, or more specifically, that the seriescorresponding to the jthmonth, Y15, 1 =
0,...,r — 1, satisfies a difference equation of the form

Yj+12t = (I>1Y_,‘+12(t—1) -+ q)PYi+12(t—P) + Uj+12f (653)
+ ®1Uj+12(z—1) +-+ ®QUJ'+12(’*Q)’

where
{Ujjrz,t =...,—1,0,1,...} ~WN (O, 05) ) (6.5.4)

Then sincethe same ARMA(P, Q) model isassumed to apply to each month, (6.5.3)
holds for each j = 1, ..., 12. (Notice, however, that E(U,U, ;) is not necessarily
zero except when £ is an integer multiple of 12.) We can thus write (6.5.3) in the
compact form

@ (B®) Y, =0 (B®) U, (6.5.5)
where®(z) = 1—®1z—- - —Ppz”’,0(z) = 14+ 012+ -+ 0Opz2,and{U, 12, =
....,=1,0,1,...} ~ WN(0,07) for each j. We refer to the model (6.5.5) as the
between-year model. O

Suppose P =0, Q0 = 1,and ®; = —0.41in (6.5.5). Then the seriesfor any particular
monthisamoving-averageof order 1. If E(U,U,,,) = Ofordl a,i.e., if thewhitenoise
sequences for different months are uncorrelated with each other, then the columns
themselves are uncorrelated. The correlation function for such a processis shown in
Figure 6.15. O

Suppose P = 1, Q = 0, and ®; = 0.7 in (6.5.5). In this case the 12 series (one for
each month) are AR(1) processes that are uncorrelated if the white noise sequences
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3]
<
Figure 6-15 o
The ACF of the model Sl | | | | | |
X, = U, —0.4U,_y 0 10 20 30 40 50 60
of Example 6.5.2. Lag
for different months are uncorrelated. A graph of the autocorrelation function of this
processis shown in Figure 6.16. O
In each of the Examples6.5.1, 6.5.2, and 6.5.3, the 12 series corresponding to the
different months are uncorrelated. To incorporate dependence between these series
L
O
< ‘
Figure 6-16 o
The ACF of the model S . . . . . .
Xe — 0.7 Xi—12 = Uy 0 10 20 30 40 50 60

of Example 6.5.3. Lag
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Example 6.5.4

we alow the process {U,} in (6.5.5) to follow an ARMA(p, ¢g) model,
#(B)U, = 6(B)Z,, {Z,} ~WN (0,05?). (6.5.6)

This assumption implies possible nonzero correlation not only between consecutive
values of U,, but also within the twelve sequences (U412, = ..., —1,0,1, ...},
each of which was assumed to be uncorrelated in the preceding examples. In this
case (6.5.4) may no longer hold; however, the coefficients in (6.5.6) will frequently
have values such that E (U, U,;12,) issmall for j = +1, £2, .. .. Combining the two
models (6.5.5) and (6.5.6) and allowing for possible differencing leads directly to
Definition 6.5.1 of the general SARIMA model as given above.

Thefirst stepsin identifying SARIMA models for a (possibly transformed) data
set areto find d and D so as to make the differenced observations

Y, = (1 - B)d (1 - BS)D Xy

stationary in appearance (see Sections 6.1-6.3). Next we examine the sample ACF
and PACF of {Y,} at lags that are multiples of s for an indication of the orders P and
Q inthe modd (6.5.5). If 5(-) isthe sample ACF of {Y,}, then P and Q should be
chosensuchthat p(ks), k = 1, 2, .. ., iscompatiblewith the ACF of an ARMA(P, Q)
process. The orders p and ¢ are then selected by trying to match p(1), ..., p(s — 1)
withthe ACF of anARMA(p, ¢) process. Ultimately, the AICC criterion (Section 5.5)
and the goodness of fit tests (Section 5.3) are used to select the best SARIMA model
from competing alternatives.

For givenvaluesof p, d, ¢, P, D, and Q, the parameters ¢, 8, ®, ®, and o2 can
be found using the maximum likelihood procedure of Section 5.2. The differences
Y, =@1-B)(1- B")DXt constitute an ARMA(p + s P, g + s Q) processin which
some of the coefficients are zero and the rest are functions of the (p + P + g + Q)-
dimensional vector 3 = (¢’, @', 6', ®'). For any fixed 3 the reduced likelihood ¢(3)
of thedifferences Y, y.sp. . .., Y, iseasily computed asdescribed in Section 5.2. The
maximum likelihood estimator of 3 is the value that minimizes ¢(3), and the maxi-
mum likelihood estimate of o2 isgiven by (5.2.10). The estimates can be found using
the program I TSM by specifying the required multiplicative rel ationships among the
coefficients as given in Remark 2 above.

A more direct approach to modeling the differenced series {Y;} is simply to fit
asubset ARMA model of the form (6.5.2) without making use of the multiplicative
form of ¢*(-) and 6*(-) in (6.5.1).

Monthly accidental deaths

In Figure 1.27 we showed the series { Y, = (1 — B*?)(1 — B)X,} obtained by differ-
encing the accidental deaths series {X,} once at lag 12 and once at lag 1. The sample
ACF of {Y,} isshown in Figure 6.17. O
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Figure 6-17 o
The sample ACF of the S | | |
differenced accidental 0 10 20 30
deaths {VV;,X:}. Lag

The values p(12) = —0.333, p(24) = —0.099, and »(36) = 0.013 suggest a
moving-average of order 1 for the between-year model (i.e, P = 0and Q = 1).
Moreover, inspection of p(1), ..., p(11) suggests that p(1) is the only short-term
correlation different from zero, so we also choose a moving-average of order 1 for
the between-month model (i.e., p = 0 and ¢ = 1). Taking into account the sample
mean (28.831) of the differences {Y,}, we therefore arrive at the model

Y, =28.831+ (1+6:B)(1+ ©:B¥)Z,, {Z}~WN(0,0%), (65.7)

for the series {Y,}. The maximum likelihood estimates of the parameters are obtained
from ITSM by opening the file DEATHS.TSM and proceeding as follows. After
differencing (at lags 1 and 12) and then mean-correcting the data, choose the op-
tion Model>Specify. In the dialog box enter an MA(13) model with 6, = —0.3,
01, = —0.3, 613 = 0.09, and all other coefficients zero. (This corresponds to the
initial guess Y, = (1—0.3B)(1—0.3B"?) Z,.) Then choose Mode1>Estimation>Max
likelihood and click on the button Constrain optimization. Specify the num-
ber of multiplicative relations (one in this case) in the box provided and define the
relationship by entering 1, 12, 13 to indicate that 6; x 61, = 63. Click OK to return
to the Maximum Likelihood dialog box. Click 0K again to obtain the parameter
estimates

6, = — 0.478,
®, = —0.591,
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and
62 = 94255,

with AICC value 855.53. Thecorresponding fitted model for { X, } isthusthe SARIMA
0,1,1) x (0,1, 1)y, process

VViX, = 28.831+ (1 — 0.478B) (1 — 0.588B%) Z,, (6.5.8)

where {Z,} ~ WN(O0, 94390).

If we adopt the alternative approach of fitting a subset ARMA model to {Y,}
without seeking amultiplicative structurefor the operators¢* (B) and6*(B) in(6.5.2),
we begin by fitting a preliminary MA(13) model (as suggested by Figure 6.17) to
the series {Y,}. We then fit a maximum likelihood MA(13) model and examine the
standard errors of the coefficient estimators. This suggests setting the coefficients at
lags2, 3, 8, 10, and 11 equal to zero, since asthese are all lessthan one standard error
from zero. To do this select Mode1>Estimation>Max likelihood and click onthe
button Constrain optimization. Then highlight the coefficients to be set to zero
andclick onthebuttonSet to zero.Click 0K toreturntotheMaximum Likelihood
Estimation dialog box and again to carry out the constrained optimization. The
coefficients that have been set to zero will be held at that value, and the optimization
will bewith respect to theremaining coefficients. Thisgivesamodel with substantially
smaller AICC than the unconstrained MA(13) model. Examining the standard errors
again we see that the coefficients at lags 4, 5, and 7 are promising candidates to be
set to zero, since each of them islessthan one standard error from zero. Setting these
coefficients to zero in the same way and reoptimizing gives a further reduction in
AICC. Setting the coefficient at lag 9 to zero and reoptimizing again gives a further
reduction in AICC (to 855.61) and the fitted model

VVpX, = 28831+ Z, — 0.596Z,_, — 0.407Z,_¢ — 0.685Z,_1, + 0.460Z,_13,

(6.5.9)
{Z,} ~ WN(0, 71240).

The AICC value 855.61 is quite close to the value 855.53 for the moddl (6.5.8). The
residuals from the two models are also very similar, the randomness tests (with the
exception of the difference-sign test) yielding high p-values for both.

6.5.1 Forecasting SARIMA Processes

Forecasting SARIMA processesiscompl etely anal ogousto theforecasting of ARIMA
processes discussed in Section 6.4. Expanding out the operator (1 — B)*(1 — BS)D
in powers of B, rearranging the equation

1-B'1-B)X, =V,
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and setting r = n + h gives the analogue

d+Ds
Xn+h = Ip4p + annJrh,j (6510)
j=1
of equation (6.4.2). Under the assumption that thefirst  + Ds observations X _;_ p,,1,
..., Xo areuncorrelated with {Y,, t > 1}, we can determine the best linear predictors
P, X, Of X, based on {1, X_;_ps+1, ..., X,} by applying P, to each side of
(6.5.10) to obtain

d+Ds
P Xuin = PYoun + Y ajPiXopn ;. (6.5.11)
=1

The first term on the right is just the best linear predictor of the (possibly nonzero-
mean) ARMA process {Y;} interms of {1, Y4, ..., Y, }, which can be calculated as
described in Section 3.3. The predictors P, X, can then be computed recursively
forh=1,2,...from(6.5.11), if wenotethat P, X, 1 ; = X, 41— foreach j > 1.

An argument analogous to the one leading to (6.4.5) gives the prediction mean
squared error as

2
h-1 J
G;lz(h) = E(Xn+h - Pan+h)2 = Z ( XanJrhrl,jr) UnJrhfjfla (6512)
j=0 0

r=l

where6,; and v, areobtained by applying theinnovationsalgorithm to the differenced
series {Y;} and

00 -1
1@ =3 17 =[p@(E)A-2'1-2)"] ", ll<1
r=0
For large n we can approximate (6.5.12), if 6(z)® (z*) isnonzero for all |z| < 1, by
h—1
oi(h) = yio? (6.5.13)
j=0

where

0(2)0 (z*)
P(2)® () (L —2)¢ (1 —z°)”’

lz] < 1.

Y@ =) ¥ =

j=0
Therequired calculationscan al be carried out withthe aid of the program ITSM.
Themean squared errorsare computed from the large-sampl e approximation (6.5.13)
if thefitted model isinvertible. If thefitted model isnot invertible, I TSM computesthe

mean squared errors by converting the model to the equivalent (in terms of Gaussian
likelihood) invertible model and then using (6.5.13).
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Table 6.1

Example 6.5.5

Predicted values of the Accidental Deaths series for t = 73,
..., 78, the standard deviations o; of the prediction errors,
and the corresponding observed values of X; for the same
period.

t 73 74 75 76 77 78
Model (6.5.8)

Predictors 8441 7704 8549 8885 9843 10279
o 308 348 383 415 445 474
Model (6.5.9)

Predictors 8345 7619 8356 8742 9795 10179
o 292 329 366 403 4472 486
Observed values

Xi 7798 7406 8363 8460 9217 9316

Monthly accidental deaths

Continuing with Example 6.5.4, we next use ITSM to predict six future values of
the Accidental Deaths series using the fitted models (6.5.8) and (6.5.9). First fit the
desired model as described in Example 6.5.4 or enter the data and model directly
by opening the file DEATHS.TSM, differencing at lags 12 and 1, subtracting the
mean, and then entering the MA(13) coefficients and white noise variance using
the option Model>Specify. Select Forecasting>ARMA, and you will see the ARMA
Forecast dialog box. Enter 6 for the number of predicted values required. You will
notice that the default options in the dialog box are set to generate predictors of
the original series by reversing the transformations applied to the data. If for some
reason you wish to predict the transformed data, these check marks can be removed.
If you wish to include prediction bounds in the graph of the predictors, check the
appropriate box and specify the desired coefficient (e.g., 95%). Click 0K, and you
will see a graph of the data with the six predicted values appended. For numerical
values of the predictors and prediction bounds, right-click on the graph and then on
Info. The prediction bounds are computed under the assumption that the white noise
sequence in the ARMA model for the transformed datais Gaussian. Table 6.1 shows
the predictors and standard deviations of the prediction errors under both models
(6.5.8) and (6.5.9) for the Accidental Deaths series. O

6.6 Regression with ARMA Errors

6.6.1 OLS and GLS Estimation

In standard linear regression, the errors (or deviations of the observations from the
regression function) are assumed to be independent and identically distributed. In



6.6

Regression with ARMA Errors 211

many applications of regression analysis, however, this assumption is clearly vio-
lated, as can be seen by examination of the residuals from the fitted regression and
their sample autocorrelations. It is often more appropriate to assume that the errors
are observations of a zero-mean second-order stationary process. Since many auto-
correlation functions can be well approximated by the autocorrelation function of a
suitably chosen ARMA(p, g) process, itisof particular interest to consider the model

Y, =XB8+W, t=1,...,n, (6.6.1)
or in matrix notation,

Y=XB+W, (6.6.2)
where Y = (Y4,...,7Y,) isthe vector of observations at timest = 1,...,n, X
is the design matrix whose rth row, X = (x,1, ..., x,), consists of the values of
the explanatory variables at time ¢, B3 = (B1,..., By)’ is the vector of regression
coefficients, and the components of W = (W, ..., W,))’ are values of a causal zero-
mean ARMA((p, q) process satisfying

¢(B)W, = 0(B)Z,, {Z;} ~WN (0,0?). (6.6.3)

The model (6.6.1) arises naturally in trend estimation for time series data. For
example, the explanatory variables x,; = 1, x,» = ¢, and x,3 = t? can be used to
estimate aquadratic trend, andthevariablesx;; = 1, x;» = cos(wt), and x,3 = Sin(wt)
can be used to estimate a sinusoidal trend with frequency ». The columns of X are
not necessarily simple functions of  asin these two examples. Any specified column
of relevant variables, e.g., temperatures at timest = 1, . .., n, can beincluded in the
design matrix X, in which case the regression is conditional on the observed values
of the variables included in the matrix.

The ordinary least squares (OLS) estimator of 3 is the value, BOLS, which
minimizes the sum of squares

n

Y —XB' (Y -xB) =) (¥, - x8)".
t=1
Equating to zero the partial derivatives with respect to each component of 3 and
assuming (as we shall) that X’X is nonsingular, we find that

BoLs = (X'X)7'X'Y. (6.6.4)

(If X’X is singular, Bo.s is not uniquely determined but still satisfies (6.6.4) with
(X'X)~! any generalized inverse of X'X.) The OLS estimate also maximizes the
likelihood of the observations when the errors Wy, ..., W, areiid and Gaussian. If
the design matrix X is nonrandom, then even when the errors are non-Gaussian and
dependent, the OLS estimator is unbiased (i.e., E(BOLS) = () and its covariance
matrix is

Cov(Bors) = (X'X) " X'T,X (X'X) ", (6.6.5)
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whereT, = E(WW') isthe covariance matrix of W.

The generalized least squares (GLS) estimator of 3 is the value 3¢.s that
minimizes the weighted sum of squares

(Y -XB) T, (Y - XPB). (6.6.6)

Differentiating partially with respect to each component of 3 and setting the deriva-
tives equal to zero, we find that

Bois = (XT,ZlX)_l X'T, Y. (6.6.7)

If thedesignmatrix X isnonrandom, the GL Sestimator i sunbiased and hascovariance
matrix

Cov (Bers) = (X'T,2x) ™" (6.6.8)

It can be shown that the GL S estimator isthe best linear unbiased estimator of 3, i.e.,
for any k-dimensional vector ¢ and for any unbiased estimator 3 of 3 that isalinear
function of the observations Y1, ..., Y,,

Var (c’BGLS) < Var (c’B) .
In this sense the GL S estimator is therefore superior to the OL S estimator. However,
it can be computed only if ¢ and 8 are known.
Let V (¢, 6) denote the matrix o —°T", and let T (¢, 8) be any square root of V1

(i.e., amatrix suchthat 7'T = vV ~1). Then we can multiply each side of (6.6.2) by T
to obtain

TY =TXB+TW, (6.6.9)

aregression equation with coefficient vector 3, data vector TY, design matrix T' X,
and error vector TW. Since the latter has uncorrelated, zero-mean components, each
with variance o2, the best linear estimator of 3 intermsof TY (whichisclearly the
same as the best linear estimator of 3 intermsof Y, i.e, ﬁGLs) can be obtained by
applying OL S estimation to the transformed regression equation (6.6.9). This gives

Bos = (X'T'TX) ' X'T'TY, (6.6.10)

which is clearly the same as (6.6.7). Cochrane and Orcutt (1949) pointed out that if
{W,} isan AR(p) process satisfying

¢BYW, = Z;, {Z;} ~WN (0’02),

then application of ¢ (B) to each side of the regression equations (6.6.1) transforms
them into regression equations with uncorrelated, zero-mean, constant-variance er-
rors, so that ordinary least squares can again be used to compute best linear unbiased
estimates of the components of 3 interms of Y* = ¢(B)Y,, t = p+ 1,...,n.
This approach eliminates the need to compute the matrix 7 but suffers from the
drawback that Y* does not contain all the information in Y. Cochrane and Orcutt’s
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transformation can be improved, and at the same generalized to ARMA errors, as
follows.

Instead of applying the operator ¢ (B) to each side of the regression equations
(6.6.1), we multiply each side of equation (6.6.2) by the matrix T (¢, 8) that maps
{W,} into the residuals (see (5.3.1)) of {W,} from the ARMA mode (6.6.3). We
have already seen how to cal culate these residual s using the innovations algorithmin
Section 3.3. To seethat T isa square root of the matrix V as defined in the previous
paragraph, we simply recall that the residuals are uncorrelated with zero mean and
variance o2, so that

Cov(TW) =TT,T' =0o?I,
where I isthen x n identity matrix. Hence
T'T =o' =V

GL S estimation of (3 can therefore be carried out by multiplying each side of (6.6.2)
by T and applying ordinary least squares to the transformed regression model. It
remainsonly tocompute 7Y and T X.

Any datavectord = (di, ..., d,)’ can beleft-multiplied by T simply by reading
it into ITSM, entering the model (6.6.3), and pressing the green button |abeled RES,
which plots the residuals. (The calculations are performed using the innovations
algorithm as described in Section 3.3.) The GLS estimator BGLS is computed as
follows. The data vector Y is left-multiplied by T to generate the transformed data
vector Y*, and each column of the design matrix X isleft-multiplied by T to generate
the corresponding column of the transformed design matrix X*. Then

BoLs = (X7 x7) T x¥Y*, (6.6.12)

The calculations of Y*, X*, and hence of BGLS, are al carried out by the program
ITSM inthe option Regression>Estimation>Generalized LS.

6.6.2 ML Estimation

If (asis usualy the case) the parameters of the ARMA(p, ¢) model for the errors
are unknown, they can be estimated together with the regression coefficients by
maximizing the Gaussian likelihood

L(B,¢.0,0%) = (27)"/*(detT,) 2 exp {—%(Y - XB) T MY - Xﬁ)} :

where T, (¢, 8, o?) is the covariance matrix of W = Y — X3. Since {W,} is an
ARMA (p, ¢) processwith parameters (¢, 6, o-2), themaximum likelihood estimators
3, &, and 6 are found (asin Section 5.2) by minimizing

n

0B, ¢.0)=In(n'S(B.$.0)) +n") Inr_y, (6.6.12)

=1
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where

n A \2
S(B,¢,0) = Z <Wr - Wr) [Ti-1,
=1
W, is the best one-step predictor of W,, and r,_;02 is its mean squared error. The
function £(3, ¢, 0) can be expressed in terms of the observations{Y,} and the param-
eters 3, ¢, and @ using the innovations algorithm (see Section 3.3) and minimized
numerically to give the maximum likelihood estimators, 3, ¢, and 6. The maximum

likelihood estimator of o2 isthen given, asin Section 5.2, by & _S(ﬁ, o, 0) /n.

An extension of aniterative scheme, proposed by Cochrane and Orcutt (1949) for
thecaseq = 0, simplifiestheminimization considerably. Itisbased ontheobservation
that for fixed ¢ and 6, the value of 3 that minimizes £(3, ¢, 0) isBGLS(qb, 0), which
can be computed algebraically from (6.6.11) instead of by searching numerically for
the minimizing value. The scheme is as follows.

(i) Compute BoLs and the estimated residuals ¥, — X/Bors, t=1,....n

(i) Fit an ARMA(p.q) model by maximum Gaussian likelihood to the estimated
residuals.

(iii) For the fited ARMA model compute the corresponding estimator 3g.s from
(6.6.112).

(iv) Compute the residuas Y, — x;BGLS, t =1,...,n,and return to (ii), stopping
when the estimators have stabilized.

If {w,} isacausa and invertible ARMA process, then under mild conditions
on the explanatory variables x;, the maximum likelihood estimates are asymptoti-
cally multivariate normal (see Fuller, 1976). In addition, the estimated regression
coefficients are asymptotically independent of the estimated ARMA parameters.

Thelarge-sample covariance matrix of the ARMA parameter estimators, suitably
normalized, has acomplicated form that involves both the regression variables x, and
the covariance function of {W,}. It is therefore convenient to estimate the covari-
ance matrix as —H 1, where H isthe Hessian matrix of the observed log-likelihood
evaluated at its maximum.

TheOLS, GL S, and maximum likelihood estimators of the regression coefficients
all have the same asymptotic covariance matrix, so in this sense the dependence does
not play amajor role. However, the asymptotic covariance of both the OLSand GL S
estimatorscan bevery inaccurateif the appropriate covariance matrix I',, isnot usedin
the expressions (6.6.5) and (6.6.8). Thispoint isillustrated in the following examples.

Remark 1. The use of theinnovations algorithm for GLS and ML estimation extends
to regression with ARIMA errors (see Example 6.6.3 below) and FARIMA errors
(FARIMA processes are defined in Section 10.5).
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Example 6.6.1

Example 6.6.2

The overshort data

The analysis of the overshort datain Example 3.2.8 suggested the model
= ﬁ + W[ ’

where —g isinterpreted as the daily leakage from the underground storage tank and
{W,} isthe MA(1) process

W, =2, +6Z_1, {Z}~WN(0,0?).

(Herek = 1 and x, = 1) The OLS estimate of g is simply the sample mean
ﬂOLs = Y, = —4.035. Under the assumption that {W,} is iid noise, the estimated
variance of the OL Sestimator of 8 isy, (0)/57 = 59.92. However, sincethisestimate
of the variance fails to take dependence into account, it is not reliable.

To find maximum Gaussian likelihood estimates of 8 and the parameters of {W,}
using ITSM, openthe file OSHORTS.TSM, select the option Regression>Specify
and check the box marked Include intercept term only. Then press the blue
GLS button and you will see the estimated value of 8. (Thisis in fact the same
as the OLS estimator since the default model in ITSM is WN(0,1).) Then select
Model>Estimation>Autofit and pressStart. The autofit option selects the mini-
mum AICC modd for the residuals,

W, = Z, — 8187, 1, {Z:} ~ WN(0, 2041), (6.6.13)

and displays the estimated MA coefficient 6> = —.818 and the corresponding GLS
estimate BS)s = —4.745, with a standard error of 1.188, in the Regression esti-
mates window. (If we reestimate the variance of the OLS estimator, using (6.6.5)
with I's; computed from the model (6.6.13), we obtain the value 2.214, adrastic re-
duction from the value 59.92 obtained when dependenceisignored. For a positively
correlated time series, ignoring the dependence would lead to underestimation of the
variance.)

Pressing the blue MLE button will reestimatethe MA parameters using theresid-
uals from the updated regression and at the same time reestimate the regression
coefficient, printing the new parameters in the Regression estimates wWindow.
After this operation has been repeated several times, the parameterswill stabilize, as
shownin Table 6.2. Estimated 95% confidence bounds for g using the GL S estimate
are —4.75 + 1.96(1.408)Y/2 = (—7.07, —2.43), strongly suggesting that the storage
tank has aleak. Such a conclusion would not have been reached without taking into
account the dependence in the data. O

The lake data

In Examples 5.2.4 and 5.5.2 we found maximum likelihood ARMA(1,1) and AR(2)
models for the mean-corrected lake data. Now let us consider fitting a linear trend
to the data with AR(2) noise. The choice of an AR(2) model was suggested by an
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Table 6.2

Estimates of B and 6; for the
overshort data of Example 6.6.1.

Iteration i 6o BY
0 0 —4.035
1 —.818 —4.745
2 —.848 —4.780
3 —.848 —4.780

analysis of the residuals obtained after removing a linear trend from the data using
OLS. Our model now takes the form

Y, =Bo+ Bt + W,
where {W,} isthe AR(2) process satisfying

W, = ¢p1W,_1 + ¢2Wio + Zi, {Z,} ~WN(0,07).
From Example 1.3.5, wefind that the OL Sestimate of 3 isBOLS = (10.202, —.0242)'.
If weignorethe correlation structure of the noise, the estimated covariance matrix T',,

of Wisy (0)7 (wherel istheidentity matrix). Thecorresponding estimated covariance
matrix of Bo s is (from (6.6.5))

not 07203 —.00110
WO (X'X) =0 , =t :[_"00110 _.60002 } (6.6.14)

Dot ;tz

=1

1

However, the estimated model for the noise process, found by fitting an AR(2) model
to theresiduals Y, — 35, s, IS

W, = 1.008W,_; — .295W,_, + Z,, {Z,} ~ WN(O, .4571).
Assuming that this is the true model for {W,}, the GLS estimate is found to be

(10.091, —.0216)’, in close agreement with the OL S estimate. The estimated covari-
ance matrices for the OLS and GL S estimates are given by

. [ 22177 —.00335]
Cov (fots) = | 00335 .00007 |
and
. [ 21392 —.00321]

Cov (Bets) = | 00321 00006 |

Notice how the estimated variances of the OLS and GL S estimators are nearly three
times the magnitude of the corresponding variance estimates of the OLS calculated




6.6

Regression with ARMA Errors 217

Example 6.6.3

Table 6.3

under the independence assumption (see (6.6.8)). Estimated 95% confidence bounds
for the slope B, using the GL S estimate are —.0216 + 1.96(.00006)/? = —.0216 +
.0048, indicating asignificant decreasing trend in the level of Lake Huron during the
years 1875-1972.

The iterative procedure described above was used to produce maximum like-
lihood estimates of the parameters. The calculations using ITSM are analogous to
thosein Example 6.6.1. The results from each iteration are summarized in Table 6.3.
Asin Example 6.6.1, the convergence of the estimatesis very rapid. O

Seat-belt legislation; SBL.TSM

Figure 6.18 shows the numbers of monthly deaths and serious injuries ¥,, ¢t =
1,...,120, on UK roads for 10 years beginning in January 1975. They are filed
as SBL.TSM. Seat-belt legislation was introduced in February 1983 in the hope of
reducing the mean number of monthly “deaths and serious injuries,” (from ¢ = 99
onwards). In order to study whether or not there was a drop in mean from that time
onwards, we consider the regression,

Y,=a+bf()+ W, t=1...,120, (6.6.15)

where f, = 0for1 < r < 98, and f;, = 1for+ > 99. The seat-belt legislation
will be considered effective if the estimated value of the regression coefficient b
is significantly negative. This problem also falls under the heading of intervention
analysis (see Section 10.2).

OLS regression based on the model (6.6.15) suggests that the error sequence
{W,} is highly correlated with a strong seasonal component of period 12. (To do the
regression using ITSM proceed as follows. Open the file SBL.TSM, select Regres-
sion>Specify, check only Include intercept term and Include auxiliary
variables, presstheBrowse button, and select thefile SBLIN.TSM, which contains
the function £, of (6.6.15) and enter 1 for the number of columns. Then select Re-
gression>Estimation>Generalized LS. The estimates of the coefficients ¢ and
b are displayed in the Regression estimates window, and the data become the

Estimates of 3 and ¢ for the lake data
after 3 iterations.

Iteration i é&ﬁ’) 125(2’) Bﬁ" ”2"
0 0 0 10.20 —.0242
1 1.008 —-.295 10.09 -—-.0216

2 1.005 —-.291 10.09 -.0216
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Figure 6-18

Monthly deaths and serious
injuries {Y;} on UK roads,
Jan., 75 - Dec., '84.

estimates of the residuals {W,}.) The graphs of the data and sample ACF clearly sug-
gest a strong seasonal component with period 12. In order to transform the model
(6.6.15) into one with stationary residuals, we therefore consider the differenced data
X, =Y, — Y,_1p, which satisfy

X, =bg +N,, t =13, ...,120, (6.6.16)

where g, = 1for 99 < r < 110, g, = O otherwise, and {N, = W, — W,_p,} isa
stationary sequence to be represented by a suitably chosen ARMA model. The series
{X,} is contained in the file SBLD.TSM, and the function g, is contained in the file
SBLDIN.TSM.

Thenext stepisto perform ordinary least squaresregression of X, on g, following
steps analogous to those of the previous paragraph (but this thime checking only the
box marked Include auxiliary variables in the Regression Trend Func-
tion dialog box) and again using the option Regression>Estimation>General-
ized LS or pressing the blue GL S button. The model

X, = —346.92¢, + N,, (6.6.17)

isthen displayed intheRegression estimates window together with the assumed
noise model (white noise in this case). Inspection of the sample ACF of theresiduals
suggests an MA(13) or AR(13) model for {N,}. Fitting AR and MA models of order
up to 13 (with no mean-correction) using the option Model>Estimation>Autofit
givesan MA(12) model asthe minimum AICC fit for the residuals. Once this model
has been fitted, the model in the Regression estimates window is automatically
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(thousands)
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Problems

Figure 6-19

The differenced deaths and
serious injuries on UK
roads {X; = Y; — Yi_12},
showing the fitted

GLS regression line.

updated to
X, = —328.45¢, + N,, (6.6.18)

with thefitted MA(12) model for the residuals also displayed. After severa iterations
(each iteration is performed by pressing the MLE button) we arrive at the model

X, = —328.45g, + N,, (6.6.19)
with

N, =Z7,+.2197Z, 1+ .098Z; ,+.031Z, 3+ .064Z,_4+ .069Z; 5+ .111Z, ¢

+.081Z, 7+ .057Z, g+ .092Z, g — .028Z,_10 + .183Z,_11 — .627Z,_12,

where {Z,} ~ WN(0, 12, 581). The estimated standard deviation of the regression
coefficient estimator is 49.41, so the estimated coefficient, —328.45, is very signifi-
cantly negative, indicating the effectiveness of the legislation. The differenced data
are shown in Figure 6.19 with the fitted regression function. O

6.1. Supposethat {X,}isan ARIMA(p, d, q) process satisfying the difference equa-
tions

¢(B)L1— B)'X, =0(B)Z,, {Z:}~WN(0,0?).

200
T

200
T
13
————

-400

-600

1 1 1 1 1 1 1 1 1 1
1976 1977 1978 1979 1980 1981 1982 1983 1984 1985
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6.2.
6.3.

6.4.

6.5.

6.6.

6.7.

6.8.

Show that these difference equations are also satisfied by the process W, =
X, + Ao+ Agt + - + Ay_1t47L, where Ao, ..., Ay, are arbitrary random
variables.

Verify the representation given in (6.3.4).

Test the datain Example 6.3.1 for the presence of aunit root in an AR(2) model
using the augmented Dickey—Fuller test.

Apply the augmented Dickey—Fuller test to the levels of Lake Huron data
(LAKE.TSM). Perform two analyses assuming AR(1) and AR(2) models.

If {Y;}isacausal ARMA process(with zero mean) andif X, isarandomvariable
with finite second moment such that X, is uncorrelated with Y, for each r =
1,2, ..., show that the best linear predictor of Y, intermsof 1, X, Y1, ..., 7,
isthe same asthe best linear predictor of Y,,; intermsof 1, Yy, ..., Y,.

Let {X,} bethe ARIMA(2,1,0) process satisfying
(1-0.8B+0.25B*) VX, = Z,, {Z,}~WN(O,1).

a. Determine the forecast function g(4) = P,X,,, forh > 0.
b. Assuming that n islarge, compute o ?(h) forh = 1,...,5.

Use a text editor to create a new data set ASHORT.TSM that consists of the
datain AIRPASS.TSM with thelast twelve values deleted. Use I TSM tofind an
ARIMA model for the logarithms of the datain ASHORT.TSM. Your analysis
should include

a. alogical explanation of the steps taken to find the chosen model,
b. approximate 95% bounds for the components of ¢ and 6,

c. an examination of the residuals to check for whiteness as described in Sec-
tion 1.6,

d. agraph of the series ASHORT.TSM showing forecasts of the next 12 values
and 95% prediction bounds for the forecasts,

e. numerical values for the 12-step ahead forecast and the corresponding 95%
prediction bounds,

f. atable of the actual forecast errors, i.e., the true value (deleted from AIR-

PASS. TSM) minus the forecast value, for each of the twelve forecasts.
Does the last value of AIRPASS. TSM lie within the corresponding 95% pre-
diction bounds?

Repeat Problem 6.7, but instead of differencing, apply the classical decomposi-
tion method to the logarithms of the datain ASHORT.TSM by deseasonalizing,
subtracting a quadratic trend, and then finding an appropriate ARMA model
for the residuals. Compare the twelve forecast errors found from this approach
with those found in Problem 6.7.
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6.9.

6.10.

6.11.

6.12.
6.13.

Repeat Problem 6.7 for the series BEER.TSM, deleting the last twelve values
to create afile named BSHORT.TSM.

Repeat Problem 6.8 for the series BEER.TSM and the shortened series
BSHORT.TSM.

A timeseries {X,} isdifferenced at lag 12, then at lag 1 to produce a zero-mean
series {Y,} with the following sample ACF:

p(12)) ~ (.8)/, j=0,41,+2 ...,
p(12j £ 1) ~ (4)(.8)/, j=0+142 ...,
o(h) ~ 0, otherwise,
and y(0) = 25.
a. Suggest aSARIMA model for {X,} specifying all parameters.

b. For large n, express the one- and twelve-step linear predictors P, X,,; and
P X, ppintermsof X,, r = -12, 11, ...,n,and Y, - Y,, t =1,...,n.

c. Find the mean squared errors of the predictorsin (b).
Use ITSM to verify the calculations of Examples 6.6.1, 6.6.2, and 6.6.3.

The file TUNDRA.TSM contains the average maximum temperature over the
month of February for the years 1895-1993 in an area of the USA whose vege-
tation is characterized as tundra.

a. Fitastraight lineto the datausing OLS. |Isthe slope of the line significantly
different from zero?

b. Find an appropriate ARMA model to the residuals from the OLSfit in (a).

c. Cdculate the MLE estimates of the intercept and the slope of the line and
the ARMA parametersin (a). Is the slope of the line significantly different
from zero?

d. Use your model to forcast the average maximum temperature for the years
1994 to 2004.
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Multivariate Time Series

7.1 Examples

7.2 Second-Order Properties of Multivariate Time Series

7.3 Estimation of the Mean and Covariance Function

7.4 Multivariate ARMA Processes

7.5 Best Linear Predictors of Second-Order Random Vectors
7.6 Modeling and Forecasting with Multivariate AR Processes
7.7 Cointegration

Many timeseriesarisingin practicearebest considered ascomponents of somevector-
valued (multivariate) time series {X,} having not only serial dependence within each
component series {X,;} but aso interdependence between the different component
series{X,;} and {X,;}, i # j. Much of the theory of univariate time series extends in
a natural way to the multivariate case; however, new problems arise. In this chapter
weintroduce the basic properties of multivariate series and consider the multivariate
extensions of some of the techniques developed earlier. In Section 7.1 we introduce
two sets of bivariate time series data for which we develop multivariate models later
in the chapter. In Section 7.2 we discuss the basic properties of stationary multi-
variate time series, namely, the mean vector . = EX, and the covariance matrices
[(h) = EX0 X)) — pp/, h =0, £1, £2, . . ., with reference to some simple exam-
ples, including multivariate white noise. Section 7.3 deals with estimation of p and
['(-) and the question of testing for serial independence on the basis of observations of
X1, ..., X,.In Section 7.4 we introduce multivariate ARMA processes and illustrate
the problem of multivariate model identification with an example of a multivariate
AR(1) processthat also hasan MA(1) representation. (Such examples do not exist in
the univariate case.) Theidentification problem can be avoided by confining attention
to multivariate autoregressive (or VAR) models. Forecasting multivariate time series
with known second-order properties is discussed in Section 7.5, and in Section 7.6
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7.1

Examples

we consider the modeling and forecasting of multivariate time series using the multi-
variate Yule-Walker equations and Whittle's generalization of the Durbin-Levinson
algorithm. Section 7.7 contains a brief introduction to the notion of cointegrated time
series.

In this section we introduce two examples of bivariate time series. A bivariate time
seriesis a series of two-dimensional vectors (X,1, X,,)’ observed at times ¢ (usually
t =1,23,...). Thetwo component series {X;1} and {X,»} could be studied inde-
pendently as univariate time series, each characterized, from a second-order point
of view, by its own mean and autocovariance function. Such an approach, however,
failsto takeinto account possible dependence between the two component series, and
such cross-dependence may be of great importance, for examplein predicting future
values of the two component series.

We therefore consider the series of random vectors X, = (X,1, X,»)" and define
the mean vector

. | EXn
u, = EX, = |:EX,2:|

and covariance matrices

Lt +h, 1) == Cov(X,pp, X;) = |:C0V(Xz+h,1, X)) cov(X;in1, th)} '

COV( X 4n,2, X11)  COV(X,yn 2, Xi2)

The bivariate series {X, } is said to be (weakly) stationary if the moments ., and
(¢ + h, t) are both independent of ¢, in which case we use the notation

B . EX;
p=EX = [Exz]

and

ru(h)  yi(h)
[ = Cov(Xeun X,) = [m(h) sz(h)} |
The diagonal elements are the autocovariance functions of the univariate series { X1}
and {X,»} asdefined in Chapter 2, whilethe off-diagonal elementsarethe covariances
between X,,;,; and X,;, i # j. Noticethat y12(h) = yau(—h).
A natural estimator of the mean vector p intermsof the observations X4, .. ., X,
is the vector of sample means

Yn = E ixt’
n t=1
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Example 7.1.1

Figure 7-1

The Dow Jones Index
(top) and Australian

All Ordinaries Index
(bottom) at closing on
251 trading days ending
August 26th, 1994.

and a natural estimator of I' (%) is

n—h

By — nil; (X,+h - Yn) <X, - Yn)/ forO<h<n-1,

['(=hY for —n+1<h<D0.
The correlation p;;(h) between X, ; and X, ; is estimated by

pij () = 74 () (715 (0)73;(0)) /2.

If i = j, then p;; reduces to the sample autocorrelation function of the ith series.
These estimators will be discussed in more detail in Section 7.2.

Dow Jones and All Ordinaries Indices; DJAO2.TSM

Figure 7.1 showstheclosingvalues Dy, . . ., Do of the Dow Jones|ndex of stockson
the New York Stock Exchange and the closing values Ay, . . ., Aoy Of the Australian
All Ordinaries Index of Share Prices, recorded at the termination of trading on 251
successive trading days up to August 26th, 1994. (Because of the time difference
between Sydney and New York, the markets do not close simultaneously in both
places; however, in Sydney the closing price of the Dow Jonesindex for the previous
day is known before the opening of the market on any trading day.) The efficient
market hypothesis suggests that these processes should resemble random walks with
uncorrelated increments. In order to model the data as a stationary bivariate time
series we first reexpress them as percentage relative price changes or percentage
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Figure 7-2

The sample ACF ;1 of the
observed values of {X;1} in
Example 7.1.1, showing
the bounds 1.96n~"/2.

0.8 1.0
T

ACF
0.4 0.6

0.2

0.0

-0.2
T

-0.4

Lag

returns (filed as DJAOPC2.TSM)

D, — D,_
x,1:1ooM, t=1 ..., 250,
Dz—l
and
A — A, _
X,zleou, t=1,...,250.
-1

The estimators p11(h) and p»(h) of the autocorrelations of the two univariate series
are shown in Figures 7.2 and 7.3. They are not significantly different from zero.

To compute the sample cross-correlations p1.(h) and p,1 (k) using I TSM, select
File>Project>Open>Multivariate. Then click 0K and double-click on the file
name DJAOPC2.TSM. You will see a dialog box in which Number of columns
should be set to 2 (the number of components of the observation vectors). Then click
OK, and the graphs of the two component series will appear. To see the correlations,
press the middle yellow button at the top of the ITSM window. The correlation
functions are plotted asa 2 x 2 array of graphswith p11(h), p12(h) in thetop row and
021(h), P22 (k) inthe second row. We see from these graphs (shown in Figure 7.4) that
although the autocorrelations p;;(h), i = 1, 2, are al small, there is a much larger
correlation between X, ;; and X, .. This indicates the importance of considering
the two series jointly as components of a bivariate time series. It also suggests that
thevalue of X, 14, i.e, the Dow Jones return on day ¢ — 1, may be of assistancein
predicting the value of X, ,, the All Ordinaries return on day ¢. Thislast observation
is supported by the scatterplot of the points (x;_11, x:2), t = 2,..., 250, shown in
Figure 7.5. O
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Figure 7-5

Scatterplot of (x;—1,1, X;2),
t=2,...,250, for the
data in Example 7.1.1.

Example 7.1.2
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Sales with a leading indicator; LS2.TSM

In this example we consider the sales data {Y,,, r = 1, ..., 150} with leading indi-
cator {Y;1,# =1, ..., 150} given by Box and Jenkins (1976), p. 537. The two series
arestored inthe ITSM datafiles SALES.TSM and LEAD.TSM, respectively, and in
bivariate format as LS2.TSM. The graphs of the two series and their sample auto-
correlation functions strongly suggest that both series are nonstationary. Application
of the operator (1 — B) yields the two differenced series {D,1} and {D,»}, whose
properties are compatible with those of low-order ARMA processes. Using ITSM,
we find that the models

Dii— 0228 = Z,y — ATAZ, 11, {Z,1} ~ WN(O, .0779), (7.1.2)
D> — .838D,_1, — .0676 = Z,, — .610Z,_1,,
{Z.5} ~ WN(O, 1.754), (7.1.2)

provide good fits to the series {D,1} and {D;}.

The sample autocorrelations and cross-correlations of {D,1} and {D,,}, are com-
puted by opening the bivariate ITSM file LS2.TSM (as described in Example 7.1.1).
The option Transform>Difference, with differencing lag equal to 1, generates the
bivariate differenced series {(D,1, D,»)}, and the correlation functions are then ob-
tained as in Example 7.1.1 by clicking on the middle yellow button at the top of the
ITSM screen. The sample auto- and cross-correlations p;;(h), i, j = 1, 2, are shown
in Figure 7.6. Aswe shall seein Section 7.3, care must be taken in interpreting the
cross-correlations without first taking into account the autocorrelations of {D;;} and
{Dzz}- o
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7.2 Second-Order Properties of Multivariate Time Series

Consider m time series {X,;,t =0,%1,...,},i = 1,...,m, with EX? < oo for al
t andi. If all the finite-dimensional distributions of the random variables {X,;} were
multivariate normal, then the distributional properties of {X;} would be completely
determined by the means

Mti = EX”' (721)
and the covariances
Vij(t +h,t) = E[(Xt+h,i - Mti)(ij - ,thj)]- (722)

Evenwhentheobservations{X,;} do not havejoint normal distributions, the quantities
w.; and y;; (t + h, t) specify the second-order properties, the covariances providing us
with ameasure of the dependence, not only between observationsin the same series,
but also between the observations in different series.

It is more convenient in dealing with m interrelated series to use vector notation.
Thus we define

X
X, = |, r=0,+£1,.... (7.2.3)
Xim
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The second-order properties of the multivariate time series {X,} are then specified by

the mean vectors
M1
w = EX, = : (7.2.4)
/'Ltm
and covariance matrices
yu+h,t) - yu@E+ht)
C'¢+h,t) .= : : , (7.2.5)
yml(t+h7[) me([+h7 t)

where
Yij(t +h,t) i= CoV(X,pni, X, j).

Remark 1. Thematrix I' (¢ + h, t) can also be expressed as

Lt +h,t) = E[(Xin — pen) Xe — )],
where as usual, the expected value of a random matrix A is the matrix whose com-
ponents are the expected values of the components of A. O

Asin the univariate case, a particularly important role is played by the class of
multivariate stationary time series, defined as follows.

Definition 7.2.1 The m-variate series {X,} is (weakly) stationary if
(i) px(¢) isindependent of ¢
and

(iily Tx(z 4+ h, 1) isindependent of ¢ for each h.

For a stationary time series we shall use the notation

231
po=EX, = | (7.2.6)
Km
and
yuh) - yu(h)
['(h) := E[(Ximn — ) (X, — N)/] = . (7.2.7)
Ymi(R) -+ Vum(h)

We shall refer to o as the mean of the series and to I' (k) as the covariance matrix at
lag h. Notice that if {X,} is stationary with covariance matrix function I"(-), then for
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each i, {X,;} is stationary with covariance function y;;(-). The function y;; (), i # j,
is called the cross-covariance function of the two series {X,;} and {X,;}. It should be
noted that y;;(-) is not in general the same as y;;(-). The correlation matrix function
R(-) isdefined by

pu(h) - pia(h)

R(h) = : : , (7.2.8)
where p;;(h) = y;;(h)/[7::(0)y;;(0)]¥2. The function R(:) is the covariance matrix
function of the normalized series obtained by subtracting . from X, and then dividing
each component by its standard deviation.

Example 7.2.1  Consider the bivariate stationary process {X,} defined by

le = Zr,

Xpo=27Z,+ 0.752,,10,
where {Z,} ~ WN(O0, 1). Elementary calculationsyield u = 0,

0 075 1 1 0 0
r-1o9 = [o 0.75] » TO= [1 1.5625] - A= [0.75 0.75] ’
and I"(j) = 0 otherwise. The correlation matrix function is given by
0 060 1 08 0 0
R(-10) = [o 0.48] - RO= [0.8 1 ] » RA9 = [0.60 0.48] ’
and R(j) = 0 otherwise. O
Basic Properties of T'(-):
1. I'(h) =T (—=h),
2. |sz(h)| =< [Vzl(o)y]j(o)]l/za i’ j’ = 17 cee,m,
3. y:i(-) isan autocovariance function,i = 1, ..., m, and
4, Zj’kzlagl“(j — kg, >0fordlne{l,2 ...}anda,...,a, € R".
Proof Thefirst property follows at once from the definition, the second from the fact that

correlations cannot be greater than one in absolute value, and the third from the
observation that y;; (+) isthe autocovariance function of the stationary series{X,;, t =
0, +1,...}. Property 4 is a statement of the obvious fact that

n 2
E(Za;(xj—u)) > 0. [
=1



232

Chapter 7

Multivariate Time Series

Definition 7.2.2

Definition 7.2.3

Definition 7.2.4

Remark 2. The basic properties of the matrices I' (k) are shared also by the cor-
responding matrices of correlations R(h) = [p;;(1)]";_;, Which have the additional

property
,0”(0):1 for dl i.

The correlation p;;(0) isthe correlation between X,; and X,;, which is generally not
equal to 1if i # j (see Example 7.2.1). It isalso possible that |y;; ()| > |y;;(0)] if
i # j (seeProblem 7.1). O

The simplest multivariate time series is multivariate white noise, the definition
of which is quite analogous to that of univariate white noise.

The m-variate series {Z,} is called white noise with mean 0 and covariance
matrix ¥, written

{Z:} ~WN(O, ¥), (7.2.9)
if {Z,} isstationary with mean vector 0 and covariance matrix function
X, ifh=0,

T(h) = (7.2.10)
0, otherwise.

Them-variate series {Z,} iscaled iid noise with mean 0 and covariance matrix
X, written

{Z:} ~id(0, %), (7.2.12)

if the random vectors {Z,} are independent and identically distributed with mean
0 and covariance matrix X.

Multivariate white noise {Z,} is used as a building block from which can be
constructed an enormous variety of multivariate time series. Thelinear processes are
generated as follows.

The m-variate series {X;} isalinear processif it has the representation

Xi= Y CiZi ;. (Z}~WNQ,%), (7.2.12)

j==s0

where {C;} is a sequence of m x m matrices whose components are absolutely
summable.
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The linear process (7.2.12) is stationary (Problem 7.2) with mean 0 and covari-
ance function

F(hy= Y Ciu3C/, h=0%£1.... (7.2.13)
j=—00
An MA(oo) processisalinear processwith C; = Ofor j < 0. Thus {X,} isan
MA (o) processif and only if there existsawhite noise sequence {Z,} and asequence
of matrices C; with absolutely summable components such that

Xt = Z CjZ,_j.
j=0

Multivariate ARMA processes will be discussed in Section 7.4, where it will
be shown in particular that any causal ARMA(p, ¢g) process can be expressed as an
MA (o0) process, while any invertible ARMA(p, g) process can be expressed as an
AR(00) process, i.e., aprocess satisfying equations of the form

X+ AX_; =2,
j=1
in which the matrices A ; have absolutely summable components.

Second-Order Properties in the Frequency Domain

Provided that the components of the covariance matrix functionI' (-) havethe property
Yo (b)) <o0,i, j=1,...,m,thenT hasamatrix-valued spectral density

function
1 - —ilh
fo) = gh;me L(h), —w<i<m,
and I" can be expressed interms of f as

I'(h) = / ’ e F(da.

/e

The second-order properties of the stationary process { X, } can therefore be described
equivalently in terms of f(-) rather than I'(:). Similarly, {X;} has a spectral repre-
sentation

X, = / eMdzZ (M),

T

where {Z()), —m < A < m} is a process whose components are complex-valued
processes satisfying

FrOoda ifn = p,

E (de()»)dik(M)) = {0 if A £
M,
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and Z, denotes the complex conjugate of Z,. We shall not go into the spectral repre-
sentation in this book. For details see TSTM.

7.3 Estimation of the Mean and Covariance Function

Proposition 7.3.1

As in the univariate case, the estimation of the mean vector and covariances of a
stationary multivariate time series plays an important role in describing and model-
ing the dependence structure of the component series. In this section we introduce
estimators, for a stationary m-variate time series {X,}, of the components r;, y;; (h),
and p;;(h) of p, T'(h), and R(h), respectively. We also examine the large-sample
properties of these estimators.

7.3.1 Estimation of p

A natural unbiased estimator of the mean vector . based on the observations
X1, ..., X, isthe vector of sample means

X, = 1 Xn:x,.
n =1

The resulting estimate of the mean of the jth time seriesisthen the univariate sasmple
mean (1/n) }",_, X,;. If each of the univariate autocovariance functions y;; (-),i =
1,...,m, satisfies the conditions of Proposition 2.4.1, then the consistency of the
estimator X,, can be established by applying the proposition to each of the component
time series {X,;}. Thisimmediately gives the following result.

If {X,} isa stationary multivariate time series with mean . and covariance function
I'(-),thenasn — oo,

E(Y,,—u),(f,,—p>—>0 if y;(n) >0, 1<i<m,

and

nE (X, — ) (X —p) = S5 e it S ) <co. 1<i<m.
h=—00

i=1 — h=—o00

Under more restrictive assumptions on the process { X, } it can a so be shown that
X,, isapproximately normally distributed for large n. Determination of the covariance
matrix of thisdistribution would allow usto obtain confidenceregionsfor p.. However,
thisisquitecomplicated, and thefollowing simple approximationisuseful in practice.

For each i we construct aconfidenceinterval for 11; based on the sample mean X,
of the univariate series Xy;, ..., X;; and combine these to form a confidence region
for p. If f;(w) isthespectral density of theith process{X,;} andif thesamplesizen is
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large, then we know, under the same conditions asin Section 2.4, that /n (X; — 1)
is approximately normally distributed with mean zero and variance

27£,0) = > yuk).

k=—00
It can also be shown (see, e.g., Anderson, 1971) that
SN |hl\ .
20fi0 =3 (1= =) pulh)
hl<r

is a consistent estimator of 27 f;(0), provided that » = r, is a sequence of numbers
depending on n in such away that r, — oo andr,/n — 0asn — oo. Thusif X;
denotes the sample mean of the ith process and @, is the «-quantile of the standard
normal distribution, then the bounds

X, £ 1 o2 (27Tfi (0)/”>1/2

are asymptotic (1 — «) confidence bounds for w;. Hence

_ R 12
P<|;L,-—X,-|§<I>1_a/2(2nfi(0)/n) ,l:l,...,m)

m

>1- Z P (|Ml —Xi| > ®1ap2 (Zﬂfi(o)/”)l/2> ,

i=1

where theright-hand side convergesto 1 — ma asn — oo. Consequently, asn — oo,
the set of m-dimensional vectors bounded by

_ N 1/2
{x,- =X, £ P1_(a/2m) (2n f,.(O)/n) =1 m} (7.3.1)

has a confidence coefficient that converges to a value greater than or equal to 1 — «
(and substantially greater if m islarge). Nevertheless, the region defined by (7.3.1) is
easy to determine and is of reasonable size, provided that m is not too large.

7.3.2 Estimation of I'(h)

Asin the univariate case, a natural estimator of the covariance I'(h) = E[(XHh —
) (X —p)]is

=

F oy = . (X,+h —Yn) (X, —7,1)/ forO<h<n—1,

N
II
iN

[(—h) for —n+1<h<D0.
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Theorem 7.3.1

Writing y;;(h) for the (i, j)-component of (), i, j = 1,2, ..., we estimate the
cross-correlations by

pij(h) = 7:;(h)(7::(0)7;;(0)) Y2,

If i = j, then p;; reduces to the sample autocorrelation function of the ith series.

Derivation of the large-sample properties of y;; and p;; is quite complicated in
general. Here we shall simply note one result that is of particular importance for
testing the independence of two component series. For details of the proof of thisand
related results, see TSTM.

Let {X,} bethe bivariate time series whose components are defined by

Xo= )Y aZ g1 {Za}~1ID(0,07),

k=—00

and

X = Z BiZi—k2, {Zi2} ~1ID (0’ 622) ’

k=—00

where the two sequences {Z,;} and {Z,,} are independent, ), |ax| < oo, and

2k 1Bl < o0.

Then for all integers & and k with 4 # k, the random variables n'/?p15(h)
and n'?p,(k) are approximately bivariate normal with mean 0, variance
>~ P11(j)p22(j), and covariance Zj‘;_w 011(J)p22(j + k — h), for n large.

[For a related result that does not require the independence of the two series { X1}
and {X,,} see Theorem 7.3.2 below.]

Theorem 7.3.1 isuseful in testing for correlation between two time series. If one
of the two processes in the theorem is white noise, then it follows at once from the
theorem that p1»(h) is approximately normally distributed with mean 0 and variance
1/n,inwhich caseitisstraightforwardtotest thehypothesisthat p1,(4) = 0. However,
if neither processiswhitenoise, thenavalueof p1,(h) thatislargerelativeton =2 does
not necessarily indicate that pq,(h) is different from zero. For example, suppose that
{X,;1} and {X,,} are two independent AR(1) processes with p11(h) = pon(h) = .8,
Then the |large-sample variance of py,(h) isn™ (1+ 23 ;2 (.64)F) = 4.556n. It
would therefore not be surprising to observe a value of p.(h) as large as 3n~/?
even though {X,,} and {X,,} are independent. If on the other hand, p.1(h) = .8"
and po»(h) = (—.8)", then the large-sample variance of p1.(h) is.2195271, and an
observed value of 3n=%2 for p1»(h) would be very unlikely.
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Example 7.3.1

7.3.3 Testing for Independence of Two Stationary Time Series

Sinceby Theorem 7.3.1 thelarge-sampl e distribution of p1,(h) dependsonboth pq1(-)
and p.(+), any test for independence of the two component series cannot be based
solely on estimated values of p12(h), h = 0, 1, .. ., without taking into account the
nature of the two component series.

This difficulty can be circumvented by “prewhitening” the two series before
computing the cross-correlations p1»(h), i.e., by transforming the two seriesto white
noise by application of suitablefilters. If {X,;} and {X,,} areinvertible ARMA(p, q)
processes, this can be achieved by the transformations

o0
(@
Z = Zﬂjl Xi—jis
j=0

where Y% o7z = ¢ (2) /69 (z) and ¢V, 0 are the autoregressive and moving-

average polynomials of the ith series, i = 1, 2.

Sincein practice thetrue mode! isnearly always unknown and sincethe data X ,;,
t < 0, arenot available, it isconvenient to replace the sequences{Z,;} by theresiduals
{W,;} after fitting a maximum likelihood ARMA model to each of the component
series(see(5.3.1)). If thefitted ARMA modelswerein fact the true models, the series
{W.:} would be white noise sequencesfor i = 1, 2.

To test the hypothesis Hy that {X,1} and {X,,} are independent series, we observe
that under Hy, the corresponding two prewhitened series{Z,,} and {Z,,} arealsoinde-
pendent. Theorem 7.3.1 thenimpliesthat the sample cross-correlations p1(h), p12(k),
h # k,of {Z,1} and {Z,,} arefor |large n approximately independent and normally dis-
tributed with means 0 and variances n 1. An approximate test for independence can
therefore be obtained by comparing the values of |p1,(h)| with 1.96n /2, exactly as
in Section 5.3.2. If we prewhiten only one of the two original series, say {X,1}, then
under Hy Theorem 7.3.1 implies that the sample cross-correlations p12(h), p12(k),
h # k, of {Z,1} and {X,,} are for large n approximately normal with means O, vari-
ancesn~! and covariance n ., (k — h), where p(-) isthe autocorrelation function
of {X,»}. Hence, for any fixed i, pio(h) aso fals (under Hy) between the bounds
+1.96n /2 with a probability of approximately 0.95.

The sample correlation functions p;;(-), i, j = 1,2, of the bivariate time series
E731A.TSM (of length n = 200) are shown in Figure 7.7. Without taking into
account the autocorrelations p;; (-), i = 1, 2, itisimpossible to decide on the basis of
the cross-correlations whether or not the two component processes are independent
of each other. Notice that many of the sample cross-correlations p;;(h), i # j, lie
outside the bounds 4-1.96n %2 = +.139. However, these bounds are relevant only if
at least one of the component series is white noise. Sincethisis clearly not the case,
awhitening transformation must be applied to at least one of the two component se-
ries. Analysisusing ITSM leadsto AR(1) models for each. The residuals from these
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Corollary 7.3.1

Example 7.3.2

maximum likelihood models are stored as a bivariate seriesin the file E731B.TSM,
and their sample correlations, obtained from ITSM, are shown in Figure 7.8. All but
two of the cross-correlations are between the bounds +.139, suggesting by Theorem
7.3.1 that thetwo residual series (and hence the two origina series) are uncorrel ated.
The data for this example were in fact generated as two independent AR(1) series
withg = 0.8and o2 = 1. O

7.3.4 Bartlett’s Formula

In Section 2.4 we gave Bartlett’s formula for the large-sample distribution of the
sample autocorrelation vector p = (b(l), e ﬁ(k))/ of a univariate time series.
The following theorem gives a large-sampl e approximation to the covariances of the
sample cross-correlations p12(h) and p1»(k) of the bivariate time series {X, } under the
assumption that {X,} is Gaussian. However, it is not assumed (asin Theorem 7.3.1)
that {X,,} isindependent of {X,,}.

Bartlett’s Formula;

If {X,} is a bivariate Gaussian time series with covariances satisfying
Yo ()| < 00,1, j = 1,2, then

=—0Q0

o0

lim nCov(p12(h), pr2(k)) = Z [pll(j)pZZ(j +k—h)+ p2(j +k)pa(j —h)

n—00 X
J=—0©

— pr2(W{p11())p12(j + k) + p22(j) p21(j — k)}
— p12(k){p11(J) p12(j + h) + p22(j) p21(j — h)}

1 2 .. 2 .. 1 2 .
+ p12(h) p12(k) iépn(J) + () + Epzz(J)H

If {X,} satisfies the conditions for Bartlett's formula, if either {X,,} or {X,,} iswhite
noise, and if

plZ(h) = O’ h ¢ [a9 b],
then

lim nVar (p12(h)) =1, h ¢ [a, b].

Sales with a leading indicator

We consider again the differenced series{D,1} and {D,,} of Example 7.1.2, for which
we found the maximum likelihood models(7.1.1) and (7.1.2) using ITSM. Theresid-
ual sfrom the two models (which can befiled by ITSM) arethetwo “whitened” series
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Figure 7-9

The sample correlations
of the whitened series
VAVH—hJ and Wz of
Example 7.3.2, showing
the bounds £1.96n~"/2.

{W,1} and {W,,} with sample variances .0779 and 1.754, respectively. Thisbivariate
seriesis contained in the file E732.TSM.

The sample auto- and cross-correlations of {D,;} and { D,,} were shownin Figure
7.6. Without taking into account the autocorrelations, it is not possible to draw any
conclusions about the dependence between the two component series from the cross-
correlations.

Examination of the sample cross-correlation function of the whitened series
{W.1} and {W,,}, on the other hand, is much more informative. From Figure 7.9
it is apparent that there is one large-sample cross-correlation (between W, 3, and
W, 1), while the others are all between +1.96n /2, m]

If {W,1} and | W,»} are assumed to bejointly Gaussian, Corollary 7.3.1 indicates
the compatibility of the cross-correlations with amodel for which

p12(=3) #0
and
p2(h) =0, h#-3.
The value p12(—3) = .969 suggests the model
Wi = 4.74W,_31 + N,, (7.3.2)

where the stationary noise {N,} has small variance compared with { W,,} and {Vif,l},
and the coefficient 4.74 is the square root of the ratio of sample variances of {W,g}
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and | W,1}. A study of the sample values of {W,, — 4.74W,_3 1} suggests the model
(14 .345B)N, = U;, {U,} ~WN(0, .0782) (7.3.3)

for {N,}. Finally, replacing W,, and W,_3 1 in (7.3.2) by Z,, and Z,_3 1, respectively,
and then using (7.1.1) and (7.1.2) to express Z,, and Z, 3 in terms of {D;,} and
{D;1}, we abtain amodel relating {D,1}, {D:»}, and {U,1}, namely,

D;; +.0773 = (1 — .610B)(1 — .838B) '[4.74(1 — .474B)'D,_3,
+ (14 .345B)U]].

This model should be compared with the one derived later in Section 10.1 by the
more systematic technique of transfer function modeling.

7.4 Multivariate ARMA Processes

Definition 7.4.1

Example 7.4.1

Asin the univariate case, we can define an extremely useful class of multivariate sta-
tionary processes {X;} by requiring that {X,} should satisfy a set of linear difference
equations with constant coefficients. Multivariate white noise {Z,} (see Definition
7.2.2) isafundamental building block from which these ARMA processes are con-
structed.

{X,}isan ARMA(p, q) processif {X,} isstationary and if for every r,
X =@ X 43— —®,X ,=Z,4+0:1Z, 1+---+0,Z,_,, (141)

where{Z,} ~ WN(O, X).({X;}isanARMA(p, q) processwith mean p if {X,—pu}
isan ARMA(p, g) process.)

Equations (7.4.1) can be written in the more compact form
®(B)X, = O(B)Z,, {Z,} ~WN(O, X), (7.4.2)

where ®(z) =1 — Pz — - — P,z and O(z) '= I + Oz + --- + O,z7 are
matrix-valued polynomials, I isthem x m identity matrix, and B asusual denotesthe
backward shift operator. (Each component of the matrices ®(z), ©(z) isapolynomial
with real coefficients and degree less than or equal to p, g, respectively.)

The multivariate AR(1) process
Setting p = 1and ¢ = 0in (7.4.1) gives the defining equations
X, =X, 1+ 2Z,, {Z;}~WN(Q, ), (7.4.3)
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for the multivariate AR(1) series {X,}. By exactly the same argument as used in
Example 2.2.1, we can express X, as

X, =Y @iz, (7.4.4)
j=0

provided that all the eigenvalues of ® arelessthan 1in absolutevalue, i.e., provided
that

det(I — z®) #0 forall z e Csuchthat |z|] < 1. (7.4.5)

If this condition is satisfied, then the coefficients &/ are absolutely summable, and
hencethe seriesin (7.4.4) converges, i.e., each component of the matrix ijo 'z,
converges (see Remark 1 of Section 2.2). Thesameargument asin Example2.2.1 aso
shows that (7.4.4) is the unique stationary solution of (7.4.3). The condition that all
the eigenvalues of @ should be less than 1 in absolute value (or equivalently (7.4.5))
isjust the multivariate analogue of the condition |¢| < 1 required for the existence
of acausal stationary solution of the univariate AR(1) equations (2.2.8). O

Causality and invertibility of a multivariate ARMA(p, ¢g) process are defined
precisely as in Section 3.1, except that the coefficients y;, ; in the representations
X, = Y oviZijand Z, = 37,7 X, ; ae replaced by m x m matrices W,
and IT; whose components are required to be absolutely summable. The following
two theorems (proofs of which can be found in TSTM) provide us with criteria for
causality and invertibility analogous to those of Section 3.1.

Causality:

An ARMA(p, q) process {X,} is causal, or a causal function of {Z,}, if there
exist matrices {¥;} with absolutely summable components such that

X, =Y w,z,_; foralt. (7.4.6)
j=0
Causality is equivalent to the condition
det ®(z) # Oforal z € C suchthat |z] < 1. (7.4.7)

The matrices ¥; are found recursively from the equations

=0+ Y &0, j=0.1..., (7.4.8)
k=1
wherewe define ®y = 1, ®; = 0for j > ¢, &, = 0for j > p,and ¥; = O for
Jj <0O.
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I nvertibility:
An ARMA(p, q) process {X,} isinvertibleif there exist matrices {I1,} with ab-
solutely summable components such that
Z,=>Y T,;X,_;forallt. (7.4.9)
j=0
Invertibility is equivalent to the condition
det®(z) #Oforadl z € Csuchthat |z| < 1. (7.4.10)
The matrices IT; are found recursively from the equations
Mj=-®;— Y O, j=01..., (7.4.12)
k=1
where we define &g = —1, ®; = 0for j > p,®; =0for j > g,and IT; = O for
j <0O.
Example 7.4.2  For the multivariate AR(1) process defined by (7.4.3), the recursions (7.4.8) give

Wy =1,
U, = dWy = O,
U, = Y, = P2,

U, =0W; =/, j>3
as aready found in Example 7.4.1. O

Remark 3. For the bivariate AR(1) process (7.4.3) with
0 05
°-[o0 7]
itiseasy to check that W; = ®/ = Ofor j > 1and hencethat {X,} hasthe aternative
representation

Xz = Zt + d)Zt,l

asan MA (1) process. Thisexample showsthat it isnot always possibleto distinguish
between multivariate ARMA models of different orders without imposing further
restrictions. If, for example, attention is restricted to pure AR processes, the prob-
lem does not arise. For detailed accounts of the identification problem for general
ARMA(p, ¢g) models see Hannan and Deistler (1988) and L titkepohl (1993). O
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7.4.1 The Covariance Matrix Function of a Causal ARMA Process

From (7.2.13) we can express the covariance matrix I'(h) = E (X,1,X;) of the causal
process (7.4.6) as

I'(h) = Z\phﬂ.}pqﬂ., h=0,%1,..., (7.4.12)
j=0
where the matrices W; are found from (7.4.8) and ¥, := Ofor j < 0.

The covariance matricesT'(h), h = 0, +1, .. ., can also be found by solving the
Yule-Walker equations

P
rGy—Y &T(G-rn=Y ©3I¥_; j=012.., (7.4.13)
r=1 Jj<r=<q
obtained by postmultiplying (7.4.1) by X; _; and taking expectations. Thefirst p+1 of
the equations (7.4.13) can be solved for the componentsof I"'(0), ..., I'(p) using the
fact that I'(—h) = I'/(h). The remaining equationsthen giveI'(p +1), ' (p + 2), ...
recursively. An explicit form of the solution of these equations can be written down by
making use of Kronecker products and the vec operator (see e.g., L iitkepohl, 1993).

Remark 4. |If zo istheroot of det ®(z) = 0 with smallest absolute value, then it
can be shown from the recursions (7.4.8) that ¥; /r/ — O as j — oo for dl r such
that |zo|™* < r < 1. Hence, there is a constant C such that each component of ;
issmaller in absolute value than Cr/. Thisimpliesin turn that there is a constant K
such that each component of the matrix W, ; ¥ W', on theright of (7.4.12) is bounded
in absolute value by Kr2/. Provided that |zo| is not very close to 1, this means that
the series (7.4.12) converges rapidly, and the error incurred in each component by
truncating the series after the term with j = k — 1 issmaller in absolute value than
S Kr¥ = Kr#/(1-r?). |

7.5 Best Linear Predictors of Second-Order Random Vectors

Let {X, = (X;1, ..., Xi»)'} be an m-variate time series with means EX, = p, and
covariance function given by them x m matrices

K@i, j) = E (X;X}) — gty

IfY = (Yy,...,Y,) isarandom vector with finite second momentsand EY = pu,
we define
PI‘L(Y) = (PnYlv"‘7PrlYm)/9 (751)

where P,Y; is the best linear predictor of the component Y; of Y in terms of all
of the components of the vectors X,,r = 1,...,n, and the constant 1. It follows
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immediately from the properties of the prediction operator (Section 2.5) that

P,(Y) =p+ Ar(X,, — ) + - -+ Ay (Xy — 1) (7.5.2)
for some matrices A4, . .., A,, and that
Y —-P(Y) L X1y, i=1,...,n, (7.5.3)

wherewe say that two m-dimensional random vectors X and Y areorthogonal (written
X LY)if E(XY’) isamatrix of zeros. Thevector of best predictors(7.5.1) isuniquely
determined by (7.5.2) and (7.5.3), dthough it is possible that there may be morethan
one possible choicefor A4, ..., A,.

Asaspecia case of the above, if {X,} is azero-mean time series, the best linear
predictor Xn+1 of X,,1intermsof X4, ..., X, isobtained onreplacing Y by X1 in
(7.5.2). Thus

. 0, ifn =0,
Xn+1 = .
P,(Xpy1), ifn>1
Hence, we can write
X1 = PpXp 44+ DXy, n=1,2,..., (7.5.4)

where, from (7.5.3), the coefficients @,,;, j = 1, ..., n, are such that

E (>A<n+1x;1+1_i) = E(Xp1X,p ), i=1....n, (7.5.5)

Y o Kn+1—jn+l-i)=Kn+1ln+l-i) i=1...n
j=1
Inthe casewhere {X,} isstationary with K (i, j) = I'(i — j), the prediction equations
simplify to the m-dimensiona analogues of (2.5.7), i.e.,

Y ®,Ii—j)=rG0, i=1....n (7.5.6)
j=1
Provided that the covariance matrix of the nm components of X, ..., X, isnonsin-

gular for every n > 1, the coefficients {®,;} can be determined recursively using
a multivariate version of the Durbin—Levinson algorithm given by Whittle (1963)
(for details see TSTM, Proposition 11.4.1). Whittle's recursions also determine the
covariance matrices of the one-step prediction errors, namely, Vo = I'(0) and, for
n>1,

Vo = EXup1 — Xug1) Kngr — Xnya)'
=T(0) — &, ['(-1) —--- — &,,['(—n). (7.5.7)
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Remark 5. The innovations algorithm also has a multivariate version that can be
used for prediction in much the same way as the univariate version described in
Section 2.5.2 (for details see TSTM, Proposition 11.4.2). O

7.6 Modeling and Forecasting with Multivariate AR Processes

If {X,} isany zero-mean second-order multivariate time series, it iseasy to show frgm
the results of Section 7.5 (Problem 7.4) that the one-step prediction errors X; — X,
j =1, ..., n, havethe property

E(X; = %) (X~ %) =0for j £k (7.6.1)
Moreover, the matrix M such that
[ Xy — X1 | [ X, |
Xz — Xz Xz
Xs—=X3 | = m| Xs (7.6.2)
Xn - )A(n Xn

is lower triangular with ones on the diagonal and therefore has determinant equal
to 1.

If the series {X,} is also Gaussian, then (7.6.1) implies that the prediction errors
U, =X;=X;,j =1,...,n,aeindependent with covariance matrices Vy, . . ., V,_1,
respectively (as specifiedin (7.5.7)). Consequently, the joint density of the prediction
errorsis the product

-1/2
n l n
s, o) = @) (H dethl) exp [—5 .y, V,-‘lluj} -
j=1 j=1

Since the determinant of the matrix M in (7.6.2) isequal to 1, the joint density of the
observations X4, ..., X, a Xy, ..., X, isobtained onreplacing us, ..., u, inthelast
expression by the values of X; — X ; corresponding to the observations Xy, . . ., X,.

If we suppose that {X,} isazero-mean m-variate AR(p) process with coefficient
matrices ® = {®4, ..., ®,} and white noise covariance matrix X, we can therefore
express the likelihood of the observations X4, ..., X, as

—1/2
n l n , _

dethl) exp |:—§ Z Uj leluj:| s
-1 =1

whereU; = X; —X;, j = 1,...,n,and X, and V; are found from (7.5.4), (7.5.6),
and (7.5.7).

J

L(®, %) = (2m)™"™? (
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Maximization of the Gaussian likelihood is much more difficult in the multivari-
ate than in the univariate case because of the potentially large number of parameters
involved and the fact that it is not possible to compute the maximum likelihood es-
timator of ® independently of X asin the univariate case. In principle, maximum
likelihood estimators can be computed with the aid of efficient nonlinear optimiza-
tion agorithms, but it isimportant to begin the search with preliminary estimates that
are reasonably close to the maximum. For pure AR processes good preliminary esti-
mates can be obtained using Whittle's algorithm or a multivariate version of Burg's
algorithm given by Jones (1978). We shall restrict our discussion here to the use of
Whittle's algorithm (the multivariate option AR-Model>Estimation>Yule-Walker
in ITSM), but Jones's multivariate version of Burg's algorithm is aso available
(AR-Model>Estimation>Burg). Other useful agorithms can befound in Litkepohl
(1993), in particular the method of conditional least squares and the method of Han-
nan and Rissanen (1982), the latter being useful also for preliminary estimationinthe
more difficult problem of fitting ARMA(p, ¢) modelswith g > 0. Spectral methods
of estimation for multivariate ARMA processesare al so frequently used. A discussion
of these (as well as some time-domain methods) is given in Anderson (1980).

Order selection for multivariate autoregressive models can be made by minimiz-
ing a multivariate analogue of the univariate AICC statistic

2(pm? + Lynm

AICC = -2InL(®y,...,P,, %) + > .
nm — pm? — 2

(7.6.3)

7.6.1 Estimation for Autoregressive Processes Using Whittle’s Algorithm

If {X,} isthe (causal) multivariate AR(p) process defined by the difference equations
XI = q)lxtfl + e + Cbpxtfp + Ztv {Zt} ~ WN(07 E)’ (764)

then postmultiplying by X;_;, j =0, ..., p, and taking expectations gives the equa-
tions

)4
T=T0) - &T(-)) (7.6.5)
j=1
and
FG@) =Y ®r6—j). i=1....p. (7.6.6)
j=1

GiventhematricesT' (0), ..., I'(p), equations(7.6.6) can be used to determinethe co-
efficient matrices @, . .., ®,. Thewhitenoisecovariance matrix X can then befound
from (7.6.5). The solution of these equationsfor @4, ..., ®,, and ¥ isidentical to the
solution of (7.5.6) and (7.5.7) for the prediction coefficient matrices @1, ..., ®,,
and the corresponding prediction error covariancematrix V,,. Consequently, Whittle's
algorithm can be used to carry out the algebra.
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Example 7.6.1

Example 7.6.2

The Yule-Walker estimators ®,, ..., ®,, and ¥ for the model (7.6.4) fitted to
the data X1, ..., X, are obtained by replacing I'(j) in (7.6.5) and (7.6.6) by I'(j),
7 =0,..., p, and solving the resulting equations for ®4, ..., ®,, and . The solu-
tion of these equations is obtained from ITSM by selecting the multivariate option
AR-Model>Estimation>Yule-Walker. The mean vector of the fitted model isthe
sample mean of thedata, and Whittle' salgorithmisused to solve the equations (7.6.5)
and (7.6.6) for the coefficient matrices and the white noise covariance matrix. The
fitted model is displayed by ITSM in theform

XI =¢0+q)1xtfl+"'+d)pxtfp+zt3 {ZI}NWN(09 E)
Note that the mean . of this model is not the vector ¢, but
p=1-0— - —®,) ey

In fitting multivariate autoregressive models using ITSM, check the box Find
minimum AICC model tofind the AR(p) model withO < p < 20 that minimizesthe
AICC value as defined in (7.6.3).

Analogous calculations using Jones's multivariate version of Burg's algorithm
can be carried out by selecting AR-Model>Estimation>Burg.

The Dow Jones and All Ordinaries Indices

To find the minimum AICC Yule-Walker model (of order less than or equal to 20)
for the bivariate series {(X,1, X;»)',t = 1, ..., 250} of Example 7.1.1, proceed as
follows. Select File>Project>0pen>Multivariate, click 0K, and then double-
click on the file name, DJAOPC2.TSM. Check that Number of columns iSSetto 2,
the dimension of the observation vectors, and click 0K again to see graphs of the two
component time series. No differencing is required (recalling from Example 7.1.1
that {X,1} and {X,,} arethe daily percentage price changes of the original Dow Jones
and All Ordinaries Indices). Select AR-Model>Estimation>Yule-Walker, check
the box Find minimum AICC Model, click 0K, and you will obtain the model

[ X1 [ .0288 + —.0148 .0357 || X;-11 " Zn
| X2 | | .00836 .6589 .0998 | | X, 1> Zio |’

Za] 0] [.3653 .0224
| Z ) WN([O]’[.0224 .6016D' H

Sales with a leading indicator

where

The series {Y;1} (leading indicator) and {Y;,} (sales) are stored in bivariate form
(Y;1 in column 1 and Y;, in column 2) in the file LS2.TSM. On opening this file
in ITSM you will see the graphs of the two component time series. Inspection of
the graphs immediately suggests, asin Example 7.2.2, that the differencing operator
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V = 1— B should be applied to the databefore a stationary AR model isfitted. Select
Transform>Difference and specify 1 for the differencing lag. Click 0K and you
will see the graphs of the two differenced series. Inspection of the series and their
correlation functions (obtained by pressing the second yellow button at the top of the
ITSM window) suggests that no further differencing is necessary. The next step isto
select AR-model>Estimation>Yule-Walker withtheoptionFind minimum AICC
model. Theresulting model has order p = 5 and parameters ¢, = (.0328 .0156)’,

6. _[—517 0247 o _[-192 -018] o _[-.073 .010
1= 1019 —.051| 27| 047 250 |° *T | 4678 .207 |
4, _[—032 —.0097 o _[.022 .011 G = 076 —.003

4713664 .004 |> ° 1300 .029| " |-.003 .09 |’

with AICC=109.49. (Analogous calculations using Burg's algorithm give an AR(8)
model for thedifferenced series.) Thesamplecross-correlationsof theresidual vectors
Z, can be plotted by clicking on the last blue button at the top of the ITSM window.
These are nearly all within the bounds +1.96/./n, suggesting that the model is a
good fit. The components of the residual vectors themselves are plotted by selecting
AR Model>Residual Analysis>Plot Residuals. Simulated observations from
the fitted model can be generated using the option AR Model>Simulate. The fitted
model has the interesting property that the upper right component of each of the co-
efficient matricesiscloseto zero. Thissuggeststhat {X,1} can be effectively modeled
independently of {X;,}. In fact, the MA(1) model

X = (1— A7AB)U,, {U,} ~ WN(0, .0779), (7.6.7)

provides an adequate fit to the univariate series { X, }. Inspecting the bottom rows of
the coefficient matrices and deleting small entries, we find that the relation between
{X,1} and {X,,} can be expressed approximately as

X2 = .250X, 55+ .207X, 3, + 4.678X, 31 + 3.664X, 41 + 1.300X, 51 + W,,
or equivalently,

Y. 4.678B3(1 + .783B + .278B?) N W,
2= 1— 250B2 — .207B° "1 25082 — 207B%’

(7.6.8)

where{W,} ~ WN(O, .095). Moreover, sincethe estimated noise covariancematrix is
essentially diagonal, it followsthat thetwo sequences{X,,} and { W, } areuncorrel ated.
Thisreduced model defined by (7.6.7) and (7.6.8) isan example of atransfer function
model that expresses the “output” series {X,,} as the output of a linear filter with
“input” {X;1} plus added noise. A more direct approach to the fitting of transfer
function modelsis given in Section 10.1 and applied to this same data set. O
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7.6.2 Forecasting Multivariate Autoregressive Processes

The technique developed in Section 7.5 alows us to compute the minimum mean
squared error one-step linear predictors X, for any multivariate stationary time
seriesfrom the mean p and autocovariance matrices " (k) by recursively determining
the coefficients @,;,i = 1, ..., n, and evaluating
Xﬂ-‘rl =p+ (Dnl(xn - ll/) +--+ (Drm(xl - ll’) (769)
The situation is simplified when {X,} is the causal AR(p) process defined by
(7.6.4), sincefor n > p (asisamost aways the casein practice)

A

Kosr = DX 4 -+ B X1 . (7.6.10)

To verify (7.6.10) it suffices to observe that the right-hand side has the required form
(7.5.2) and that the prediction error

Xn+1 - q)lxn - Cbpxn-'rl—p - Zn+1

is orthogonal to X4, ..., X, in the sense of (7.5.3). (In fact, the prediction error is
orthogonal to all X;, —oo < j < n, showing that if » > p, then (7.6.10) is a'so the
best linear predictor of X,, interms of all components of X;, —oo < j < n.) The
covariance matrix of the one-step prediction error isclearly E(Z,,1Z,,,) = ¥.

To compute the best #-step linear predictor P, X, based on all the components
of Xy, ..., X, weapply the linear operator P, to (7.6.4) to obtain the recursions

PanH-h — qDanXn+h_l + v + q)[)PanH—h—p' (7611)

These equations are easily solved recursively, first for P, X4, then for P, X, .,
P, X,43, ..., &c. If n > p, then the h-step predictors based on all components of
X;,—o0 < j < n, dso satisfy (7.6.11) and are therefore the same as the i-step
predictorsbased on X4, ..., X,.

To compute the h-step error covariance matrices, recall from (7.4.6) that

Xupn =D W Zyin_j, (7.6.12)
j=0

where the coefficient matrices W; are found from the recursions (7.4.8) with ¢ = 0.
From (7.6.12) wefind that for n > p,

o0

P Xusn =Y W,Zy ;. (7.6.13)

J=h

Subtracting (7.6.13) from (7.6.12) gives the h-step prediction error

h-1
Xupn = PiXosn = D Wi Zyin;, (7.6.14)
j=0
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Example 7.6.3

with covariance matrix
h—-1
E [(X11+/1 - Pilxn+h)(xn+h - Pan-Hl)/] = Z \IJ]E\IJ/, n= p- (7615)
j=0

For the (not necessarily zero-mean) causal AR(p) process defined by
Xi=¢o+ P X1+ + chXI—p +Z,, {Z,} ~WN(, %),

equations(7.6.10) and (7.6.11) remain valid, provided that 1o isadded to each of their
right-hand sides. The error covariance matrices are the same as in the case ¢, = 0.

The above calculations are all based on the assumption that the AR(p) model for
the series is known. However, in practice, the parameters of the model are usually
estimated from the data, and the uncertainty in the predicted values of the series
will be larger than indicated by (7.6.15) because of parameter estimation errors. See
L Utkepohl (1993).

The Dow Jones and All Ordinaries Indices

The VAR(1) model fitted to the series {X;,t = 1, ..., 250} in Example 7.6.1 was

[ X1 [ .0288 + —.0148 .0357 || X;-11 " Zn
X2 | [ .00836 .6589  .0998 | | X, 1> Zio |’

[ Z,1 ] 0 .3663 .0224
| Zi2 | WN <[0} ’ [.0224 .6016D '
The one-step mean sguared error for prediction of X,,, assuming the validity of this
model, isthus0.6016. Thisisasubstantial reduction from the estimated mean squared
error 7,,(0) = .7712 when the sample mean (i1, = .0309 is used as the one-step pre-
dictor.

If we fit a univariate model to the series {X,,} using ITSM, we find that the
autoregression with minimum AICC value (645.0) is

X2 =.0273+ .1180X, 12+ Z,, {Z,} ~ WN(O, .7604).

where

Assuming the validity of this model, we thus obtain a mean squared error for one-
step prediction of .7604, which is slightly less than the estimated mean squared error
(.7712) incurred when the sample mean is used for one-step prediction.

The preceding calculations suggest that there is little to be gained from the
point of view of one-step prediction by fitting a univariate model to {X,,}, while
there is a substantia reduction achieved by the bivariate AR(1) model for {X, =
(le, XIZ)/}'

To test the models fitted above, we consider the next forty values {X;,t =
251, ..., 290}, which are stored in the file DJAOPCF.TSM. We can use these val-
ues, in conjunction with the bivariate and univariate models fitted to the data for
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t =1,...,250, to compute one-step predictors of X,,, r+ = 251, ..., 290. The re-
sults are asfollows:

Predictor  Average Squared Error

/. = 0.0309 4706
AR(1) 4591
VAR(1) 3962

Itisclear from these results that the sample variance of the series {X,,, r = 251, .. .,
290} is rather less than that of the series {X,»,t = 1, ..., 250}, and consequently,
the average squared errors of all three predictors are substantially less than expected
from the models fitted to the | atter series. Both the AR(1) and VAR(1) models show
an improvement in one-step average squared error over the sample mean /&, but the
improvement shown by the bivariate model is much more pronounced. O

The calculation of predictors and their error covariance matrices for multivari-
ate ARIMA and SARIMA processes is anaogous to the corresponding univariate
calculation, so we shall simply state the pertinent results. Suppose that {Y,} isanon-
stationary process satisfying D(B)Y, = U, where D(z) =1 —diz —--- —d,7" isa
polynomial with D(1) = 0 and {U,} isacausal invertible ARMA process with mean
w. Then X, = U, — u satisfies

d(B)X, = O(B)Z,, {Z,} ~ WN(O, ). (7.6.16)

Under the assumption that the random vectors Y_, 4, ..., Y are uncorrelated with
the sequence {Z,}, the best linear predictors P,Y; of Y;, j > n > 0, based on 1 and
the componentsof Y ;, —r 4+ 1, < j < n, arefound asfollows. Compute the observed
vauesof U, = D(B)Y,,t =1, ..., n,and usethe ARMA model for X, = U, — u to
compute predictors P,U,,,,. Then use the recursions

f)nYn-kh = PnUVH-h + Z dj i)nYn-Fh—j (7617)
=1

j=

to compute successively P,Y i1, P,Y 12, P,Y .13, €tC. The error covariance matrices
are approximately (for large n)

h—1
E [(Y,,H, —BY ) Yois — PnY,,H,)’] =Y wrguy, (7.6.18)
j=0
where U7 is the coefficient of z/ in the power series expansion
Y VP =DE@ OO, Izl <1
j=0
The matrices ¥; are most readily found from the recursions (7.4.8) after replacing

®;,j=2L1...,p,by @5 j =1,...,p+r, where @ is the coefficient of z/ in
D(2)®(2).
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Remark 6. Inthe specia case where ©(z) = I (i.e, in the purely autoregressive
case) the expression (7.6.18) for the h-step error covariance matrix is exact for all
n > p(i.e,if thereare at least p + r observed vectors) . The program ITSM allows
differencing transformations and subtraction of the mean beforefitting amultivariate
autoregression. Predicted values for the original series and the standard deviations
of the prediction errors can be determined using the multivariate option Forecast-
ing>AR Model. O

Remark 7. In the multivariate case, simple differencing of the type discussed in
this section where the same operator D(B) isapplied to all components of the random
vectorsisrather restrictive. It isuseful to consider moregeneral linear transformations
of the datafor the purpose of generating a stationary series. Such considerations|ead
to the class of cointegrated models discussed briefly in Section 7.7 below. O

Sales with a leading indicator

Assume that the model fitted to the bivariate series{Y,, 7 =0, ..., 149} in Example
7.6.2 iscorrect, i.e., that

O(BX, =2, {Z)~WN(0.%).
where
X;=A—-B)Y,—(.0228, .420)', r=1,...,149,

®B)=I1—P,B—---—PsB%, and Py, ..., ds, I arethematricesfoundin Example
7.6.2. Then the one- and two-step predictors of X5 and X35, are obtained from
(7.6.11) as

A A .163
PragX150 = @1 X149 + -+ - + PsXa5 = |:_.217j|
and
A A A —.027
P1agX151 = @1 PragXisp + PoXg9 + -+ - + PsXyg6 = 816

with error covariance matrices, from (7.6.15),
5 = .076 —.003
| —.003 .095

and

. . [.096 —.002
XA Ode = [—.002 095 }

respectively.
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Similarly, the one- and two-step predictors of Y150 and Y 15, are obtained from

(7.6.17) as

~ [.0228 ] 13.59

P14gY 150 = | 420 | + PragXis0 + Y149 = [262.90]
and

~ [.0228 ] ~ 13.59

PragY 151 = | .420 | ~+ P14gX151 + PragY 150 = [264.14]
with error covariance matrices, from (7.6.18),

g _[ 076 —.003

~ | —.003 .095
and
A A\ .094 —-.003
B+ (1+0:) B (1+) = [—.003 181 ]

respectively. The predicted values and the standard deviations of the predictors can
easily be verified with the aid of the program ITSM. It isalso of interest to compare
the results with those obtained by fitting a transfer function model to the data as
described in Section 10.1 below. O

7.7 Cointegration

We have seen that nonstationary univariate time series can frequently be made sta-
tionary by applying the differencing operator V. = 1 — B repeatedly. If {V?X,} is
stationary for some positiveinteger 4 but { V/-*X, } isnonstationary, we say that { X}
isintegrated of order d, or more concisely, {X;} ~ I(d). Many macroeconomic
time series are found to be integrated of order 1.

If {X,} is ak-variate time series, we define {V“X,} to be the series whose jth
component isobtained by applying the operator (1— B)? tothe jth component of {X,},
j=1,...,k. Theideaof acointegrated multivariate time series was introduced by
Granger (1981) and devel oped by Engleand Granger (1987). Herewe usethe dightly
different definition of Litkepohl (1993). We say that the k-dimensional time series
{X,} is integrated of order d (or {X,} ~ I(d)) if d is a positive integer, {VX}
is stationary, and {V?~*X,} is nonstationary. The /(d) process {X,} is said to be
cointegrated with cointegration vector a if aisak x 1 vector such that {a’X,} is
of order lessthan d.
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Example 7.7.1

Example 7.7.2

A simple example is provided by the bivariate process whose first component is the
random walk

t
X;=)27;, t=12.., (Z})~1ID(0,0?%,
j=1

and whose second component consists of noisy observations of the same random
walk,

=X, +W, t=12..., {W}~1ID(0 1%,

where {W,} is independent of {Z,}. Then {(X;, Y;)’} is integrated of order 1 and
cointegrated with cointegration vector o« = (1, —1)'.

The notion of cointegration captures the idea of univariate nonstationary time
series “moving together.” Thus, even though {X,} and {Y;} in Example 7.7.1 are both
nonstationary, they are linked in the sense that they differ only by the stationary
sequence {W,}. Series that behave in a cointegrated manner are often encountered
in economics. Engle and Granger (1991) give as an illustrative example the prices
of tomatoes U, and V, in Northern and Southern California. These are linked by the
fact that if one were to increase sufficiently relative to the other, the profitability of
buying in one market and selling for aprofit in the other would tend to push the prices
(U,, V,) toward the straight line v = « in R This line is said to be an attractor
for (U,, V,), since athough U, and V, may both vary in a nonstationary manner as
t increases, the points (U;, V;)’ will exhibit relatively small random deviations from
thelinev = u. O

If we apply the operator V = 1 — B to the bivariate process defined in Example 7.7.1
in order to render it stationary, we obtain the series (U,, V,)’, where

U, =7,
and
Vi=Z,+W,—W,_1.

The series {(U;, V;)'} is clearly a stationary multivariate MA(1) process

AR R P e P |

However, the process {(U;, V;)'} cannot be represented as an AR(co) process, since
the matrix [ 2] — z[ % °] has zero determinant when z = 1, thus violating condition
(7.4.10). Care is therefore needed in the estimation of parameters for such models
(and the closely related error-correction models). We shall not go into the detailshere

but refer the reader to Engle and Granger (1987) and L iitkepohl (1993). O
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Problems

7.1.

7.2.

7.3.

7.4.

7.5.

7.6.

Let {Y,} be a stationary process and define the bivariate process X,; = Y,
X2 = Y,_4, Wwhered # 0. Show that {(X,1, X;»)'} is stationary and express its
cross-correlation function in terms of the autocorrelation function of {Y,}. If
py(h) — 0ash — oo, show that thereexistsalag k for which p12(k) > 012(0).

Show that the covariance matrix function of the multivariate linear process
defined by (7.2.12) is as specified in (7.2.13).

Let {X,} bethebivariatetime serieswhose componentsarethe MA (1) processes
defined by

Xu=Z1+.8Z_11. {Za}~1ID(0,0}),
and
Xio=2Zp—.6Z,_15 {Z32}~1ID(0,07),

where the two sequences {Z,,} and {Z,,} are independent.

a. Find alarge-sample approximation to the variance of n/2p1,(h).

b. Find a large-sample approximation to the covariance of n'/?p1,(h) and
n'2p1,(k) for h # k.

Use the characterization (7.5.3) of the multivariate best linear predictor of Y in
terms of {X,, ...X,} to establish the orthogonality of the one-step prediction
erors X; — X; and X, — Xy, j # k, asasserted in (7.6.1).

Determine the covariance matrix function of the ARMA(1,1) process satisfying
X, =X, 1 =2Z,+0Z,1, {Z;} ~WN(Q, I,

where I, isthe 2 x 2 identity matrix and ® = ©' = [%° %3].

a Let {X,} beacausa AR(p) process satisfying the recursions
Xl = (Dlxt—l+"'+(bpxr—p+zla {Zl} NWN(Ov E)

For n > p write down recursions for the predictors P, X, ,, » > 0, and
find explicit expressionsfor the error covariance matricesin terms of the AR
coefficientsand ¥ when s = 1, 2, and 3.

b. Supposenow that {Y,} isthemultivariate ARIMA (p, 1, 0) process satisfying
VY, = X,,where{X,} isthe AR processin (a). Assumingthat E (Y X)) = 0,
forz > 1, show (using (7.6.17) withr = 1 and d = 1) that

h
Baoi) = Yo 4 ) P X,

j=1
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7.7.

7.8.

7.9.

and derive the error covariance matrices when & = 1, 2, and 3. Compare
these results with those obtained in Example 7.6.4.

Use the program ITSM to find the minimum AICC AR model of order less
than or equal to 20 for the bivariate series {(X,;1, X;2)',t = 1, ..., 200} with
components filed as APPIK2.TSM. Use the fitted model to predict (X1, X,2)’,
+ = 201, 202, 203 and estimate the error covariance matrices of the predictors
(assuming that the fitted model is appropriate for the data).

Let{X,;,t=1,...,63}and {X,»,t = 1,..., 63} denote the differenced series
{(VInY,1} and {V InY,,}, where{Y,1} and {Y,,} arethe annual mink and muskrat
trappings filed as APPH.TSM and APPI.TSM, respectively).

a. Use ITSM to construct and save the series {X;1} and {X,,} as univariate
data files X1.TSM and X2.TSM, respectively. (After making the required
transformations press the red EXP button and save each transformed series
to afilewith the appropriate name.) To enter X1 and X2 as abivariate series
in ITSM, open X1 as amultivariate series with Number of columns equal
to 1. Then open X2 as a univariate series. Click the project editor button
(at the top left of the ITSM window), click on the plus signs next to the
projects X1.TSM and X2.TSM, then click on the series that appears just
below X2.TSM and drag it to the first line of the project X1.TSM. It will
then be added as a second component, making X1.TSM a bivariate project
consisting of the two component series X1 and X2. Click 0K to close the
project editor and close the ITSM window labeled X2.TSM. You will then
see the graphs of X1 and X2. Press the second yellow button to see the
correlation functionsof {X,,} and {X,,}. For more information on the project
editor in ITSM select Help>Contents>Project Editor.

b. Conduct afor independence of the two series {X,1} and {X,1}.

Use I TSM to openthedatafile STOCK7.TSM, which containsthe daily returns
on seven different stock market indices from April 27th, 1998, through April
9th, 1999. (Click on Help>Contents>Data sets for moreinformation.) Fit a
multivariate autoregression to the trivariate series consisting of the returns on
the Dow Jones Industrials, All Ordinaries, and Nikkei indices. Check the model
for goodness of fit and interpret the resuilts.



This page intentionally left blank



State-Space Models

8.1 State-Space Representations

8.2 The Basic Structural Model

8.3 State-Space Representation of ARIMA Models
8.4 The Kalman Recursions

8.5 Estimation For State-Space Models

8.6 State-Space Models with Missing Observations
8.7 The EM Algorithm

8.8 Generalized State-Space Models

In recent years state-space representations and the associated Kal man recursions have
had a profound impact on time seriesanalysis and many related areas. The techniques
were originally developed in connection with the control of linear systems (for ac-
counts of this subject see Davis and Vinter, 1985, and Hannan and Deistler, 1988).
An extreméely rich class of models for time series, including and going well beyond
thelinear ARIMA and classical decomposition models considered so far in thisbook,
can be formulated as special cases of the general state-space model defined below in
Section 8.1. In econometrics the structural time series models devel oped by Harvey
(1990) are formulated (like the classical decomposition model) directly in terms of
components of interest such as trend, seasonal component, and noise. However, the
rigidity of the classical decomposition model is avoided by alowing the trend and
seasonal components to evolve randomly rather than deterministically. An introduc-
tion to these structural modelsisgiven in Section 8.2, and astate-space representation
is developed for a general ARIMA process in Section 8.3. The Kalman recursions,
which play a key role in the analysis of state-space models, are derived in Section
8.4. These recursions alow a unified approach to prediction and estimation for all
processes that can be given a state-space representation. Following the development
of the Kalman recursions we discuss estimation with structural models (Section 8.5)
and theformul ation of state-space model sto deal with missing values (Section 8.6). In
Section 8.7 weintroduce the EM algorithm, aniterative procedurefor maximizing the



260 Chapter 8  State-Space Models
likelihood when only asubset of the complete data set isavailable. The EM algorithm
isparticularly well suited for estimation problemsin the state-space framework. Gen-
eralized state-space modelsareintroduced in Section 8.8. These are Bayesian models
that can be used to represent time series of many different types, as demonstrated by
two applications to time series of count data. Throughout the chapter we shall use
the notation
{W;} ~WN(Q, {R,})
to indicate that the random vectors W, have mean 0 and that
R, ifs=1,
E (WYW;) =
0, otherwise
8.1 State-Space Representations

A state-space model for a (possibly multivariate) time series{Y,,t = 1,2, ...} con-
sists of two equations. The first, known as the observation equation, expresses the
w-dimensional observation Y, as alinear function of a v-dimensiona state variable
X; plus noise. Thus

Y, =GX, +W,, =12 ..., (8.1.1)

where {W,} ~ WN(O, {R,;}) and {G,} is a sequence of w x v matrices. The second
equation, called the state equation, determinesthe state X, 1 at timer + 1in terms
of the previous state X, and a hoise term. The state equation is

Xz+1: tht +Vlv t=1, 2,”-» (8.1.2)

where {F;} isasequence of v x v matrices, {V,} ~ WN(O, {Q,}), and {V,} is uncor-
related with {W,} (i.e., E(W,V)) = Ofor al s and ). To complete the specification,
it is assumed that the initial state X, is uncorrelated with al of the noise terms {V,}
and {W,}.

Remark 1. A more general form of the state-space model allows for correlation
between V, and W, (see TSTM, Chapter 12) and for the addition of a control term
H,u; in the state equation. In control theory, H;u, represents the effect of applying
a “control” u, at time ¢ for the purpose of influencing X,,,. However, the system
defined by (8.1.1) and (8.1.2) with E(W,V) = Ofor all s and 7 will be adequate for
our purposes. O

Remark 2. In many important special cases, the matrices F,, G,, Q,, and R, will
be independent of ¢, in which case the subscripts will be suppressed. O
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Definition 8.1.1

Example 8.1.1

Remark 3. It follows from the observation equation (8.1.1) and the state equation
(8.1.2) that X, and Y, havethe functional forms, forr =2, 3, ..,

Xi=F_1Xi_1+V,
= thl(F172Xt72 + szz) + thl

=(F1--F)Xe+ (Foa- - F)Vi+ -+ FoaV, o+ V1

= ﬁ(xl7 Vl’ ey Vt—l) (813)

and
Yl — gl(le Vla ey Vt—la Wf) (814)
O

Remark 4. From Remark 3 and the assumptions on the noise terms, it is clear that
E (VX)) =0, E(V,Y))=0, l=<s=<t,

and
E(WX))=0, 1=<s<t, EW,Y))=0, l<s<t. O

A time series {Y,} has a state-space representation if there exists a state-space
model for {Y,} as specified by equations (8.1.1) and (8.1.2).

Asalready indicated, it is possible to find a state-space representation for alarge
number of time-series (and other) models. It is clear also from the definition that
neither {X,} nor {Y,} isnecessarily stationary. The beauty of astate-space representa-
tion, when one can be found, liesin the simple structure of the state equation (8.1.2),
which permits relatively simple analysis of the process {X,}. The behavior of {Y,} is
then easy to determine from that of {X,} using the observation equation (8.1.1). If the
sequence {X1, V1, Vo, ...} isindependent, then {X;} has the Markov property; i.e.,
thedistribution of X,,; given X,, ..., X, isthesame asthe distribution of X,,; given
X;. Thisisaproperty possessed by many physical systems, provided that we include
sufficiently many components in the specification of the state X, (for example, we
may choose the state vector in such away that X, includes components of X,_; for
eacht).

An AR(T) process
Let {Y,} be the causal AR(1) process given by
Y, =¢Y, 1+ Z, {Z}~WN(0,0%). (8.1.5)
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In this case, a state-space representation for {Y,} is easy to construct. We can, for
example, define a sequence of state variables X, by

Xm=¢X,+V,, t=12,..., (8.1.6)
where X; = Y, = Z;O:o $'Zy_; and V, = Z,,1. The process {Y,} then satisfies the
observation equation

Y, = X,
which hasthe form (8.1.1) with G, = 1and W, = 0. O

An ARMA(1,1) process

Let {Y,} bethe causal and invertible ARMA(1,1) process satisfying the equations
Y, =¢Y 1+ Z,+0Z_1, {Z}~WN(0,07). (8.1.7)

Although the existence of a state-space representation for {Y,} is not obvious, we can
find one by observing that

v,=6B)X, =6 1][’(}21 } (8.1.8)

where {X,} isthe causal AR(1) process satisfying
¢(B)Xt = Z[’
or the equivalent equation

X 0 1| X 0
[X’“}:[O ¢H X, }Jr[z,ﬂ}- (8.1.9)

Noting that X, = 372, ¢’Z,_;, we see that equations (8.1.8) and (8.1.9) for r =
1, 2,... furnish a state-space representation of {¥,} with

o0

The extension of this state-space representation to general ARMA and ARIMA pro-
cessesisgiven in Section 8.3. O

In subsequent sections we shall give examples that illustrate the versatility of
state-space models. (M oreexamplescan befoundin Aoki, 1987, Hannanand Deistl er,
1988, Harvey, 1990, and West and Harrison, 1989.) Before considering these, we need
adlight modification of (8.1.1) and (8.1.2), which allows for seriesin which thetime
index runs from —oo to co. Thisis amore natural formulation for many time series
models.
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State-Space Models with t € {0, £1,...}

Consider the observation and state equations
Y, =GX;,+W,, t=0,%1,..., (8.1.10)
Xip1i=FX,+V,, 1=0,%1,..., (8.1.11)

where F and G are v x v and w x v matrices, respectively, {V,} ~ WN(O, Q),
{W,} ~WN(0, R), and E(V,W,) = Oforall s, and z.

The state equation (8.1.11) is said to be stable if the matrix F has all its eigen-
valuesin the interior of the unit circle, or equivalently if det(/ — Fz) # Oforall z
complex such that |z| < 1. The matrix F isthen also said to be stable.

Inthestable casethe equations(8.1.11) have the unique stationary sol ution (Prob-
lem 8.1) given by

[o.¢]
X, =) FV,_..
j=0

The corresponding sequence of observations

Yo =W, +> GFV,_;,
j=0

isaso stationary.

8.2 The Basic Structural Model

Example 8.2.1

A structural time series model, like the classical decomposition model defined by
(1.5.1), is specified in terms of components such as trend, seasonality, and noise,
which are of direct interest in themselves. The deterministic nature of the trend
and seasonal components in the classical decomposition model, however, limits its
applicability. A natural way in which to overcomethis deficiency isto permit random
variation in these components. This can be very conveniently done in the framework
of a state-space representation, and the resulting rather flexible model is called a
structural model. Estimation and forecasting with thismodel can be encompassed in
the general procedurefor state-space model s made possible by the Kalman recursions
of Section 8.4.

The random walk plus noise model

One of the simplest structural modelsis obtained by adding noise to arandom walk.
It is suggested by the nonseasonal classical decomposition model

Y, =M, + W, where{W,} ~WN(0,07), (8.2.1)
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Figure 8-1

Realization from a random
walk plus noise model.
The random walk is
represented by the solid
line and the data are
represented by boxes.

and M, = m,, the deterministic “level” or “signal” at time . We now introduce
randomness into the level by supposing that M, isarandom walk satisfying

Mia=M+V, ad {V;}~WN(0,07), (8:22)

with initial value M; = m,. Equations (8.2.1) and (8.2.2) constitute the “local level”
or “random walk plus noise” model. Figure 8.1 shows a realization of length 100 of
this model with M; = 0,02 = 4, and 02 = 8. (The redized values m, of M, are
plotted asa solid line, and the observed data are plotted as square boxes.) The differ-
enced data

D :=VY, =Y, =Y, 1=V + W —-W_,, r = 2,

congtitute a stationary time series with mean 0 and ACF
2
p,(h) =1 202 (—;livavz’ Al =1,
0, if |7 > 1.

Since{D,} is1-correlated, we conclude from Proposition 2.1.1 that {D,} isan MA(1)
process and hencethat {Y,} isan ARIMA(0,1,1) process. More specifically,

D, =Z+0Z_1, {Z}~WN(00?)), (8.2.3)
where 6 and o2 are found by solving the equations

0 —0?2 )

= w and #o? = —0c2.
1+62 202407 7 T

For the process {Y;} generating the data in Figure 8.1, the parameters 6 and o2 of

30
T

20
T

10
T

0 20 40 60 80 100
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the differenced series {D,} satisfy 6/(1 + 6?) = —.4 and 602 = —8. Solving these
equations for 6 and o2, wefindthat = —.5and 02 = 16 (or 6 = —2 and 0 = 4).
The sample ACF of the observed differences D, of the realization of {Y;} in Figure
8.1isshownin Figure 8.2.

The local level mode is often used to represent a measured characteristic of the
output of anindustrial processfor which theunobserved processlevel {M,} isintended
to be within specified limits (to meet the design specifications of the manufactured
product). To decide whether or not the process requires corrective attention, it is
important to be able to test the hypothesis that the process level {M,} is constant.
From the state equation, we seethat {M,} is constant (and egual to m;) when V;, = 0
or equivaently when o2 = 0. Thisin turn is equivalent to the moving-average model
(8.2.3) for {D,} being noninvertible with 6 = —1 (see Problem 8.2). Tests of the unit
root hypothesis 9 = —1 were discussed in Section 6.3.2. O

Thelocal level model can easily be extended to incorporate alocally linear trend
with slope 8, at time . Equation (8.2.2) is replaced by

My =M, 1+ B,_1+ V1, (8.2.4)
where B;_; = B,_1. Now if we introduce randomness into the slope by replacing it
with the random walk

B,=B,_1+ U1, Where{U}~WN(0,0?), (8.2.5)
we obtain the “local linear trend” model.

3)
| N USSR USSR SRR
(=] | | | | ; | | | L | | ‘ | —L | | | —t |
o | | ‘ | T | ‘ | T ‘ T | |
Figure 8-2 Stk
Sample ACF of the series | | | | |

obtained by differencing
the data in Figure 8.1.
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To expressthelocal linear trend model in state-space form weintroduce the state
vector

Xz = (M;, Br)/-
Then (8.2.4) and (8.2.5) can be written in the equivalent form

x,+1=[é ﬂ X, 4V, =12 .. (8.2.6)

whereV, = (V;, U,)". Theprocess{Y,} isthen determined by the observation equation
Y,=[1 0| X, +W,. (8.2.7)

If {X1, U1, V1, W1, Us, Vo, Wy, ...} isanuncorrelated sequence, then equations(8.2.6)
and (8.2.7) constitute a state-space representation of the process {Y;}, which is a
model for datawith randomly varying trend and added noise. For this model we have
v=2,w=1,

11 B _|e? O 5
T L ) R

u

A seasonal series with noise

The classical decomposition (1.5.11) expressed the time series {X;} as a sum of
trend, seasonal, and noise components. The seasonal component (with period d) was
a sequence {s,} with the propertiess,,, = s, and Zf:1 s, = 0. Such a sequence can
be generated, for any values of sy, so, ..., s_s13, Dy means of the recursions

Sip1 = —8 — - — Si_g42, = 1,2, .... (828)

A somewhat more general seasonal component {Y;}, allowing for random deviations
from strict periodicity, is obtained by adding a term S, to the right side of (8.2.8),
where {V,} is white noise with mean zero. This |leads to the recursion relations

Yl+l:_Yl_"'_Yt—d+2+Slv t::l., 2, (829)

To find a state-space representation for {Y,} we introduce the (d — 1)-dimensional
state vector

Xo= Y1, ..., Yiai2) .
The series {Y;} isthen given by the observation equation

Y,=[1 0 0---0]X,, t=1,2..., (8.2.10)
where {X,} satisfies the state equation

Xep1=FX, +V,, t=12..., (8.2.11)
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V,=(,0,...,0,and
[ 1 -1 ... -1 1]
1 0 0 0
F=| 0 1 0O O 0
0 O 1 0
Example 8.2.3 A randomly varying trend with random seasonality and noise

A series with randomly varying trend, random seasonality and noise can be con-
structed by adding the two series in Examples 8.2.1 and 8.2.2. (Addition of series
with state-space representationsisin fact always possible by means of the following
construction. See Problem 8.9.) We introduce the state vector

where X! and X? are the state vectorsin (8.2.6) and (8.2.11). Wethen have thefollow-
ing representationfor {Y,}, the sum of thetwo serieswhose state-space representations
weregivenin (8.2.6)—«8.2.7) and (8.2.10)—«8.2.11). The state equation is

| F O v}
Xt+l_ [ 0 F2:|xt+ [VIZ 9
where Fi, F, are the coefficient matrices and {V}}, {V?} arethe noise vectorsin the
state equations (8.2.6) and (8.2.11), respectively. The observation equation is
Y=[1 0 1 0---0X,+W, (8.2.13)

where {W,} is the noise sequence in (8.2.7). If the sequence of random vectors
{X1, Vi, V2 Wy, Vi, V3 W,, .. }isuncorrelated, then equations(8.2.12) and (8.2.13)
constitute a state-space representation for {Y,}. O

(8.2.12)

8.3 State-Space Representation of ARIMA Models

Example 8.3.1

We begin by establishing a state-space representation for the causal AR(p) process
and then build on this example to find representations for the general ARMA and
ARIMA processes.

State-space representation of a causal AR(p) process
Consider the AR(p) process defined by
Yiia=¢d1Yi+ Y g+ -+ @Y pr1+ Ziya,

t=0,+1,..., (83.)
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where {Z,} ~ WN(0, 02), and ¢(z) := 1 — 1z — - - - — $,z7 isnonzero for |z| < 1.
To express {Y,} in state-space form we simply introduce the state vectors
Yipia
x,— | " ot (83.2)
v,

From (8.3.1) and (8.3.2) the observation equation is
Y,=[0 0 0---1X,, r=0,41,..., (8.3.3)
while the state equation is given by

0 1 o --- 0 0
0 0 1 ... 0 0
Xiy1=1 : : X+ | | Zy, =0,£1,.... (834)
0 0 o --- 1 0
Op Gp-1 Gp2 - P1 1
These equations have the required forms (8.1.10) and (8.1.11) with W, = 0 and
V,=(0,0,...,Z.,1),t=0,%+1,.... |

Remark 1. InExample 8.3.1 the causality condition ¢ (z) # Ofor |z| < 1isequiv-
alent to the condition that the state equation (8.3.4) is stable, since the eigenvalues
of the coefficient matrix in (8.3.4) are simply the reciprocals of the zeros of ¢(z)
(Problem 8.3). O

Remark 2. If equations (8.3.3) and (8.3.4) are postulated to hold only for 1 =
1,2,..., andif X4 isarandom vector such that {X,, Z1, Z», ...} isan uncorrelated
sequence, then we have a state-space representation for {Y,} of the type defined
earlier by (8.1.1) and (8.1.2). The resulting process {Y;} is well-defined, regardless
of whether or not the state equation is stable, but it will not in general be stationary.
It will be stationary if the state equation is stable and if X, is defined by (8.3.2) with
Y, = Zjio V,Z_;,t=10,...,2—p,and ¥(z) = 1/¢(2), Iz| < 1. O

State-space form of a causal ARMA(p, q) process

State-space representations are not unique. Here we shall give one of the (infinitely
many) possible representations of a causal ARMA(p,q) process that can easily be
derived from Example 8.3.1. Consider the ARMA(p,q) process defined by

o(B)Y, =0(B)Z,, t=0,+1, ..., (8.3.5)
where {Z,} ~ WN(0, 62) and ¢ (z) # Ofor |z| < 1. Let
r=max(p,q+1), ¢;=0 forj>p, 6,=0 forj>gq, and 6=1
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If {U,} isthe causal AR(p) process satisfying

»(BU, = Z,, (8.3.6)
thenY, = 6(B)U,, since

¢ (B)Y, = ¢(B)O(B)U, = 0(B)p(B)U, = 0(B)Z,.

Consequently,
Y, = [Qrfl O 2 -+ QO]XM (837)
where
Ut—r+l
Ui
X, =| " (8.3.8)
U
But from Example 8.3.1 we can write
[0 1 0o ... 0] [o]
0O oO 1 .. 0 0
Xpr=| ¢ : o X+ P Zys, t=0,41,.... (83.9)
0O oO o .- 1 0
¢r‘ ¢r—1 ¢r—2 e ¢l 1

Equations (8.3.7) and (8.3.9) are the required observation and state equations. As
in Example 8.3.1, the observation and state noise vectors are again W, = 0 and
V,=(0,0,...,Z,,1),t =041, .... O

State-space representation of an ARIMA(p, d, g) process

If {v,} isan ARIMA(p,d, q) process with {V?Y,} satisfying (8.3.5), then by the
preceding example {V/Y, } has the representation

vly,=GX,, t=0,41,..., (8.3.10)
where {X,} isthe unique stationary solution of the state equation
Xz+1 = Fxt +Vt,

F and G are the coefficients of X, in (8.3.9) and (8.3.7), respectively, and V, =
(0,0,...,Z,41).Let Aand B bethed x 1andd x d matricesdefinedby A = B =1
if d =1and

0 0 1 0 0
0 0 0 1 0
A=|:1|, B= : : : :
0 0 0 0 1
1 (_1)d+l(;l) (D¢ (dil) (_1)d71(di2) e d
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if d > 1. Then since
Y, =V, =) ( .)(—1)114_], (8.3.11)
=1\
the vector
Yie1: =Ygy .o, Y1)
satisfies the equation
Y, = AVYY, + BY,_1 = AGX, + BY,_1.

Defining anew state vector T, by stacking X, and Y,_;, we therefore obtain the state
equation

. Xl‘+1 _ F 0 Vl‘ _
Tt+1._[ Y }_[AG B}T,+[O}, t=12..., (8.3.12)

and the observation equation, from (8.3.10) and (8.3.11),

_ a4 i @ _peaf @ Xi
Y,—|:G (-1 (d) (=1 (d—l) -1 (d—2> d:| |:Yt—1:|’

r=12,..., (8313

with initial condition
FIV_;
T, = [Xl} _ Z il (8.3.14)

and the assumption
E(NYoZ)=0, t=0%£1,..., (8.3.15)

where Yo = (Y1_4, Yo_4, ..., Yo)'. The conditions (8.3.15), which are satisfied in
particular if Y, is considered to be nonrandom and equal to the vector of observed
values (y1_q, Y2—a» - - - » Yo), @re imposed to ensure that the assumptions of a state-
spacemodel givenin Section 8.1 aresatisfied. They alsoimply that £ (X;Y{) = Oand
E(YOV"Y,’) =0, t+ > 1, asrequired earlier in Section 6.4 for prediction of ARIMA
processes.

State-space models for more general ARIMA processes (e.g., {¥;} such that
{VVyY,}isan ARMA(p, q) process) can be constructed in the same way. See Prob-
lem 8.4. O

For the ARIMA(1, 1, 1) process defined by
(1-¢B)1—B)Y,=1+6B)Z,, {Z}~WN(0,07),
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the vectors X; and Y,_; reduceto X; = (X,_1, X;) and Y,_; = Y,_;. From (8.3.12)
and (8.3.13) the state-space representation is therefore (Problem 8.8)

X1
Y,=[9 1 1] x, |, (8.3.16)
Y1
where
X, 01 0]|[x._, 0
Xo1|=|0 6 O] X, |+|zul r=12.. (8317
Y, 6 1 1| v, 0
and
2 V7,
Xo j=0
X, | =] & (8.3.18)
YO Zd)]zl_j
j=0
Yo

8.4 The Kalman Recursions

Inthissectionweshall consider three fundamental problemsassociated with the state-
space model defined by (8.1.1) and (8.1.2) in Section 8.1. These are all concerned
with finding best (in the sense of minimum mean square error) linear estimates of
the state-vector X, in terms of the observationsY,, Yo, ..., and arandom vector Y
that is orthogonal to V, and W, for al r > 1. In many cases Y will be the constant
vector (1,1, ..., 1). Estimation of X, in terms of:

a. Yo,..., Y, 1 definesthe prediction problem,
b. Yo, ..., Y, definesthefiltering problem,
c. Yo, ..., Y, (n>r)definesthe smoothing problem.

Each of these problems can be solved recursively using an appropriate set of Kalman
recursions, which will be established in this section.

In the following definition of best linear predictor (and throughout this chapter)
it should be noted that we do not automatically include the constant 1 among the
predictor variables as we did in Sections 2.5 and 7.5. (It can, however, be included
by choosing Yo = (1,1,...,1).)
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Definition 8.4.1

For the random vector X = (X4, ..., X,)/,
P,(X) := (P(X1), ..., P(X,)),

where P,(X;) '= P(X;|Yo, Y41,...,Y,),isthebest linear predictor of X; interms
of al componentsof Yo, Y1,...,Y,.

Remark 1. By the definition of the best predictor of each component X; of X,
P, (X) isthe unique random vector of the form

Pz(x):A0Y0+"‘+Ath
with v x w matrices Ay, . .., A, such that
[X=PX)] LY, s=0,...,¢1

(cf. (7.5.2) and (7.5.3)). Recall that two random vectors X and Y are orthogonal
(written X L Y) if E(XY’) isamatrix of zeros. O

Remark 2. If all the componentsof X, Y, ..., Y, arejointly normally distributed
andY,=(1,...,1), then

PX)=EX|Ys,....,Y), t>1 a
Remark 3. P, islinear inthesensethat if A isany k x v matrix and X, V are two
v-variate random vectors with finite second moments, then (Problem 8.10)

P, (AX) = AP, (X)
and

P(X+V)=PX)+ P (V). O
Remark 4. If X andY arerandom vectors with v and w components, respectively,
each with finite second moments, then

PX|Y) = MY,

where M isav xw matrix, M = E(XY")[E(YY")] twith[E(YY")]"*any generalized
inverse of E(YY’). (A generdized inverse of a matrix S is a matrix S~* such that
§§S71§ = . Every matrix has at least one. See Problem 8.11.)

In the notation just devel oped, the prediction, filtering, and smoothing problems
(@), (b), and (c) formulated above reduce to the determination of P,_1(X,), P,(X,),
and P,(X;) (n > r), respectively. We deal first with the prediction problem. O
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Kalman Prediction:
For the state-space model (8.1.1)—(8.1.2), the one-step predictors X, = P,_1(X,)
and their error covariance matrices , = E[(X, — X,)(X, — X,)’] are uniquely
determined by theinitial conditions
X1 = P(X1|Yo), Q= E[(X1— )21) (X1 — Xl)/]
and therecursions, forr =1, ...,
XWF:EX,+@Aﬁ(Y,—aXJ, (8.4.1)
Q1=FQF +0,—0,A10, (8.4.2)
where
At - GtQtG; + Rta
®z = FIQIG;7
and A isany generalized inverse of A,.
Proof We shall make use of theinnovations |, defined by 1, = Y, and

h:ﬁ—ﬂ{ﬂ:ﬁ—@&:G%&—XJ+W“t:LZ””
Thesequence{l,} isorthogonal by Remark 1. Using Remarks 3 and 4 and therelation
P () = P1() + P(lY) (8.4.3
(see Problem 8.12), we find that
Xip1 = PoaXop1) + PXoqall) = Pa(FX, + V) + 0,471,
= FX, +0,A7,, (8.4.4)
where
A =E(,1))=G,G, +R,
(L=EMHﬂD=EUEK+Vqu—XJYX+WQ]
= F,Q.G.
To verify (8.4.2), we observe from the definition of 2, that

Qt-ﬁ-l =E (Xt+1x;+1) —-E (>A(t+1)A<;+1> .
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Example 8.4.1

With (8.1.2) and (8.4.4) this gives

t

Q1= FEXX)F + Q, — F,E ()2,5(;) F — ©,A70)

= F,Q.F + 0, — ©,A'0),. |

h-step Prediction of {Y,} Using the Kalman Recursions

The Kalman prediction equations|ead to avery simple a gorithm for recursive calcu-
lation of the best linear mean square predictors P,Y,,,, h = 1,2, .... From (8.4.4),
(8.1.1), (8.1.2), and Remark 3 in Section 8.1, wefind that

szt+1 =F Ptlet + ®tAt_1(Yt - Ptlet)s (845)
PXiinh = Fiopn—1PiXiipn-1

— (FnaFono - Fiid) PXoys, h=23 ..., (8.4.6)
and
PYoin = GrnPXen, h=12.... (8.4.7)
From the relation
Xiwn — PXopn = FnmaXigpmr — PX 1) + Vg1, h=2,3,...,
wefind that Q" := E[(X,3n — P-Xssn) KXin — P X,45)] satisfies the recursions
QW = F 1 Q" F 1+ OQrnr, h=2,3,..., (8.4.8)

with @Y = Q,,1. Thenfrom (8.1.1) and (8.4.7), A" := E[(Y,s1 — P.Y o) (Y 1in —
PiY )] isgiven by

AP =G Q"G+ Ry, h=12.... (8.4.9

Consider the random walk plus noise model of Example 8.2.1 defined by
Y, =X, + W, {W}~WN(0,0?),

w

where the local level X, follows the random walk
X=X, +V, {(V}~WN(0,0?).
Applying the Kalman prediction equations with Y, := 1, R = 02, and Q = 0?2, we
obtain
V= PY=X +®’(Y f/)
t+1 — L4l — Ag A t t

t

= (1_at)1?t +aY,
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where

6,
A, Q402

w

a;

For astate-spacemodel (likethisone) with time-independent parameters, the solution
of the Kalmanrecursions (8.4.2) iscalled asteady-state solution if €2, isindependent
of t. If @, = Q for al ¢, then from (8.4.2)

2 Q? Qoi 2
QH_]_:Q:Q—{—O’U — Q-|—o’2 = Q+02 +Uv'

Solving this quadratic equation for € and noting that > 0, we find that

1
Q= > (crv2+,/a,j‘+4avza£)

Since Q,,1 — £, is a continuous function of &, on @, > 0, positive at Q, = 0,
negative for large 2;, and zero only at 2, = Q, itisclear that 2,1 — €, is negative
for @, > Q and positivefor 2, < Q. A similar argument shows (Problem 8.14) that
(2,41 — Q)(2, — ) > 0for all 2, > 0. These observationsimply that 2,,; always
falls between © and ;. Consequently, regardless of the value of Q2;, 2, converges
to @, the unique solution of Q,,; = ,. For any initia predictors ¥, = X; and any
initial mean squared error Q; = E (X, — f(l)z, the coefficients a, := @,/ (, + 02)
converge to

_ Q
Q402

w

a

and the mean sguared errors of the predictors defined by
?z-&-l =(1- at)?z‘ +aY,

convergeto Q + o2

If, asisoftenthe case, we do not know €21, then we cannot determinethe sequence
{a,}. It is natural, therefore, to consider the behavior of the predictors defined by

?Hl =(1- a)f]t +at,

with a as above and arbitrary ¥;. It can be shown (Problem 8.16) that this sequence
of predictorsis also asymptotically optimal in the sense that the mean squared error
convergesto 2 + o2 ast — oo.

Asshownin Example 8.2.1, the differenced process D, = Y, — Y,_; isthe MA(1)
process

D, =Z+0Z_y, {Z,} ~WN(0,07),
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Proof

where 6/ (14 6%) = —02/ (202 + 02). Solving this equation for 6 (Problem 8.15),
we find that

1
0=—-— (202402~ /0! + 40202
202

andthat 0 =a — 1.
It isinstructive to derive the exponential smoothing formulafor Y, directly from
the ARIMA(0,1,1) structure of {Y,}. For ¢+ > 2, we have from Section 6.5 that

?H-l = Yz + 9t1(Yt - ?t) = _th?l + (l + Qzl)Yz

for ¢t > 2, where6,, isfound by application of theinnovations algorithm to an MA(1)
processwith coefficient 6. It followsthat 1—a, = —6,1,andsinced,; — 6 (seeRemark
1 of Section 3.3) and a, converges to the steady-state solution a, we conclude that

l-a=Ilim@A—-a)=-1imo, =—6. O
—>00 —00

Kalman Filtering:

The filtered estimates X,, = P,(X,) and their error covariance matrices Q,, =
E[(X; — X;)(X; — X;1)'] are determined by the relations

PX, = P_iX, + Q.G AT (YZ - G,)Z,) (8.4.10)
and

Q= — UG AGQ. (8.4.11)

From (8.4.3) it follows that
PX, = P_1X, + Ml,,
where
M =EX IDIE( D] = E[X,(G,(X, — X)) + W) |A = Q,GA (8.4.12)
To establish (8.4.11) we write
X, — P_iX, =X, — PX, + PX, — P_1X, =X, — PX, + Ml,.

Using (8.4.12) and the orthogonality of X, — P, X, and M|, we find from the last
equation that

Q = + QUG ATG,Q,,

asrequired. [ |
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Kalman Fixed-Point Smoothing:

The smoothed estimates X,,, = P,X, and the error covariance matrices ,, =
E[(X; — X)X, — X,,)'] are determined for fixed 7 by the following recursions,
which can be solved successively forn =¢,¢r + 1, .. .

PX, = Pi_iX, + 2,,G. ATt (Y,, - Gx) : (8.4.13)
Qi1 = QalF — 0,A,1G,], (8.4.14)
Q= Q1 — .G AG,Q, (8.4.15)

n="n t,n?

with initial conditions P,_1 X, = X, and Q,, = Q,—1 = 2, (found from Kalman
prediction).

A

Proof  Using (8.4.3) wecanwrite P, X, = P,_1X, + Cl,,, wherel, = G,(X, — X,) + W,.
By Remark 4 above,

C=E [X,(Gn (x,, — X) n Wn)’] [E(L1)] " =9.,G,A%  (84.16)

n n

where ., = E[(X, — X,)(X, — X")J It follows now from (8.1.2), (8.4.5), the
orthogonality of V,, and W, with X, — X,, and the definition of 2, ,, that
Qs = E [(x, - X,) (x,, - x) (F, — @,,A;lG,,)/] =, [F, - 0,A,%G,] .
thus establishing (8.4.14). To establish (8.4.15) we write
X, — PX, =X, — P, X, — Cl,.
Using (8.4.16) and the orthogonality of X, — P,X; and |, thelast equation then gives
Qup = Q-1 — aGLAGQ,, n=1t1+1...,

as required. ]

8.5 Estimation For State-Space Models

Consider the state-space model defined by equations (8.1.1) and (8.1.2) and suppose
that the model is completely parameterized by the components of the vector 6. The
maximum likelihood estimate of 8 isfound by maximizing thelikelihood of the obser-
vationsYy, ..., Y, with respect to the components of the vector 8. If the conditional
probability density of Y, givenY,_1 =V¥,_1,..., Yo = YoiS f;¢-lYi1, ..., Yo), then
thelikelihood of Y,,r = 1, ..., n (conditional on Y ), can immediately be written as

LO: Y1 ....Y) =[[AYilYi1. ... Yo). (8.5.1)
=1
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The calculation of the likelihood for any fixed numerical value of 0 is extremely
complicated in general, but is greatly ssimplified if Yo, X; andW,,V,,r =1,2,...,
are assumed to be jointly Gaussian. The resulting likelihood is called the Gaussian
likelihood and iswidely used intime seriesanalysis(cf. Section 5.2) whether thetime
seriesistruly Gaussian or not. Asbefore, we shall continueto use theterm likelihood
to mean Gaussian likelihood.

If Yo, X;and W,,V,,r = 1,2,..., arejointly Gaussian, then the conditional
densitiesin (8.5.1) are given by

_ 1, _
Fi YY1, ..., Yo) = 2n)™"/2 (detA,) Y exp |:—§I,A, 1|,} ,

wherel, =Y, — P._1Y, = Y, — GX,, P..1Y,,and A,, t > 1, are the one-step pre-
dictors and error covariance matrices found from the Kalman prediction recursions.
The likelihood of the observations Y4, ..., Y, (conditional on Y ) can therefore be
expressed as

n -1/2 n
L@:;Y1,....Y,) = 2r)"/? (]‘[ detA,-) exp [—% > orA ,} . (85.2)
j=1 j=1

GiventheobservationsY,, ..., Y,, thedistribution of Y (see Section 8.4), and a
particular parameter value 8, the numerical value of thelikelihood L can be computed
from the previous equation with the aid of the Kalman recursions of Section 8.4. To
find maximum likelihood estimates of the components of 8, anonlinear optimization
algorithm must be used to search for the value of 6 that maximizes the value of L.

Having estimated the parameter vector 6, we can compute forecasts based on the
fitted state-space model and estimated mean squared errors by direct application of
equations (8.4.7) and (8.4.9).

Application to Structural Models

The genera structural model for a univariate time series {Y,} of which we gave
examples in Section 8.2 has the form

Y, =GX,+W,, {W,}~WN(0,02), (8.5.3)
Xig1=FX; +V;, {V.} ~WN(Q, 0), (8.5.4)
forr = 1,2,..., where F and G are assumed known. We set Yy = 1 in order to

include constant terms in our predictors and compl ete the specification of the model
by prescribing the mean and covariance matrix of the initia state X;. A ssmple and
convenient assumption isthat X is equal to a deterministic but unknown parameter
p and that )A(l = u, So that Q; = 0. The parameters of the model are then i, O,
and o 2.

Direct maximization of the likelihood (8.5.2) is difficult if the dimension of the
state vector islarge. The maximization can, however, be simplified by the following
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stepwiseprocedure. For fixed O wefind f1(Q) and o2 ( Q) that maximizethelikelihood
L (p, Q. 02). Wethen maximize the “reduced likelihood” L (£(Q), 0, 62(Q)) with
respect to Q.

To achieve this we define the mean-corrected state vectors, X* = X, — F'~!p,
and apply the Kalman prediction recursions to {X*} with initial condition X; = O.
This gives, from (8.4.1),

Ria=FX +0,07 (Y, -GX;). r=12... (855)
with X3 = 0. Since X, also satisfies (8.5.5), but with initial condition X, = p, it
follows that

X, =Xi+ Cips (8.5.6)

for some v x v matrices C;. (Note that although >2, = P(X;|Yo, Y1, ..., Y}), thequan-
tity )2;* is not the corresponding predictor of X*.) The matrices C, can be determined
recursively from (8.5.5), (8.5.6), and (8.4.1). Substituting (8.5.6) into (8.5.5) and
using (8.4.1), we have

= FX,+ 0,8 (Y, = GX,) = (F - ©,A,%G) Cu

=X — (F = ©,A7'G) C,p,

so that
Crii=(F—0©,A7G) C, (8.5.7)
with C; equal to the identity matrix. The quadratic form in the likelihood (8.5.2) is
therefore
A\ 2
s 2 Xn:(Y’_GX’) 8538
,0Q,0,) = EEe— .O.
(», Q,0,) 2 A ( )
~ 2
: (Y, —GXr - GC,u)
= . (8.5.9)

=1 A

Now let O* := 0,20 and define L* to be the likelihood function with this new
parameterization, i.e., L* (u, 0%, 02) = L (p, 620", 07). Writing A7 = 0,2A, and

QF = 0,°Q,, we see that the predictors X and the matrices C, in (8.5.7) depend on
the parameters only through Q*. Thus,

S(m. Q.02) =0,°S(n. 0%, 1),
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Example 8.5.1

<0 that

—2InL* (u, 0*,02) =nIn(2r) + Z INA, + 0,28 (1, 0%, 1)

t=1

=nIn@m)+ > INA7 +ninol +0,%S (1. 07, 1).
=1
For O* fixed, it is easy to show (see Problem 8.18) that this function is minimized
when

1 ¢
n v n C/IG'(Y, — GX*
L C/G'GC (G (Y, :
f=p(0") = [Z e ’} > ( e ) (8.5.10)
=1 t =1 t
and
N R 2
52 =62(0") =n"" Z (Yt O - GC’“> (8.5.11)
o = =n RO N
w w — A;k

Replacing p and o2 by these valuesin —2In L* and ignoring constants, the reduced
likelihood becomes

+n7tY In(detar). (8512

t=1

Y, — GX* — Gc,ﬁ)z)

2(Q*) =In (n_li:( X

If O* denotesthe minimizer of (8.5.12), then the maximum likelihood estimator of the
parameters i, O, o2 are fi, 620*, 62, where fu and 62 are computed from (8.5.10)
and (8.5.11) with Q* replaced by O*.

We can now summarizethe stepsrequired for computing the maximum likelihood

estimators of p, O, and o2 for the model (8.5.3)—(8.5.4).

1. For afixed Q*, apply the Kalman prediction recursions with X; =0, 2; =0,

0 = 0%, and 02 = 1 to obtain the predictors X*. Let A* denote the one-step

prediction error produced by these recursions. A

Set o = 1(0") = [X1_, C/G'GC,/A] Y, C/G'(Y, — GX) /AL,

3. Let O* bethe minimizer of (8.5.12).

4. Themaximum likelihood estimators of ., Q, and o2 arethen given by fi, 20,
and 62, respectively, where fx and 62 are found from (8.5.10) and (8.5.11) eval-
uated at Q*.

N

Random walk plus noise model
In Example 8.2.1, 100 observations were generated from the structural model
Y, =M+ W, {W}~WN(002),
M1 =M +V, {Vi}~WN(0 0},
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Example 8.5.2

with initial values u = M; = 0, 62 = 8, and 02 = 4. The maximum likelihood
estimates of the parameters are found by first minimizing (8.5.12) with i given by
(8.5.10). Substituting these valuesinto (8.5.11) gives 62. The resulting estimates are
ft = .906, 62 = 5.351, and 62 = 8.233, which are in reasonably close agreement
with the true values. O

International airline passengers, 1949-1960; AIRPASS.TSM

Themonthly totalsof international airline passengersfrom January 1949 to December
1960 (Box and Jenkins, 1976) are displayed in Figure 8.3. The data exhibit both a
strong seasona pattern and a nearly linear trend. Since the variability of the data
Y1, ..., Y1y increases for larger values of Y;, it may be appropriate to consider a
logarithmic transformation of the data. For the purpose of thisillustration, however,
we will fit a structural model incorporating a randomly varying trend and seasonal
and noise components (see Example 8.2.3) to the raw data. This model has the form

Y, = ze + W,
Xz+l = Fxt +Vta

{W,} ~WN (0,02),
{V:} ~WN(, 0),

where X, isa 13-dimensional state-vector,

(112 0 0 - 0 O]
01 0 0 --- 0 O
00 -1 -1 1 -1
F_|l00 1 o0 o o |
00 0 1 0 0
00 0 0 - 1 0
G=[1 010 ... 0],
and

(62 0 0 0 --- 0]

0 62 0 0 --- 0

0 0 620 --- 0
=0 0 0 0 --- 0

0O 0 0 0 --- 0

The parameters of the model are u, o2, 02, 02, and o2, where p = X;. Minimizing
(8.5.12) with respect to 0* we find from (8.5.11) and (8.5.12) that

(62,62, 62,62) = (170.63, .00000, 11.338, .014179)

w
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International airline
passengers; monthly °
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to December 1960.

and from (8.5.10) that » = (146.9, 2.171, —34.92, —34.12, —47.00, —16.98, 22.99,
53.99, 58.34, 33.65, 2.204, —4.053, —6.894)". The first component, X, of the state
vector corresponds to the local linear trend with slope X,,. Since 62 = 0, the Slope
at time ¢, which satisfies

Xio=X,_12+ Via,

o
sL
Yo}
—— local level
-------- slope
o p
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n o™
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in Example 8.5.2.
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must be nearly constant and equal to X1, = 2.171. Thefirst three components of the
predictors X, are plotted in Figure 8.4. Notice that the first component varies like a
random walk around astraight line, while the second component is nearly constant as
aresult of 62 ~ 0. The third component, corresponding to the seasonal component,
exhibits a clear seasonal cycle that repeats roughly the same pattern throughout the
12 years of data. The one-step predictors X,; + X3 of ¥, are plotted in Figure 8.5
(solid line) together with the actual data (square boxes). For this model the predictors
follow the movement of the data quite well. O

8.6 State-Space Models with Missing Observations

State-space representations and the associated Kalman recursions are ideally suited
to the analysis of data with missing values, as was pointed out by Jones (1980) in the
context of maximum likelihood estimation for ARMA processes. In this section we
shall deal with two missing-value problems for state-space models. The first is the
evaluation of the (Gaussian) likelihood based on {Y,,, ..., Y, }, whereiy, ip, ..., i,
are positive integers such that 1 < iy < i, < --- < i, < n. (This alows for
observation of theprocess{Y,} at irregular intervals, or equivalently for the possibility
that (n —r) observationsaremissing fromthe sequence{Y, ..., Y,}.) Thesolution of
thisproblemwill, in particular, enable usto carry out maximum likelihood estimation
for ARMA and ARIMA processes with missing values. The second problem to be
considered is the minimum mean squared error estimation of the missing values
themselves.
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The Gaussian Likelihood of {Y,,,...,Y;}, 1<ii<h<---<i.<n

Consider the state-space model defined by equations (8.1.1) and (8.1.2) and suppose
that the model is completely parameterized by the components of the vector 6. If
there are no missing observations, i.e., if r =nandi; = j,j = 1,...,n, thenthe
likelihood of the observations{Y4, ..., Y,} iseasily found asin Section 8.5 to be

-1/2
n 1 n , .

detAj) @(p[—EZIjAj |_,},
=1 j=1

wherel; = Y, — P;_1Y; and A;, j > 1, are the one-step predictors and error
covariance matrices found from (8.4.7) and (8.4.9) with Y, = 1.

To deal with the more general case of possibly irregularly spaced observations
{Yi,...,Y,;}, weintroduce a new series {Y}, related to the process {X,} by the
modified observation equation

J

L@O;Yq,....Y,) = (271)*”“’/2 (

Y; =G/ X, +W;, =12 ..., (8.6.1)
where
G, ift e {ils”-,ir}’ W, ifre {il,...,ir},
G = _ Wi = (8.6.2)
and {N,} isiid with
N, ~ N, I,xw), Ny LX;, N;L [\X; ] s,t=0,%1,.... (86.3)
t

Equations(8.6.1) and (8.1.2) constitute a state-space representation for the new series
{Y7}, which coincides with {Y,} at each r € {i1, ip, ..., i}, and at other times takes
random values that are independent of {Y,} with a distribution independent of 6.
Let Ly (6; Vi, ....Y;) bethe Gaussian likelihood based on the observed values
Vi ---»>Yi Of Yi, ..., Y; under the model defined by (8.1.1) and (8.1.2). Corre-

sponding to these observed values, we define anew sequence, y;, . .., Yy, by
ifrefil,....i.},
_ {y’ oo i} (8.6.4)
0 otherwise.
Then it is clear from the preceding paragraph that
Li(0; Vi, ..., Yi) = o)Ly (055, ..., Y5, (8.6.5)

where L, denotes the Gaussian likelihood under the model defined by (8.6.1) and
(8.1.2).

In view of (8.6.5) we can now compute the required likelihood L of the realized
vaues{y,, t =iy, ..., i} asfollows:

i. Definethesequence{y’,r =1,...,n}asin(8.6.4).
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ii. Find the one-step predictors Y* of Y#, and their error covariance matrices A*,
using Kalman prediction and equations (8.4.7) and (8.4.9) applied to the state-
space representation (8.6.1) and (8.1.2) of {Y}. Denote the realized values of the
predictors, based on the observation sequence {y;}, by {y:}.

iii. Thereguired Gaussian likelihood of theirregularly spaced observations{y;,, . ..,
y;.} isthen, by (8.6.5),

—1/2
n 1 g
Li(6: Yo, Yi) = (2”)%/2( aet A7> eXp{_EZ'? & l'j}’
j=1 j=1

where ij. denotes the observed innovation y; — y;, j=1...,n.
Example 8.6.1  An AR(1) series with one missing observation
Let {Y,} be the causal AR(1) process defined by

Y, —¢Y1=2Z, {Z}~WN(0,07).

Tofind the Gaussian likelihood of the observations y1, ys, y4, and ys of Yy, Y3, Y4, and
Ys we follow the steps outlined above.

i. Sety*=y,i=1345andy; =0.
ii. We start with the state-space model for {Y;} from Example 8.1.1, i.e, ¥; =
X, Xi41 = ¢X,+ Z,41. Thecorresponding model for {Y;*} isthen, from (8.6.1),
Y/=GX, +W',t=12...,
where

X[+1=FIXI+‘/t’ t=1927"'7

1 ifr#2, 0 ifr#£2,
F =9, G;"z{ Vi=Zi, W' =
0 ifr=2 N, ifr=2
0 ifr+#2,
Q, =o? er{ SF=0,
1 ifr=2,

and X1 = Y7, ¢’ Z1;. Starting from theinitial conditions

A

X1 =0, Q =0%/(1-¢%).
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and applying the recursions (8.4.1) and (8.4.2), we find (Problem 8.19) that

o’/ (1—9¢%) ifr=1,
¢ ift=134,5,

O,A7 = Q, ={ 0?2 (1+ ¢? ifr =3,
o 0 ifr=2 ' (1+9%)

o2 iftr =245,
and

X1=0, Xo=¢Y, Xs=0¢Y1, Xo=¢Ys, Xs5=¢Vs
From (8.4.7) and (8.4.9) with h = 1, wefind that
Y7 =0, ¥3=0, ¥5=¢°11, V;=¢Ys V=9V,
with corresponding mean squared errors
Aj=0%/(1-¢%), A;=1Aj=0*(1+9¢%), Aj=0% Ai=0"

iii. From the preceding cal culations we can now write the likelihood of the original
data as

Li(¢.0% y1, v3, ya y5) =0 *2m) ?[(1-¢%) / (1 + ¢2)]1/2

22
[Y%(1—¢2)+M+()’4—¢y3)2+()’5—¢)’4)2:|}-D

1
x exp | — 1342

202
Remark 1. If we are given observations y; 4, Y2-a, - - - » Y0, Yiy» Yip» - - - » ¥i, OF @
ARIMA(p,d, q) processat times1 —d,2—4d,...,0,i1,...,i,, wherel < i; <
i» <--- < i, <n,asimilar argument can be used to find the Gaussian likelihood of
Vitr s Vi, conditional on Yia=y1a,Y0ag = You,--., Yo = Yo. Mlssmg values
among thefirst d observations y1_4, y2_4, . . ., ¥o can be handled by treating them as
unknown parameters for likelihood maximization. For more on ARIMA series with
missing values see TSTM and Ansley and Kohn (1985). O

Estimation of Missing Values for State-Space Models

Giventhat weobserveonly Y, Y;,, ..., Y; , 1 <iy <ip <--- <i, < n,where{Y,}
has the state-space representation (8.1.1) and (8.1.2), we now consider the problem
of finding the minimum mean squared error estimators P (Y,|Yo, Yy, ..., Y;) of Y,,
1 <r < n,whereYy = 1. To handle this problem we again use the modified process
{Y;} defined by (8.6.1) and (8.1.2) with Y = 1. Since Y! = Y, fors € {i1, ..., i}
andY* L X,, Yoforl <t <nands ¢ {0,i1,...,i}, weimmediately obtain the
minimum mean squared error state estimators

P(XIYo, Vi, Y5) = P(XJIYE YL, ...,Y), 1<t<n  (866)
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Example 8.6.2

Theright-hand side can be eval uated by application of the Ka man fixed-point smooth-
ing agorithmto the state-spacemodel (8.6.1) and (8.1.2). For computational purposes
the observed values of Y, ¢ ¢ {0, i1, ..., i}, are quite immaterial. They may, for
example, all be set equal to zero, giving the sequence of observations of Y defined
in (8.6.4).

Toevaluate P (Y|Yo, Y, ..., Y;), 1 <1 <n, weuse(8.6.6) and the relation

Y[ — GtXf + Wt‘ (8.6.7)
SinceE (V,W)) =5, =0, r=1,...,n, wefindfrom (8.6.7) that
P(YlYo0, Yoo, Yi) =GP (X |YE, Y5, ..., 7). (8.6.8)

An AR(1) series with one missing observation

Consider the problem of estimating the missing value Y, in Example 8.6.1 in terms of
Yo = 1, Y1, Y3, ¥4, and Ys. We start from the state-space model X, ;1 = ¢ X, + Z;,1,
Y, = X,,for {Y,}. Thecorresponding model for {Y,*} isthe one used in Example 8.6.1.
Applying the Kalman smoothing equations to the latter model, we find that

@Y1+ Y3)
P1X2=¢Y1, P2X2=¢Y1, P3X2=(1+—¢2),
PyXy = P3X5, PsXo = P3X»,
Qo2 =07, Q23 = ¢po?, Q, =0, t>4,
and
2 2 o?
Qo =0 Qp=0°, 92\z=a+—(]>2), t>3,

where P, (-) heredenotes P (-|Y3, ..., Y;*) and Q, ,, 2, aredefined correspondingly.
We deducefrom (8.6.8) that the minimum mean squared error estimator of the missing
valueY,is

Y- Y
PsY, = PsX, = m,
(1+¢?)
with mean squared error
Q= O
2|5 = (l+ ¢2).
Remark 2. Suppose we have observations Y1 4, Y2 4, ..., Y0, Yy, ..., Y, (1 <
i1 <iz---<i, <n)ofan ARIMA(p, d, q) process. Determination of the best linear
estimates of the missing values Y;, ¢ ¢ {i1,...,i.},intermsof Y,, t € {i1,..., i},
and the components of Y := (Y1_4, Ya_4, ..., Yo)’ can be carried out asin Example

8.6.2 using the state-space representation of the ARIMA series {Y;} from Example
8.3.3 and the Kalman recursions for the corresponding state-space model for {Y,*}
defined by (8.6.1) and (8.1.2). See TSTM for further details. O
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Example 8.6.3

We close this section with a brief discussion of a direct approach to estimating
missing observations. This approach is often more efficient than the methods just
described, especialy if the number of missing observations is small and we have
a simple (e.g., autoregressive) model. Consider the general problem of computing
E(X]Y) when the random vector (X’, Y’)" hasamultivariate normal distribution with
mean 0 and covariance matrix . (In the missing observation problem, think of X as
the vector of the missing observationsand Y asthe vector of observed values.) Then
the joint probability density function of X and Y can be written as

Fon O Y) = Loy XIV) £, (), (8.6.9)

where f, . (X]y) is amultivariate normal density with mean E(X|Y) and covariance
matrix ¥, . (see Proposition A.3.1). In particular,

XIY

1
ForXIy) = exp {—§<x — EXXIY) =2 x — E<X|y)>} . (86.10)

1
J@ryidets,

where ¢ = dim(X). It is clear from (8.6.10) that f,,(X|y) (and also fx.v(X,y))
is maximum when X = E(X|y). Thus, the best estimator of X in terms of Y can be
found by maximizing thejoint density of X and Y with respect to x. For autoregressive
processes it is relatively straightforward to carry out this optimization, as shown in
the following example.

Estimating missing observations in an AR process

Suppose {Y;} isthe AR(p) process defined by
YI=¢1Yt71+"'+¢th7p+Zt’ {Z,}’\'WN (0’0_2)’

andY = (Y;,,...,Y;),withl<i; <--- <i, <n,aetheobserved values. If there
are no missing observationsin thefirst p observations, then the best estimates of the
missing values are found by minimizing

Y=Y — =Y’ (8.6.11)
t=p+1

with respect to the missing values (see Problem 8.20). For the AR(1) model in Ex-
ample 8.6.2, minimization of (8.6.11) is equivalent to minimizing

(Y2 — pY1)* + (Y3 — ¢Y2)°

with respect to Y,. Setting the derivative of this expression with respect to Y, equa
to 0 and solving for Y, we obtain E(Y,|Y1, Ya, Ya, Y5) = ¢ (Y1 + Y3)/ (L+¢?). O
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8.7 The EM Algorithm

The expectation-maximization (EM) algorithm is an iterative procedure for comput-
ing the maximum likelihood estimator when only a subset of the complete data set is
available. Dempster, Laird, and Rubin (1977) demonstrated the wide applicability of
the EM algorithm and are largely responsible for popularizing this method in statis-
tics. Details regarding the convergence and performance of the EM algorithm can be
found in Wu (1983).

In the usual formulation of the EM algorithm, the “complete” data vector W is
made up of “observed” dataY (sometimes called incomplete data) and “ unobserved”
data X. In many applications, X consistsof valuesof a“latent” or unobserved process
occurring in the specification of the model. For example, in the state-space model of
Section 8.1, Y could consist of the observed vectors Y4, ..., Y, and X of the unob-
served state vectors X4, ..., X,,. The EM agorithm provides an iterative procedure
for computing the maximum likelihood estimator based only onthe observed data Y .
Each iteration of the EM algorithm consists of two steps. If 9 denotes the estimated
value of the parameter 6 after i iterations, then the two stepsin the (i + 1)th iteration
are

E—step. Calculate Q(810") = Eqo [£(6; X, Y)|Y]
and
M-—step. Maximize Q(60|60®) with respect to 6.

Then 6+ isset equal to themaximizer of Q intheM-step. Inthe E-step, £(6; X, y) =
In f(x,y; 0),and Egx (-]Y) denotes the conditional expectation relative to the condi-
tional density f(xly; 6©) = f(x.y; 69)/f (y: 6©).

It can be shown that ¢(6);Y) is nondecreasing in i, and a simple heuristic
argument shows that if 6 has alimit & then & must be a solution of the likelihood
equations¢'(6; Y) = 0. Toseethis, observethatIn £ (x, y; 8) = In f(X]y; 6)+£(8; Y),
from which we obtain

0 (016©) :/(Inf(xw;e))f(xw;e@) dx +£0;Y)
and
0w = [ [a%f(XIY; 9)} JFOIY: 0)f (XIY:6%) dx+ £(6; V).

Now replacing 6 with 9¢+Y noticing that Q' (9“*Y19@) = 0, and lettingi — oo, we
find that

ozf%[f(xw;e)]g:é dx + ¢ (é;Y) y (é;Y).
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The last equality follows from the fact that

9 0 !

The computational advantage of the EM algorithm over direct maximization of the
likelihood is most pronounced when the calculation and maximization of the exact
likelihood is difficult as compared with the maximization of Q inthe M-step. (There
are some applications in which the maximization of Q can easily be carried out
explicitly.)

Missing Data

The EM algorithm is particularly useful for estimation problems in which there are
missing observations. Suppose the complete data set consists of Y, .. ., Y, of which
r are observed and n — r are missing. Denote the observed and missing databy Y =
Yy,....Y,) and X = (Y, ..., Y, ), respectively. Assuming that W = (X', Y’)’
has a multivariate normal distribution with mean 0 and covariance matrix X, which
depends on the parameter 6, the log-likelihood of the complete datais given by

£O; W) = —g In(27) — % Indet(x) — :—ZLW’EW.

The E-step requires that we compute the expectation of £(0; W) with respect to the
conditional distribution of W given'Y with @ = 8. Writing X (0) asthe block matrix

Yu X
Y= ,
|: Yo1 X :|
which is conformable with X and Y, the conditional distribution of W given Y is
multivariate normal with mean [};] and covariance matrix [**2@ %], where X =

Eg(XlY) = leZz_zlY and 211‘2(9) = X1 — 21222_21221 (See PrOpOSition A31)
Using Problem A.8, we have

Ego [(X,Y)YE"XOX, Y)Y |Y] = trace (Zup0)T5L0) + W EHO)W,

where W = ()2/, Y’>/. It follows that

. " 1 .
0(616”) =¢(6.W) - Strace (Zuz (6°) Tify(0))

Thefirst term on the right is the log-likelihood based on the compl ete data, but with
X replaced by its “best estimate” X calculated from the previous iteration. If the
increments 8¢+ — 9 are small, then the second term on theright is nearly constant
(= n — r) and can be ignored. For ease of computation in this application we shall
use the modified version

0(616”) =¢(6:W).
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Example 8.7.1

With this adjustment, the steps in the EM algorithm are as follows:

E-step. Calculate Eqo (X|Y) (€.9., withthe Kalman fixed-point smoother) and form
E(G; W)

M-step.  Find the maximum likelihood estimator for the “complete” data problem,
i.e., maximize £(6 : W). For ARMA processes, ITSM can be used directly, with
the missing values replaced with their best estimates computed in the E-step.

The lake data
It was found in Example 5.2.5 that the AR(2) model

W, — 1.0415W,_; + 0.2494W,_, = Z,, {Z.} ~ WN(O, .4790)

was a good fit to the mean-corrected lake data {W,}. To illustrate the use of the EM
algorithm for missing data, consider fitting an AR(2) model to the mean-corrected
data assuming that there are 10 missing values at times: = 17, 24, 31, 38, 45, 52,
59, 66, 73, and 80. We start the algorithm at iteration 0 with ¢.° = $° = 0. Since
this initial model represents white noise, the first E-step gives, in the notation used
above, Wi7 = - - - = Wy = 0. Replacing the “missing” values of the mean-corrected
lake data with 0 and fitting a mean-zero AR(2) model to the resulting complete
data set using the maximum likelihood option in ITSM, we find that ¢\ = .7252,
psP = .0236. (Examination of the plots of the ACF and PACF of this new data set
suggests an AR(1) as a better model. This is aso borne out by the small estimated
value of ¢,.) The updated missing values at timest = 17, 24, . .., 80 are found (see
Section 8.6 and Problem 8.21) by minimizing

2

. . 2
Z (WH—j — P W1 — b5 WH—j—Z)

=0

with respect to W,. The solution is given by

B Wit Weio) + (91 = 30857) (Weoa + Wi

2 2
L 60+ 67)
The M-step of iteration 1 is then carried out by fitting an AR(2) model using ITSM
appliedto the updated data set. Asseenin thesummary of theresultsreported in Table
8.1, the EM agorithm convergesin four iterations with the final parameter estimates
reasonably close to the fitted model based on the complete data set. (In Table 8.1,
estimates of the missing values are recorded only for the first three)) Also notice
how —2¢ (6), W) decreases at every iteration. The standard errors of the parameter
estimates produced from the last iteration of ITSM are based on a “complete” data
set and, as such, underestimate the true sampling errors. Formulae for adjusting the

Wt ==
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Table 8.1  Estimates of the missing observations at times t = 17,
24, 31 and the AR estimates using the EM algorithm in

Example 8.7.1.

iteration i Wi, W,y W o) oY —2¢(6Y, W)
0 0 0 322.60
1 0 0 0 .7252 .0236 244.76
2 534 205 .746 1.0729 —-.2838 203.57
3 458 393  .821 1.0999 -—-.3128 202.25
4 454 405 .826 1.0999 -—-.3128 202.25

standard errors to reflect the true sampling error based on the observed data can be
found in Dempster, Laird, and Rubin (1977). O

8.8 Generalized State-Space Models

As in Section 8.1, we consider a sequence of state variables {X,, + > 1} and a se-
guence of observations{Y;, ¢ > 1}. For ssimplicity, we consider only one-dimensional
state and observation variables, since extensions to higher dimensions can be car-
ried out with little change. Throughout this section it will be convenient to write
Y® and X® for the r+ dimensional column vectors Y® = (Y4, Y,,...,Y;) and
XO = (X1, Xo, ..., X,).

There are two important types of state-space models, “parameter driven” and
“observation driven,” both of which are frequently used in time series analysis. The
observation equation isthe same for both, but the state vectors of a parameter-driven
model evolve independently of the past history of the observation process, while the
state vectors of an observation-driven model depend on past observations.

8.8.1 Parameter-Driven Models

In place of the observation and state equations (8.1.1) and (8.1.2), we how make the
assumptions that ¥, given (X,, X“~Y, YD) isindependent of (X, YD) with
conditional probability density

pilx) = p(ylx, XUV YY), =12, (8.8.1)
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andthat X, given (X,, X“~P, Y ®) isindependent of (X~ ,Y®) with conditional
density function

p(xX41lx,) = p(xt+1|x,, XD, y")) tr=12,.... (8.8.2)

We shall also assume that the initial state X; has probability density p;. The joint
density of the observation and state variables can be computed directly from (8.8.1)—
(8.8.2) as

P()’L s Y X1, 000y Xn) =p (yn|xn, X("*l), y("*l)) p (xm X(nfl)’ y(nfl))
= P()’n|xn)P (X,,|X(”7l), y(nil)) p (y("fl)’ X("*l))

— POl PGl (72 X0D)

(1'[ Py |x,->) (H p(x; |x,-1)> pa(xy),
j=1 j=2

and since (8.8.2) impliesthat {X,} is Markov (see Problem 8.22),

p(yl’ . --,yn|X1, ...,)Cn) = (1_[ p()’j|x1)> . (883)
=1

We conclude that Y3, ..., Y, are conditionally independent given the state variables
X1, ..., X,, sothat the dependence structure of {Y,} isinherited from that of the state
process { X, }. The sequence of state variables {X;,} is often referred to as the hidden
or latent generating process associated with the observed process.

In order to solve the filtering and prediction problems in this setting, we shall
determine the conditional densities p (x,ly®) of X, given Y@, and p (x,[y“~?) of X,
given Y =D respectively. The minimum mean squared error estimates of X, based
onY® and Y“~b can then be computed as the conditional expectations, E (X,|Y )
and E (X,|YD).

An application of Bayes's theorem, using the assumption that the distribution of
Y, given (X,, X“~P, Y ¢~D) does not depend on (X, Y1), yields

p(xly?) = pGulx)p (xly™) /p (nly“™?) (8.8.4)
and
p (xt+1|y([)) = /P (xt|y(t)) P (xepalxs) din(x;). (8.8.5)

(Theintegral relativeto du(x,) in (8.8.4) isinterpreted asthe integral relative to dx;
in the continuous case and as the sum over all values of x, in the discrete case.) The
initial condition needed to solve these recursionsis

p (xaly?@) = p1(xp). (8.8.6)
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Thefactor p (y,ly“~") appearing in the denominator of (8.8.4) isjust a scale factor,
determined by the condition [ p (x;ly®) du(x,) = 1. In the generalized state-space
setup, prediction of afuture state variable is less important than forecasting a future
value of the observations. The relevant forecast density can be computed from (8.8.5)
as

p (y,+1|y(’>) = /P(yt+1|xz+1)P (xt-ﬁ-lly(t)) dp(x;11). (8.8.7)

Equations (8.8.1)—(8.8.2) can be regarded as a Bayesian model specification. A
classical Bayesian model hastwo key assumptions. ThefirstisthatthedataYs, ..., Y,,
given an unobservable parameter (X in our case), are independent with specified
conditional distribution. This corresponds to (8.8.3). The second specifies a prior
distribution for the parameter value. This corresponds to (8.8.2). The posterior
distribution is then the conditiona distribution of the parameter given the data. In
the present setting the posterior distribution of the component X, of X isdetermined
by the solution (8.8.4) of the filtering problem.

Consider the simplified version of the linear state-space model of Section 8.1,
Y, =GX,+W,, {W,}~iidN(0, R), (8.8.8
Xipi=FX,+V, {V;}~iidN(O, Q), (8.8.9)

wherethe noise sequences {W, } and {V,} areindependent of each other. For thismodel
the probability densitiesin (8.8.1)—8.8.2) become

p1(x1) = n(xg; EXy1, Var(Xy)), (8.8.10)
p(yilx:) = n(y;; Gx,, R), (8.8.11)
pXpalx) = n(x s Fx,, Q), (8.8.12)

where n (x; u, 0?) is the normal density with mean n and variance o2 defined in
Example (a) of Section A.1.

To solve the filtering and prediction problems in this new framework, we first
observethat thefiltering and prediction densitiesin (8.8.4) and (8.8.5) areboth normal.
We shall write them, using the notation of Section 8.4, as

p (xtlY(t)) =n(x; X, Q411) (8.8.13)
and

p (xt+1|Y(t)) =n <xt+1§ )A(Hl’ Qz+1> . (8.8.14)
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From (8.8.5), (8.8.12), (8.8.13), and (8.8.14), we find that
}A(z+1 = / x,+1p(xl+1|Y(t))dx,+1
= / Xt+1/ p(xtlY(Z))p(xt+l|xt) dx; dx; 41
= / p(x,|Y(’)) [/ xt+1p(-xf+l|xl)dxt+li| dx;
= [ Fap¥©x
= FXt|r
and (see Problem 8.23)
Qt+l = FZQm + Q
Substituting the corresponding densities (8.8.11) and (8.8.14) into (8.8.4), wefind by
equating the coefficient of x? on both sides of (8.8.4) that
Qﬁtl — G2R71 4 Q:l — GZRfl + (FZQt—llt—l 4 Q)fl
and
X, = X, + 2,GR™ (Y, — G)A(t> .
Also, from (8.8.4) with p (x1]ly©®) = n(x1; EX1, 1) weobtaintheinitial conditions
X1 = EX1 + QuuGR(Y1 — GEX))
and
Q=GR+ Q"
The Kalman prediction and filtering recursions of Section 8.4 give the same results
for X, and X,, since for Gaussian systems best linear mean square estimation is
equivalent to best mean square estimation. O
Example 8.8.2 A non-Gaussian example

In general, the solution of the recursions (8.8.4) and (8.8.5) presents substantial com-
putational problems. Numerical methods for dealing with non-Gaussian models are
discussed by Sorenson and Alspach (1971) and Kitagawa (1987). Here we shall il-
lustrate the recursions (8.8.4) and (8.8.5) in avery simple special case. Consider the
state equation

X, = aX, 1, (8.8.15)
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with observation density

()Y e ™

pilxe) = T, y»»=01,..., (8.8.16)
!
where r is a constant between 0 and 1. The relationship in (8.8.15) implies that the
transition density (in the discrete sense—see the comment after (8.8.5)) for the state
variablesis

1, ifx=ax,
p(Xiq1lx) = _
0, otherwise.

We shall assume that X, has the gamma density function

)»“xf_le’“l

, x1>0.
IN'a)

p1(x1) = g(xg; a, A) =

(This is a simplified model for the evolution of the number X, of individuals at
time ¢ infected with a rare disease, in which X, is treated as a continuous rather
than an integer-valued random variable. The observation Y, represents the number of
infected individuals observed in arandom sample consisting of asmall fraction = of
the population at timet.) Because the transition distribution of {X,} isnot continuous,
we use the integrated version of (8.8.5) to compute the prediction density. Thus,

oo
P (X, <xly"?) = / P(X, < xlxi-)p (v-aly' ™) doiy
0

x/a
= / p (xt—lly(l_l)) dx,_3.
0
Differentiation with respect to x gives

p (x,|y(’_1)) =a tpx, yeo (a_lxt|y(’_1)) ) (8.8.17)
Now applying (8.8.4), we find that
p(x1ly1) = p(ilxD) p1(x1)/ p(y1)

_ ((nxl)yle”“) ()J"xf_leb‘l) ( 1 )
a ! I () pO1)

at+y1—1 —(z+r)x
= c(y1)x; e Tthn

X1>O,

where c(y;) isan integration factor ensuring that p(-|y,) integratesto 1. Since p(-|y1)
has the form of a gamma density, we deduce (see Example (d) of Section A.1) that

p(xafy1) = g(x1; 1, A), (8.8.18)
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Example 8.8.3

wherea; = o + y; and A, = A + 7. The prediction density, calculated from (8.8.5)
and (8.8.18), is

p (x2|y(1)) = Cflpxlwm (6171X2|y(1))
= ailg ((flxz; o1, kl)
= g(xz; o1, A1/a).
Iterating the recursions (8.8.4) and (8.8.5) and using (8.8.17), wefind that for r > 1,

P (aly?) =g o, &) (8.8.19)
and
P (xaly®) =a g (a x5 00, 1)
= g(Xiv1; 04, A /@), (8.8.20)

whereo, = oy 1+ y, = a+y+--+y andir = Az a/a+nmx = ra'" +
m(l—a™)/(1—a™"). Inpaticular, the minimum mean squared error estimate of
x; based on y® isthe conditional expectation o, /2, with conditional variance «, /2.
From (8.8.7) the probability density of Y,,; given Y@ is

. o
(nx l)}r+le TTXi4+1
POaly?) = / ( as g(Xp1: @y A fa) dx, s
0

Vig1!

Tl +yiq1) <1_L>a’< b )y’“
@)l (y1+ D Art1 Ar1

:nb(yt+l; atyl_n/)"l-&-l)’ yl+l:09 1""5

where nb(y; a, p) is the negative binomia density defined in example (i) of Sec-
tion A.1. Conditional on Y, the best one-step predictor of Y., is therefore the
mean, o, /(A1 — 1), Of this negative binomial distribution. The conditional mean
squared error of the predictor is Var(Y,41|Y®) = w11/ (A1 — 7)? (See Problem
8.25). O

A model for time series of counts

We often encounter time series in which the observations represent count data. One
such example is the monthly number of newly recorded cases of poliomyelitisin the
U.S. for the years 1970-1983 plotted in Figure 8.6. Unless the actual countsare large
and can be approximated by continuous variables, Gaussian and linear time series
models are generally inappropriate for analyzing such data. The parameter-driven
specification provides a flexible class of models for modeling count data. We now
discussaspecific model based on aPoisson observation density. Thismodel issimilar
to the one presented by Zeger (1988) for analyzing the polio data. The observation
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Figure 8-6
Monthly number of
U.S. cases of polio,

Jan. ’70-Dec. '83.

density is assumed to be Poisson with mean exp{x,}, i.e.,

e Vi€
pilxe) = o »w=01,..., (8.8.21)
!
while the state variables are assumed to follow a regression model with Gaussian
AR(1) noise. If U, = (u,1, ..., uy) aretheregression variables, then
X, =0u + W, (8.8.22)

where 3 is ak-dimensional regression parameter and
W, =¢W,.1+Z,, {Z}~1IDN(0,07%).
The transition density function for the state variablesis then
p(xipalx) = n(xis1; BUpr + ¢ (x0 — B'Uy), 02) . (8.8.23)

The case 02 = 0 corresponds to alog-linear model with Poisson noise.

Estimation of the parameters 8 = (3', ¢, o?)’ in the model by direct numerical
maximization of the likelihood function is difficult, since the likelihood cannot be
written down in closed form. (From (8.8.3) the likelihood is the n-fold integral,

‘/_oo.../_oo @(p{X];(xtyt —exr)} L(G, X(")) (dxl---dx,,)/l_!(y,-!),

where L(0; x) is the likelihood based on X4, ..., X,.) To overcome this difficulty,
Chan and L edolter (1995) proposed an algorithm, called Monte Carlo EM (MCEM),
whoseiterates 0¥ converge to the maximum likelihood estimate. To apply thisalgo-
rithm, first note that the conditional distribution of Y™ given X™ does not depend
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on 6, so that the likelihood based on the complete data (X, Y ™)' is given by
L(6; X", Y?) = f(Y®IX™)L(6; X™).
The E-step of the algorithm (see Section 8.7) requires calculation of
0(016") = Ego (INL(O; X™,Y™)|Y™)
= Ego (IN f(YP XY™ + Ego (INL(; X™)[Y™).

We delete the first term from the definition of Q, since it is independent of 8 and
hence plays no role in the M-step of the EM algorithm. The new Q isredefined as

Q(0|9(i)) = Ego (InL(G; X(n))|Y(n)) . (8.8.29)

Even with this simplification, direct calculation of Q is still intractable. Suppose
for the moment that it is possible to generate replicates of X from the conditional
distribution of X givenY ™ when 8 = 6. If we denotem independent replicates of
X® py X{, ..., X™ thenaMonte Carlo approximation to Q in (8.8.24) isgiven by

0. (6169 = ZInL(G x<">)

The M-step is easy to carry out using Q,, in place of Q (especidly if we condition
on X; = 0inal the smulated replicates), since L isjust the Gaussian likelihood of
the regression model with AR(1) noise treated in Section 6.6. The difficult stepsin
the algorithm are the generation of replicates of X™ given Y ™ and the choice of .
Chan and Ledolter (1995) discuss the use of the Gibb's sampler for generating the
desired replicates and give some guidelines on the choice of m.

In their analyses of the polio data, Zeger (1988) and Chan and Ledolter (1995)
included as regression components an intercept, aslope, and harmonics at periods of
6 and 12 months. Specifically, they took

u; = (1, ¢/1000, cos(2rt/12), sin(2wt/12), cos(2rt/6), Sin(2rt/6))'.

The implementation of Chan and Ledolter's MCEM method by Kuk and Cheng
(1994) gave estimates 3 = (.247, —3.871, .162, —.482, 414, —.011), ¢ = .648, and
62 = .281. The estimated trend function 3'u, isdisplayed in Figure 8.7. The negative
coefficient of /1000 indicates a slight downward trend in the monthly number of
polio cases. O

8.8.2 Observation-Driven Models

Inan observation-driven model it isagain assumed that Y;, conditional on (X,, X,

YD), isindependent of (X", Y¢~1). The model is specified by the conditional
densities

p()’r|xr) — p ()G'Xm, y(til)) k) t = la 27 ey (8825)

p (xtJrlly(l)) = PX,alY® (xt+l|y(t)) s = 07 19 R (8826)
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Figure 8-7

Trend estimate for the
monthly number of
U.S. cases of polio,
Jan. ‘70-Dec. ‘83.
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where p (x1]y@) := p1(x1) for some prespecified initial density p;(x;). The advan-
tage of the observation-driven state equation (8.8.26) isthat the posterior distribution
of X, given Y can be computed directly from (8.8.4) without the use of the updat-
ing formula (8.8.5). This then alows for easy computation of the forecast function
in (8.8.7) and hence of the joint density function of (Y4, ..., Y,)’,

POy =[P (ely“ ). (8.8.27)
=1

On the other hand, the mechanism by which the state X,_; makes the transition to
X, isnot explicitly defined. In fact, without further assumptions there may be state
sequences {X,} and {X} with different distributions for which both (8.8.25) and
(8.8.26) hold (see Example 8.8.6). Both sequences, however, lead to the same joint
distribution, given by (8.8.27), for Y1, ..., Y,. The ambiguity in the specification of
the distribution of the state variables can be removed by assuming that X,,; given
(X®, Y®) isindependent of X, with conditional distribution (8.8.26), i.e.,

P (xuaX ) = b, (valy) (38.29)
With this modification, the joint density of Y™ and X™ is given by (cf. (8.8.3))

14 (y(n)’ X(n)) = P(Yn|xn)P (xn|y(n71)) p (y(nil)v X(nil))

n

(Pilx)p (xly"™)).

=1
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Example 8.8.4 An AR(1) process
An AR(2) process with iid noise can be expressed as an observation driven model.
Suppose {Y,} isthe AR(1) process
Yz = ¢Yz—l + Zla
where {Z,} isaniid sequence of random variables with mean 0 and some probability
density function f(x). Thenwith X, := Y,_; we have
pilx) = f(ye — ox;)
and
1 ifx1=y,
P (xialy®”) = e m
0, otherwise.
Example 8.8.5  Suppose the observation-equation density is given by

Yt ,—x;

X
pOilx) = ~——, »=01..., (8.8.29)

t-

and the state equation (8.8.26) is

p (xipaly®) = g (s i, 1), (8.8.30)

whereo, = o+ y1+---+ y, and A, = A + ¢. It is possible to give a parameter-
driven specification that givesrise to the same state equation (8.8.30). Let { X} bethe
parameter-driven state variables, where X = X ; and X} has agammadistribution
with parameters « and A. (This corresponds to the model in Example 8.8.2 with
7w = a = 1) Then from (8.8.19) we see that p (x|y") = g(x}; , A,), which
coincides with the state equation (8.8.30). If {X,} are the state variables whose joint
distribution is specified through (8.8.28), then {X,} and {X} cannot have the same
joint distributions. To see this, note that

H * *
e L ifx/ = x7,
p (xt+1|xt) - .
0, otherwise,

while

p (-XH-llX(t)a y(t)) =P (-xt+l|y([)) = g (x5 oy Ay).

If the two sequences had the same joint distribution, then the latter density could take
only the values 0 and 1, which contradicts the continuity (as afunction of x,) of this
density. O

Exponential Family Models

The exponential family of distributions provides a large and flexible class of distri-
butions for use in the observation equation. The density in the observation equation
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issaid to belong to an exponential family (in natural parameterization) if

pOilx) = explyix; — b(x,) + c(y)}, (8.8.31)

where b(-) isatwice continuoudly differentiable function and c¢(y;) does not depend
on x;. Thisfamily includes the normal, exponential, gamma, Poisson, binomial, and
many other distributions frequently encountered in statistics. Detailed properties of
the exponential family can be found in Barndorff-Nielsen (1978), and an excellent
treatment of itsusein the analysisof linear modelsisgiven by McCullagh and Nelder
(1989). We shall need only the following important facts:

e’ = / exply.x; + c(y)} v(dy), (8.8.32)
b'(x)) = E(Y;|x,), (8.8.33)
b'(x,) = Var(Y,|x,) = / V2p(yelx) vidy) — [b' ], (8.8.34)

where integration with respect to v(dy,) means integration with respect to dy, in the
continuous case and summeation over al values of y, in the discrete case.

Proof of (8.8.32)—(8.8.34)

Example 8.8.6

Thefirst relationissimply the statement that p(y,|x;) integratesto 1. The second rela-
tion is established by differentiating both sides of (8.8.32) with respect to x, and then
multiplying through by e =@ (for justification of the differentiation under theintegral
sign see Barndorff-Nielson (1978)). The last relation is obtained by differentiating
(8.8.32) twice with respect to x, and simplifying. ]

The Poisson case

If the observation Y;, given X, = x,, has a Poisson distribution of the form (8.8.21),
then

pilx) = expl{yx. —e" —Iny !}, »=01..., (8.8.35)

which has the form (8.8.31) with b(x;) = ¢* and ¢(y,) = —Iny,!. From (8.8.33) we
easily find that E(Y;|x,) = b'(x;) = ¢*. This parameterization is dightly different
fromtheone used in Examples8.8.2 and 8.8.5, where the conditional mean of Y, given
x; was rx, and not e*. For this observation equation, define the family of densities

f(x;a,)) =explax — Ab(x) + A(a, )}, —00 < x < 00, (8.8.36)

wherea > 0and A > 0 are parameters and A(o, ) = —InT(a) + @ lni. Now
consider state densities of the form

p(xt+1|y(’)) = f g1 Qrgryes Mevrye)s (8.8.37)
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Proof

whereq, 1, and A, 1, are, for themoment, unspecified functionsof y. (Thesubscript
¢+ 1|t onthe parametersisashorthand way to indicate dependence on the conditional
distribution of X,,; given Y®.) With this specification of the state densities, the
parameters o, 1, are related to the best one-step predictor of Y, through the formula

Q1) /Mgty = Yiy1 = E (Yisaly®). (8.8.38)

We have from (8.8.7) and (8.8.33) that

(o] oo
E(Yaly?) = Z / Vi1 P YralXer ) p (xt+1|y(’)) dxiq1
Yig1=0Y =%

:/ b'(x;41)p (xr+1|y(t)) dxii1.

[e¢]

Addition and subtraction of o1 /A,+1, then gives

o0
o273 Oy 41
E(Y ly”) = / (b’(xm— = ")p(mﬂy“’) dx 1+
oo Al +1)
_ *© )»71 , ) d Qry1)r
= —A L P (xmly ) X1+ x
—00 t+1)t
1 X141=00 [O7E% T}
= [_)\'l-‘rl\tp (xf+l|y(t))]x,+1=—00 )LtJrlIt

O i1y
_ Sl m

T
Letting A,;—1 = A(oti—1, Ai—1), We Can write the posterior density of X, given
Y® as
p (xly?”) = explyix: — b(x:) + c ()} &Xplar—1x: — hyi-1b(x)
+ A1}/ (nly*?)
= eXp{hey (ctrxe — b(x))) — Agel,
=[x o, A,

where wefind, by equating coefficients of x, and b(x,), that the coefficients A, and «,
are determined by

=1+ )\t|z—1, (8.8.39)
o = Y + -1 (8.8.40)

The family of prior densitiesin (8.8.37) is called a conjugate family of priors for
the observation equation (8.8.35), since the resulting posterior densities are again
members of the same family.
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Asmentioned earlier, the parameters «,,_; and A,,_1 can be quite arbitrary: Any
nonnegative functions of y“—b will lead to a consistent specification of the state
densities. One convenient choice isto link these parameters with the corresponding
parameters of the posterior distribution at time ¢ — 1 through the relations

Mrae = 82 (= 8L+ A1) (8.8.41)
e = Sy (= 8(yr + i-1)) (8.8.42)
where 0 < § < 1 (see Remark 4 below). Iterating the relation (8.8.41), we see that
Agap = 8L+ A1) =8 4+ 8A
=8+ 8(8+8h_242)

=8 +824+ -+ 8+ 80 (8.8.43)
— §/(1—9)
ast — oo. Similarly,
Qq1 = 8y + o1
=8y + 8%+ + 8y + 8. (8.8.44)
For large r, we have the approximations
A1 = 8/(1—8) (8.8.45)
and
t—1
Ay =8 8y, (8.8.46)
j=0

whichareexactif 110 = §/(1—6) and a0 = 0. From (8.8.38) the one-step predictors
are linear and given by

% 41 Zt_];](-) ajyt*j + al_lal\o
1= = _ R
T ke X8+ 8ty

Replacing the denominator with its limiting value, or starting with 140 = 8/(1 — 8),
we find that Y, isthe solution of the recursions

Yor=@A—=08)y +8Y, =12 ..., (8.8.48)

(8.8.47)

with initia condition ¥; = (1 — 8)8 *ayo. In other words, under the restrictions
of (8.8.41) and (8.8.42), the best one-step predictors can be found by exponential
smoothing. O
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Remark 1. The preceding analysis for the Poisson-distributed observation equa-
tion holds, almost verbatim, for the general family of exponential densities (8.8.31).
(One only needs to take care in specifying the correct range for x and the allowable
parameter space for « and A in (8.8.37).) The relations (8.8.43)—(8.8.44), as well
as the exponentia smoothing formula (8.8.48), continue to hold even in the more
general setting, provided that the parameters «,,_1 and A,,_, satisfy the relations
(8.8.41)—8.8.42). O

Remark 2. Equations (8.8.41)—(8.8.42) are equivalent to the assumption that the
prior density of X, given y“~ is proportional to the §-power of the posterior distri-
bution of X,_; given Y “~Y, or more succinctly that
f s Q|r—1, )"f\t—l) = f(x; Sat—lll—la 8kt—1|z—1)
(0.8 fs(xtQ Q11 }"tflltfl)‘

This power relationship is sometimes referred to as the power steady model (Grun-
wald, Raftery, and Guttorp, 1993, and Smith, 1979). O

Remark 3. The transformed state variables W, = ¢*' have a gamma state density
given by

P (wesaly?”) = g(Wis1s sy, Aesarr)
(see Problem 8.26). The mean and variance of this conditional density are

E (Wz+1|y(t)) =a,4y and Var (Wt+1|y(l)) = at+1\t/}“t2+l|t' g

Remark 4. If we regard the random walk plus noise model of Example 8.2.1 as
the prototypical state-space model, then from the calculations in Example 8.8.1 with
G =F =1, wehave

E (X11lY?) = E(X,|Y®)
and
Var (X,41)Y") = Var (X,IY?) + 0 > Var (X,|Y?).

Thefirst of these equationsimpliesthat the best estimate of the next state isthe same
as the best estimate of the current state, while the second implies that the variance
increases. Under the conditions (8.8.41), and (8.8.42), the same is also true for the
state variablesin the above model (see Problem 8.26). Thiswas, in part, therationale
behind these conditions given in Harvey and Fernandes (1989). O

Remark 5. While the calculations work out neatly for the power steady model,
Grunwald, Hyndman, and Hamza (1994) have shown that such processes have de-
generate sample paths for large ¢. In the Poisson example above, they argue that the
observations Y; convergeto 0 ast — oo (See Figure 8.12). Although such models
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Example 8.8.7

Table 8.2

may still be useful in practice for modeling series of moderate length, the efficacy of
using such models for describing long-term behavior is doubtful. O

Goals scored by England against Scotland

Thetime series of the number of goals scored by England against Scotland in soccer
matches played at Hampden Park in Glasgow is graphed in Figure 8.8. The matches
have been played nearly every second year, with interruptions during the war years.
Wewill treat thedata yy, . . ., ys2 ascoming from an equally spaced time series model
{Y,}. Sincethe number of goalsscored issmall (seethefrequency histogramin Figure
8.9), a model based on the Poisson distribution might be deemed appropriate. The
observed relative frequencies and those based on a Poisson distribution with mean
equal to ys, = 1.269 are contained in Table 8.2. The standard chi-squared goodness
of fit test, comparing the observed frequencies with expected frequencies based on
a Poisson model, has a p-value of .02. The lack of fit with a Poisson distribution is
hardly unexpected, since the sample variance (1.652) is much larger than the sample
mean, while the mean and variance of the Poisson distribution are equal. In this case
the data are said to be overdispersed in the sense that there is more variability in
the data than one would expect from a sample of independent Poisson-distributed
variables. Overdispersion can sometimes be explained by serial dependence in the
data.

Dependencein count data can often be reveal ed by estimating the probabilities of
transition from one stateto another. Table 8.3 contai ns estimates of these probabilities,
computed as the average number of one-step transitions from state y, to state y, 1. If
the datawere independent, then in each column the entries should be nearly the same.
Thisis certainly not the case in Table 8.3. For example, England is very unlikely to
be shut out or score 3 or more goals in the next match after scoring at least 3 goalsin
the previous encounter.

Harvey and Fernandes (1989) model the dependence in this data using an obser-
vation-driven model of the type described in Example 8.8.6. Their model assumes a

Relative frequency and fitted Poisson
distribution of goals scored by England
against Scotland

Number of goals

0 1 2 3 4 5

Relative frequency .288 .423 .154 .019 .096 .019

Poisson distribution .281 .356 .226 .096 .030 .008
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Table 8.3

Transition probabilities for the
number of goals scored by England
against Scotland.

Y
pYely) 0 1 2 =3
0 214 500 214 .072
ve 1 409 272 136 .182
2 250 .375 .125 .250
>3 0 .857 .143 0

forr =1,2,..., where f isgiven by (8.8.36) and oy0 = 0, 1190 = 0. The power
steady conditions (8.8.41)—8.8.42) areassumed to hold for «;,_; and A,,_1. Theonly
unknown parameter in the model is . Thelog-likelihood function for § based on the
conditional distribution of yi, ..., ys; given y; isgiven by (see (8.8.27))

n—1
£(8.y™) = "Inp (yaaly®). (8.8.49)

=1

where p (y,41ly®) isthe negative binomial density (see Problem 8.25(c))

p (Yt+1|y(t)) =nb (y,+1; oy, (14 )\t+1|t)_1) )

with e, 1), and 1,41, as defined in (8.8.44) and (8.8.43). (For the goal data, y; = 0,
which implies az; = 0 and hence that p (y.|y™) is a degenerate density with unit
mass at y, = 0. Harvey and Fernandes avoid this complication by conditioning the
likelihood on y®, where 7 is the time of the first nonzero data value.)

Maximizing this likelihood with respect to §, we obtain § = .844. (Starting the
equations (8.8.43)—«(8.8.44) with a0 = 0 and A0 = §/(1 — §), we obtain § = .732.)
With .844 as our estimate of §, the prediction density of the next observation Ys; given
y©2 isnb(yss; asgsz, (14 Asgs2) . Thefirst fivevaluesof thisdistribution aregivenin
Table 8.4. Under thismodel, the probability that England will be held scorelessin the
next matchis.471. Theone-step predictors, ¥, = 0, Y», . . ., Ys, aregraphed in Figure
8.10. (This graph can be obtained by using the ITSM option Smooth>Exponential
with o = 0.154.)

Figures 8.11 and 8.12 contain two realizations from the fitted model for the goal
data. The general appearance of thefirst realization is somewhat compatible with the
goal data, while the second realization illustrates the convergence of the sample path
to 0 in accordance with the result of Grunwald et al. (1994). O
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Table 8.4  Prediction density of Y53 given Y®? for data in

Figure 8.7.
Number of goals
0 1 2 3 4 5
plyssly®®) 472 326 138 .046  .013  .004

Example 8.8.8 The exponential case

Suppose Y; given X, has an exponential density with mean —1/X; (X, < 0). The
observation density is given by

p(yilx) = exply.x, + In(=x)},  » >0,

which hasthe form (8.8.31) with b(x) = — In(—x) and ¢(y) = 0. The state densities
corresponding to the family of conjugate priors (see (8.8.37)) are given by

p (xt+1|y(t)) = eXp{ai1 X1 — A b (Xiq1) + Aryyed,  —00 <x < 0.
[Tol o8 (o]
<l o o 0o o
ol o

Goals

Figure 8-10
One-step predictors
of the goal data.
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Figure 8-11

A simulated time L) _
series from the fitted °L I I I ! I I ! ! | i
model to the goal data.

(Here p(x,41ly®) is a probability density when o;,4, > 0 and A,41, > —1.) The
one-step prediction density is
0

p (yt+1|y(t) :/ eX1+1}’z+1+|n(*xr+1)+az+1\rx*lx+1|rb(x)+Ar+1\r dxz+l
—00
Ay +1 —hopa—2
= (Apgy + 1)01,_’:1‘; Yes1 + gre) 7% 311> 0
el
|
-
ol
-
|
o
Figure 8-12
A second simulated time
series from the fitted el

model to the goal data.
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Problems

(see Problem 8.28). While E(Y,41ly"”) = a11/A+11, the conditional variance is
finiteif and only if 1,44, > 1. Under assumptions (8.8.41)—8.8.42), and starting with
A0 = 8/(1—§), the exponential smoothing formula (8.8.48) remains valid. O

8.1

8.2

8.3.

8.4.

8.5.

8.6.

Show that if all the eigenvalues of F are less than 1 in absolute value (or
equivalently that F* — Oask — oo), the unique stationary solution of equation
(8.1.11) is given by the infinite series

Xi =) F'Vija
j=0

and that the corresponding observation vectors are

o0

Y, =W, + ZGF]AV,,J',]_.

=0

Deducethat {(X], Y!)'} isamultivariate stationary process. (Hint: Use a vector
anal ogue of the argument in Example 2.2.1.)

In Example 8.2.1, show that # = —1if and only if avz = 0, whichinturnis
equivalent to the signal M, being constant.

Let F bethe coefficient of X, in the state equation (8.3.4) for the causal AR(p)
process

X, =1 Xoa— - — Xy =Z,, {Z}~WN(0,67%).
Establish the stahility of (8.3.4) by showing that
det(zl — F) = 2"¢ (%),

and hence that the eigenvalues of F are the reciprocals of the zeros of the
autoregressive polynomial ¢ (z) =1 — ¢1z — - - - — ¢,2".

By following the argument in Example 8.3.3, find a state-space model for {Y,}
when {VV,Y,} isan ARMA(p, ¢g) process.

For thelocal linear trend model defined by equations (8.2.6)—(8.2.7), show that
V?Y, = (1 — B)?Y, isa2-correlated sequence and hence, by Proposition 2.1.1,
isan MA(2) process. Show that this MA(2) processis noninvertible if o2 = 0.

a. For the seasonal model of Example 8.2.2, show that VY, = Y, — Y,_; isan
MA(1) process.
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b. Show that VV,Y, isan MA(d + 1) process where {Y,} follows the seasona
model with alocal linear trend as described in Example 8.2.3.

8.7. Let {Y,;} bethe MA(1) process
Y, =Z +0Z_1, {Z}~WN(0,0?).
Show that {Y,} has the state-space representation
Y,=[1 0]X,,
where {X,} is the unique stationary solution of

0 1 1
XI+1 = |:0 O}XI + 9 :|Zt+l‘

In particular, show that the state vector X, can written as

1 6]] z ]
Xl_[e 0}[211 .

8.8. Verify equations (8.3.16)—(8.3.18) for an ARIMA(1,1,1) process.

8.9. Consider the two state-space models
Xir11= F1X;1 + Vi1,

Yii =GiX;1+Wp,
and
Xiy12= F2Xi2+ V2,
Yo = G2X2+ W,

where{(V},, W/,, V/,, W/,)'} iswhitenoise. Derive astate-space representation
for {(Y;, Y,)'}.

8.10. Use Remark 1 of Section 8.4 to establish thelinearity properties of the operator
P, stated in Remark 3.

8.11. a. Showthat if thematrix equation XS = B canbesolvedfor X, thenX = BS—!
isasolution for any generalized inverse 1 of S.
b. Use the result of (a) to derive the expression for P(X]Y) in Remark 4 of
Section 8.4.

8.12. In the notation of the Kalman prediction equations, show that every vector of
theform

Y =A X1+ 4+ AX
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8.13.

8.14.

8.15.

8.16.

8.17.

8.18.

8.19.
8.20.

8.21.

can be expressed as
Y =B X1+ -+ B_1 X1+ Cily,

where By, ..., B,_; and C, arematricesthat depend onthematrices Ay, ..., A;.
Show also that the converseistrue. Usetheseresultsand thefact that E(X;l,) =
Ofor al s < r to establish (8.4.3).

In Example 8.4.1, verify that the steady-state sol ution of the Kalman recursions
(8.1.2) isgiven by @, = (03 + . Joh+ 40305) /2

Show fromthedifferenceequationsfor 2, inExample8.4.1that (2,1 —Q) (2, —
Q) > Oforal ©, > 0, where Q is the steady-state solution for €, givenin
Problem 8.13.

Show directly that for the MA(1) model (8.2.3), the parameter 9 is equa to
- (205 +02—\Jor+ 40305) / (202), which in turn is equal to —o2/(Q2 +
a2), where  is the steady-state solution for &, given in Problem 8.13.

Usethe ARMA(0,1,1) representation of the series{Y;} in Example8.4.1 to show
that the predictors defined by

?ﬂ“r‘l:aYﬂ-’-(l_a)?n’ n:172""7
wherea = Q/(Q + 02), satisfy

A

Vo= Pa = Zua+ A=) (Yo— Zo— 11).
Deducethat if 0 < @ < 1, the mean squared error of ¥, convergesto Q + o2
for any initial predictor Y; with finite mean squared error.

a. Using equations (8.4.1) and (8.4.10), show that X, .1 = F,X,,.
b. From (a) and (8.4.10) show that X, satisfies the recursions

XI|I = thlxtflltfl + Q,G;At_l(Yt - Gthflxtflufl)
fort = 2,3,..., with X1|1 = )A(]_ + QlGéI.AIl <Y1 — G]_)A<1>.

In Section 8.5, show that for fixed Q*, —2In L (p, Q*, 02) isminimized when
p and o2 are given by (8.5.10) and (8.5.11), respectively.

w

Verify the calculation of ®, A1 and 2, in Example 8.6.1.

Verify that the best estimates of missing valuesin an AR(p) process are found
by minimizing (8.6.11) with respect to the missing values.

Suppose that {Y;} isthe AR(2) process
Yi =¢1Y 1+ @Y o+ 7y, {Zz}'\’WN (0,0'2),
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8.22.

8.23.

8.24.

8.25.

8.26.

8.27.

and that we observe Yy, Ys, Ya, Y5, Yg, Y7. Show that the best estimator of Y3 is
(d2(Y1 + Y5) + (b1 — d1¢92) (V2 + Ya)) / (1 + 62 + 43) .

Let X, be the state at time ¢ of a parameter-driven model (see (8.8.2)). Show
that {X,} isaMarkov chain and that (8.8.3) holds.

For the generalized state-space model of Example 8.8.1, show that Q,.; =
FZQ,“ + 0.

If Y and X are random variables, show that

Var(Y) = E(Var(Y|X)) + Var(E(Y|X)).

Supposethat Y and X are two random variables such that the distribution of Y

given X is Poisson with mean 7 X, 0 < = < 1, and X has the gamma density

g(x; o, A).

a. Show that the posterior distribution of X given Y also has a gamma density
and determine its parameters.

b. Compute E(X|Y) and Var(X|Y).
c. Show that Y has a negative binomia density and determine its parameters.
d. Use(c) to compute E(Y) and Var(Y).
e. Verify in Example 8.8.2that E (¥,41|Y") = a,7r/(A11 — 7) and
Var(Y51)Y?) = a1/ (A — 7).

For the model of Example 8.8.6, show that
a E (X1lY?) = E(X,|Y®), Var(X,11]Y?) >Var(X,[Y?), and
b. the transformed sequence W, = ¢X' has a gamma state density.
Let {V,} beasequence of independent exponential random variableswith EV, =
+~! and suppose that {X,, + > 1} and {Y,, + > 1} are the state and observation
random variables, respectively, of the parameter-driven state-space system

X, =V,

XI:XZ—1+‘/I7 t:2135"'3
wherethedistribution of the observation Y,, conditional ontherandom variables
Y1, Yo, ..., Y:_1, X;, isPoisson with mean X,.

a. Determinethe observation and state transition density functions p(y;|x;) and
p(x;41]|x,) in the parameter-driven moded for {Y,}.

b. Show, using (8.8.4)—8.8.6), that

p(xily) = glx1; y1+1,2)
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and

p(xaly1) = g(x2; y1+ 2, 2),
where g(x; «, A) isthe gammadensity function (see Example (d) of Section

Al).
c. Show that
p(xly?) =gxiar+1,1+1)
and

p(xsaly?) = g + 14+ 11+ 1),

whereo, = y1 +--- + yi.

d. Concludefrom (c) that the minimum mean squared error estimates of X, and
X1 basedonyy, ..., Y, ae

t+Yi+-+Y,

tht =

t+1
and
o  _t+14Vi4---4Y,
t+1 — t+1 s
respectively.

8.28. Let Y and X be two random variables such that ¥ given X is exponentia with
mean 1/ X, and X has the gamma density function with
o’ x> exp{—ax}

)\' 17 - ) 07
glxii+1 ) FG+ D) x>

wherel > —1and« > 0.

a. Determine the posterior distribution of X given Y.

b. Show that Y has a Pareto distribution

P =G+ +a) 2 y>0.

c. Find the mean of variance of Y. Under what conditions on o« and A does the
|atter exist?

d. Verify the calculation of p (y..1ly®) and E (Y,11]y®) for the model in Ex-
ample 8.8.8.

8.29. Consider an observation-driven model in which Y, given X, is binomia with
parametersn and X, i.e.,

n

t

pOyilx) = < )xty’(l—x,)”_y’, y,=0,1,...,n.
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a. Show that the observation equation with state variable transformed by the

logit transformation W, = In(X,/(1 — X,)) follows an exponential family

p(yilw,) = exply,w; — b(w;) + c(y,)}.
Determine the functions () and ¢(+).

. Suppose that the state X, has the beta density

PxalY?) = F(i1s vty Aegan),
where
fOa,n) =[Bl, )] X 1-x*1 0<x<1,

B(a, )) ;=T (@)l (1)/ ' (a+ 1) isthebetafunction, and «, A > 0. Show that
the posterior distribution of X, given Y, isalso betaand expressits parameters
intermsof y, and ot;;;—1, Asj—1.

. Under the assumptions made in (b), show that E(X,|Y®) = E(X41/Y®)

and Var(X,|Y®) <Var(X,1/Y®).

. Assuming that the parametersin (b) satisfy (8.8.41)—(8.8.42), show that the

one-step prediction density p(y..1]y") is beta-binomial,

B(atryay + Yir1, Aigry + 10— Y1)
mn+DBy1+Lln—y+ 1)B(Olt+1|z, )\t+1|z) '

POealy?”) =

and verify that ¥, , is given by (8.8.47).



Forecasting Techniques

9.1 The ARAR Algorithm

9.2 The Holt-Winters Algorithm

9.3 The Holt-Winters Seasonal Algorithm
9.4 Choosing a Forecasting Algorithm

We have focused until now on the construction of time series models for stationary
and nonstati onary seriesand the determination, assuming the appropriateness of these
models, of minimum mean squared error predictors. If the observed series had in
fact been generated by the fitted model, this procedure would give minimum mean
squared error forecasts. In this chapter we discuss three forecasting techniques that
have less emphasis on the explicit construction of a model for the data. Each of the
three selects, from alimited class of algorithms, the one that is optimal according to
specified criteria.

The three techniques have been found in practice to be effective on wide ranges
of real data sets (for example, the economic time series used in the forecasting com-
petition described by Makridakis et al., 1984).

The ARAR algorithm described in Section 9.1 is an adaptation of the ARARMA
algorithm (Newton and Parzen, 1984; Parzen, 1982) in which the idea is to apply
automatically selected “memory-shortening” transformations (if necessary) to the
dataand then to fit an ARMA model to the transformed series. The ARAR algorithm
we describe is a version of this in which the ARMA fitting step is replaced by the
fitting of a subset AR modéd to the transformed data.

The Holt-Winters (HW) algorithm described in Section 9.2 uses a set of simple
recursions that generalize the exponential smoothing recursions of Section 1.5.1 to
generate forecasts of series containing alocally linear trend.
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TheHolt-Wintersseasonal (HWS) a gorithm extendsthe HW a gorithmto handle
data in which there are both trend and seasonal variation of known period. It is
described in Section 9.3.

The agorithms can be applied to specific data sets with the aid of the ITSM op-
tionsForecasting>ARAR,Forecasting>Holt-Winters andForecasting> Sea-
sonal Holt-Winters.

9.1 The ARAR Algorithm

9.1.1 Memory Shortening

Givenadataset {Y,,t = 1, 2, ..., n}, thefirst step isto decide whether the underlying
processis“long-memory,” andif soto apply amemory-shortening transformation be-
fore attempting to fit an autoregressive model. The differencing operations permitted
under the option Transform of ITSM are examples of memory-shortening transfor-
mations, however, the ones from which the option Forecasting>ARAR selects are
members of a more general class. There are two types allowed:

Y, =Y, — (%)Y (9.1.1)
and
Y, =Y, — ¢1¥i 1 — $a¥i o (9.1.2)

With the aid of the five-step algorithm described below, we classify {Y,} and take
one of the following three courses of action:

o L.Declare({Y,} to belong-memory and form {¥,} using (9.1.1).
e M. Declare {Y,} to be moderately long-memory and form {7, } using (9.1.2).
e S Declare {Y,} to be short-memory.

If the alternative L or M is chosen, then the transformed series {f/,} is again
checked. If it isfound to belong-memory or moderately long-memory, then afurther
transformation is performed. The process continues until the transformed series is
classified as short-memory. At most three memory-shortening transformations are
performed, but it is very rare to require more than two. The agorithm for deciding
among L, M, and S can be described as follows:

1. Foreacht =1,2,...,15, wefind thevalueg@(r) of ¢ that minimizes

Z:l:z-»,-l[Yr - ¢Yt—r]2
Z?:'H—l Ytz

ERR(¢, 7) =

We then define
Err(t) = ERR(¢(7), 7)
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and choose the lag T to be the value of ¢ that minimizes Err(z).

If Err(?) < 8/n,gotolL.

3. 1f¢(¢) > .93and # > 2,goto L.

4. 1f $(t) > .93 and ¢ = 1 or 2, determine the values ¢, and ¢, of ¢; and ¢, that
minimize Y" .[Y, — ¢1Y,_1 — ¢2Y,_5]? then go to M.

5. 1f ¢(%) < .93,goto S.

N

9.1.2 Fitting a Subset Autoregression

Let{S;,r =k +1,...,n} denotethe memory-shortened series derived from {Y;} by
thealgorithm of theprevioussectionand let S denotethesamplemeanof Sy, 4, ..., S,.

The next step in the modeling procedure isto fit an autoregressive process to the
mean-corrected series

X, =S-S5, t=k+1,...,n.
The fitted model has the form
Xi =1 X1+ Xy + O, X, + G, Xy + Zy,

where{Z,} ~ WN (0, 0'2), and for given lags, [y, >, and /5, the coefficients ¢; and the
white noise variance o2 are found from the Yule-Walker equations

1 pli =1 pl—=1) plzs—1) 1 p(D)
pl1—1) 1 po—11) pUzs—1) || ¢ | | P
pla—1 pll—11) 1 pls—10) (| o | | P2
plz—1) pls—1) pls—1p) 1 &1 p(l3)

and

0? =70 [1—¢1p(D) — ¢, p(l) — P, p(l2) — . pU3)]

where 7 (j) and p(j), j = 0,1, 2,..., are the sample autocovariances and autocor-
relations of the series { X, }.
The program computes the coefficients ¢, for each set of lags such that

1<l <lb<Il3<m,

where m can be chosen to be either 13 or 26. It then selects the model for which the
Yule-Walker estimate o2 is minimal and prints out the lags, coefficients, and white
noise variance for the fitted model.

A slower procedure chooses the lags and coefficients (computed from the Yule—
Walker equationsasabove) that maximizethe Gaussianlikelihood of theobservations.
For this option the maximum lag m is 13.

The options are displayed in the ARAR Forecasting dialog box, which appears
on the screen when the option Forecasting>ARAR is selected. It alows you also to
bypass memory shortening and fit a subset AR to the original (mean-corrected) data.
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9.1.3 Forecasting

If the memory-shortening filter found in the first step has coefficients yo(= 1),
Y1, ..., ¥y (k > 0), then the memory-shortened series can be expressed as

S=yB)YY, =Y, +Y1Yia+--+ WYy, (9.12.3)
where v (B) isthe polynomial in the backward shift operator,
Y(B) =1+y1B+---+ ¥ B".

Similarly, if the coefficients of the subset autoregression found in the second step are
o1, d1,, P, @nd ¢, then the subset AR model for the mean-corrected series {X, =
S, —S}is

¢(B)X, = Z,, (9.1.4)
where {Z,} ~ WN (0, ¢'2) and

¢(B) =1—¢1B — ¢, B" — ¢,B" — ¢, B".
From (9.1.3) and (9.1.4) we obtain the equations

EB)Y, =p()S+Z, (9.1.5)
where

EB) =Y (B)p(B) =1+ &B+ - + &, B,

Assuming that the fitted model (9.1.5) is appropriate and that the white noise
term Z, is uncorrelated with {Y;, j < ¢} for each ¢, we can determine the minimum
mean squared error linear predictors P,Y,., of Y,., intermsof {1, Yy, ..., Y,}, for
n > k + I3, from the recursions

k+I3
PYoun ==Y EPYou;+ DS, h>1, (9.1.6)
j=1
with theinitial conditions
PnYIH-h = Ly+h, for h < 0 (917)
The mean squared error of the predictor P,Y,.; isfound to be (Problem 9.1)
h—1
E [(Yn-ﬁ-h - PnYrH-h)z] = Z TJ'ZJZa (918)
j=1

where 37 7;z/ is the Taylor expansion of 1/&(z) in a neighborhood of z = 0.
Equivalently the sequence {;} can be found from the recursion

0=1Y 16 ;=0 n=12... (9.1.9)
=0
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Example 9.1.1

9.1.4 Application of the ARAR Algorithm

To determine an ARAR model for a given data set {Y,} using ITSM, select Fore-
casting>ARAR and choose the appropriate optionsin the resulting dialog box. These
include specification of the number of forecasts required, whether or not you wish
to include the memory-shortening step, whether you require prediction bounds, and
which of the optimality criteriaisto be used. Once you have made these selections,
click 0k, and the forecasts will be plotted with the original data. Right-click on the
graph and then Info to see the coefficients 1, 1, . .., ¥ of the memory-shortening
filter v+ (B), the lags and coefficients of the subset autoregression

X =01 Xio1 — b Xy, — P, Xit, — Qu Xiiy = 2y,
and the coefficients ¢; of B/ in the overall whitening filter
£B) = (14 1B + -+ Y B*) (L — ¢1B — ¢, B" — ¢,,B” — ¢,B") .

The numerical values of the predictors, their root mean squared errors, and the pre-
diction bounds are also printed.

Tousethe ARAR agorithmto predict 24 values of the accidental deathsdata, openthe
file DEATHS.TSM and proceed as described above. Selecting Minimize WN vari-
ance [max lag=26] gives the graph of the data and predictors shown in Figure
9.1. Right-clicking on the graph and then Info, we find that the selected memory-
shortening filter is (1 — .9779B*2). The fitted subset autoregression and the coeffi-
cients ¢; of the overall whitening filter £(B) are shown below:

Optimal lags 1 3 12 13
Optimal coeffs .5915 -.3822 -.3022 .2970
WN Variance: .12314E+06
COEFFICIENTS OF OVERALL WHITENING FILTER:
1.0000 -.5915 .0000 -.2093 .0000
.0000 .0000 .0000 .0000 .0000
.0000 .0000 -.6757 .2814 .0000
2047 .0000 .0000 .0000 .0000
.0000 .0000 .0000 .0000 -.2955
.2904 O

In Table 9.1 we compare the predictors of the next six values of the accidental
deaths series with the actual observed values. The predicted values obtained from
ARAR as described in the example are shown together with the predictors obtained
by fitting ARIMA models as described in Chapter 6 (see Table 9.1). The observed

root mean squared errors(i.e., \/ Z,f:l(Y72+,, — P1Y70,1)?/6) for thethreeprediction
methodsare easily calculated to be 253 for ARAR, 583 for the ARIMA model (6.5.8),
and 501 for the ARIMA model (6.5.9). The ARAR algorithm thus performs very
well here. Notice that in this particular example the ARAR algorithm effectively fits
acausal AR model to the data, but thisis not always the case.
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Figure 9-1

The data set DEATHS.TSM
with 24 values predicted
by the ARAR algorithm.
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9.2 The Holt-Winters Algorithm

Table 9.1

9.2.1 The Algorithm

Given observations Y;, Y, ..., Y, from the “trend plus noise” model (1.5.2), the
exponential smoothing recursions (1.5.7) allowed us to compute estimates i, of the
trendattimes: = 1, 2, ..., n. If the seriesis stationary, then m, is constant and the
exponential smoothing forecast of Y, , based on the observations Y3, ..., Y, is

P Yy =iy, h=12.... (9.2.1)

If the data have a (honconstant) trend, then anatural generalization of the forecast
function (9.2.1) that takes thisinto account is

PYyp =, +bh, h=12 ..., (9.2.2)

where 4, and b, can be thought of as estimates of the “level” a, and “slope’ b, of
the trend function at timer. Holt (1957) suggested arecursive scheme for computing

Predicted and observed values of the accidental deaths series for
t=73,...,78.

t 73 74 75 76 77 78

Observed Y; 7798 7406 8363 8460 9217 9316
Predicted by ARAR 8168 7196 7982 8284 9144 9465
Predicted by (6.5.8) 8441 7704 8549 8885 9843 10279
Predicted by (6.5.9) 8345 7619 8356 8742 9795 10179
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the quantitiesa, and b, in (9.2.2). Denoting by Y, the one-step forecast P, Y, 1, we
have from (9.2.2)

Yn+l = a, + b,.

Now, asin exponential smoothing, we suppose that the estimated level at timen + 1
isalinear combination of the observed value at time n + 1 and the forecast value at
timen + 1. Thus,

app1 = Y1 + (L—a)(a, +b,). (9.2.3)

We can then estimate the slope at timen + 1 asalinear combination of a1 — a, and
the estimated slope b,, a timen. Thus,

S

bur1 = B (Gpe1 — Gn) + 1= B)b,. (9.2.4)

Inorder to solvetherecursions(9.2.3) and (9.2.4) weneed initial conditions. A natural
choiceisto set

ar = Y> (9.2.5)
and
by =Y, — Yy (9.2.6)

Then (9.2.3) and (9.2.4) can be solved successively for a; and b;, i = 3,...,n, and
the predictors P, Y, ., found from (9.2.2).

Theforecastsdepend on the* smoothing parameters’ o and 8. These can either be
prescribed arbitrarily (with values between 0 and 1) or chosen in a more systematic
way to minimize the sum of squares of the one-step errors Y ,(Y; — P,_1Y:)?,
obtained when the algorithm is applied to the already observed data. Both choices
areavailableinthe ITSM option Forecasting>Holt-Winters.

Beforeillustrating the use of the Holt—Wintersforecasting procedure, we discuss
the connection between the recursions (9.2.3)—<9.2.4) and the steady-state solution
of the Kalman filtering equationsfor alocal linear trend model. Suppose {Y,} follows
the local linear structural model with observation equation

Yi=M+W,
and state equation

M| |1 1| M, 4 14

Bt+1 - O 1 Bt U[
(see (8.2.4)—(8.2.7)). Now define 4, and b, to be thefiltered estimates of M, and B,,
respectively, i.e.,

&n = Mnln = PnMn’
b, = By, = P,B,.
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Example 9.2.1

Using Problem 8.17 and the Kalman recursion (8.4.10), we find that

iln_,'_l _ ay :i_ bn + A—lQnG/ <Yn _ &n _ Bn) , (927)
bn+l bn "

whereG = [1 O].Assumingthat Q,=Q = [Qij]f_izl isthe steady-state solution

of (8.4.2) for this model, then A, = Q3 + o2 for al n, so that (9.2.7) simplifiesto
the equations

A A Qq A 2
Apy1 = dy + bn + m (Yn —dap — bn) (928)
and
Bray = b, + 212 (Yn —a,— én) . (9.2.9)
Qu+o02
Solving (9.2.8) for (Y, — &, — b,) and substituting into (9.2.9), we find that
tpin = a¥y1 4+ (1—a) (a,, + Bn) , (9.2.10)
bur1 = B (Gns1 — an) + (L= P)b, (9.2.11)

with o = Qu1/ (Qu +02) and B = Qa1/Qu. These equations coincide with the
Holt-Winters recursions (9.2.3)—9.2.4). Equationsrelating « and 8 to the variances
02,02, and o2 can be found in Harvey (1990).

To predict 24 values of the accidental deaths series using the Holt—-Wintersa gorithm,
open thefile DEATHS.TSM and select Forecasting>Holt-Winters. Intheresult-
ing dialog box specify 24 for the number of predictors and check the box marked
Optimize coefficients for automatic selection of the smoothing coefficients «
and 8. Click 0K, and the forecasts will be plotted with the original data as shownin
Figure 9.2. Right-click on the graph and then Info to see the numerical values of the
predictors, their root mean squared errors, and the optimal values of « and 8. O

Theroot mean squared error (\/ Zﬁzl(Ymh — P1Y741,)?/6) for the nonseasonal
Holt-Wintersforecastsisfound to be 1143. Not surprisingly, since we have not taken
seasonality into account, thisisamuch larger value than for the three sets of forecasts
shown in Table 9.1. In the next section we show how to modify the Holt—Winters
algorithm to alow for seasonality.

9.2.2 Holt-Winters and ARIMA Forecasting

The one-step forecasts obtained by exponential smoothing with parameter « (defined
by (1.5.7) and (9.2.1)) satisfy the relations

PYp1=Y,—A—a)¥, — P,_1Y,), n>2 (9.2.12)
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The data set DEATHS.TSM L |

with 24 values predicted
by the nonseasonal
Holt-Winters algorithm.

Table 9.2

1 1 1 1 1 1 1 1 1
1973 1974 1975 1976 1977 1978 1979 1980 1981

But these are the same rel ati ons sati sfied by the large-sampl e minimum mean squared
error forecasts of the invertible ARIMA(0,1,1) process

Y=Y 1+Z —1-a)Z_1, {Z}~WN(0,0?). (9.2.13)

Forecasting by exponential smoothing with optimal « can therefore be viewed as
fittingamember of thetwo-parameter family of ARIMA processes(9.2.13) tothedata
and using the corresponding large-sample forecast recursions initialized by PyY; =
Y:. In1TSM, the optimal « isfound by minimizing the average squared error of the
one-step forecasts of the observed data Y-, . . ., Y,,, and the parameter o2 is estimated
by this average squared error. This algorithm could easily be modified to minimize
other error measures such as average absolute one-step error and average 12-step
squared error.

In the same way it can be shown that Holt—-Winters forecasting can be viewed as
fitting a member of the three-parameter family of ARIMA processes,

1-B?%,=Z,—-Q2—-a—ap)Zi 1+ 1 —a)Zi_5, (9.2.14)

Predicted and observed values of the accidental deaths series
fort =73,...,78 from the (nonseasonal) Holt-Winters

algorithm.
t 73 74 75 76 77 78
Observed Y; 7798 7406 8363 8460 9217 9316

Predicted by HW 9281 9322 9363 9404 9445 9486
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where {Z,} ~ WN(O, o2). The coefficients « and B are selected as described after
(9.2.6), and the estimate of o2 is the average squared error of the one-step forecasts
of Y3, ..., Y, obtained from the large-sample forecast recursions corresponding to
(9.2.14).

9.3 The Holt-Winters Seasonal Algorithm

9.3.1 The Algorithm

If the series Y1, Y», ..., ¥, contains not only trend, but also seasonality with period
d (asin the model (1.5.11)), then a further generalization of the forecast function
(9.2.2) that takes thisinto account is

PnY11+/1 = &n + l;nh + En-ﬁ-h’ h = la 2, LR (931)

where &, b,, and ¢, can be thought of as estimates of the “trend level” a,,, “trend
dope” b,, and “seasonal component” ¢, at time n. If k is the smallest integer such
that n + h — kd < n, then we set

6'n-',-h - 6‘n-',-h—lwl’ h = 1’ 2» ey (932)

whilethevaluesof ;,b;,and¢;,i = d+2, . .., n,arefound fromrecursionsanal ogous
to (9.2.3) and (9.2.4), namely,

ani1 =0 (Vo1 — Guvia) + L= a)(@, + by), (9.3.3)

buyir = B (nss — an) + (L = Bby, (9.3.4)
and

Cnr1 =Y Yoy1 — Gny1) + (L= y)Cry1as (9.3.9)

with initial conditions

dar1 = Yar1, (9.3.6)

baya = (Yara — Y1) /d, (9.3.7)
and

& =Yi— (Yi+bpali—1), i=1..,d+1 (9.3.8)

Then (9.3.3)«(9.3.5) can be solved successively for a;, b;, and &,i =d + 1,...,n,
and the predictors P, Y, ., found from (9.3.1).

Asinthe nonseasonal case of Section 9.2, theforecasts depend on the parameters
o, B, and y. These can either be prescribed arbitrarily (with values between 0 and 1)
or chosen in a more systematic way to minimize the sum of squares of the one-step
errors y_!_,.,(Y; — Pi_1Y;)?, obtained when the algorithm is applied to the aready
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by the seasonal
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Example 9.3.1

Table 9.3

1973 1974 1975 1976 1977 1978 1979 1980 1981

observed data. Seasonal Holt—Winters forecasts can be computed by selecting the
ITSM option Forecasting>Seasonal Holt-Winters.

Asin Example 9.2.1, open the file DEATHS.TSM, but this time select Forecast-
ing>Seasonal Holt-Winters. Specify 24 for the number of predicted values re-
quired, 12 for the period of the seasonality, and check the box marked Optimize
Coefficients. Click OK, and the graph of the data and predicted values shown in
Figure 9.3 will appear. Right-click on the graph and then on Info and you will seethe
numerical values of the predictors and the optimal values of the coefficients«, 8, and
y (minimizing the observed one-step average squared error ZZM(}@ — P,_1Y)?/59).
Table 9.3 compares the predictors of Y+, ..., Yzg with the corresponding observed
values. O

The root mean squared error (\/ Z,L(Ymh — P;,Y75.,)2/6) for the seasonal
Holt—-Winters forecasts is found to be 401. This is not as good as the value 253
achieved by the ARAR model for this example but is substantially better than the

Predicted and observed values of the accidental deaths series

fort =73,...,78 from the seasonal Holt-Winters algorithm.
t 73 74 75 76 77 78
Observed Y, 7798 7406 8363 8460 9217 9316

Predicted by HWS 8039 7077 7750 7941 8824 9329
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values achieved by the nonseasonal Holt—Winters algorithm (1143) and the ARIMA
models (6.5.8) and (6.5.9) (583 and 501, respectively).

9.3.2 Holt-Winters Seasonal and ARIMA Forecasting

As in Section 9.2.2, the Holt-Winters seasonal recursions with seasonal period d
correspond to the large-sample forecast recursions of an ARIMA process, in this
case defined by

A-B)YA-BY, =Z++Zi a1 +yQ—o)Zig— Zi_4-1)
- QR-a—ap)(Zia+ -+ Zi—y)
+ (1 —a)(Zio+ -+ Zi_q-1),

where{Z,} ~WN(0, o%). Holt-Winters seasonal forecastingwith optimal o, g, andy
can therefore be viewed asfitting amember of thisfour-parameter family of ARIMA
models and using the corresponding large-sampl e forecast recursions.

9.4 Choosing a Forecasting Algorithm

Real data are rarely if ever generated by a simple mathematical model such as an
ARIMA process. Forecasting methods that are predicated on the assumption of such
amodel are therefore not necessarily the best, even in the mean squared error sense.
Nor is the measurement of error in terms of mean squared error necessarily aways
the most appropriate one in spite of its mathematical convenience. Even within the
framework of minimum mean squared-error forecasting, we may ask (for example)
whether we wish to minimize the one-step, two-step, or twelve-step mean squared
error.

The use of more heuristic algorithms such as those discussed in this chapter
is therefore well worth serious consideration in practical forecasting problems. But
how do we decide which method to use? A relatively simple solution to this problem,
given theavailability of asubstantial historical record, isto choose among competing
algorithms by comparing the relevant errors when the algorithms are applied to the
data already observed (e.g., by comparing the mean absol ute percentage errors of the
twelve-step predictors of the historical data if twelve-step prediction is of primary
concern).

Itis extremely difficult to make general theoretical statements about the relative
merits of the various techniques we have discussed (ARIMA modeling, exponential
smoothing, ARAR, and HW methods). For the series DEATHS. TSM we found on
the basis of average mean sguared error for predicting the series at times 73—78
that the ARAR method was best, followed by the seasonal Holt—Winters algorithm,
and then the ARIMA models fitted in Chapter 6. This ordering is by no means
universal. For example, if we consider the natural logarithms {Y;} of the first 130



9.4

Choosing a Forecasting Algorithm 329

Figure 9-4

The first 132 values of the
data set AIRPASS.TSM
and predictors of the last
12 values obtained by
direct application of

the ARAR algorithm.

observations in the series WINE.TSM (Figure 1.1) and compare the average mean
squared errorsof theforecastsof Yy, . . ., Y142, wefind (Problem 9.2) that an MA(12)
model fitted to the mean corrected differenced series {Y, — Y,_1,} does better than
seasonal Holt—Winters (with period 12), which in turn does better than ARAR and
(not surprisingly) dramatically better than nonseasona Holt—-Winters. Aninteresting
empirical comparison of these and other methods applied to a variety of economic
time seriesis contained in Makridakis et a. (1998).

The versions of the Holt—Winters algorithms we have discussed in Sections 9.2
and 9.3 arereferredto as* additive,” sincethe seasonal and trend componentsenter the
forecasting functionin anadditivemanner. “ Multiplicative” versionsof thealgorithms
can a so be constructed to deal directly with processes of the form

Y, =m;s,7Z,, (9.4.1)

where m,, s;, and Z, are trend, seasonal, and noise factors, respectively (see, e.g.,
Makridakis et al., 1983). An alternative approach (provided that ¥, > Ofor all ¢) isto
apply the linear Holt—Winters algorithms to {In¥;} (asin the case of WINE.TSM in
the preceding paragraph). Because of therather general memory shortening permitted
by the ARAR agorithm, it gives reasonable results when applied directly to series
of the form (9.4.1), even without preliminary transformations. In particular, if we
consider thefirst 132 observationsin the series AIRPASS.TSM and apply the ARAR
algorithm to predict the last 12 values in the series, we obtain (Problem 9.4) an
observed root mean squared error of 18.21. On the other hand if we use the same
data take logarithms, difference at lag 12, subtract the mean and then fit an AR(13)
model by maximum likelihood using I TSM and useit to predict thelast 12 values, we

(thousands)
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obtain an observed root mean squared error of 21.67. The data and predicted values
from the ARAR agorithm are shown in Figure 9.4.

Problems

9.1

9.2

9.3.
9.4.

Establish the formula (9.1.8) for the mean sgquared error of the i-step forecast
based on the ARAR algorithm.

Let{X4, ..., X1} denotethedatainthefile WINE.TSM and let {Y1, ..., Y4}

denotetheir natural logarithms. Denote by m the sample mean of the differenced

series{Y, — Y,_1p,t = 13,...,130}.

a. Usethe program ITSM to find the maximum likelihood MA (12) model for
the differenced and mean-corrected series{Y, —Y,_»—m,t = 13, ..., 130}.

. Use the model in (a) to compute forecasts of { X1y, ..., X142}.

. Tabulate the forecast errors { X, — P130X,,t = 131, ..., 142}.

. Compute the average squared error for the 12 forecasts.

. Repeat steps (b), (c), and (d) for the corresponding forecasts obtained by
applying the ARAR algorithm to the series {X,, ¢ = 1, ..., 130}.

f. Repeat steps (b), (c), and (d) for the corresponding forecasts obtained by
applying the seasonal Holt—Winters algorithm (with period 12) to the logged
data{Y;,t=1,...,130}. (OpenthefileWINE.TSM, select Transform>Box-
Cox with parameter A = 0, then select Forecasting>Seasonal Holt-
Winters, and check Apply to original data inthediaog box.)

0. Repeat steps (b), (c), and (d) for the corresponding forecasts obtained by
applying the nonseasonal Holt—-Wintersalgorithmto thelogged data {Y,, t =
1,...,130}. (The procedure is analogous to that described in part (f).)

h. Compare the average squared errors obtained by the four methods.
Inequations (9.2.10)—9.2.11), show that o = Q11/(Q11+02) and = Q21 / Qu1.

w

O o O T

Verify the assertions made in the last paragraph of Section 9.4, comparing the
forecasts of the last 12 values of the series AIRPASS.TSM obtained from the
ARAR agorithm (with no log transformation) and the corresponding forecasts
obtained by taking logarithms of the original series, then differencing at lag 12,
mean-correcting, and fitting an AR(13) model to the transformed series.
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10.1  Transfer Function Models
10.2 Intervention Analysis
10.3 Nonlinear Models

10.4 Continuous-Time Models
10.5 Long-Memory Models

Inthisfinal chapter wetouch on avariety of topics of specia interest. In Section 10.1
we consider transfer function models, designed to exploit for predictive purposesthe
rel ationship between two time serieswhen one acts asaleading indicator for the other.
Section 10.2 deals with intervention analysis, which allows for possible changesin
the mechanism generating a time series, causing it to have different properties over
different time intervals. In Section 10.3 we introduce the very fast growing area of
nonlinear time seriesanalysis, and in Section 10.4 we briefly discuss continuous-time
ARMA processes, which, besides being of interest in their own right, are very useful
also for modeling irregularly spaced data. In Section 10.5 we discuss fractionally
integrated ARMA processes, sometimes called “long-memory” processes on account
of the slow rate of convergence of their autocorrelation functions to zero as the lag
increases.

10.1 Transfer Function Models

In this section we consider the prablem of estimating the transfer function of alinear
filter when the output includes added uncorrel ated noise. Supposethat { X} and { X,,}
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are, respectively, the input and output of the transfer function model

Xp=Y X1+ N, (10.1.1)
j=0
where T = {r;,j = 0,1,...} isacausa time-invariant linear filter and {N,} isa
zero-mean stationary process, uncorrelated with the input process { X;1}. We further
assume that {X,;} is a zero-mean stationary time series. Then the bivariate process
{(X;1, X;2)'} is also stationary. Multiplying each side of (10.1.1) by X, ; and then
taking expectations gives the equation

yak) = tiyulk — j). (10.1.2)
j=0

Equation (10.1.2) simplifiesagreat deal if theinput process happensto be white
noise. For example, if {X,1} ~ WN(O, o), then we can immediately identify 7, from
(10.1.2) as

7 = yau(k) /0. (10.1.3)

This observation suggeststhat “ prewhitening” of theinput process might simplify the
identification of an appropriate transfer function model and at the same time provide
simple preliminary estimates of the coefficients z;.

If {X,1} can berepresented as an invertible ARMA(p, g) process

¢(B)X1=6(B)Z,, {Z,} ~WN (0,07), (10.1.4)

then application of thefilter 7 (B) = ¢ (B)6~1(B) to {X,1} will produce the whitened
series {Z;}. Now applying the operator 7 (B) to each side of (10.1.1) and letting
Y, = n(B)X,», we obtain the relation

Y, =) 1,Z_;+N,,
j=0
where
N/ =n(B)N,,
and {N/} is a zero-mean stationary process, uncorrelated with {Z,}. The same argu-
ments that led to (10.1.3) therefore yield the equation
T = prz(j)oy/oz, (10.1.5)

where py; is the cross-correlation function of {Y,} and {Z,}, 02 =Var(Z,), and
UYZ =Var(Y,).

Given the observations {(X,1, X;»)',t = 1,..., n}, the results of the previous
paragraph suggest the following procedure for estimating {r;} and analyzing the
noise {N,} in the model (10.1.1):
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1. FitanARMA model to{X,,} andfiletheresiduals(Zs, . . ., Z,) (usingtheExport
buttonin ITSM to copy them to the clipboard and then pastl ng theminto thefirst
column of an Excel file). Let ¢ and 6 denote the maximum likelihood estimates
of the autoregressive and moving-average parametersand let 622 bethe maximum
likelihood estimate of the variance of {Z,}.

2. Apply theoperator 7 (B) = ¢(B)d~1(B)t0{X 2} toobtaintheseries (¥4, ..., 1,).
(After fitting the ARMA model asin Step 1 above, highlight the window con-
taining thegraph of {X,} and replace {X,} by {Y;} using the option File>Import.
The residuals are then automatically replaced by the residuals of {Y;} under the
model aready fitted to {X,}.) Export the new residuals to the clipboard, paste
them into the second column of the Excel file created in Step 1, and save this
as atext file, FNAME. TSM. The file FNAME.TSM then contains the bivariate
series{((Z;,Y,)}.) Let 6Y2 denote the sample variance of Y,.

3. Compute the sample auto- and cross-correlation functions of {Z;} and {Y;} by
opening the bivariate project FNAME.TSM in ITSM and clicking on the second
yellow button at the top of the ITSM window. Comparison of p,, (k) with the
bounds +1.96n /2 gives a preliminary indication of the lags # at which p,, (h)
is significantly different from zero. A more refined check can be carried out by
using Bartlett’s formula in Section 7.3.4 for the asymptotic variance of p,, (h).
Under the assumptions that {Z,} ~ WN (0,62) and {(¥,, Z,)'} is a stationary
Gaussian process,

nVar(pyz(h)) ~ 1 - p?,(h) [1.5 — Y (0p, k) + p%(k)/@}

k=—00

+ Z [oyz(h + k) pyz(h — k) — 2pyz(h)pyz(k + h)pfy (k)] .
k=—00
In order to check the hypothesis Hy that pyz(h) = 0, h ¢ [a, b], wherea and b
areintegers, we note from Corollary 7.3.1 that under Ho,

Var (ﬁyz(l’l)) ~ n_l for h ¢ [a, b]

We can therefore check the hypothesis Hy by comparing oy, i ¢ [a, b], withthe
bounds + 1.96rn /2. Observe that p,y (k) should be zero for 4 > 0 if the model
(10.1.2) isvalid.

4. Preliminary estimatesof 7, for thelagsh at which p,, (k) issignificantly different
from zero are

%h = Z)YZ(h)6Y/6'Z~

For other values of 4 the preliminary estimatesare 7, = 0. The numerical values
of the cross-correlations pyz (h) are found by right-clicking on the graphs of the
sample correlations plotted in Step 3 and then on Info. Thevauesof 6, and 6y
arefound by doing the same with the graphs of the seriesthemselves. Let m > 0
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bethelargest value of j suchthat 7; isnonzeroandlet 5 > 0 bethe smallest such
value. Then b isknown asthe delay parameter of thefilter {z;}. If m isvery large
and if the coefficients {;} are approximately related by difference equations of
the form

T, —untj1— - —v,T_,=0, j=b+p,
then 7(B) = >, T B’ can be represented approximately, using fewer param-
eters, as

T(B) =wo(l—viB—---—v,B,) ‘B’
In particular, if £, = 0, j < b, and #; = wev] *, j > b, then

T(B) = wo(1 — v1B) *B’. (10.1.6)

Box and Jenkins (1976) recommend choosing 7'(B) to be a ratio of two poly-
nomials. However, the degrees of the polynomials are often difficult to estimate
from {%j}. The primary objective at this stage is to find a parametric function
that provides an adequate approximation to 7'(B) without introducing too large
anumber of parameters. If 7(B) is represented as 7(B) = B*w(B)v~1(B) =
B (wo+wiB + -+ + w,BY) (L—vB — - — v, B?) " withv(z) # Ofor|z| <
1, then we definem = max(q + b, p).

. Thenoisesequence {N,,t =m + 1, ..., n}isestimated as

N =X — T(B)X 1.

(Weset N, = 0,7 < m,inordertocompute N,, t > m = max(b+q, p)). Thecal-
culations are donein ITSM by opening the bivariate file containing {(X,1, X;2)},
selecting Transfer>Specify Model, and entering the preliminary model found
in Step 4. Click on the fourth green button to see a graph of the residuas {N,}.
These should then be filed as, say, NOISE.TSM.

. Preliminary identification of a suitable model for the noise sequence is carried

out by fitting a causal invertible ARMA model
»™M(B)N, = 0V (BYW,, {(W,} ~WN (0, 04), (10.1.7)
to the estimated noise N1, . .., N, filed asNOISE.TSM in Step 5.

. At this stage we have the preliminary model

o™ (B)u(B)X,2 = B"¢" (B)w(B) X1 + 0™ (B)v(B)W,,

where 7(B) = B*w(B)v-Y(B) asin step (4). For this model we can compute
W, (W, v, ™, 0™M), t > m* = max(p, + p,b + p» + q), by setting W, = 0
for r < m*. The parametersw, v, ¢, and 8™ can then be reestimated (more
efficiently) by minimizing the sum of squares

S W2 (w,v, 6™, 0M).

t=m*+1
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(The calculations are performed in ITSM by opening the bivariate project {(X1,
X:2)}, selecting Transfer>Specify model, enteringthepreliminary model, and
clicking 0K. Then choose Transfer>Estimation, click OK, and theleast squares
estimates of the parameters will be computed. Pressing the fourth green button
at the top of the screen will give a graph of the estimated residuals W,.)

8. Totest for goodness of fit, the estimated residuals {W;, t > m*} and {Z,.t > m*}
should befiled as abivariate series and the auto- and cross correl ations compared
with the bounds 4-1.96/./n in order to check the hypothesis that the two series
are uncorrelated white noise sequences. Alternative models can be compared
using the AICC value that is printed with the estimated parameters in Step 7.
It is computed from the exact Gaussian likelihood, which is computed using a
state-space representation of the model, described in TSTM, Section 13.1.

Example 10.1.1  Sales with a leading indicator

Inthisexamplewefit atransfer function model to the bivariate time series of Example
7.1.2. Let

X1=0-B)Y,—.0228, r=2,...,150,
X2 = (1— B)Y;, — .420, t=2,...,150,

where {Y,1} and {Y,»}, r = 1,..., 150, are the leading indicator and sales data,
respectively. It was found in Example 7.1.2 that {X;;} and {X,,} can be modeled as
low-order zero-mean ARMA processes. |n particular, we fitted the model

X1 =(1-.474B)Z,, {Z,} ~WN(O, .0779),

to the series {X,1}. We can therefore whiten the series by application of the filter
7(B) = (1 — .474B)~1. Applying 7 (B) to both {X,;} and {X,,} we obtain

Z, = (1— 474B)7*X,;, 62 =.0779,
Y, = (1— 474B) X, 6%=4.0217.

These calculations and the filing of the series {Z,} and {¥,} were carried out us-
ing I TSM asdescribed in steps (1) and (2). Their sample auto- and cross-correl ations,
found as described in step (3), are shown in Figure 10.1. The cross-correlations
ozy(h) (top right) and pyz(h) (bottom left), when compared with the bounds
+1.96(149)"Y? = £.161, strongly suggest a transfer function model for {X,,} in
terms of {X,,} with delay parameter 3. Since 7, = pyz(j)dy/6, IS decreasing ap-
proximately geometrically for j > 3, wetake T'(B) to have the form (10.1.6), i.e.,

T(B) = wo(1 — v1B) B3

Thepreliminary estimatesof wgand v, arewg = 73 = 4.86and v, = 4/73 = .698, the
coefficients r; being estimated as described in step (4). The estimated noise sequence
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Figure 10-1

The sample correlation
functions p;i(h), of Example
10.1.1. Series 1 is {Z,}

and Series 2 is { V;}.

isdetermined and filed using ITSM as described in step (5). It satisfies the equations
N, = X, —486B%(1 — .698B)*X,;, 1=5,6,...,150.

Analysis of this univariate series with ITSM gives the MA(1) model
N, = (1-.364B)W,, {W,} ~ WN(O, .0590).

Substituting these preliminary noise and transfer function models into equation
(10.1.1) then gives

X,» = 4.86B%(1 — .698B)"X,1 + (1 — .364B)W,, {W,} ~ WN(0, .0590).

Now minimizing the sum of squares (10.1.7) with respect to the parameters (wo, vy,
6;") as described in step (7), we obtain the least squares model

X2 =4.717B%(1 — .724B)"*X,1 + (1 — .582B)W,, (10.1.8)
where {W,} ~ WN(0O, .0486) and
X1 =(1—474B)Z,, {Z,) ~WN(O0,.0779).

Notice the reduced white noise variance of {W;} in the least squares model as com-
pared with the preliminary model.

The sample auto- and cross-correlation functions of the series Z, and W,, t =
5,..., 150, are shown in Figure 10.2. All of the correlations lie between the bounds
+1.96/+/144, supporting the assumption underlying thefitted model that theresiduals

are uncorrelated white noise sequences. O
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Figure 10-2

The sample correlation
functions of the estimated
residuals from the

model fitted in Example
10.1.1. Series 1 is {Z,}
and Series 2 is {W,}.
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10.1.1 Prediction Based on a Transfer Function Model

Whenpredicting X .., » onthebasisof thetransfer function model defined by (10.1.1),
(10.1.4), and (10.1.7), with observations of X,; and X,,r = 1,...,n, 0ur aimisto
find thelinear combination of 1, X1, ..., X,1, X12, - . ., X,2 that predicts X, » with
minimum mean squared error. The exact solution of this problem can be found with
the help of the Kalman recursions (see TSTM, Section 13.1 for details). The program
ITSM usesthese recursions to compute the predictors and their mean squared errors.

In order to provide a little more insight, we give here the predictors P, X,
and mean squared errors based on infinitely many past observations X;; and X,,,
—o00 < t < n. These predictors and their mean squared errors will be close to those
based on X,; and X,», 1 < r < n, if n issufficiently large.

The transfer function model defined by (10.1.1), (10.1.4), and (10.1.7) can be
rewritten as

X2 =T(B)X:1 + B(B)W,, (10.1.9)
X1 =0(B)¢ (B)Z,, (10.1.10)
where B(B) = 0™ (B)/¢™(B). Eliminating X,; gives

XZZZZath—j+Z,Bth—ja (10111)
j=0 j=0

where a(B) = T(B)0(B)/¢(B).



338

Chapter 10

Further Topics

Example 10.1.2

Noting that each limit of linear combinations of {X,;, X;», —00 <t < n}isa
limit of linear combinations of {Z,, W,, —oo0 < ¢ < n} and conversaly and that {Z;}
and {W,} are uncorrelated, we see at once from (10.1.11) that

P Xyiho = Zaj Znin—j+ Z BiWain—- (10.1.12)
= p

Setting s = n+ h in (10.1.11) and subtracting (10.1.12) gives the mean squared error

h—
E (Xn+h,2 - f)an-Hl, ) - Gé Ol + G
i=0 j=

,_\

h—1

p2. (10.1.13)

M

~.
o

To compute the predictors P, X, » we proceed as follows. Rewrite (10.1.9) as
A(B)X,;2 = B°U(B)X,1 + V(B)W,, (10.1.14)
where A, U, and V are polynomials of the form
AB)=1-— A1B—---— A,B°,
UB)=Uy+UB+---+U,B",
V(B)y=14+ViB+---+V,B".
Applying the operator P, to equation (10.1.14) with ¢ = n + h, we obtain

Pxn+h2—ZA P Xpin- ,2+ZU PoXpihb- ,1+van+h j» (10.1.15)
j=1 j=0 =h
wherethe last sumiszeroif & > v.

Since {X,1} is uncorrelated with {W,}, the predictors appearing in the second
sum in (10.1.15) are therefore obtained by predicting the univariate series {X,1} as
described in Section 3.3 using the model (10.1.10). In keeping with our assumption
that n islarge, we can replace P, X ;, for each j by the finite-past predictor obtained
fromtheprogram I TSM. ThevaluesW;, j < n, arereplaced by their estimated values
W from the |east squares estimation in step (7) of the modeling procedure.

Equations (10.1.15) can now be solved recursively for the predictors P X, 12,
P Xni22, PuXoiz2, ...

Sales with a leading indicator

Applying the preceding results to the series {X;1, X,»,2 < ¢ < 150} of Example
10.1.1, and USing the values Xl48,1 = —.093, X]_50,2 = .08, Wisop = —.0706, Wiy9 =
.1449, we find from (10.1.8) and (10.1.15) that

f’150X151’2 = .724X150’2 —+ 4717X1481 — 1.306Wisg + .421W g9 = —.228
and, using the value X149, = .237, that
f’150X152’2 = .724;’150)(151’2 =+ 4.717X14g’1 + 421W150 = .923.
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In terms of the original sales data {Y,,} we have Y149, = 262.7 and
Yio =Y 12+ Xio + .420.

Hence the predictors of actual salesare
Py Y1512 = 262.70 — .228 + .420 = 262.89,
Pl Y1502 = 262.89 + .923 + .420 = 264.23,

where P} isbased on {1, Y11, Y12, X1, X2, —00 < s < 150}, and it is assumed that
Y11 and Yy, are uncorrelated with {X,} and with {X,,}. The predicted values are in
close agreement with those based on the finite number of available observations that
are computed by ITSM. Since our model for the sales dataiis

(1— B)Y,, = .420 + 4.717B%(1 — .474B)(1 — .724B)'Z, + (1 — 582B)W,,

it can be shown, using an argument anal ogous to that which gave (10.1.13), that the
mean squared errors are given by
h—1 h—1
E(Y1so1n2 — PisoY1sorn2)” =07 ) _aiP+of, Y B
j=0 j=0

where

Y et =AT178(1 - 474 (1 - 724 H(1—2) !
j=0

and

00

Y B = (1- 58212

=0
For h = 1 and 2 we obtain
E(Y1s1.2 — PjsyY1s1.2)? = .0486,
E(Yisp.2 — PisyY1s2.2)? = .0570,

in close agreement with the finite-past mean squared errors obtained by ITSM.

It isinteresting to examine theimprovement obtai ned by using the transfer func-
tion model rather than fitting a univariate model to the sales data alone. If we adopt
the latter course, we obtain the model

X,z — .249Xt_1’2 — .199Xl_2,2 = U,,

where {U,} ~ WN(0, 1.794) and X,, = Y,» — Y,_1, — .420. The corresponding
predictors of Y151, and Y3s, > are easily found from the program ITSM to be 263.14
and 263.58 with mean sguared errors 1.794 and 4.593, respectively. These mean
squared errors are dramatically worse than those obtained using the transfer function
model. O
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10.2

Intervention Analysis

During the period for which atime seriesis observed, it is sometimes the case that a
change occurs that affects the level of the series. A change in the tax laws may, for
example, have a continuing effect on the daily closing prices of shares on the stock
market. In the same way construction of a dam on ariver may have adramatic effect
on the time series of streamflows below the dam. In the following we shall assume
that thetime T at which the change (or “intervention”) occursis known.

To account for such changes, Box and Tiao (1975) introduced a model for inter-
vention analysis that has the same form as the transfer function model

Y, =) 1;X,_j+ N, (10.2.1)
j=0
except that the input series { X, } is not arandom series but a deterministic function of
t. Itisclear from (10.2.1) that Zj‘;o 7;X,_; isthen the mean of Y,. Thefunction {X,}
and the coefficients {z;} are therefore chosen in such a way that the changing level
of the observations of {Y,} is well represented by the sequence 3" 7; X, ;. For a
series{Y,} with EY, = 0forr < T and EY, — Oast — oo, asuitableinput seriesis
1 ifr=T,
X, =1(T) = (10.2.2)
{ 0 ifr#T.
For aseries {Y,} with EY, = Ofort < T and EY, — a # 0ast — oo, aslitable
input seriesis
1 ifer>T,
= H,(T) = Z I, (k) = ! T (10.2.3)
0 ift<T.
(Other deterministic input functions {X,} can also be used, for example when inter-
ventions occur at more than one time.) The function {X,} having been selected by
inspection of the data, the determination of the coefficients {r;} in (10.2.1) then re-
ducesto aregression problem in which the errors { N,} constitute an ARMA process.
This problem can be solved using the program ITSM as described bel ow.

The goa of intervention analysis is to estimate the effect of the intervention
as indicated by the term 3% 7; X, ; and to use the resulting model (10.2.1) for
forecasting. For example, Wichern and Jones (1978) used intervention analysis to
investigate the effect of the American Dental Association’s endorsement of Crest
toothpaste on Crest’s market share. Other applications of intervention analysiscan be
found in Box and Tiao (1975), Atkins (1979), and Bhattacharyya and Layton (1979).
A more general approach can also be found in West and Harrison (1989), Harvey
(1990), and Pole, West, and Harrison (1994).

Asinthecaseof transfer function modeling, once{X, } hasbeen chosen (usually as
either (10.2.2) or (10.2.3)), estimation of the linear filter {z;} in (10.2.1) issimplified
by approximating the operator T(B) = Zj"zo t; B/ with a rational operator of the
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Example 10.2.1

form
B"W(B)
V(B)
where b isthe delay parameter and W (B) and V (B) are polynomials of the form

T(B) = , (10.2.4)

W(B) = wo+w1B +--- + w,B?
and
ViB)=1—uv1B—---—v,B".

By suitable choice of the parameters b, ¢, p and the coefficients w; and v;, the
intervention term T'(B) X, can made to take a great variety of functional forms.

For example, if T(B) = wB?/(1 — vB) and X, = I,(T) asin (10.2.2), the
resulting intervention termiis

sz o] . 00 )
T ) =) vwlo(T) = ) v/ wl(T +2+ ),
(1— 'UB) /=0 j=0
aseriesof pulsesof sizesv/w attimesT+2+j,j =0,1,2,....1f |v| < 1, theeffect
of the intervention isto add a series of pulseswith sizew at time T + 2, decreasing
to zero at ageometric rate depending on v ast — oo. Similarly, with X, = H,(T) as

in (10.2.3),

w B?

mHz(T): 2 vwH,_;_o(T) :;(14‘U+"'+U")WIt(T+2—|—j),

j=0

aseriesof pulsesof sizes(1+v +---+vHwattimesT +2+j,j =0,1,2,....
If |v| < 1, the effect of the intervention is to bring about a shift in level of the series
X;, the size of the shift convergingto w/(1 — v) ast — oo.

Anappropriateformfor X, and possiblevaluesof b, ¢, and p having been chosen
by inspection of the data, the estimation of the parametersin (10.2.4) and the fitting
of the model for {N,} can be carried out using steps (6)—(8) of the transfer function
modeling procedure described in Section 10.1. Start with step (7) and assume that
{N,} iswhite noise to get preliminary estimates of the coefficients w; and v; by least
squares. Theresiduals arefiled and used as estimates of {N,}. Then go to step (6) and
continue exactly as for transfer function modeling with input series {X,} and output
series {Y,}.

Seat-belt legislation

In this example we reanalyze the seat-belt legidation data, SBL.TSM of Example
6.6.3 from the point of view of intervention analysis. For this purpose the bivariate
series {( f;, Y;)} consisting of the seriesfiled as SBLIN.TSM and SBL.TSM respec-
tively hasbeen saved inthefile SBL2.TSM. Theinput series{ f;} isthe deterministic
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Figure 10-3

The differenced series

of Example 10.2.1
(showing also the

fitted intervention term
accounting for the seat-belt
legislation of 1983).
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step-function defined in Example 6.6.3 and Y, is the number of deaths and serious
injuries on UK roads in month #, t = 1, ..., 120, corresponding to the 10 years
beginning with January 1975.

To account for the seat-belt legislation, we use the same model (6.6.15) as in
Example 6.6.3 and, because of the apparent non-stationarity of the residuas, we
again difference both { /;} and {Y,} at lag 12 to obtain the model (6.6.16), i.e.,

X, =bg + N, (10.2.9)

where X, = VY, g = Vo f;, and {N,} is a zero-mean stationary time series. This
is a particularly simple example of the general intervention model (10.2.1) for the
series {X,} with intervention {bg,}. Our aim is to find a suitable model for {~,} and
at the same time to estimate b, taking into account the autocorrelation function of
the model for {N,}. To apply intervention analysis to this problem using ITSM, we
proceed as follows:

(1) Open the bivariate project SBL2.TSM and difference the series at lag 12.

(2) Select Transfer>Specify model and you will see that the default input and
noise are white noise, while the default transfer model relating the input g, to
the output X, is X, = bg, with b = 1. Click 0K, leaving these settings as they
are. The input model is irrelevant for intervention analysis and estimation of
the transfer function with the default noise model will give usthe ordinary least
squares estimate of » inthemodel (10.2.4), with theresidual s providing estimates
of N,. Now selection Transfer>Estimation and click OK. You will then seethe
estimated value —346.9 for b. Finally, press the red Export button (top right in
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the ITSM window) to export the residuals (estimated values of N;) to afileand
cal it, say, NOISE.TSM.

(3) Without closing the bivariate project, open the univariate project NOISE.TSM.
The sample ACF and PACF of the series suggests either an MA(13) or AR(13)
model. Fitting AR and MA models of order up to 13 (with no mean-correction)
using the option Model>Estimation>Autofit gives an MA(12) model asthe
minimum AICC fit.

(4) Return to the bivariate project by highlighting the window labeled SBL2.TSM
and select Transfer>Specify model. The transfer model will now show the
estimated value —346.9 for b. Click on the Residual Model tab, enter 12 for
the MA order and click OK. Select Transfer>Estimation and again click OK.
The parameters in both the noise and transfer models will then be estimated and
printed on the screen. Repeating the minimization with decreasing step-sizes, .1,
.01 and then .001, gives the model,

X, = —362.5¢, + N,.

where N, =W, + .201W,_1 + .311W,_, + .105W,_3 + .040W,_, + .194W,_5 +
.100W, _+.299W,_7+.080W, _g+.125W, _g-+.210W,_19+.109W,_11+.501W,_15,
and {W,} ~ WN(0,17289). Filetheresiduals (which arenow estimatesof {W,}) as
RES.TSM. Thedifferenced series{ X, } and thefitted interventionterm, —362.5g;,
are shown in Figure 10.3.

(5) Open the univariate project RES.TSM and apply the usual tests for randomness
by selectingStatistics>Residual Analysis. Thetestsareall passed at level
.05, leading us to conclude that the model found in step (4) is satisfactory. The
sample ACF of the residualsis shown in Figure 10.4. O

10.3 Nonlinear Models

A time series of the form
X, =Y ¥;Z;. {Z)}~1ID(0.07), (10.3.1)
j=0

where Z; is expressible as a mean sguare limit of linear combinations of {X;, co <
s < t}, hasthe property that the best mean square predictor E (X, | X,, —00 < s < 1)
and the best linear predictor P.X,., interms of {X,, —oo < s < r} areidentical. It
can be shown that if iid is replaced by WN in (10.3.1), then the two predictors are
identical if and only if {Z,} isamartingale difference sequencerelativeto {X,},i.e,
if andonly if E(Z,|X,, —00 <s <r)=0forall .

TheWold decomposition (Section 2.6) ensuresthat every purely nondeterministic
stationary process can be expressed intheform (10.3.1) with {Z,} ~ WN (0, 62). The
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Figure 10-4

The sample ACF of the
residuals from the model
in Example 10.2.1
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process {Z,} in the Wold decomposition, however, is generaly not an iid sequence,
and the best mean square predictor of X,,, may be quite different from the best linear
predictor.

In the case where { X, } is a purely nondeterministic Gaussian stationary process,
the sequence {Z,} in the Wold decomposition is Gaussian and therefore iid. Every
stationary purely nondeterministic Gaussian process can therefore be generated by
applying acausal linear filter to an iid Gaussian sequence. We shall therefore refer to
such aprocess as a Gaussian linear process.

In this section we shall use the term linear process to mean a process {X,} of the
form (10.3.1). Thisis amore restrictive use of the term than in Definition 2.2.1.

10.3.1

Many of the time series encountered in practice exhibit characteristics not shown by
linear processes, and so to obtain good models and predictorsit is necessary to look
to models more general than those satisfying (10.3.1) with iid noise. As indicated
above, this will mean that the minimum mean squared error predictors are not, in
general, linear functions of the past observations.

Gaussian linear processes have a number of properties that are often found to
be violated by observed time series. The former are reversible in the sense that
(X, -, X,) hasthe same distribution as (X,,, -- -, X,,)". (Except in a few special
cases, ARMA processes are reversible if and only if they are Gaussian (Breidt and
Davis, 1992).) Deviations from this property by observed time series are suggested
by sample pathsthat riseto their maximaand fall away at different rates (see, for ex-
ample, the sunspot numbersfiled as SUNSPOTS.TSM). Bursts of outlying valuesare

Deviations from Linearity
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Figure 10-5

A sequence generated
by the recursions

Xp = 4xp_1(1 — Xp_1).

frequently observed in practical time series and are seen aso in the sample paths of
nonlinear (and infinite-variance) models. They arerarely seen, however, inthe sample
paths of Gaussian linear processes. Other characteristics suggesting deviation from
a Gaussian linear model are discussed by Tong (1990).

Many observed time series, particularly financial time series, exhibit periods
during which they are “less predictable” (or “more volatile”), depending on the past
history of the series. This dependence of the predictability (i.e., the size of the pre-
diction mean squared error) on the past of the series cannot be modeled with alinear
time series, since for a linear process the minimum A-step mean squared error is
independent of the past history. Linear models thus fail to take account of the pos-
sibility that certain past histories may permit more accurate forecasting than others,
and cannot identify the circumstances under which more accurate forecasts can be
expected. Nonlinear models, on the other hand, do allow for this. The ARCH and
GARCH models considered below arein fact constructed around the dependence of
the conditional variance of the process on its past history.

10.3.2 Chaotic Deterministic Sequences

To distinguish between linear and nonlinear processes, we need to be ableto decidein
particular when awhite noise sequenceis also iid. Sequences generated by nonlinear
deterministic difference equations can exhibit sample correlation functions that are
very closetothoseof samplesfromawhitenoisesequence. However, thedeterministic
nature of therecursionsimpliesthe strongest possible dependence between successive
observations. For example, the cel ebrated | ogistic equation (see May, 1976, and Tong,
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Figure 10-6

The sample autocorrelation
function of the sequence

in Figure 10.5.

1990) defines a sequence {x,}, for any given xo, viathe equations
Xy =4x,_1(1—x,-1), O<xo<L1l

The values of x, are, for even moderately large values of n, extremely sensitive
to small changesin xo. Thisis clear from the fact that the sequence can be expressed
explicitly as

x, = Sin” (2"arcsin (v/x0)), n=0,1,2,....

A very small changeés inarcsin (ﬁ) leadstoachange2"§ intheargument of thesine
function defining x,,. If we generate a sequence numerically, the generated sequence
will, for most values of xg in the interval (0,1), be random in appearance, with a
sample autocorreation function similar to that of a sample from white noise. The
data file CHAOS.TSM contains the sequence x, . . ., xo9 (correct to nine decimal
places) generated by the logistic equation with xo = 7/10. The calculation requires
specification of xq to at least 70 decimal places and the use of correspondingly high
precision arithmetic. The series and its sample autocorrelation function are shownin
Figures 10.5 and 10.6. The sample ACF and the AICC criterion both suggest white
noise with mean .4954 as a modd for the series. Under this model the best linear
predictor of X,y would be .4954. However, the best predictor of X5, to nine decimal
placesis, in fact, 4xo00(1 — x200) = 0.016286669, with zero mean squared error.
Distinguishing between iid and non-iid white noiseis clearly not possible on the
basis of second-order properties. For insight into the dependence structure we can
examine sample moments of order higher than two. For exampl e, the dependencein
the data in CHAOS.TSM s reflected by a significantly nonzero sample autocorre-
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lation at lag 1 of the squared data. In the following paragraphs we consider several
approaches to this problem.

10.3.3 Distinguishing Between White Noise and iid Sequences

If {X,;} ~WN(0,02) and E|X,|* < oo, auseful tool for deciding whether or not
{X,} isiid isthe ACF px:(h) of the process { X2}. If {X,} isiid, then px2(h) = O for
al h # 0, whereasthisis not necessarily the case otherwise. Thisisthe basis for the
test of McLeod and Li described in Section 1.6.

Now supposethat {X,} isastrictly stationary timeseriessuchthat E|X,|* < K <
oo for some integer k > 3. The kth-order cumulant Ci(r4, ..., rr_1) Of {X,} isthen
defined as the joint cumulant of the random variables, X,, X,4r,, - -, X147, 1.€, 8
the coefficient of i*z1z,---z; inthe Taylor expansion about (O, . .., 0) of

X1, ..., z) = INE[exp(izi X, + 122X qp + -+ iZkX,+,k71)]. (10.3.2)

(Since {X,} is strictly stationary, this quantity does not depend on ¢.) In particular,
the third-order cumulant function Cs of {X,} coincides with the third-order central
moment function, i.e.,

C3(r7 S) = E[(Xt - M)(Xf+r - I’L)(XZJrS - M)]9 r,s € {Ov :l:l’ . -}v

where u = EX,. If Y, > |Cs(r,s)] < oo, we define the third-order polyspectral
density (or bispectral density) of {X,} to be the Fourier transform

o]

o0
E E Cs(r, s)e™"" 1792 —x <@, wp <,

r=—00 §=—00

fa(wy, wp) =

1
(2m)2
in which case

Ci(r,s) = / / et (w1, wp)dwy dw,.

[More generally, if the kth order cumulants Cy (r1, - - -, ri_1), Of {X,} are absolutely
summable, we define the kth order polyspectral density as the Fourier transform of
C;.. For details see Rosenblatt (1985) and Priestley (1988).]

If {X,}isaGaussianlinear process, it followsfrom Problem 10.3 that the cumulant
function C; of {X,} isidentically zero. (The same is aso true of all the cumulant
functions C; with k > 3.) Consequently, f3(w1, w;) = O for al w1, w, € [—7, 7].
Appropriateness of a Gaussian linear model for a given data set can therefore be
checked by using the data to test the null hypothesis f3 = 0. For details of such a
test, see Subba-Rao and Gabr (1984).

If {X,} isalinear process of the form (10.3.1) with E|Z;|® < oo, EZ? = 5, and
Zj‘;o |¥;| < oo, it canbeshown from (10.3.2) (see Problem 10.3) that the third-order
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cumulant function of {X,} isgiven by

Cs(r,s) =n Z ViVivr Yiss (10.3.3)

(withy; = Ofor j < 0), and hence that {X,} has bispectral density
P (ei(lerwz)) W (e—iwl) v (e—iwz) ’ (10.3'4)

where ¥ (z) := Z‘;‘;O ¥;z/. By Proposition 4.3.1, the spectral density of {X,} is

fa(w1, wp) =

02 —iw
f@ =5 [y ()
Hence,

@y, ) = | f3(w1, w2)|? _ n?
P fnfe for+w) 2108
Appropriateness of the linear process (10.3.1) for modeling a given data set can
therefore be checked by using the data to test for constancy of ¢ (w1, w») (See Subba-

Rao and Gabr, 1984).

10.3.4 Three Useful Classes of Nonlinear Models

If it is decided that alinear Gaussian model is not appropriate, there is a choice of
several families of nonlinear processes that have been found useful for modeling
purposes. Theseinclude bilinear models, autoregressive models with random coeffi-
cients, and threshold models. Excellent accounts of these are available in Subba-Rao
and Gabr (1984), Nicholls and Quinn (1982), and Tong (1990), respectively.

The bilinear model of order (p, g, r, s) is defined by the equations

P q r K
X, =7Z + ZaiX,_; + ijzz—j + chijxt—izt—j’
i—1 =)

i=1 j=1

where{Z,} ~ iid (0, o2). A sufficient condition for the existence of astrictly station-
ary solution of these equationsis given by Liu and Brockwell (1988).

A random coefficient autoregressive process { X, } of order p satisfies an equation
of theform

V4
X, = Z (6 + U)X + Z4,
i=1

where {Z,} ~ 11D (0,02), {U/} ~ 1ID(0,v?), {Z,} is independent of {U,}, and
¢1,...,¢p e R.

Threshold model s can be regarded as piecewise linear modelsin which the linear
relationship varies with the values of the process. For example, if RV,i =1, ...k,
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isapartition of R”, and {Z,} ~ IID(0, 1), then the k difference equations

P . )
X, =092, 4> ¢"Xi_;, X+ X)) €RO, i=1--k (1035
j=1
define athreshold AR(p) model. Model identification and parameter estimation for
threshold models can be carried out in a manner similar to that for linear models
using maximum likelihood and the AIC criterion.

10.3.5 Modeling Volatility

For modeling changing volatility as discussed above under deviations from linearity,
Engle (1982) introduced the ARCH (p) process {X,} asasolution of the equations

Z, = /he,, {e;} ~ 11D N(0, 1), (10.3.6)

where h, isthe (positive) function of {Z;, s < ¢}, defined by
P
hi=ao+ Y aZl,, (10.3.7)
i=1

withag > Oanda; > 0, j = 1,..., p. The name ARCH signifies autoregressive
conditional heteroscedasticity. #, isthe conditional variance of Z, given {Z,, s < t}.
The simplest such process is the ARCH(1) process. In this case the recursions
(10.3.6) and (10.3.7) give
Z,2 = aoetz + alszle,z

2 2 2 272 2 2
= ape, + ajxpere, g + alzt—zet €1

—-n*

n
_ j 22 2 n+l-2 22 2
= 0o 2 :alet e e tay L, qerer g€
—

If |¢1] < 1and {Z,} isstationary and causdl (i.e., Z, isafunction of {e,, s < t}),
then the last term has expectation o"+* E Z2 and consequently (by the Borel-Cantelli
lemma) converges to zero with probability oneasn — oo. The first term converges
with probability one by Proposition 3.1.1 of TSTM, and hence

[e.¢]
Z% = Za{e?eil el (10.3.8)
/=0

From (10.3.8) we immediately find that
EZ,2 = Oto/(l - Oll). (1039)
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Since

Z, = e,J oo (1 + Za{eil e e,z_j), (10.3.10)
=1

itisclear that {Z,} is strictly stationary and hence, since EZ? < oo, also stationary
in the weak sense. We have now established the following result.

Solution of the ARCH(1) Equations:

If @] < 1, the unique causal stationary solution of the ARCH(1) equations is
given by (10.3.10). It has the properties

E(Z;) = E(E(Zles, s <)) =0,
Var(Z;) = ao/(1 — o),
and

E(ZiinZ) = E(E(ZyinZi)es, s <t +h)) =0forh > 0.

Thus the ARCH(1) process with |a;| < 1 is strictly stationary white noise.
However, it is not an iid sequence, since from (10.3.6) and (10.3.7),

E(ZZ, 1) = (o + anZ? )E(€?|Zi_1) = ap + a1 Z7 ;.

This also shows that {Z;} is not Gaussian, since strictly stationary Gaussian white
noise is necessarily iid. From (10.3.10) it is clear that the distribution of Z, is sym-
metric, i.e., that Z, and —Z, have the same distribution. From (10.3.8) it is easy to
calculate E£(Z}) (Problem 10.4) and hence to show that £(Z}) is finite if and only
if 3x2 < 1. More generaly (see Engle, 1982), it can be shown that for every a;
in theinterval (0, 1), E(Z%) = oo for some positive integer k. This indicates the
“heavy-tailed” nature of the marginal distribution of Z,. If EZ} < oo, the squared
process ¥, = Z?2 has the same ACF asthe AR(1) process W, = ay W, 1 + ¢, aresult
that extends also to ARCH(p) processes (see Problem 10.5).

The ARCH(p) processisconditionally Gaussian, inthe sensethat for given values
of {Z,,s =t—-1,t-2,...,t—p}, Z, isGaussianwith known distribution. Thismakes
it easy to write down the likelihood of Z,., ..., Z, conditiona on {Z, ..., Z,}
and hence, by numerical maximization, to compute conditional maximum likelihood
estimates of the parameters. For example, the conditional likelihood of observations
{z2, ..., z,} Of the ARCH(1) process given Z; = z; is

n Z2
L= | | exp ——’} .
=2 \/ 2m (oo + 127 ) { 2(e0 + ez )
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Example 10.3.1  An ARCH(1) series

Figure 10.7 shows aredlization of the ARCH(1) processwith ap = 1 and «; = 0.5.
The graph of the realization and the sample autocorrel ation function shown in Figure
10.8 suggest that the processiswhite noise. Thisconclusionis correct from asecond-
order point of view.
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Figure 10-8

The sample autocorrelation o ! | ! !
function of the series

in Figure 10.7. Lag
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Figure 10-9

The sample autocorrelation
function of the

squares of the data

shown in Figure 10.7.

However, the fact that the seriesis not arealization of iid noiseis very strongly
indicated by Figure 10.9, which shows the sample autocorrelation function of the
series { Z2}. (The sample ACF of {|Z,|} and that of {Z?} can be plotted in ITSM by
selecting Statistics>Residual Analysis>ACF abs values/Squares.)

It isinstructive to apply the Ljung—Box and McLeod-Li portmanteau tests for
white noise to this series (see Section 1.6). To do this using ITSM, open the file
ARCH.TSM, and then select Statistics>Residual Analysis>Tests of Ran-
domness. Wefind (with 2 = 20) that the Ljung—Box test (and all the others except for
the McLeod-Li test) are passed comfortably at level .05. However, the McLeod-Li
test gives a p-value of 0 to five decimal places, clearly rejecting the hypothesis that
the seriesisiid. O

The GARCH(p, q) process (see Bollerdev, 1986) is a generalization of the
ARCHY(p) process in which the variance equation (10.3.7) is replaced by

4 q
hi=ao+ Y & Z2,+ Y Bih? . (10.3.12)
i=1 j=1
withao > 0andw;, 8; >0, =1,2,....

In the analysis of empirical financial data such as percentage daily stock returns
(definedas1001In( P,/ P,_1), where P, istheclosing priceontrading day ¢), itisusually
found that better fits to the data are obtained by relaxing the Gaussian assumption
in (10.3.6) and supposing instead that the distribution of Z, given {Z,,s < ¢} hasa
heavier-tailed zero-mean distribution such as Student’s z-distribution. To incorporate
such distributions we can define a genera GARCHY(p, g) process as a stationary
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Example 10.3.2

process {Z,} satisfying (10.3.11) and the generalized form of (10.3.6),

Z, = /hie,, {e} ~11D(0,1). (10.3.12)
For modeling purposesit is usually assumed in addition that either
e, ~N(@O,1), (10.3.13)

(asin (10.3.6)) or that

v

. e ~1t, vV>2 (10.3.14)
wherer, denotes Student’s¢-distribution with v degrees of freedom. (The scale factor
on the left of (10.3.14) is introduced to make the variance of ¢, equa to 1.) Other
distributions for e, can also be used.

Oneof thestriking features of stock return datathat isreflected by GARCH mod-
elsisthe” persistence of volatility,” or the phenomenon that large (small) fluctuations
in the data tend to be followed by fluctuations of comparable magnitude. GARCH
models reflect this by incorporating correlation in the sequence {k;} of conditional
variances.

Fitting GARCH models to stock data

The top graph in Figure 10.10 shows the percentage daily returns of the Dow Jones
Industrial Index for the period July 1st, 1997, through April 9th, 1999, contained
in the file E1032.TSM. The graph suggests that there are sustained periods of both
high volatility (in October, 1997, and August, 1998) and of low volatility. The sam-
ple autocorrelation function of this series, like that Example 10.3.1, has very small
values, however the sampl e autocorrel ations of the absol ute values and squares of the
data (like those in Example 10.3.1) are significantly different from zero, indicating
dependence in spite of the lack of autocorrelation. (The sample autocorrelations of
the absolute values and squares of the residuals (or of the data if no transformations
have been made and no mode! fitted) can be seen by clicking on the third green button
at thetop of the ITSM window.) These properties suggest that an ARCH or GARCH
model might be appropriate for this series.
The model

Y, =a+Z, (10.3.15)

where{Z,} isthe GARCH(p, ¢) processdefined by (10.3.11), (10.3.12) and (10.3.13),
can befitting using ITSM as follows. Open the project E1032.TSM and click on the
red button labeled GAR at the top of the ITSM screen. In the resulting dialog box
enter the desired values of p and ¢, e.g., 1 and 1 if you wish to fit a GARCH(1,1)
model. Youmay also enter initial valuesfor thecoefficientsa, . .., a,,and gy, .. ., B,
or alternatively use the default values specified by the program. Make sure that Use
normal noiseisselected, click on 0K andthen click onthered MLE button. Youwill
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Figure 10-10

The daily percentage
returns of the Dow

Jones Industrial Index
(E1032.TSM) from July 1,
1997, through April 9,
1999 (above), and the
estimates of o, = /h; for
the conditional Gaussian
GARCH(1,1) model

of Example 10.3.2.
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be advised to subtract the sample mean (unless you wish to assumethat the parameter
ain(10.3.15) iszero). If you subtract the samplemean it will be used asthe estimate of
a inthe model (10.3.15). The GARCH Maximum Likelihood Estimation box will
then open. When you click on 0K the optimization will proceed. Denoting by {Z,}
the (possibly) mean-corrected observations, the GARCH coefficients are estimated
by numerically maximizing thelikelihood of Z,,,1, ..., Z, conditional on the known
vaues Zy, ..., Z,, and with assumed values O for each Z,, r < 0, and 62 for each &,
t < 0, where 62 is the sample variance of {Zl, el Zn}. In other words the program
maximizes

-~ 1 (7
L(ag, ., 0y, 1y -y By) l:]:L ofp(a,)’ (10.3.16)
with respect to the coefficients v, ..., a, and g, . .., B,, where ¢ denotes the stan-
dard normal density, and the standard deviations o, = +/h,,t > 1, are computed
recursively from (10.3.11) with Z, replaced by Z,, and with Z, = 0 and , = 62 for
t < 0. To find the minimum of —2In(L) it is advisable to repeat the optimization by
clicking on thered MLE button and then on 0K several timesuntil theresult stabilizes.
Itisalso useful to try other initial valuesfor «y, ..., «,, and g1, ..., B,, to minimize
the chance of finding only aloca minimum of —2In(L). Note that the optimization
is constrained so that the estimated parameters are all non-negative with

5514_..._|_5¢p_|_[31_|_..._|_[3q<]_7 (10.3.17)

and &, > 0. Condition (10.3.17) is necessary and sufficient for the corresponding
GARCH eguations to have a causal weakly stationary solution.
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Comparison of modelswith different orders p and g can be made with the aid of

the AICC, which is defined in terms of the conditional likelihood L as
AICC:= —2- " InL+2(p+q+2n/(n —p —q — 3. (10.3.18)
n—p

The factor n/(n — p) multiplying the first term on the right has been introduced to
correct for the fact that the number of factorsin (10.3.16) isonly n — p. Notice aso
that the GARCH(p, ¢) model has p + g + 1 coefficients.

The estimated mean is a = 0.0608 and the minimum-AICC GARCH model
(with Gaussian noise) for theresiduas, Z, = Y; — a, isfound to be the GARCH(1,1)
with estimated parameter values

&o = 0.1300, &; = 0.1266, B; = 0.7922,

and an AICC value (defined by (10.3.18)) of 1469.02. The bottom graph in Figure
10.10 shows the corresponding estimated conditional standard deviations, 6;, which
clearly reflect the changing volatility of the series {Y,}. This graph is obtained from
ITSM by clicking on the red SV (stochastic volatility) button. Under the model de-
fined by (10.3.11), (10.3.12), (10.3.13) and (10.3.15), the GARCH residual s, {Z, /6:},
should be approximately 1D N(0,1). A check on the independence is provided by
the sample ACF of the absolute values and squares of the residuals, which is ob-
tained by clicking on the fifth red button at the top of the ITSM window. These
are found to be not significantly different from zero. To check for normality, select
Garch>Garch residuals>QQ-Plot(normal). If the model is appropriate the re-
sulting graph should approximate a straight line through the origin with slope 1. It
is found that the deviations from the expected line are quite large for large values of
|Z,|, suggesting the need for a heavier-tailed model, e.g., amodel with conditional
t-distribution as defined by (10.3.14).

Tofit the GARCH model defined by (10.3.11), (10.3.12), (10.3.14) and (10.3.15)
(i.e., with conditional 7-distribution), we proceed in the same way, but with the con-
ditional likelihood replaced by

n Jv Z,\Jv
L(ag,...,0, B1,...,B,,V) = t,
! ! J:L oV —2 \ov—2

Maximizationisnow carried out with respect to the coefficients, a, . . . , &, B1, - . -, B4
and the degrees of freedom v of the r-density, 7,. The optimization can be performed
using ITSM in exactly the same way as described for the GARCH model with
Gaussian noise, except that the option Use t-distribution for noise should
be checked in each of the dialog boxes where it appears. In order to locate the min-
imum of —2In(L) it is often useful to initialize the coefficients of the model by first
fitting a GARCH model with Gaussian noise and then carrying out the optimization
using z-distributed noise.

The estimated mean isa = 0.0608 as before and the minimum-AICC GARCH
model for the residuals, Z, = Y, — a, isthe GARCH(1,1) with estimated parameter

) . (10.3.19)
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values
Go = 0.1324, &, =0.0672, B, =0.8400, » =5714,

and an AICC value (asin (10.3.18) with g replaced by ¢ + 1) of 1437.89. Thusfrom
the point of view of AICC, the model with conditional z-distribution is substantially
better than the conditional Gaussian model. The sample ACF of the absolute values
and squaresof the GARCH residualsaremuch the same asthosefound using Gaussian
noise, but the qq plot (obtained by clicking on the red QQ button and based on the
t-distribution with 5.714 degrees of freedom) is closer to the expected line than was
the case for the model with Gaussian noise.

There are many important and interesting theoretical questions associated with
the existence and properties of stationary solutionsof the GARCH equationsand their
moments and of the sampling properties of these processes. As indicated above, in
maximizing the conditional likelihood, ITSM constrains the GARCH coefficients to
be non-negative and to satisfy the condition (10.3.17) with &, > 0. These conditions
are sufficient for the process defined by the GARCH eguations to be stationary. It is
frequently found in practice that the estimated values of 4, ..., «, and g1, ..., B,
have a sum which is very close to 1. A GARCH(p,q) model with a; + -+ + «,, +
p1+ ---B, = liscaled I-GARCH. Many generdizations of GARCH processes
(ARCH-M, E-GARCH, I-GARCH, T-GARCH, FI-GARCH, €tc., aswell asARMA
models driven by GARCH noise, and regression models with GARCH errors) can
now be found in the econometrics literature.

ITSM can be used to fit ARMA and regression models with GARCH noise by
using the procedures described in Example 10.3.2 to fit a GARCH model to the
residuals {Z,} from the ARMA (or regression) fit.

Fitting ARMA models driven by GARCH noise

If we open the data file SUNSPOTS.TSM, subtract the mean and use the option
Model>Estimation>Autofit with the default ranges for p and ¢, we obtain an
ARMA (3,4) model for the mean-corrected data. Clicking on the second green button
at the top of the ITSM window, we see that the sample ACF of the ARMA residuals
is compatible with iid noise. However the sample autocorrelation functions of the
absolute values and squares of the residuals (obtained by clicking on the third green
button) indicate that they are not independent. To fit a Gaussian GARCH(1,1) model
tothe ARMA residuals click on the red GAR button, enter the value 1 for both p and
g and click OK. Then click on the red MLE button, click 0K in the dialog box, and the
GARCH ML Estimates window will open, showing the estimated parameter values.
Repeat the stepsin the previous sentence two moretimes and the window will display
the following ARMA(3,4) model for the mean-corrected sunspot data and the fitted
GARCH model for the ARMA noise process {Z,}.

X, =2463Z, 1 — 22487, ,+ .7571Z, 3+ Z, — .948Z, ,
—.296Z,_,+ .313Z, 3+ .136Z;_,,
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where

Z, = \/]’7,8,
and
h, = 31.152 + .22377% | + 5964, ;.

TheAlCCvaluefor the GARCH fit (805.12) should be used for comparing alternative
GARCH models for the ARMA residuals. The AICC vaue adjusted for the ARMA
fit (821.70) should be used for comparison with aternative ARMA models (with
or without GARCH noise). Standard errors of the estimated coefficients are also
displayed.

Simulation using the fitted ARMA(3,4) model with GARCH (1,1) noise can be
carried out by selecting Garch>Simulate Garch process. If youretainthesettings
inthe ARMA Simulation dialog box and click 0K you will see asimulated realization
of the model for the original datain SUNSPOTS.TSM. O

Some useful references for extensions and further properties of GARCH models
are Weiss (1986), Engle (1995), Shephard (1996), and Gouriéroux (1997).

10.4 Continuous-Time Models

Discrete time series are often obtained by observing a continuous-time process at a
discrete sequence of observation times. It is then natural, even though the observa-
tionsaremade at discrete times, to model the underlying process as a continuous-time
series. Evenif thereisno underlying continuous-time process, it may still be advanta-
geousto model the dataas observations of acontinuous-time processat discretetimes.
The analysis of time series data observed at irregularly spaced times can be handled
very conveniently via continuous-time models, as pointed out by Jones (1980).

Continuous-time ARMA processes are defined in terms of stochastic differential
eguations analogous to the difference equations that are used to define discrete-time
ARMA processes. Here we shall confine attention to the continuous-time AR(1) pro-
cess, which is defined as a stationary solution of thefirst-order stochastic differential
equation

DX(t) +aX(t) = o DB(t) + b, (10.4.1)

where the operator D denotes differentiation with respect to ¢, {B(¢)} is standard
Brownian mation, and a, b, and o are parameters. The derivative D B(r) does not
exist in the usual sense, so equation (10.4.1) is interpreted as an [td differential
eguation

dX(t) +aX@)dt =odB(t) +bdt, t >0, (10.4.2)

withd X (r) andd B(¢) denctingtheincrementsof X and B inthetimeinterval (¢, t+dr)
and X (0) a random variable with finite variance, independent of {B(?)} (see, e.g.,



358

Chapter 10

Further Topics

Chung and Williams, 1990, Karatzas and Shreve, 1991, and Oksendal, 1992). The
solution of (10.4.2) can be written as

4 t
X(t) — e*atX(O) + O’/ e*a(tfu) dB(u) + b/ efa(tfu) du,
0 0
or equivalently,
t
X(t)=e"X0)+e “I(t) +be™™ / e du, (10.4.3)
0

where (1) = o fo’ e dB(u) isan It integral (see Chung and Williams, 1990) satis-
fying E(1(t)) = 0and Cov(I (t + h), I (1)) = azf(; e dyforalt>0andh > 0.

If a > 0 and X(0) has mean b/a and variance o2/(2a), it is easy to check
(Problem 10.9) that {X (z)} as defined by (10.4.3) is stationary with

2
E(X(t)):g and COV(X(t—I-h),X(t)):GZe’“h, t,h >0. (10.4.4)

Conversely, if {X (¢)} is stationary, then by equating the variances of both sides of
(10.4.3), wefind that (1 — e=2) Var(X (0)) = o2 [; e~%* du for al + > 0, and hence
that « > 0 and Var(X (0)) = o0?/(2a). Equating the means of both sides of (10.4.3)
then gives E(X(0)) = b/a. Necessary and sufficient conditions for {X(¢)} to be
stationary are thereforea > 0, E(X(0)) = b/a, and Var(X(0)) = ¢2/(2a).1fa > 0
and X (0) isN(b/a, 02/(2a)), then the CAR(1) process will also be Gaussian and
strictly stationary.
Ifa>0and0 <s <t,itfollowsfrom (10.4.3) that X (+) can be expressed as

X(t) =e VX (s) + g (1= e 9) f e (I (1) — I(s)). (10.4.5)

This shows that the process is Markovian, i.e., that the distribution of X (¢) given
X ), u < s,isthesameasthedistribution of X () given X (s). It aso showsthat the
conditional mean and variance of X (¢) given X (s) are

E(X(l)|X(s)) — e*a(tfs)X(s) + b/a (l _ efa(tfs))

and
Var (X (1)|X (s)) = o [1— ¢ 20-9]
2a :

We can now use the Markov property and the moments of the stationary distribu-
tion to write down the Gaussian likelihood of observations x(#,), . .., x(z,) at times
t,...,t, of a CAR(1) process satisfying (10.4.1). This is just the joint density of
(X(t), ..., X(t,)) a (x(t1), ..., x(,)),whichcanbeexpressed asthe product of the
stationary density at x (z;) and thetransitiondensitiesof X (¢;) given X (¢;_1) = x(t;_1),
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i =2,...,n. Thejoint density g istherefore given by

=1 x(t;) —m
g(x(t),...,x(t);a,b,0%) = —f <—> , (10.4.6)
(s ) 11 Joi Vi
where f(x) = n(x; 0, 1) is the standard normal density, m; = b/a, v1 = 02/(2a),
andfori > 1,

b
m; = e*d(liflifl)x(tiil) + = (1 _ e*a(li*fifl))
a

and
0.2

- 2a

The maximum likelihood estimators of a, b, and o2 are the values that maxi-
mize g (x(r1), ..., x(t,); a, b, o?). These can be found with the aid of a nonlinear
maximization algorithm. Notice that the times¢; appearing in (10.4.6) are quite arbi-
trarily spaced. It isthisfeature that makesthe CAR(1) process so useful for modeling
irregularly spaced data.

If the observations are regularly spaced, say r; = i,i = 1, ..., n, then the joint
density g is exactly the same as the joint density of observations of the discrete-time
Gaussian AR(1) process

b b 2(l—e ™
Yy ——=e¢" (Yn—l - —) +Zy, {Z}~WN (0, M) :
a

V;

[1 _ 672a(t,<7t,,1)] )

a 2a

This shows that the “embedded” discrete-time process {X (i), i = 1,2,...} of the
CAR(1) processisadiscrete-time AR(1) processwith coefficient e—“. Thiscoefficient
isclearly positive, immediately raising the question of whether thereisa continuous-
time ARMA processfor which theembedded processisadiscrete-time AR(1) process
with negative coefficient. It can be shown (Chan and Tong, 1987) that the answer is
yes and that given a discrete-time AR(1) process with negative coefficient, it can
aways be embedded in a suitably chosen continuous-time ARMA(2,1) process.

We define a zero-mean CARMA(p, ¢) process {Y (1)} (with0 < ¢ < p)tobea
stationary solution of the pth-order linear differential equation

DPY(t) +arD" 'Y (t) + -+ +a,Y (1)
= boDB(t) + b1D*B(t) + - - - + b, D" B(1), (10.4.7)

where D) denotes j-fold differentiation with respect to 7, {B(¢)} is standard Brow-
nian motion, and as, ..., ap, bo, ..., b,, and ¢ are constants. We assume that b, # 0
and define b, := 0 for j > ¢. Since the derivatives D’ B(t), j > 0, do not exist in
the usua sense, we interpret (10.4.7) as being equivalent to the observation and state
equations

Y(1) = b'X(1), t>0, (10.4.8)
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and
dX(t) = AX(t)dt + edB(t), (10.4.9)
where
[ 0 1 0 0 |
0 0 1 0
A=| Lo |
0 0 0 1
—a,, —a,,_l —ap_z L —daq
e=[0 0 - 0 1],b=[bo b - byo b, 1], ad(1048)isanItD

differential equation for the state vector X (¢). (We assume also that X (0) isindepen-
dent of {B(¢)}.)
The solution of (10.4.9) can be written as

t
X(t) = e X (0) + [ A edBu),
0

which is stationary if and only if

EXO)=[0 0 - o]/,

Cov(X(0)) = / eMedeY dy,
0

and al the eigenvalues of A (i.e., the roots of z7 + a1z”"* + --- 4+ a, = 0) have
negative real parts.

Then {Y (¢),t > 0} is said to be a zero-mean CARMA(p, q) process with para-
meters (as, ..., ap, bo, ..., by, 0,¢) if

Yy =[bo b1 - byo by |X0),

where {X(¢)} is a stationary solution of (10.4.9) and b; := O for j > g.
The autocovariance function of the process X (¢) at lag 4 is easily found to be

Cov(X(t + h), X(1)) = e**®, h >0,
where
Y= / eMVeeetVdy.
0
Themean and autocovariancefunction of the CARMA(p, ¢) process{Y (¢)} arethere-
fore given by

EY(t)=0
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and
Cov(Y(t + h), Y()) = be?"xh.

Inference for continuous-time ARMA processes is more complicated than for
continuous-time AR(1) processes because higher-order processes are not Marko-
vian, so the simple calculation that led to (10.4.6) must be modified. However, the
likelihood of observations at timesr, ..., #, can till easily be computed using the
discrete-time Kaman recursions (see Jones, 1980).

Continuous-time ARMA processes with thresholds constitute a useful class of
nonlinear time series models. For example, the continuous-time threshold AR(1)
process with threshold at r is defined as a solution of the stochastic differential
equations

dX(t) + a1 X(@t)dt = by dt +01dB(t), X(@)<r,
and
dX(t) + ax X (t)dt = by dt + 0,dB(t), X(t) > r.

For a detailed discussion of such processes, see Stramer, Brockwell, and Tweedie
(1996). Continuous-time threshold ARMA processes are discussed in Brockwell
(1994) and non-Gaussian CARMA(p, ¢) processes in Brockwell (2001). For more
on continuous-time models see Bergstrom (1990) and Harvey (1990).

10.5 Long-Memory Models

The autocorrelation function p(-) of an ARMA process at lag  converges rapidly to
zeroash — oo inthe sense that there existsr > 1 such that

r"p(h) = 0 as h — oo. (10.5.1)

Stationary processes with much more slowly decreasing autocorrelation function,
known as fractionally integrated ARMA processes, or more precisaly as ARIMA
(p,d, q) processeswith O < |d| < 0.5, satisfy difference equations of the form

(1- B)¢(B)X, = 6(B)Z,, (10.5.2)
where ¢ (z) and 6(z) are polynomials of degrees p and ¢, respectively, satisfying
$(2)#0 and 6(z) #0 foral zsuchthat |z] <1,
B isthe backward shift operator, and {Z,} is awhite noise sequence with mean 0 and

variance o'2. The operator (1 — B)? is defined by the binomial expansion

(1- By = anBj,
j=0
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whereny = 1 and

n,-:]’[u, ji=12....

O<k<j k

The autocorrelation p (k) at lag 4 of an ARIMA(p, d, q) processwith0 < |d| < 0.5
has the property

p(Mh*2 — ¢ as h — oo. (10.5.3)

Thisimplies (see (10.5.1)) that p (k) convergesto zero ash — oo at amuch slower
rate than p (k) for an ARMA process. Conseguently, fractionally integrated ARMA
processes are said to have “long memory.” In contrast, stationary processes whose
ACF convergesto O rapidly, such as ARMA processes, are said to have “ short mem-
ory.”

A fractionally integrated ARIMA(p, d, q) process can beregarded asan ARMA
(p, q) process driven by fractionally integrated noise; i.e., we can replace equation
(10.5.2) by the two equations

¢(B)X, = 0(B)W, (10.5.4)
and
(1-B)W, = Z,. (10.5.5)

The process {W,} is called fractionally integrated white noise and can be shown
(see, eg., TSTM, Section 13.2) to have variance and autocorrelations given by

LT -2d)

yw() =0 a—d (10.5.6)
and

ow(h) = Lh+HId—d) I w, h=1,2,..., (10.5.7)

F'th—d+1I'd) k—d

O<k<h

where I'(-) is the gamma function (see Example (d) of Section A.1). The exact
autocovariance function of the ARIMA(p, d, q) process{X,} defined by (10.5.2) can
therefore be expressed, by Proposition 2.2.1, as

yx(h) =D wiyw(h + j — k), (10.5.8)
j=0 k=0

where Y vz’ = 0(2)/¢(2), 1z| < 1, and yw (-) is the autocovariance function of
fractionally integrated white noise with parametersd and o2, i.e.,

yw () = yw(Q)pw(h),

with yy (0) and pw (k) as in (10.5.6) and (10.5.7). The series (10.5.8) converges
rapidly aslong as ¢ (z) does not have zeros with absolute value close to 1.
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Example 10.5.1

The spectral density of {X,} isgiven by

—iA
|9(e—)|2 11— (10.5.9)

Calculation of the exact Gaussian likelihood of observations {x, ..., x,} of afrac-
tionally integrated ARMA processisvery slow and demanding in terms of computer
memory. Instead of estimating the parameters d, ¢1, ..., ¢,, 61, ...,6,, and o2 by
maximizing the exact Gaussian likelihood, itismuch simpler to maximize the Whittle
approximation Ly, defined by

—2|n(LW)_nIn(Zn)+2n|na+a’ZZ ”(“” —|—Z|ng(a)) (10.5.10)

where I, is the periodogram, o2g/(2r)(= f) isthe model spectral density, and > i
denotes the sum over al nonzero Fourier frequencies w; = 2nj/n € (—n, ]. The
program ITSM estimates parametersfor ARIMA(p, d, ¢) modelsin thisway. It can
also be used to predict and simulate fractionaly integrated ARMA series and to
compute the autocovariance function of any specified fractionally integrated ARMA
model.

Annual Minimum Water Levels; NILE.TSM

The data file NILE.TSM consists of the annual minimum water levels of the Nile
river as measured at the Roda gauge near Cairo for the years 622-871. These values
are plotted in Figure 10.11 with the corresponding sample autocorrelations shown in
Figure 10.12. The rather slow decay of the sample autocorrelation function suggests
the possihility of afractionally intergrated model for the mean-corrected series Y, =
X, — 1119.

The ARMA model with minimum (exact) AICC value for the mean-corrected
series {Y,} isfound, using Mode1>Estimation>Autofit, to be

Y, = —.323Y,_; — .060Y,_, + .633Y,_3 + .069Y,_, + .248Y,_5
+Z, + .702Z,_1 + .350Z,_, — .419Z, _3, (10.5.11)

with {Z,} ~ WN(0, 5663.6) and AICC= 2889.9.

To fit a fractionally integrated ARMA model to this series, select the option
Model>Specify, check the box marked Fractionally integrated model, and
click on OK. Then select Model>Estimation>Autofit, and click on Start. This
estimation procedure is relatively slow so the specified ranges for p and ¢ should
be small (the default is from 0O to 2). When models have been fitted for each value
of (p, q), the fractionally integrated model with the smallest modified AIC valueis
found to be

(1 - B)*(1 — .1694B + .9704B%)Y, = (1 — .1800B + .9278B%Z,, (10.5.12)
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Figure 10-11

Annual minimum water
levels of the Nile river
for the years 622-871.

Figure 10-12

The sample correlation
function of the data

in Figure 10.11.
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with{Z,} ~ WN(O0, 5827.4) and modified AlC= 2884.94. (The modified AIC statis-
tic for estimating the parameters of afractionally integrated ARMA(p, g) processis
defined in terms of the Whittle likelihood Ly as —2In Ly +2(p +q + 2) if d is
estimated, and —2InLy +2(p +¢g + 1) otherwise. The Whittlelikelihood was defined
in (10.5.10).)

In order to compare the models (10.5.11) and (10.5.12), the modified AlIC value
for (10.5.11) is found as follows. After fitting the model as described above, select
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Figure 10-13

The minimum annual
Nile river levels for the
years 821-871, with
20 forecasts based on
the model (10.5.12).

Model>Specify, check the box marked Fractionally integrated model, Set
d = 0 and click on 0K. The next step isto choose Model>Estimation>Max like-
lihood, check No optimization and click on OK. You will then see the modified
AlCvalue, 2884.58, displayed intheML. estimates window together with the value
2866.58 of —2InLy,.

The ARMA(5,3) model isdightly better in terms of modified AlC than the frac-
tionally integrated model and its ACF is closer to the sample ACF of the data than
isthe ACF of the fractionally integrated model. (The sample and model autocorrela-
tion functions can be compared by clicking on the third yellow button at the top of
the ITSM window.) The residuals from both models pass all of the ITSM tests for
randomness.

Figure 10.13 shows the graph of {xxup, ..., x250} With predictors of the next 20
values obtained from the model (10.5.12) for the mean-corrected series. O

10.1. Find atransfer function model relating the input and output series X,; and X5,
r=1,...,200, contained in the ITSM datafiles APPJ.TSM and APPK.TSM,
respectively. Use the fitted model to predict X012, X202.2, @nd X503 2. Compare
the predictors and their mean sgquared errors with the corresponding predictors
and mean squared errors obtained by modeling {X,,} as a univariate ARMA
process and with the results of Problem 7.7.
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10.2.

10.3.

10.4.

10.5.

10.6.

Verify the calculations of Example 10.2.1 to fit an intervention model to the
series SB.TSM.

If {X,} isthelinear process (10.3.1) with {Z,} ~ IID (0, ¢2?) and n = EZ?, how
that the third-order cumulant function of {X,} is given by

Ca(r,s) =1 Z Yivisr Vigs.

Usethisresult to establish equation (10.3.4). Concludethat if {X,} isaGaussian
linear process, then Cs(r, s) = 0 and f3(w1, wz) = 0.

Evaluate EZ? for the ARCH(1) process (10.3.10) with 0 < oy < 1 and {e,} ~
[ID N(O, 1). Deduce that EX? < oo if and only if 30 < 1.

Let {Z;} be a causal stationary solution of the ARCH(p) eguations (10.3.6)
and (10.3.7) with EZ? < oo. Assuming that such a process exists, show that
Y, = Z2/a, satisfies the equations

)4
Yt = etz (1 + ZO{i Yti)
i=1
and deducethat {Y,} hasthe sasme autocorrel ation function asthe AR(p) process

)4
W, = Zai Wi +e, {e} ~WN(O,1).

i=1

(Inthecase p = 1, anecessary and sufficient condition for existence of acausal
stationary solution of (10.3.6) and (10.3.7) with EZ} < oo is3a? < 1,asshown
by the results of Section 10.3 and Problem 10.4.)

Suppose that {Z,} is a causal stationary GARCH(p, ¢q) process Z, = /h;e;,
where {e,;} ~11D(0,1), > a; + 3%, B; < 1land

he=ao+oarZfy+ - +ayZl , + Brhia+ -+ Byhiy.

a Show that E(Z2|2% ,,Z? ,,...) = h,.

b. Show that the squared process {Z?} is an ARMA(m, ¢) process satisfying
the equations

ZZ=ag+ (1 + BOZ2 + -+ (A + Bu) Z2,

+ Ut - ,3le—1 -t ﬁqUt—qa

wherem = max{p, ¢},a; = Ofor j > p, g; = Oforj > g,andU, = Z?>—h,
iswhite noiseif EZ? < oo.
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c¢. For p > 1, show that the conditional variance process {#;} isan
ARMA(m, p — 1) process satisfying the equations

hy = ag+ (a1 + ,Bl)htfl + oo+ (ay + IBm)htfm
Vit e Vit Vi,
whereV, = a;*Uyand o} = aj /e for j=1,....p— 1.

10.7. To each of the seven components of the multivariate time series filed as
STOCK7.TSM, fit an ARMA model driven by GARCH noise. Compare the
fitted models for the various series and comment on the differences. (For ex-
porting components of a multivariate time seriesto a univariate project, seethe
ITSM Help topic, Project editor.)

10.8.1f a > 0 and X (0) has mean b/a and variance o?/(2a), show that the pro-
cess defined by (10.4.3) is stationary and evaluate its mean and autocovariance
function.

10.9. a. Fit afractionally integrated ARMA mode to the first 230 tree-ring widths
contained in the file TRINGS . TSM. Use the model to general forecasts and
95% prediction bounds for the last 20 observations (corresponding to 1 =
231, ..., 250) and plot the entire data set with the forecasts and prediction
bounds superposed on the graph of the data.

b. Repeat part (a), but this time fitting an appropriate ARMA model. Compare
the performance of the two sets of predictors.
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Random Variables and
Probability Distributions

A.1 Distribution Functions and Expectation
A.2 Random Vectors
A.3  The Multivariate Normal Distribution

Distribution Functions and Expectation

The distribution function F of arandom variable X is defined by
F(x) = P[X < x] (A.1.1)
for al real x. The following properties are direct consequences of (A.1.1):
1. Fisnondecreasing, i.e, F(x) < F(y)ifx < y.

2. Fisright continuous,i.e., F(y) | F(x)asy | x.
3. F(x) > land F(y) > Oasx — oo and y — —o0, respectively.

Conversely, any function that satisfies properties 1-3 is the distribution function of
some random variable.

Most of the commonly encountered distribution functions F can be expressed
either as

Fx) = / FO)dy (A.12)
or

Fx)y= ) px)), (A.13)

JXj=<x
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where {xo, x1, x2, ...} isafinite or countably infinite set. In the case (A.1.2) we shall
say that therandomvariable X iscontinuous. Thefunction f iscalled the probability
density function (pdf) of X and can be found from the relation

f(x) = F'(x).

In case (A.1.3), the possible values of X are restricted to the set {xg, x1, ...}, and
we shall say that the random variable X is discrete. The function p is caled the
probability mass function (pmf) of X, and F is constant except for upward jumps
of size p(x;) at the points x;. Thus p(x,) isthe size of thejumpin F at x;, i.e,

p(xj) = F(x;) — F(x;) = P[X = x;],
where F(x;) = limy,, F(y).

Examples of Continuous Distributions

(@ The normal distribution with mean . and variance o2. We say that a random
variable X has the normal distribution with mean p and variance ¢ (Written
more concisely as X ~ N(u, 0?)) if X hasthe pdf given by

2 2
n (x; uw, 02) = (2n) V25 le W20 _ 50 < x < 00.

It followsthenthat Z = (X — u)/o ~ N(O, 1) and that
P[ng]=P[z§x_”]=q><x_”>,
o

o

where ® (x) = [foo(Zn)—l/ze‘%zz dz isknown asthe standard normal distribu-
tion function. Thesignificanceof thetermsmean and variancefor the parameters
w and o2 is explained below (see Example A.1.1).

(b) The uniform distribution on [a,b]. The pdf of a random variable uniformly dis-
tributed on theinterval [a, b] is given by

1 .
, ifa<x<b,
ux;a,by=3 b—a

0, otherwise.

(c) The exponential distribution with parameter A. The pdf of an exponentialy dis-
tributed random variable with parameter A > Ois

0, if x <0,
re M ifx > 0.

The corresponding distribution function is

{O, if x <O,
F(x)=

e(x; A) = {

1—e™™, ifx>0.
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(d) Thegammadistributionwith parametersa and A. Thepdf of agamma-distributed
random variableis

0, if x <O,

glx;a,A) =
{ X% ™ /T (), ifx >0,

where the parameters o and A are both positive and I' is the gamma function
defined as

') =/ xte ™ dx.
0

Note that f is the exponential pdf when « = 1 and that when « is a positive
integer

() = (@ — 1)! with O! defined to be 1.

(e) Thechi-squared distributionwith v degrees of freedom. For each positive integer
v, the chi-squared distribution with v degrees of freedom is defined to be the
distribution of the sum

X=Z72+...4+72

where Z,, ..., Z, are independent normally distributed random variables with
mean 0 and variance 1. This distribution is the same as the gamma distribution
with parameterso = v/2 and A = 1.

Examples of Discrete Distributions

(f) The binomial distribution with parameters n and p. The pmf of a binomially
distributed random variable X with parameters» and p is
n . .
b(j;n,p):P[X:j]:<j>p’(1—p)"_/, j=01...,n,
wheren isapositiveinteger and0 < p < L.

(g The uniform distribution on {1,2, ... ,k}. The pmf of a random variable X uni-
formly distributedon {1, 2, ..., k} is

: 41 .
p(j)=P[X=j]= o =1,2...k
where k is a positive integer.
(h) The Poisson distribution with parameter A. A random variable X is said to have
a Poisson distribution with parameter A > 0 if
j

)\‘.
p(j;k)zP[ij]:Fe*, j=0,1,....



372

Appendix A

Random Variables and Probability Distributions

We shall seein Example A.1.2 below that A isthe mean of X.

(i) Thenegativebinomial distributionwith parametersa and p. Therandom variable
X is said to have a negative binomial distribution with parameters « > 0 and
p € [0, 1] if it has pmf

. Lk—1+a A _
nb(j; o, p) = (HT> A-p’p* j=01...,
k=1

where the product isdefined to be 1 if j = 0.

Not all random variables can be neatly categorized as either continuous or dis-
crete. For example, consider the time you spend waiting to be served at a checkout
counter and suppose that the probability of finding no customers ahead of you is %
Then the time you spend waiting for service can be expressed as

0,  with probability %
W = .
W1, with probability >

where Wy is a continuous random variable. If the distribution of W; is exponentia
with parameter 1, then the distribution function of W is

0, ifx <O,
Fx)=31 1 1

—+-(1—e)=1-—=¢", |f .

2—|—2( e ) Ze , Ifx>0

Thisdistribution function is neither continuous (since it has adiscontinuity at x = 0)
nor discrete (sinceit increases continuously for x > 0). It isexpressible asamixture,

with p = 2, of adiscrete distribution function

0, x<0O,
Fy =
1, x>0,
and a continuous distribution function
0, x <0,
F. =
1—-¢*, x=>0.

Every distribution function can in fact be expressed in the form
F = p1Fy+ paoFc + paFg,

where0 < pq, po, p3 < 1, p1+ p2+ p3s = 1, Fyisdiscrete, F; iscontinuous, and Fy
issingular continuous (continuous but not of the form A.1.2). Distribution functions
with asingular continuous component are rarely encountered.
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Example A.1.1

Expectation, Mean, and Variance

The expectation of afunction g of arandom variable X is defined by

E (5(X)) = / (0 dF (x).
where

/ g(x) f(x)dx inthe continuous case,

/g(x)dF(x) =1
> g(x)p(x;)  inthediscrete case,
j=0

and g isany functionsuchthat E|g(x)| < oo. (If Fisthemixture F = p Fe+(1—p) Fy,
then E(g(X)) = p [ g(x) dFe(x) + (1— p) [ g(x) d Fy(x).) Themean and variance
of X aredefinedasu = EX and 02 = E(X — )2, respectively. They are evaluated
by setting g(x) = x and g(x) = (x — u)? in the definition of E(g(X)).

It is clear from the definition that expectation has the linearity property

E@X +b)=aE(X)+b

for any real constantsa and b (provided that E|X| < o0).

The normal distribution
If X hasthenormal distributionwith pdf n (x; i, o) asdefined in Example(a) above,
then

(o]

EX—un = /oo(x — u)n(x; M,(fz) dx = —sz n’(x : /,L,UZ) dx = 0.

o0

This shows, with the help of the linearity property of E, that
E(X) = pu,

i.e., that the parameter . is in fact the mean of the normal distribution defined in
Example (a). Similarly,

E(X — ;,L)Z = /oo(x — ;L)zn(x; ", 02) dx = —c? /oo(x — /L)n/(x; ", 02) dx.

Integrating by parts and using the fact that f is a pdf, we find that the variance of X
is

E(X—/L)zzo*z/ n(x;u,crz) dx = o2 O

—00
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Example A.1.2  The Poisson distribution

The mean of the Poisson distribution with parameter 2 (see Example (h) above) is
given by

Lo 00 1
uzz _ X; 'Wl)l A= rete ™ = i

j=0

A similar calculation showsthat thevarianceisalsoequal to A (seeProblemA.2). O

Remark. Functions and parameters associated with a random variable X will be
label ed with the subscript X whenever it isnecessary toidentify the particular random
variable to which they refer. For example, the distribution function, pdf, mean, and
variance of X will be written as Fx, fx, ux, and o2, respectively, whenever it is
necessary to distinguish them from the corresponding quantities Fy, fy, uy, and o2
associated with a different random variable Y. O

A.2 Random Vectors

Ann-dimensional randomvectorisacolumnvector X = (X4, ..., X,)’ eachof whose
components is a random variable. The distribution function F of X, aso caled the
joint distribution of X, ..., X,, isdefined by

F(x1,...,%,) = P[X1, <x1,..., X, < x,] (A.2.2)
for al real numbersx, ..., x,. This can be expressed in amore compact form as
F(X)=P[X=X], X=(x1...,x),

for all read vectors x = (xi,...,x,). The joint distribution of any subcollection

X, ..., X;, of these random variables can be obtained from F by setting x; = oo in
(A.2D) foral j ¢ {iy, ..., i}. Inparticular, the distributions of X; and (X4, X,)’ are
given by

Fx,(x1) = P[X1 < x1] = F(x1, 00, ..., 00)
and
FXl,X,, (xl’ xn) = P[Xl <x, X, =< xn] = F(.X']_, o0, ..., 00, xn)'

Asin the univariate case, arandom vector with distribution function F is said to be
continuousif F' has adensity function, i.e., if

F(xl,..-,xn)=/ / / SO yn)dyrdyz- - - dy
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The probability density of X isthen found from
0"F(x1,...,%X,)
Axy---0x,

Therandom vector X issaid to be discreteif there exist rea-valued vectors xo, X1, . . .
and a probability mass function p(x;) = P[X = X;] such that

D opxp) =1
j=0

The expectation of afunction g of arandom vector X is defined by

f(-x17~--sxn):

E(g(X))Z/g(X)dF(X):/g(m,.--,xn)dF(xl,-.-,xn),
where

/g(xl,...,xn)dF(xl,...,xn)

/---/g(xl,...,xn)f(xl,...,xn)dxl--~dxn, in the continuous case,

DD 8 X)) P ), in the discrete case,
jl jn
and g isany function such that E|g(X)| < oc.
Therandom variables X, ..., X, aresaid to beindependent if

P[lexl,...,Xnan]:P[lexl]-‘-P[X,,§x,,],

F(xy,...,x,) = Fx,(x1) --- Fx, (x,)

for all real numbers x4, . .., x,. In the continuous and discrete cases, independence
is equivalent to the factorization of the joint density function or probability mass
function into the product of the respective marginal densities or mass functions, i.e.,

O e X)) = fra () - fx, (xn) o
or
POaL. o %0) = Py (30) -+ P, (5. (A23)
For two random vectors X = (Xi,...,X,) andY = (Y,...,Y,) withjoint
density function fx v, the conditional density of Y given X = x is
xyOGy) .
FrxyIx) = ff)(?)y’ if fx(x) >0,

), if fix(x)=0.
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Proposition A.2.1

The conditional expectation of g(Y) given X = x isthen

E@Y)IX =x) = / e W) Fex(YIX) dy.

If X andY areindependent, then fyx (YIX) = fv(y) by (A.2.2), and so the conditional
expectation of g(Y) given X = x is

E(g(IX =X) = E(g(Y)),

which, as expected, does not depend on X. The same ideas hold in the discrete case
with the probability mass function assuming the role of the density function.

Means and Covariances

If E|X;| < oo for each i, then we define the mean or expected value of X =
(X4, ..., X,) to be the column vector

px = EX = (EX4,...,EX,).

Inthe sameway we definethe expected value of any array whose elementsarerandom
variables (e.g., amatrix of random variables) to be the same array with each random
variable replaced by its expected value (if the expectation exists).

fX=Xy,....X,) adY = (Y, ...,Y,) aerandom vectors such that each
X; and Y; has afinite variance, then the covariance matrix of X and Y is defined to
be the matrix

Sxy = Cov(X,Y) = E[(X — EX)(Y — EY)']
= EXXY") = (EX)(EY)'.

The (i, j) element of Xxy isthe covariance Cov(X;,Y;) = E(X,;Y;) — E(X))E(Y;).
Inthe special casewhereY = X, Cov(X, Y) reducesto the covariance matrix of the
random vector X.

Now suppose that Y and X are linearly related through the equation

Y =a+ BX,

where a is an m-dimensional column vector and B isanm x n matrix. Then'Y has
mean

EY =a+ BEX (A.2.9)
and covariance matrix

Svy = BXxx B’ (A.2.5)
(see Problem A.3).

The covariance matrix Xxx of a random vector X is symmetric and nonnegative
definite, i.e., b’Xxxb > 0 for all vectorsb = (b4, ... ,b,)" with real components.
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Proof Sincethe (i, j) element of Zxx isCov(X;, X;) =Cov(X;, X,), itisclear that Txx is

symmetric. To prove nonnegative definiteness, let b = (b4, ..., b,)’ be an arbitrary
vector. Then applying (A.2.5) witha = 0and B = b, we have
b'Tyxb = Var(b’X) = Var(b1 X1+ --- + b,X,) > 0. [ |

Proposition A.2.2  Everyn x n covariance matrix ¥ can be factorized as
¥ = PAP

where P isan orthogonal matrix (i.e., P’ = P~') whose columns are an orthonormal
set of right eigenvectors corresponding to the (nonnegative) eigenvalues A4, ..., A,
of X, and A isthe diagonal matrix

M 0 .. 0
0 A --- 0
A= . . )
0 0 --- A,

In particular, ¥ isnonsingular if and only if all the eigenvalues are strictly positive.

Proof Every covariance matrix is symmetric and nonnegative definite by Proposition A.2.1,
and for such matrices the specified factorization is a standard result (see Grayhill,
1983 for a proof). The determinant of an orthogonal matrix is 1, so that det(X) =
det(P) det(A) det(P) = Ay - - - A,,. Itfollowsthat T isnonsingular if andonlyif A; > 0
for al i. |

Remark. Given acovariance matrix ¥, it is sometimes useful to be able to find a
square root A = %2 with the property that AA’ = X. It is clear from Proposition
A.2.2 and the orthogonality of P that one such matrix is given by

A=3xY2=ppat?p.
If X isnonsingular, then we can define
¥ = PA'P, —oco<s < 00.

The matrix %2 defined inthisway isthen asguareroot of ¥~ and also theinverse
of £1/2, O

A.3 The Multivariate Normal Distribution

The multivariate normal distribution is one of the most commonly encountered and
important distributions in statistics. It plays akey rolein the modeling of time series
data. Let X = (X4, ..., X,,)’ bearandom vector.
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Definition A.3.1

X hasamultivariate normal distribution with mean . and nonsingular covari-
ance matrix ¥ = Xxx, writtenas X ~ N(u, 2), if

ﬂ00=(&ﬂ%p@ﬁzyiqap{—%@—WUT_%X—Mﬁ.

If X ~ N(u, X), we can define a standardized random vector Z by applying the
linear transformation

Z=3x2X - p), (A.3.1)

where Y2 isdefined asin the remark of Section A.2. Then by (A.2.4) and (A.2.5),
Z hasmean 0 and covariance matrix X;; = X~ Y2222 = [, where I, isthen x n
identity matrix. Using the change of variables formulafor probability densities (see
Mood, Graybill, and Boes, 1974), we find that the probability density of Z is

f2(2) = (det ©)"? fx (2?2 + p)

= (det ©)"?(2r)"/*(det £) * exp {_%(2—1/22)/2—12—1/22}
1

— —n/2 R

= (27) eXp{ 52 z}

= ((271)1/2 exp{ - %zi}) e ((27T)1/2 @<p{ - %Zf}) ,

showing, by (A.2.2),that Z,, ..., Z, areindependent N(0O, 1) random variables. Thus
the standardized random vector Z defined by (A.3.1) hasindependent standard normal
random components. Conversely, given any n x 1 mean vector p, anonsingular n x n
covariancematrix X, and ann x 1 vector of standard normal random variables, wecan
construct a normally distributed random vector with mean p and covariance matrix
> by defining

X =XY2Z 4+ p. (A.3.2
(See Problem A.4.)

Remark 1. Themultivariatenormal distributionwith mean . and covariance matrix
> canbedefined, evenwhen T issingul ar, asthedistribution of thevector X in(A.3.2).
Thesingular multivariate normal distribution does not have ajoint density, since
the possiblevalues of X — p are constrained to liein asubspace of R” with dimension
equal to rank(X). O
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Remark 2. If X ~N(u, X), Bisanm x n matrix, andaisareal m x 1 vector, then
the random vector

Y =a+ BX
isalso multivariate normal (see Problem A.5). Notethat from (A.2.4) and (A.2.5), Y
has mean a + B and covariance matrix BX B’. In particular, by taking B to be the
row vector b’ = (by, ..., b,), we see that any linear combination of the components
of amultivariate normal random vector isnormal. Thusb’X = b1 X1+ ---+ b, X, ~
N(b'px, b Exxb). a
Example A.3.1  The bivariate normal distribution

Suppose that X = (X, X,)' is a bivariate normal random vector with mean pu =
(u1, (2) and covariance matrix

2
5 [ o; ,0(71(72:|’ 0>00,>0 —1<p<1 (A.3.3)

2
pPO102 o,

The parameters o1, 05, and p are the standard deviations and correlation of the com-
ponents X; and X,. Every nonsingular 2-dimensional covariance matrix can be ex-
pressed in the form (A.3.3). Theinverseof T is

-2 -1 -1
_ -1 o —po; o
(1= p?) [ o oo ]

—poy 0y g

and so the pdf of X isgiven by

fx(X) = (2710102 (1- 02)1/2)71
-1 x1— )\
Xexp{z(l_pZ) |:( o1 )
_2p (xl—m) (Xz—uz)Jr(xZ—uz)z”_ -
(X} (op] (op)

Multivariate normal random vectors have the important property that the condi-
tional distribution of any set of components, given any other set, isagain multivariate
normal. In the following proposition we shall suppose that the nonsingular normal
random vector X is partitioned into two subvectors

X®
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Proposition A.3.1

Example A.3.2

Definition A.3.2

Correspondingly, we shall write the mean and covariance matrix of X as

@
I X X
= and E == )
H |:H(2) :| |: Yo X :|

where u® = EX® and 5, = E (X — p®) (X0 — Y

i. X® and X@ areindependent if and only if £, = 0.
ii. The conditional distribution of X given X@ = x@ isN(u® + 2,55, (x@ —
p®), 21 — T35, ). In particular,

E(X®IX® = x@) = u® 4 5,51 (x@ — @),

The proof of this proposition involves routine algebraic manipulations of the
multivariate normal density function and is left as an exercise (see Problem A.6).

For the bivariate normal random vector X in Example A.3.1, weimmediately deduce
from Proposition A.3.1 that X; and X, are independent if and only if po10, = 0 (or
o = 0, since o; and o, are both positive). The conditional distribution of X; given
X, = x, isnormal with mean

E(X1|X2 = x2) = 1 + po105 (X2 — 112)
and variance

Var(X1|X2:X2):Gl2 (1—,02). O

{X,} is a Gaussian time series if all of its joint distributions are multivari-
ate normal, i.e., if for any collection of integers iy, ..., i,, the random vector
(Xi,, ..., X;) hasamultivariate normal distribution.

i1y -

Remark 3. If {X,} isa Gaussian time series, then al of its joint distributions are
completely determined by the mean function (1) = E X, and the autocovariance
function « (s, 1) = Cov(X,, X,). If the process aso happens to be stationary, then
the mean function is constant (u, = w foral r) and « (r + h, t) = y(h) for al z. In
this case, the joint distribution of X, ..., X, isthesame asthat of X1, ..., X,
for al integers h and n > 0. Hence for a Gaussian time series strict stationarity is
equivalent to weak stationarity (see Section 2.1). O
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Problems

Al

A2

A3

A4

A.5.

A.6.
A.T.

A8.

A.9.

Let X have a negative binomial distribution with parameters « and p, where
a>0and0<p <l

a Show that the probability generating function of X (defined as M(s) =
E(s¥))is

M(s)=p*QA—-s+sp)™®, 0=<s=<L1l

b. Using the property that M'(1) = E(X) and M"(1) = E(X?) — E(X), show
that

EX)=a(l-p)/p and Var(X)=a(l- p)/p>
If X has the Poisson distribution with mean A, show that the variance of X is
also A.

Use the linearity of the expectation operator for real-valued random variables
to establish (A.2.4) and (A.2.5).

If ¥ isann x n covariance matrix, £/ isthe square root of ¥ defined in the
remark of Section A.2, and Z isan n-vector whose components are independent
normal random variables with mean 0 and variance 1, show that

X=3Y2Z+p
isanormally distributed random vector with mean p and covariance matrix .

Show that if X isan n-dimensional random vector such that X ~ N(u, £), B
isarea m x n matrix, and a is area-valued m-vector, then

Y =a+ BX

isamultivariate normal random vector. Specify the mean and covariance matrix
of Y.

Prove Proposition A.3.1.

Suppose that X = (X4,..., X))’ ~ N(O, X) with £ nonsingular. Using the
factthat Z, asdefined in (A.3.1), hasindependent standard normal components,
show that (X — )’ ==X — p) hasthe chi-squared distribution with » degrees
of freedom (Section A.1, Example (€)).

Suppose that X = (X4,...,X,)" ~ N(u, ) with £ nonsingular. If A isa
symmetric n x n matrix, show that £(X'AX) = trace(AX) + u/'Zpu.

Supposethat {X,} isastationary Gaussian time series with mean 0 and autoco-
variance function y (k). Find E(X,|X,) and Var(X,|X,), s # t.
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Statistical Complements

B.1 Least Squares Estimation

B.2 Maximum Likelihood Estimation
B.3 Confidence Intervals

B.4 Hypothesis Testing

B.1 Least Squares Estimation

Consider the problem of finding the “best” straight line
y =6+ 01x

to approximate observations yy, . . . , y, of adependent variable y taken at fixed values
X1, ..., x, of theindependent variable x. The (ordinary) least squar es estimatesfy,
0, are defined to be values of 6, 01 that minimize the sum

S(0o, 01) = Y _(yi — o — O1xi)°
i=1

of squared deviations of the observations y; from the fitted values 6 + 61x;. (The
“sum of squares’ S(6, 61) isidentical to the Euclidean squared distance between y
and 691 + 91X, i.e.,

S(0o, 01) = lly — 61 — 61|12,

wherex = (x1,...,x,),1=(@,..., ) ,andy = (y1, ..., y,)".) Setting the partial
derivatives of S with respect to 6, and 6; both equal to zero shows that the vector
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Example B.1.1

6 = (bo, H1) satisfies the “normal equations”
X'X0 = X'y,

where X isthen x 2matrix X = [1, x]. Since0 < S(6) and §(0) — coas 8] — oo,
the normal equations have at least one solution. If 8 and 8@ are two solutions of
the normal equations, then a simple calculation shows that

(g)m _ 9<2>)' X'x (@(b _ @@) _o

i.e, that X0© = X6@. The solution of the normal equationsisuniqueif and only if
the matrix X’X isnonsingular. But the preceding cal culations show that even if X'X
is singular, the vector § = X8 of fitted values is the same for any solution 8 of the
normal equations.

The argument just given applies equally well to least squares estimation for the
general linear model. Given a set of data points

(Xi1, Xi2, -« o s Xim» Vi) i=1...,nwithm <n,

the least squares estimate, @ = (01, . .., 6,) of 8 = (@, ..., 6,) minimizes

SO) =Y (i — Orxis — -+ — Ouxi)? = |y — 0xP — o — 6, x" |,
i=1
wherey = (y1, ..., ) and x¥ = (x4, ..., x,), j = 1,..., m. Asin the previous
special case, 0 satisfies the equations
X'X0 = Xy,
where X isthe n x m matrix X = [x®, ..., x"™]. The solution of this equation is

uniqueif and only if X’X nonsingular, in which case
0= (X'X)"1Xy.

If XX issingular, there areinfinitely many solutions 6, but the vector of fitted values
X6 isthe samefor all of them.

To illustrate the general case, let usfit a quadratic function
y =6+ 01x + Oox2

to the data

o =
w N
1 W
o A~
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The matrix X for thisproblemis

10 0

11 1 1 [ 124 -108 20
X=|12 4 ,giving(X/X)‘1:m|:—108 174 —40]

13 9 20 —-40 10

1 4 16

The least squares estimate 6 = (6o, 61, 6)' is therefore unique and given by

A 0.6
0=XX)Xxy=|-01].

0.5
The vector of fitted valuesis given by
¥ =X60=(0.612448,82)
as compared with the observed values
y=1(1,0,358). O

B.1.1 The Gauss—Markov Theorem

Suppose now that the observations yy, . . ., y, arerealized values of random variables
Y1,...,Y, sdtisfying

Y = O01xin + - + OpXin + Z;,

where Z; ~ WN (0,02). LettingY = (Yy,...,Y,) andZ = (Zy,..., Z,)', wecan
write these equations as

Y=X0+7Z.

Assume for simplicity that the matrix X’X is nonsingular (for the general case see,
e.g., Silvey, 1975). Then the least squares estimator of 0 is, as above,

0= (X'X)x,
and the least squares estimator of the parameter o2 is the unbiased estimator

5= 2|y - x8|*
n—m
Itiseasy to seethat 6 is also unbiased, i.e., that
E(6) =6.

It follows at once that if ¢'@ is any linear combination of the parameters 6;, i =
1,...,m,then ¢'0 is an unbiased estimator of ¢'0. The Gauss-Markov theorem says
that of all unbiased estimators of ¢'@ of theform }";_, a;Y;, the estimator ¢’ 0 hasthe
smallest variance.
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Inthespecial casewhere Z;, ... ., Z, arellD N(0, o%), theleast squares estimator
6 has the distribution N(6, 02(X'X)™"), and (n — m)62/0? has the x? distribution
with n — m degrees of freedom.

B.1.2 Generalized Least Squares

The Gauss-Markov theorem depends on the assumption that the errors Z4, ..., Z,
are uncorrelated with constant variance. If, on the other hand, Z = (Z4, ..., Z,)
has mean 0 and nonsingular covariance matrix o?% where © # I, we consider the
transformed observation vector U = R~'Y, where R is a nonsingular matrix such
that RR' = X. Then

U=RX0+W =M0+W,

where M = R~1X and W hasmean 0 and covariance matrix o-21. The Gauss-Markov
theorem now implies that the best linear estimate of any linear combination c'6 is
c'6, where 0 isthe generalized least squares estimator, which minimizes

U — M6

Inthe special casewhere Z, . . ., Z, areuncorrelated and Z; hasmean 0 and variance
o2r?, the generalized least squares estimator minimizes the weighted sum of squares

n 1 2
Y S =ik — - = O’
i—1 i
Inthe genera case, if X’X and X are both nonsingular, the generalized least squares
estimator is given by

0= (M M)"M'U.

Although the least squares estimator (X’X)~1X'Y is unbiased if E(Z) = 0, even
when the covariance matrix of Z isnot equal to o21, the variance of the correspond-
ing estimate of any linear combination of 64, ..., 6,, is greater than or equal to the
estimator based on the generalized least squares estimator.

B.2 Maximum Likelihood Estimation

The method of least squares has an appealing intuitive interpretation. Its application
depends on knowledge only of the means and covariances of the observations. Max-
imum likelihood estimation depends on the assumption of a particular distributional
form for the observations, known apart from the values of parametersé, ..., 6,,. We
can regard the estimation problem as that of selecting the most appropriate value of
aparameter vector 6, taking valuesin asubset ® of R™. We suppose that these distri-
butions have probability densities p(x; 8), 8 € ®. For afixed vector of observations
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Example B.2.1

X, the function L(0) = p(x;0)on ® is caled the likelihood function. A maximum
likelihood estimate 6(x) of @ isavalue of 8 € © that maximizes the value of L(0)
for the given observed value x, i.e.,

L(é) = p(x; f9(x)) = TE%( p(X; 0).

If X = (x1,...,x,) isavector of observations of independent N(i, o) random
variables, the likelihood function is

1 1 &
2\ __ 2
L(M,U)—W@(p[—ﬁiil()ﬁ—ﬂ)}, 0 < U <00, o> 0.
Maximization of L with respect to  and o is equivalent to minimization of
1 n
2\ __ 2
—2InL (u,0%) =nlIn@2r) + 2nln(o) + = i§=1(x,» — >

Setting the partial derivatives of —21n L with respect to © and o both equal to zero
gives the maximum likelihood estimates

lll
p=x==>"x ad 6= (-0 O
ni=3

B.2.1 Properties of Maximum Likelihood Estimators

The Gauss-Markov theorem lent support to the use of least squares estimation by
showing its property of minimum variance among unbiased linear estimators. Maxi-
mum likelihood estimatorsare not generally unbiased, but in particular casesthey can
be shown to have small mean squared error relative to other competing estimators.
Their main justification, however, liesin their good large-sample behavior.

For independent and identically distributed observations with true probability
density p(-; 8p) satisfying certain regularity conditions, it can be shown that the
maximum likelihood estimator & of 6, converges in probability to 8, and that the
distribution of /n (@ — 6y) is approximately normal with mean O and covariance
matrix 1 (6)~1, where I () is Fisher’sinformation matrix with (i, j) component

E dlnp(X;0)0dlnp(X; 0)
o 36; 36, '

In time series analysis the situation is rather more complicated than in the case
of iid observations. “Likelihood” in the time series context is ailmost always used in
the sense of Gaussian likelihood, i.e., the likelihood computed under the (possibly
false) assumption that the series is Gaussian. Nevertheless, estimators of ARMA
coefficients computed by maximization of the Gaussian likelihood have good large-
sampl e propertiesanal ogousto those described inthe preceding paragraph. For details
see TSTM, Section 10.8.
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B.3 Confidence Intervals

Example B.3.1

Estimation of aparameter or parameter vector by |east squaresor maximum likelihood
leads to a particular value, often referred to as a point estimate. It is clear that this
will rarely be exactly equal to the true value, and so it is important to convey some
idea of the probable accuracy of the estimator. This can be done using the notion of
confidence interval, which specifies a random set covering the true parameter value
with some specified (high) probability.

If X = (X1, ..., X,) isavector of independent N (1, o?) random variables, we saw
in Section B.2 that the random variable X, = 2 " | X; isthe maximum likelihood
estimator of w. Thisisapoint estimator of . To construct a confidence interval for
w from X,,, we observe that the random variable

Yn — M
S/\/n

has Student’s ¢-distribution with » — 1 degrees og freedom, where S is the sample
standard deviation, i.e, $2 = -1 > | (X; — X,,)". Hence,

Yn_:u“
Pl—t o< —— <tiqo =1—Ol,
|: 1-a/2 S/ﬁ 1 /2:|

where r,_,,» denotes the (1 — «/2) quantile of the ¢-distribution with n — 1 degrees
of freedom. This probability statement can be expressed in the form

Pl X, —tiapS/Vn<p<X,+tapS/Vn]=1-a,

which shows that the random interval bounded by X, +,_,/»S/+/n includesthe true
value . with probability 1 — «. Thisinterval iscalled a (1 — «) confidence interval
for the mean w. O

B.3.1 Large-Sample Confidence Regions

Many estimators of a vector-valued parameter 6 are approximately normaly dis-
tributed when the sample size n is large. For example, under mild regularity condi-
tions, theAmaximum likelihood estimator 8(X) of 8 = (64, ..., 6,,) isapproximately
N(O, 21(6)~?), where 1(8) is the Fisher information defined in Section B.2. Conse-
quently,

n(6—6)1(6)(6—0)
is approximately distributed as x 2 with m degrees of freedom, and the random set of
6-values defined by

n(6—80)1(8)(6—8) < x2,(m)
coversthe true value of 6 with probability approximately equal to 1 — «.
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Example B.3.2  For iid observations X, ..., X, from N(u, 0?), astraightforward calculation gives,
for @ = (M, 02),,

-2
=% 5]

Thus we obtain the large-sample confidence region for (, o),

n(n—X,)° /62 +n(0® — 627/ (26%) < x2.(2),

which coversthe true value of @ with probability approximately equal to 1 — «. This
region is an ellipse centered at (X, 62). O

B.4 Hypothesis Testing

Example B.4.1

Parameter estimation can be regarded as choosing one from infinitely many possible
decisionsregarding the value of aparameter vector 6. Hypothesi stesting, onthe other
hand, involves a choice between two alternative hypotheses, a“null” hypothesis Hy
and an “alternative” hypothesisH,, regarding the parameter vector 8. The hypotheses
Ho and H; correspond to subsets ® and ®; of the parameter set ®. The problem
is to decide, on the basis of an observed data vector X, whether or not we should
reject the null hypothesis Hy. A statistical test of Hy can therefore be regarded as a
partition of the sample space into one set of values of X for which we reject Hy and
another for which we do not. The problem is to specify atest (i.e., a subset of the
sampl e space called the“ rejection region”) for which the corresponding decision rule
performs well in practice.

If X = (X4,...,X,) isavector of independent N(u, 1) random variables, we may
wish to test the null hypothesis Ho: © = O against the alternative Hy: n # 0. A
plausible choice of rejection region in this case isthe set of all samples X for which
|X,| > ¢ for some suitably chosen constant c. We shall return to this example after
considering those factorsthat should be taken into account in the systematic selection
of a“good” rejection region. O

B.4.1 Error Probabilities

There are two types of error that may be incurred in the application of a statistical
test:

e typel error istheregjection of Hy when it istrue.
e typell error isthe acceptance of Hp when it isfalse.
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For a given test (i.e., for a given regjection region R), the probabilities of error can
both be found from the power function of the test, defined as

Py(R), 0€0,

where P, isthedistribution of X when thetrue parameter valueis . The probabilities
of atypel error are

06(0) = Pg(R), 0c @o,
and the probabilities of atypell error are
ﬂ(e):]-_PG(R), 06@1.

Itisnot generally possibleto find atest that simultaneously minimizes« () and 8(0)
for al values of their arguments. Instead, therefore, we seek to limit the probability
of type | error and then, subject to this constraint, to minimize the probability of type
Il error uniformly on ®;. Given a significance level «, an optimum level-« testisa
test satisfying

a(@) <a, fordl e ©,

that minimizes 8(0) for every & € ©;. Such atest is caled a uniformly most
powerful (U.M.P.) test of level a. The quantity supy., «(8) iscalled the size of the
test.

Inthe special case of asimple hypothesisvs. asimple hypothesis, e.g., Hp: 8 = 6,
vs. Hi: 6 = 61, anoptimal test based onthelikelihood rati o stati stic can be constructed
(see Silvey, 1975). Unfortunately, it is usually not possible to find a uniformly most
powerful test of asimple hypothesis against a composite (more than one value of 6)
alternative. This problem can sometimes be solved by searching for uniformly most
powerful tests within the smaller classes of unbiased or invariant tests. For further
information see Lehmann (1986).

B.4.2 Large-Sample Tests Based on Confidence Regions

Thereisanatural link between the testing of asimple hypothesisHy: 6 = 6, vs. Hy:
6 +# 6, and the construction of confidenceregions. To illustrate this connection, sup-
posethat 6 isan estimator of @ whose distribution is approximately N(6,n"*17%(8)),
where I (0) isapositive definite matrix. Thisisusually the case, for example, when 6
isamaximum likelihood estimator and I (@) isthe Fisher information. Asin Section
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B.3.1, we have
Py(n(8—8)1(6)(6 —6) < x2 ,(m) ~1—a.
Consequently, an approximate «-level test isto reject Hy if
n(60—6)'1(8) (60— 8) > xi_,(m),
or equivalently, if the confidence region determined by those 6's satisfying
n(0—6)'1(6)(6 —6) < x2,(m)
does not include 6,.
Example B.4.2  Consider again the problem described in Example B.4.1. Since X, ~N(u, n™?), the
hypothesisHo: 1 = O isregjected at level « if
n (%) > K
or equivalently, if

— b,
| X, | > nll/‘);/z.
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Mean Square Convergence

C.1 The Cauchy Criterion

The segquence S, of random variablesissaid to convergein mean squareto therandom
variable S if

E(S,—5)?— 0 asn — oo.

In particular, we say that thesum )"/ _, X converges (in mean square) if there exists
arandom variable S such that E( e Xk — S)2 — 0 asn — oo. If thisisthe case,
then we use the notation S = > "~ | X;.

C.1 The Cauchy Criterion

Example C.1.1

For a given sequence S, of random variables to converge in mean sguare to some
random variable, it is necessary and sufficient that

E(S,, —S,)?>— 0 asm,n — o0

(for aproof of thissee TSTM, Chapter 2). The point of the criterion isthat it permits
checking for mean square convergence without having to identify the limit of the
sequence.

Consider the sequence of partial sums S, =Y  a,Z,,n=1,2,...,where{Z,} ~

t=—n

WN (0, '2). Under what conditions on the coefficientsa; doesthis sequence converge
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in mean square? To answer this question we apply the Cauchy criterion as follows.
Forn > m > 0,
2
ES,—S.)?=E ( > a,»Z,») =0 Y d’.
m<|i|<n m<l|i|<n
Consequently, E(S, — S,)> — Oif and only if 3", _, _, a? — 0. Since the Cauchy
criterion applies aso to real-valued sequences, this last condition is equivalent to
convergence of the sequence >"_  a?, or equivalently to the condition
Z a2 < 0 O
Properties of Mean Square Convergence:
If X, > XandY, — Y,inmean squareasn — oo, then
@ E(X?) — E(X?),
(b) E(X,) — E(X),
and
(© E(X,Y,) — E(XY).
Proof See TSTM, Proposition 2.1.2. [ |



An ITSM Tutorial

D.1 Getting Started

D.2 Preparing Your Data for Modeling
D.3  Finding a Model for Your Data
D.4 Testing Your Model

D.5 Prediction

D.6  Model Properties

D.7 Multivariate Time Series

The package 1TSM2000, the student version of which is included with this book,
requires an IBM-compatible PC operating under Windows 95, NT, version 4.0 or a
later version of either of these operating systems. To install the package, copy the
folder ITSM2000 from the CD-ROM to any convenient location on your hard disk.
To run the program, you can either double-click on theicon ITSM.EXE in the folder
ITSM2000 or, on the Windows task bar, left-click on Start, select Run, enter the
location and name of thefile ITSM.EXE (e.g. C:\ITSM2000\I TSM.EXE) and click
on OK. You may find it convenient to create a shortcut on your desktop by right-
clicking on the ITSM.EXE icon and selecting Create shortcut. Then right-click
on the shortcut icon, drag it to your desktop, and select Move here. The program
can then be run at any time by double-clicking on the shortcut icon. The program
can aso be run directly from the CD-ROM by opening the folder ITSM2000 and
double-clicking on the icon ITSM.EXE. The package | TSM2000 supersedes earlier
versions of the package ITSM distributed with this book.
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D.1

Getting Started

D.1.1 Running ITSM

Double-click on the icon labeled ITSM.EXE, and the ITSM window will open. Se-
lecting the option Help>Contents will show you the topics for which explanations
and examples are provided. Clicking on Index at the top of the Help window will
allow you to find more specific topics. Close the Help window by clicking on the
X at its top right corner. To begin analyzing one of the data sets provided, select
File>Project>0pen a thetop left corner of the ITSM window.

There are several distinct functions of the program ITSM. Thefirst isto analyze
and display the properties of time seriesdata, the second isto compute and display the
properties of time series models, and the third isto combine these functions in order
to fit models to data. The last of these includes checking that the properties of the
fitted model match those of the datain a suitable sense. Having found an appropriate
model, we can (for example) then useit in conjunction with the datato forecast future
values of the series. Sections D.2-D.5 of this appendix deal with the modeling and
analysis of data, while Section D.6 is concerned with model properties. Section D.7
explains how to open multivariate projects in ITSM. Examples of the anaysis of
multivariate time series are given in Chapter 7.

Itisimportant to keep in mind the distinction between dataand model properties
and not to confuse the data with the model. In any one project ITSM stores one data
set and one model (which can be identified by highlighting the project window and
pressing thered INFO button at thetop of thel TSM window). Until amodel isentered
by the user, ITSM stores the default model of white noise with variance 1. If the data
are transformed (e.g., differenced and mean-corrected), then the data are replaced
in ITSM by the transformed data. (The original data can, however, be restored by
inverting the transformations.) Rarely (if ever) is a rea time series generated by a
model as simple as those used for fitting purposes. In model fitting the objectiveisto
develop amodel that mimicsimportant features of the data, but is still simple enough
to be used with relative ease.

The following sections constitute a tutorial that illustrates the use of some of
the features of ITSM by leading you through a complete analysis of the well-known
airline passenger series of Box and Jenkins (1976) filed as AIRPASS.TSM in the
ITSM2000 folder.

D.2 Preparing Your Data for Modeling

The observed values of your time series should be availablein asingle-column ASCI|

file (or two columnsfor abivariate series). Thefile, likethose provided with the pack-
age, should be given aname with suffix .TSM. You can then begin mode fitting with
ITSM. The program will read your data from thefile, plot it on the screen, compute
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sample statistics, and alow you to make a number of transformations designed to
make your transformed data representable as a realization of a zero-mean stationary
process.

To illustrate the analysis we shall use the file AIRPASS.TSM, which contains the
number of international airline passengers (in thousands) for each month from Jan-
uary, 1949, through December, 1960. O

D.2.1 Entering Data

Once you have opened the ITSM window as described above under Getting Started,
select the options File>Project>0pen, and you will see adialog box in which you
can check either Univariate or Multivariate. Since the data set for this example
is univariate, make sure that the univariate option is checked and then click OK.
A window labeled Open File will then appear, in which you can either type the
name AIRPASS.TSM and click Open, or else locate the icon for AIRPASS. TSM
in the Open File window and double-click on it. You will then see a graph of the
monthly international airline passenger totals (measured in thousands) X3, ..., X,,
with n = 144. Directly behind the graph is a window containing data summary
statistics.

Anadditional, second, project can be opened by repeating the procedure described
in the preceding paragraph. Alternatively, the data can be replaced in the current
project using the option File>Import File. This option is useful if you wish to
examine how well afitted model representsadifferent dataset. (Seetheentry Project
Editorinthel TSM HelpFilesfor information on multiple project management. Each
ITSM project has its own data set and model.) For the purpose of this introduction
we shall open only one project.

D.2.2 Information

If, with the window labeled AIRPASS.TSM highlighted, you press the red INFO
button at thetop of the TSM window, you will seethe sample mean, samplevariance,
estimated standard deviation of the sample mean, and the current model (white noise
with variance 1).

Go through the steps in Entering Data to open the project AIRPASS.TSM and use
the INFO button to determine the sample mean and variance of the series. O

D.2.3 Filing Data

You may wish to transform your datausing I TSM and then store it in another file. At
any time before or after transforming the datain 1TSM, the data can be exported to a
fileby clicking onthered Export button, selecting Time Series andFile, clicking



398

Appendix D

An ITSM Tutorial

Example D.2.3.

Example D.2.4

Example D.2.5.

0K, and specifying a new file name. The numerical values of the series can aso be
pasted to the clipboard (and from there into another document) in the same way by
choosing Clipboard instead of File. Other quantities computed by the program
(e.g., the residuals from the current model) can be filed or pasted to the clipboard in
the same way by making the appropriate selection in the Export dialog box. Graphs
can a'so be pasted to the clipboard by right-clicking on them and selecting Copy to
Clipboard.

Copy the series AIRPASS.TSM to the clipboard, open Wordpad or some convenient
screen editor, and choose Edit>Paste to insert the series into your new document.
Then copy the graph of the series to the clipboard and insert it into your document
in the same way.

D.2.4 Plotting Data

A time series graph is automatically plotted when you open a data file (with time
measured in units of the interval between observations, i.e.,r = 1,2,3,...). Tosee
a histogram of the data press the rightmost yellow button at the top of the ITSM
screen. If you wish to adjust the number of bins in the histogram, select Statis-
tics>Histogram>Set Bin Count and specify the number of bins required. The
histogram will then be replotted accordingly.

To insert any of the ITSM graphs into a text document, right-click on the graph
concerned, select Copy to Clipboard, andthegraphwill becopiedtotheclipboard.
It can then be pasted into adocument opened by any standard text editor suchasMS-
Word or Wordpad using the Edit>Paste option in the screen editor. The graph can
also be sent directly to a printer by right-clicking on the graph and selecting Print.
Another useful graphics feature is provided by the white Zoom buttons at the top of
the ITSM screen. The first and second of these enable you to enlarge a designated
segment or box, respectively, of any of the graphs. The third button restores the
origina graph.

Continuing with our analysis of AIRPASS.TSM, press the yellow histogram but-
ton to see a histogram of the data. Replot the histogram with 20 bins by selecting
Statistics>Histogram>Set Bin Count. O

D.2.5 Transforming Data

Transformationsareapplied in order to produce datathat can be successfully modeled
as “stationary time series” In particular, they are used to eliminate trend and cyclic
components and to achieve approximate constancy of level and variability with time.

The airline passenger data (see Figure 9.4) are clearly not stationary. The level and
variability bothincreasewithtime, and there appearsto bealarge seasonal component
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(with period 12). They must therefore be transformed in order to be represented as
a realization of a stationary time series using one or more of the transformations
available for this purpose in ITSM. O

Box—Cox Transformations

Box—Cox transformations are performed by selecting Transform>Box-Cox and
specifying the value of the Box—Cox parameter A. If the original observations are
Y1, Yo, ..., Y,, the Box—Cox transformation f, convertsthemto f, (Y1), fo(Yo), ...,
fA(Yn): where

-1
fi(y) = A
log(y), 1=0.

) }"_+L09

These transformations are useful when the variability of the data increases or
decreases with the level. By suitable choice of 2, the variability can often be made
nearly constant. In particular, for positive data whose standard deviation increases
linearly with level, the variability can be stabilized by choosing A = 0.

The choice of A can be made visually by watching the graph of the data when
you click on the pointer in the Box—Cox dialog box and drag it back and forth along
the scale, which runs from zero to 1.5. Very often it is found that no transformation
is needed or that the choice & = 0 is satisfactory.

For the series AIRPASS.TSM, the variability increases with level, and the data are
strictly positive. Taking natural logarithms (i.e., choosing a Box—Cox transformation
with A = 0) gives the transformed data shown in Figure D.1.

Notice how the amplitude of the fluctuations no longer increases with the level of
the data. However, the seasonal effect remains, as does the upward trend. These will
be removed shortly. The data stored in ITSM now consist of the natural logarithms
of the original data. O

Classical Decompositon

There are two methods provided in ITSM for the elimination of trend and seasonality.
These are:

i. “classical decomposition” of the seriesinto atrend component, a seasona com-
ponent, and a random residual component, and
ii. differencing.
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Figure D-1

The series AIRPASS.TSM

after taking logs.
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6.5

55
T

5.0
T

1 1 1 1 1 1 1 1 1 1 1 1 1
1949 1951 1953 1955 1957 1959 1961

Classical decomposition of the series {X,} is based on the model
Xi=m; +s+Y,

where X, is the observation at time ¢, m, is a “trend component,” s, is a “seasonal
component,” and Y, is a“random noise component,” which is stationary with mean
zero. The objective is to estimate the components m, and s, and subtract them from
the data to generate a sequence of residuals (or estimated noise) that can then be
modeled as a stationary time series.

To achieve this, select Transform>Classical and you will see the Classica
Decomposition dialog box. To remove a seasonal component and trend, check the
Seasonal Fit and Polynomial Fit boxes, enter the period of the seasona com-
ponent, and choose between the alternatives Quadratic Trend andLinear Trend.
Click 0K, and thetrend and seasonal componentswill be estimated and removed from
the data, leaving the estimated noise sequence stored as the current data set.

The estimated noise sequence automatically replaces the previous data stored in
ITSM.

The logged airline passenger data have an apparent seasonal component of period
12 (corresponding to the month of the year) and an approximately quadratic trend.
Remove these using the option Transform>Classical as described above. (An
alternative approach isto use the option Regression, which allows the specification
and fitting of polynomials of degree up to 10 and alinear combination of up to 4 sine
waves.)

Figure D.2 shows the transformed data (or residuals) Y;, obtained by removal
of trend and seasonality from the logged AIRPASS.TSM series by classical decom-
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Figure D-2

The logged AIRPASS.TSM
series after removal of trend
and seasonal components
by classical decomposition.
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position. {Y,} shows no obvious deviations from stationarity, and it would now be
reasonable to attempt to fit a stationary time series model to this series. To see how
well theestimated seasonal and trend componentsfit thedata, select Transform>Show
Classical Fit.Weshall not pursuethisapproach any further here, but turninstead
to the differencing approach. (You should have no difficulty in later returning to this
point and compl eting the classical decomposition analysis by fitting a stationary time
series model to {Y;}.) O

Differencing

Differencing isatechnique that can also be used to remove seasonal components and
trends. The ideais simply to consider the differences between pairs of observations
with appropriate time separations. For example, to remove a seasonal component of
period 12 from the series { X, }, we generate the transformed series

Yz = Xt - Xr—12-

It is clear that all seasonal components of period 12 are eliminated by this transfor-
mation, which is called differencing at lag 12. A linear trend can be eliminated by
differencing at lag 1, and a quadratic trend by differencing twiceat lag 1 (i.e., differ-
encing once to get a new series, then differencing the new seriesto get a second new
series). Higher-order polynomials can be eliminated analogoudly. It is worth noting
that differencing at lag 12 eliminates not only seasonal components with period 12
but also any linear trend.

Dataaredifferencedin| TSM by selecting Transform>Difference and entering
therequired lag in the resulting dialog box.
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Figure D-3

The series AIRPASS.TSM
after taking logs

and differencing

atlags 12 and 1.

Restore the origina airline passenger datausing the option File>Import File and
selecting AIRPASS.TSM. We take natural logarithms as in Example D.2.6 by se-
lecting Transform>Box-Cox and setting A = 0. The transformed series can now be
deseasonalized by differencing at lag 12. To do this select Transform>Difference,
enter the lag 12 in the dialog box, and click OK. Inspection of the graph of the desea
sonalized series suggests a further differencing at lag 1 to eliminate the remaining
trend. To do this, repeat the previous step with lag equal to 1 and you will see the
transformed and twice-differenced series shown in Figure D.3. O

Subtracting the Mean

The term ARMA model is used in ITSM to denote a zero-mean ARMA process
(see Definition 3.1.1). To fit such a model to data, the sample mean of the data
should therefore be small. Once the apparent deviations from stationarity of the data
have been removed, we therefore (in most cases) subtract the sample mean of the
transformed data from each observation to generate a series to which we then fit a
zero-mean stationary model. Effectively we are estimating the mean of the model by
the sample mean, then fitting a (zero-mean) ARMA model to the “mean-corrected”
transformed data. If we know a priori that the observations are from a process with
zero mean, then this process of mean correction is omitted. ITSM keeps track of all
thetransformations (including mean correction) that are made. When it comestimeto
predict the original series, ITSM will invert all these transformations automatically.

Subtract the mean of thetransformed and twice-differenced seriesAIRPASS. TSM by
selecting Transform>Subtract Mean. To check the current model status press the
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red INFO button, and you will seethat the current model iswhite noise with variance
1, since no model has yet been entered. O

D.3 Finding a Model for Your Data

After transforming the data (if necessary) asdescribed above, weare now inaposition
to fit an ARMA model. ITSM uses a variety of tools to guide us in the search for
an appropriate model. These include the sample ACF (autocorrelation function),
the sample PACF (partial autocorrelation function), and the AICC stetistic, a bias-
corrected form of Akaike's AlIC statistic (see Section 5.5.2).

D.3.1 Autofit

Before discussing the considerations that go into the selection, fitting, and checking
of a stationary time series model, we first briefly describe an automatic feature of
ITSM that searches through ARMA(p, ¢) models with p and ¢ between specified
limits (less than or equal to 27) and returns the model with smallest AICC value
(see Sections 5.5.2 and D.3.5). Once the data set is judged to be representable by a
stationary model, select Model>Estimation>Autofit. A dialog box will appear in
which you must specify the upper and lower limitsfor p and ¢. Since the number of
maximum likelihood modelsto befitted isthe product of the number of p-valuesand
the number of ¢-values, theseranges should not be chosen to be larger than necessary.
Once the limits have been specified, press Start, and the search will begin. You can
watch the progress of the search in the dialog box that continually updates the values
of p and ¢ and the best model found so far. This option does not consider models
in which the coefficients are required to satisfy constraints (other than causality) and
consequently does not always |ead to the optimal representation of the data. However,
like the tool s described below, it provides valuable information on which to base the
selection of an appropriate model.

D.3.2 The Sample ACF and PACF

Pressing the second yellow button at thetop of the I TSM window will produce graphs
of the sample ACF and PACF for values of the lag # from 1 up to 40. For higher lags
chooseStatistics>ACF/PACF>Specify Lag, enter themaximumlagrequired, and
click OK. Pressing the second yell ow button repeatedly then rotatesthedisplay through
ACF, PACF, and side-by-side graphs of both. Values of the ACF that decay rapidly as
h increases indicate short-term dependency in the time series, while slowly decaying
values indicate long-term dependency. For ARMA fitting it is desirable to have a
sample ACF that decaysfairly rapidly. A sample ACF that is positive and very slowly
decaying suggests that the data may have a trend. A sample ACF with very slowly
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damped periodicity suggeststhe presence of aperiodic seasonal component. Ineither
of these two cases you may need to transform your data before continuing.

As arule of thumb, the sample ACF and PACF are good estimates of the ACF
and PACF of a stationary process for lags up to about a third of the sample size. Itis
clear from the definition of the sample ACF, p(h), that it will beavery poor estimator
of p(h) for h close to the sample size n.

The horizontal lines on the graphs of the sample ACF and PACF are the bounds
+1.96//n. If the data constitute a large sample from an independent white noise
sequence, approximately 95% of the sample autocorrelations should lie between
these bounds. Large or frequent excursions from the bounds suggest that we need a
model to explain the dependence and sometimesto suggest the kind of model we need
(see below). To obtain numerical values of the sample ACF and PACF, right-click on
the graphs and select Info.

The graphs of the sample ACF and PACF sometimes suggest an appropriate
ARMA modd for the data. As arough guide, if the sample ACF falls between the
plotted bounds +1.96//n for lagsh > ¢, then an MA(g) model is suggested, while
if the sample PACF falls between the plotted bounds +1.96/./n for lagsh > p, then
an AR(p) model is suggested.

If neither the sample ACF nor PACF “cuts off” as in the previous paragraph, a
more refined model selection technique is required (see the discussion of the AICC
statistic in Section 5.5.2). Even if the sample ACF or PACF does cut off at somelag,
itis dtill advisable to explore models other than those suggested by the sample ACF
and PACF values.

Figure D.4 shows the sample ACF of the AIRPASS.TSM series after taking loga-
rithms, differencing at lags 12 and 1, and subtracting the mean. Figure D.5 showsthe
corresponding sample PACF. These graphs suggest that we consider an MA model
of order 12 (or perhaps 23) with alarge number of zero coefficients, or aternatively
an AR model of order 12. O

D.3.3 Entering a Model

A magjor function of ITSM isto find an ARMA model whose properties reflect to
a high degree those of an observed (and possibly transformed) time series. Any
particular causal ARMA(p, ¢) model with p < 27 and ¢ < 27 can be entered
directly by choosing Model>Specify, entering the values of p, ¢, the coefficients,
and the white noise variance, and clicking OK. If there is a data set already open in
ITSM, a quick way of entering a reasonably appropriate model is to use the option
Model>Estimation>Preliminary, which estimatesthe coefficientsand whitenoise
variance of an ARMA model after you have specified the orders p and g and selected
one of the four preliminary estimation algorithms available. An optimal preliminary
AR model can also be fitted by checking Find AR model with min AICC inthe
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If you have data and no particular ARMA model in mind, it is advisable to use
the option Model>Estimation>Preliminary Or equivalently to pressthe blue PRE
button at the top of the ITSM window.

Sometimes you may wish to try amodel found in a previous session or a model
suggested by someone else. In that case choose Model>Specify and enter the re-
quired model. You can save both the model and data from any project by selecting
File>Project>Save as and specifying the name for the new file. When the new
fileis opened, both the model and the datawill be imported. To create a project with
this model and a new data set select File>Import File and enter the name of the
file containing the new data. (This file must contain data only. If it aso contains a
model, then the model will be imported with the data and the model previoudly in
ITSM will be overwritten.)

D.3.4 Preliminary Estimation

The option Mode1>Estimation>Preliminary contains fast (but not the most effi-
cient) model-fitting algorithms. They are useful for suggesting the most promising
modelsfor the data, but should be followed by maximum likelihood estimation using
Model>Estimation>Max likelihood. The fitted preliminary model is generally
used as an initial approximation with which to start the nonlinear optimization car-
ried out in the course of maximizing the (Gaussian) likelihood.

Tofitan ARMA model of specified order, first enter thevaluesof p and ¢ (see Sec-
tion 2.6.1). For pure AR modelsg = 0, and the preliminary estimation option offersa
choice between the Burg and Yule-Walker estimates. (The Burg estimates frequently
give higher vaues of the Gaussian likelihood than the Yule-Walker estimates.) If
g = 0, you can also check the box Find AR model with min AICC to alow the
programtofit AR modelsof ordersO, 1, ..., 27 and select theonewith smallest AICC
value (Section 5.5.2). For models with ¢ > 0, ITSM provides a choice between two
preliminary estimation methods, one based on the Hannan—Rissanen procedure and
the other on theinnovationsalgorithm. If you choose theinnovations option, adefault
value of m will be displayed on the screen. This parameter was defined in Section
5.1.3. The standard choice is the default value computed by ITSM. The Hannan—
Rissanen algorithm is recommended when p and ¢ are both greater than 0, since it
tends to give causal models more frequently than the innovations method. The latter
is recommended when p = 0.

Once the required entries in the Preliminary Estimation dialog box have been
completed, click 0K, and ITSM will quickly estimate the parameters of the selected
model and display anumber of diagnostic statistics. (If p and ¢ are both greater than
0, it is possible that the fitted model may be noncausal, in which case ITSM sets
all the coefficients to .001 to ensure the causality required for subsequent maximum
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likelihood estimation. It will also give you the option of fitting a model of different
order.)

Provided that the fitted modéd is causal, the estimated parameters are given with
the ratio of each estimate to 1.96 times its standard error. The denominator (1.96
x standard error) is the critical value (at level .05) for the coefficient. Thus, if the
ratio is greater than 1 in absolute value, we may conclude (at level .05) that the
corresponding coefficient is different from zero. On the other hand, aratio less than
1 in absolute value suggests the possibility that the corresponding coefficient in the
model may be zero. (If the innovations option is chosen, the ratios of estimates to
1.96 x standard error are displayed only when p = g or p = 0.) In the Preliminary
Estimateswindow you will also see one or more estimates of the white noise variance
(the residual sum of squares divided by the sample size is the estimate retained by
ITSM) and some further diagnostic statistics. These are —2In L (¢, 8, 62), where L
denotes the Gaussian likelihood (5.2.9), and the AICC statistic

—2InL+2(p+q+n/n—p—q—2)

(see Section 5.5.2).

Our eventual aim is to find a model with as small an AICC value as possible.
Smallness of the AICC value computed in the preliminary estimation phase is in-
dicative of a good model, but should be used only as a rough guide. Final decisions
between models should be based on maximum likelihood estimation, carried out us-
ing the option Model>Estimation>Max likelihood, since for fixed p and ¢, the
values of ¢, 8, and o2 that minimize the AICC statistic are the maximum likelihood
estimates, not the preliminary estimates. After completing preliminary estimation,
ITSM stores the estimated model coefficients and white noise variance. The stored
estimate of the white noise variance isthe sum of squares of the residual s (or one-step
prediction errors) divided by the number of observations.

A variety of models should be explored using the preliminary estimation algo-
rithms, with aview to finding the most likely candidates for minimizing AICC when
the parameters are reestimated by maximum likelihood.

To find the minimum-AICC Burg AR model for the logged, differenced, and mean-
corrected seriesAIRPASS. TSM currently stored in I TSM, pressthe blue PRE button,
set the MA order equal to zero, select Burg and Find AR model with min AICC,
and then click 0K. The minimum-AlCC AR model is of order 12 with an AICC value
of —458.13. To fit a preliminary MA(25) model to the same data, press the blue
PRE button again, but this time set the AR order to 0, the MA order to 25, select
Innovations, and click OK.

The ratios (estimated coefficient)/(1.96x standard error) indicate that the coeffi-
cientsat lags 1 and 12 are nonzero, as suggested by the sample ACF. The estimated
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coefficients at lags 3 and 23 aso look substantial even though the corresponding
ratios are less than 1 in absolute value. The displayed values are as follows:

MA COEFFICIENTS

—.3568 .0673 —.1629 —.0415 1268
.0264 .0283 —.0648 1326 —.0762
—.0066 —.4987 1789 —.0318 1476
—.1461 .0440 —.0226 —.0749 —.0456
—.0204 —.0085 .2014 —-.0767 —.0789
RATIO OF COEFFICIENTS TO (1.96*STANDARD ERROR)

—2.0833 .3703 —.8941 —.2251 .6875
1423 1522 —.3487 7124 —.4061
—.0353 —2.6529 .8623 —.1522 .7068
—.6944 .2076 —.1065 —.3532 —.2147
—.0960 —.0402 9475 —.3563 —.3659

The estimated white noise variance is .00115 and the AICC valueis —440.93, which
is not as good as that of the AR(12) model. Later we shall find a subset MA(25)
model that has a smaller AICC value than both of these models. O

D.3.5 The AICC Statistic

The AICC statistic for the model with parameters p, g, ¢, and 0 is defined (see
Section 5.2.2) as

AICC(¢, 0) = -2InL(¢. 0, S(¢,0)/n)+2(p+q + Dn/(n — p —q — 2),

and amodel chosen according to the AICC criterion minimizes this statistic.

M odel-sel ection statisticsother than AICC arealsoavailablein I TSM. A Bayesian
modification of the AIC statistic known as the BIC statistic is also computed in the
option Model>Estimation>Max likelihood. It is used in the same way as the
AICC.

An exhaustive search for a model with minimum AICC or BIC value can be
very slow. For this reason the sample ACF and PACF and the preliminary estimation
techniques described above are useful in narrowing down the range of models to
be considered more carefully in the maximum likelihood estimation stage of model
fitting.

D.3.6 Changing Your Model

The model currently stored by the program can be checked at any time by selecting
Model>Specify. Any parameter can bechangedintheresulting dialog box, including
the white noise variance. The model can be filed together with the data for later use
by selecting File>Project>Save as and specifying afile name with suffix .TSM.
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Weshall now set someof the coeffi cientsinthe current model to zero. Todo thischoose
Model>Specify and click onthe box containing thevalue —.35676 of Theta(1). Press
Enter, and the value of Theta(2) will appear in the box. Set thisto zero. PressEnter
again, andthevalueof Theta(3) will appear. Continueto work through the coefficients,
setting all except Theta(1), Theta(3), Theta(12), and Theta(23) equa to zero. When
you have reset the parameters, click 0K, and the new model stored in ITSM will be
the subset MA (23) model

X, =2, —.357Z,_1 — 163Z,_3 — .499Z, 1, + .201Z, 3,
where {Z,} ~ WN(0, .00115). O

D.3.7 Maximum Likelihood Estimation

Once you have specified values of p and ¢ and possibly set some coefficientsto zero,
you can carry out efficient parameter estimation by selecting Model>Estimation>
Max likelihood or equivalently by pressing the blue MLE button.

The resulting dialog box displays the default settings, which in most cases will
not need to be modified. However, if you wish to compute the likelihood without
maximizing it, check thebox labeled No optimization. Theremaininginformation
concerns the optimization settings. (With the default settings, any coefficients that
are set to zero will be treated as fixed values and not as parameters. Coefficients to
be optimized must therefore not be set exactly to zero. If you wish to impose further
constraints on the optimization, press the Constrain optimization button. This
allows you to fix certain coefficients or to impose multiplicative relationships on the
coefficients during optimization.)

To find the maximum likelihood estimates of your parameters, click 0K, and the
estimated parameterswill be displayed. To refine the estimates, repeat the estimation,
specifying a smaller value of the accuracy parameter in the Maximum Likelihood
dialog box.

To find the maximum likelihood estimates of the parameters in the model for the
logged, differenced, and mean-corrected airline passenger data currently stored in
ITSM, press the blue MLE button and click 0K. The following estimated parameters
and diagnostic statistics will then be displayed:

ARMA MODEL:
X = Z0 + (—=.355) « Z(t — 1) + (—.201) * Z(t — 3) + (—=.523) = Z(t — 12) 4 (.242) + Lt — 23)

WN Variance = .001250

MA Coefficients
THETA( 1)=-.355078 THETA( 3)=-.201125
THETA(12)= -.523423 THETA(23)= .241527
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Standard Error of MA Coefficients
THETA( 1): .059385 THETA( 3): .059297
THETA(12): .058011 THETA(23): .055828

(Residual SS)/N = .125024E-02
AICC = -.486037E+03
BIC = -.487622E+03

-2 Ln(Likelihood)= -.496517E+03
Accuracy parameter = .00205000
Number of iterations = 5

Number of function evaluations = 46

Optimization stopped within accuracy level.

The last message indicates that the minimum of —21n L has been located with
the specified accuracy. If you see the message

Iteration limit exceeded,
then the minimum of —21n L could not be located with the number of iterations (50)
allowed. You can continue the search (starting from the point at which the iterations
were interrupted) by pressing the MLE button to continue the minimization and
possibly increasing the maximum number of iterations from 50 to 100. O

D.3.8 Optimization Results

After maximizing the Gaussian likelihood, ITSM displays the model parameters
(coefficients and white noise variance), the values of —21In L, AICC, BIC, and infor-
mation regarding the computations.

The next stage of the analysis is to consider a variety of competing models and to
select the most suitable. The following table shows the AICC statistics for a variety
of subset moving average models of order less than 24.

Lags AICC
1 3 12 23 —486.04
1 3 12 13 23 —485.78
1 3 5 12 23 —489.95
1 3 12 13 —482.62
1 12 —475.91

The best of these models from the point of view of AICC value is the one with
nonzero coefficients at lags 1, 3, 5, 12, and 23. To obtain this model from the one
currently stored in ITSM, select Model>Specify, change the value of THETA(5)
from zero to .001, and click 0K. Then reoptimize by pressing the blue MLE button



D.4  Testing Your Model 411

and clicking 0K. You should obtain the noninvertible model
X, =Z,— 4347, , — .305Z; 3+ .238Z, 5 — .656Z, 15 + .351Z; 53,

where {Z,} ~ WN(0, .00103). For future reference, file the model and dataas AIR-
PASS2.TSM using the option File>Project>Save as. O

The next step isto check our model for goodness of fit.

D.4 Testing Your Model

Once we have amoded, it isimportant to check whether it is any good or not. Typi-
cally thisisjudged by comparing observations with corresponding predicted values
obtained from the fitted model. If the fitted model is appropriate then the prediction
errors should behave in amanner that is consistent with the model. Theresidualsare
the rescaled one-step prediction errors,

Wt = (X, — 5(1)/\/ Ti—1,

where X, isthe best linear mean-square predictor of X, based on the observations up
totimer — 1, r,_1 = E(X, — X,)%/o2 and o2 is the white noise variance of the fitted
model.

If thedataweretruly generated by thefitted ARMA (p, g) model with whitenoise
sequence {Z,}, then for large samples the properties of {W,} should reflect those of
{Z,}. To check the appropriateness of the model we therefore examine the residual
series {W,}, and check that it resembles a realization of awhite noise seguence.

ITSM provides a number of tests for doing this in the Residuals Menu, which
is obtained by selecting the option Statistics>Residual Analysis. Within this
option are the suboptions

Plot

QQ-Plot (normal)
QQ-Plot (t-distr)
Histogram

ACF/PACF

ACF Abs vals/Squares
Tests of randomness
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D.4.1 Plotting the Residuals

SelectStatistics>Residual Analysis>Histogram,andyouwill seeahistogram
of the rescaled residuals, defined as

kt = W[/6,

where né? isthe sum of the squared residuals. If the fitted model is appropriate, the
histogram of the rescaled residual s should have mean close to zero. If in addition the
data are Gaussian, this will be reflected in the shape of the histogram, which should
then resemble a normal density with mean zero and variance 1.

Select Statistics>Residual Analysis>Plot and you will seeagraph of R,
vs. t. If the fitted model is appropriate, this should resemble a realization of awhite
noise sequence. Look for trends, cycles, and nonconstant variance, any of which
suggest that the fitted model is inappropriate. If substantially more than 5% of the
rescaled residuals lie outside the bounds 4-1.96 or if there are rescaled residuals far
outside these bounds, then the fitted model should not be regarded as Gaussian.

Compatibility of the distribution of the residuals with either the normal distribu-
tion or the ¢-distribution can be checked by inspecting the corresponding qqg plotsand
checking for approximate linearity. To test for normality, the Jarque-Bera statistic is
also computed.

The histogram of the rescaled residuals from our model for the logged, differenced,
and mean-corrected airline passenger series is shown in Figure D.6. The mean is
close to zero, and the shape suggests that the assumption of Gaussian white noiseis
not unreasonable in our proposed model.

The graph of R, vs. ¢ is shown in Figure D.7. A few of the rescaled residuals
are greater in magnitude than 1.96 (as is to be expected), but there are no obvious
indications here that the model is inappropriate. The approximate linearity of the
normal qq plot and the Jarque-Bera test confirm the approximate normality of the
residuals. O

D.4.2 ACF/PACF of the Residuals

If we were to assume that our fitted model is the true process generating the data,
then the observed residuals would be realized values of awhite noise sequence.

In particular, the sample ACF and PACF of the observed residuals should lie
within the bounds 4-1.96/ ,/n roughly 95% of the time. These bounds are displayed
on the graphs of the ACF and PACF. If substantially more than 5% of the correlations
are outside these limits, or if there are a few very large values, then we should look
for a better-fitting model. (M ore precise bounds, due to Box and Pierce, can befound
in TSTM Section 9.4.)
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Figure D-6
Histogram of the
rescaled residuals
from AIRPASS.MOD.

Example D.4.2

Figure D-7

Time plot of the
rescaled residuals
from AIRPASS.MOD.
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Choose Statistics>Residual Analysis>ACF/PACF, or equivaently press the
middle green button at the top of the ITSM window. The sample ACF and PACF
of the residuals will then appear as shown in Figures D.8 and D.9. No correlations
are outside the boundsin this case. They appear to be compatible with the hypothesis
that the residuals are in fact observations of a white noise sequence. To check for
independence of the residuals, the sample autocorrel ation functions of their absolute
values and squares can be plotted by clicking on the third green button. O
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Figure D-8
Sample ACF of the residuals
from AIRPASS.MOD.

Example D.4.3

Figure D-9
Sample PACF of
the residuals from
AIRPASS.MOD.
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D.4.3 Testing for Randomness of the Residuals

Theoption Statistics>Residual Analysis>Tests of Randomness carriesout
the six tests for randomness of the residuals described in Section 5.3.3.

Theresiduals from our model for the logged, differenced, and mean-corrected series
AIRPASS.TSM are checked by selecting the option indicated above and selecting
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the parameter 4 for the portmanteau tests. Adopting the value = 25 suggested by
ITSM, we obtain the following results:

RANDOMNESS TEST STATISTICS (see Section 5.3.3)

LJUNG-BOX PORTM.= 13.76 CHISQUR( 20), p-value = 0.843
MCLEOD-LI PORTM.= 17.39 CHISQUR( 25), p-value = 0.867
TURNING POINTS = 87. ANORMAL( 86.00, 4.79**2), p-value = 0.835
DIFFERENCE-SIGN = 65. ANORMAL( 65.00, 3.32%*2), p-value = 1.000
RANK TEST = 3934. ANORMAL(4257.50, 251.3*%*2), p-value = 0.198
JARQUE-BERA = 4.33 CHISQUR(2) p-value = 0.115
ORDER OF MIN AICC YW MODEL FOR RESIDUALS =0

Every test is easily passed by our fitted model (with significance level o =
.05), and the order of the minimum-AICC AR model for the residuals supports the
compatibility of the residuals with white noise. For later use, file the residuas by
pressing the red EXP button and exporting the residuals to a file with the name
AIRRES.TSM. O

D.5 Prediction

One of the main purposes of time series modeling is the prediction of future ob-
servations. Once you have found a suitable model for your data, you can predict
future values using the option Forecasting>ARMA. (The other options listed under
Forecasting refer to the methods of Chapter 9.)

D.5.1 Forecast Criteria

Givenobservations X, ..., X, of aseriesthat weassumeto beappropriately modeled
asan ARMA(p, q) process, ITSM predicts future values of the series X, from the
dataand the model by computing thelinear combination P, (X,.;) of X1, ..., X, that
minimizes the mean squared error E (X, — Py(X,40))2.

D.5.2 Forecast Results

Assuming that the current data set has been adequately fitted by the current
ARMA(p, ¢g) model, choose Forecasting>ARMA, and you will seethe ARMA Fore-
cast dialog box.
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You will be asked for the number of forecasts required, which of the transforma-
tions you wish to invert (the default settings are to invert all of them so asto obtain
forecasts of the original data), whether or not you wish to plot prediction bounds
(assuming normality), and if so, the confidence level required, e.g., 95%. After pro-
viding thisinformation, click 0K, and the data will be plotted with the forecasts (and
possibly prediction bounds) appended. As is to be expected, the separation of the
prediction bounds increases with the lead time & of the forecast.

Right-click on the graph, select Info, and the numerical values of the predictors
and prediction bounds will be printed.

We left our logged, differenced, and mean-corrected airline passenger data stored in
ITSM with the subset MA(23) model found in Example D.3.5. To predict the next
24 values of the original series, select Forecasting>ARMA and accept the default
settingsin the dialog box by clicking 0K. You will then see the graph shownin Figure
D.10. Numerical values of the forecasts are obtained by right-clicking on the graph
and selecting Info. The ARMA Forecast dialog box also permits using a model
constructed from a subset of the data to obtain forecasts and prediction bounds for
the remaining observed values of the series. O

D.6 Model Properties

Figure D-10

The original AIRPASS
data with 24
forecasts appended.

(thousands)

ITSM can be used to analyze the properties of a specified ARMA process without
reference to any data set. This enables us to explore and compare the properties
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of different ARMA models in order to gain insight into which models might best
represent particular features of a given data set.

For any ARMA(p, q) process or fractionally integrated ARMA(p, g) process
with p < 27 and ¢ < 27, ITSM alows you to compute the autocorrelation and
partial autocorrelation functions, the spectral density and distribution functions, and
the MA (o0) and AR(c0) representations of the process. It also allowsyou to generate
simulated realizations of the processdriven by either Gaussian or non-Gaussian noise.
The use of these optionsis described in this section.

We shall illustrate the use of ITSM for model analysis using the model for the trans-
formed series AIRPASS. TSM that is currently stored in the program. O

D.6.1 ARMA Models

For modeling zero-mean stationary time series, ITSM uses the class of ARMA (and
fractionally integrated ARMA) processes. ITSM Enables you to compute character-
istics of the causal ARMA model defined by

X, =¢1 X1+ ¢2Xt72 +- 4+ Cbpxz—p +Zi+0Z 1+ 072 o+ + equfq’

or more concisely ¢(B)X, = 6(B)Z,, where {Z,} ~ WN (0, o) and the parame-
ters are al specified. (Characteristics of the fractionally integrated ARIMA(p, d, q)
process defined by

(1-B)Y¢(B)X, =60(B)Z:, |d| <05,

can aso be computed.)

ITSM works exclusively with causal models. It will not permit you to enter a
model for which1 —¢.z —- - - — ¢,z” hasazeroinside or on the unit circle, nor does
it generate fitted models with this property. From the point of view of second-order
properties, this represents no loss of generality (Section 3.1). If you are trying to
enter an ARMA(p, ¢) model manually, the simplest way to ensure that your model
is causal isto set al the autoregressive coefficients close to zero (e.g., .001). ITSM
will not accept a noncausal model.

ITSM does not restrict models to be invertible. You can check whether or not
the current model isinvertible by choosing Model>Specify and pressing the button
labeled Causal/Invertible in the resulting dialog box. If the model is noninvertible,
i.e., if the moving-average polynomia 1+ 6,z + - - - + 6,z hasazero inside or on
the unit circle, the message Non-invertible will appear beneath the box contain-
ing the moving-average coefficients. (A noninvertible model can be converted to an
invertible model with the same autocovariance function by choosing Model>Switch
to invertible. If the model isaready invertible, the program will tell you.)
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Figure D-11

The ACF of the model in
Example D.3.5 together
with the sample ACF

of the transformed
AIRPASS.TSM series.

D.6.2 Model ACF, PACF

The model ACF and PACF are plotted using Mode1>ACF/PACF>Model. If you wish
to change the maximum lag from the default value of 40, select Model>ACF/PACF>
Specify Lag and enter the required maximum lag. (It can be much larger than 40,
e.g., 10000). The graph will then be modified, showing the correlations up to the
specified maximum lag.

If thereisadatafile open aswell asamodel in ITSM, the model ACF and PACF
can be compared with the sample ACF and PACF by pressing the third yellow button
at the top of the ITSM window. The model correlations will then be plotted in red,
with the corresponding sample correlations shown in the same graph but plotted in
green.

The sample and model ACF and PACF for the current model and transformed series
AIRPASS.TSM are shown in Figures D.11 and D.12. They are obtained by pressing
thethird yellow button at thetop of the I TSM window. Thevertical linesrepresent the
model values, and the squares are the sample ACF/PACF. The graphs show that the
data and the model ACF both havelarge valuesat lag 12, while the sample and model
partial autocorrelation functions both tend to die away geometrically after the peak at
lag 12. The similarities between the graphsindicate that the model is capturing some

of the important features of the data. O
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Example D.6.3

D.6.3 Model Representations

Asindicated in Section 3.1, if {X,} isacausa ARMA process, thenit hasan MA (o)
representation

XZZZVIJ‘Z;,]', t=0,:|:1,:|:2,...,

j=0

Where2|1p|<ooandwo_l

S|m|IarIy, if {X,} isaninvertible ARMA process, then it has an AR(c0) repre-
sentation

Z,=) miXi_; t=0+142 .,
j=0

where 37 || < oo and o = 1.

For any specified causal ARMA model you can determinethe coefficientsin these
representations by selecting the option Mode1>AR/MA Infinity. (If themodel isnot
invertible, youwill see only the M A (c0) coefficients, sincethe AR(co) representation
does not exist in this case.)

The current subset MA(23) model for the transformed series AIRPASS.TSM does
not have an AR(co) representation, sinceit isnot invertible. However, we can replace
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the model with an invertible one having the same autocovariance function by select-
ing Model>Switch to Invertible. For this model we can then find an AR(o0)
representation by selectingModel>AR Infinity. Thisgives50 coefficients, thefirst
20 of which are shown bel ow.

MA-Infinity AR — Infinity

J psi()) pi
0 1.00000 1.00000
1 —.36251 36251
2 01163 11978
3 —.26346 .30267
4 —.06924 .27307
5 15484  —.00272
6 —.02380 .05155
7 —.06557 16727
8 —.04487 .10285
9 .01921 .01856
10 —.00113 07947
11 .01882 .07000
12 —.57008 .58144
13 .00617 41683
14 .00695 .23490
15 .03188 .37200
16 .02778 .38961
17 .01417 10918
18 .02502 .08776
19 .00958 .22791 O

D.6.4 Generating Realizations of a Random Series

ITSM can be used to generate realizations of a random time series defined by the
currently stored model.

To generate such arealization, select the option Model>Simulate, and you will
see the ARMA Simulation dialog box. You will be asked to specify the number of
observations required, the white noise variance (if you wish to changeit from the cur-
rent value), and an integer-va ued random number seed (by specifying and recording
this integer with up to nine digits you can reproduce the same realization at a later
date by reentering the same seed). You will also have the opportunity to add a spec-
ified mean to the smulated ARMA values. If the current model has been fitted to
transformed data, then you can also chooseto apply theinversetransformationsto the
simulated ARMA to generate a ssimulated version of the original series. The default
distribution for the white noise is Gaussian. However, by pressing the button Change
noise distribution You can select from a variety of alternative distributions or
by checking the box Use Garch model for noise process you can generate an
ARMA process driven by GARCH noise. Finally, you can choose whether the sim-
ulated data will overwrite the data set in the current project or whether they will be
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used to create a new project. Once you are satisfied with your choices, click 0k, and
the simulated series will be generated.

Example D.6.4  To generate a simulated realization of the series AIRPASS.TSM using the current
model and transformed data set, select the option Model>Simulate. The default
options in the dialog box are such as to generate a realization of the original series
asanew project, so it sufficesto click OK. You will then see agraph of the simulated
series that should resemble the original series AIRPASS.TSM. O

D.6.5 Spectral Properties

Spectral properties of both data and fitted ARMA models can aso be computed and
plotted with the aid of ITSM. The spectral density of the model is determined by
selecting the option Spectrum>Model. Estimation of the spectral density from ob-
servations of a stationary series can be carried out in two ways, either by fitting an
ARMA model as already described and computing the spectral density of the fitted
model (Section 4.4) or by computing the periodogram of the dataand smoothing (Sec-
tion 4.2). The latter method is applied by selecting the option Spectrum>Smoothed
Periodogram. Examples of both approaches are given in Chapter 4.

D.7 Multivariate Time Series

Observations {xg, . .., X, } of an m-component time series must be stored asan ASCI|
filewith n rows and m columns, with at least one space between entries in the same
row. To open amultivariate seriesfor analysis, select File>Project>0pen>Multi-
variate and click OK. Then double-click on thefile containing the data, and you will
be asked to enter the number of columns (i) in the datafile. After doing this, click
0K, and you will see graphs of each component of the series, with the multivariate
tool bar at the top of the ITSM screen. For examples of the application of ITSM to
the analysis of multivariate series, see Chapter 7.
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A

accidental deaths (DEATHS.TSM), 3, 13,

32, 33, 43, 109, 207, 321, 324, 327
ACF (see autocorrel ation function)
AlC, 173
AICC, 161, 173, 191, 247, 407
airline passenger data (AIRPASS.TSM),

220, 281, 329, 330
All Ordinaries index, 248
All-star baseball games, 2, 8
aternative hypothesis, 375
APPH.TSM, 257
APPI.TSM, 257
APPJTSM, 365
APPJIK2.TSM, 257
APPK.TSM, 365
ARAR agorithm, 318-322

forecasting, 320
application of, 321
ARCH(1) process, 351, 366
ARCH(p) process, 349, 366
ARCH.TSM, 352
AR(1) process, 17, 41, 53, 62, 65, 261,
301
ACVF of, 18, 53
causal, 54
confidence regions for coefficients, 142
estimation of mean, 58
estimation of missing value, 67, 287
observation driven model of, 299
plus noise, 79
prediction of, 65, 68
sample ACF of, 63
spectral density of, 119
state-space representation of, 261

with missing data, 67, 82, 285, 287
with non-zero mean, 68
AR(2) process, 23
ACVF of, 89
AR(p) process (see autoregressive
process)
ARIMA(1, 1, 0) process, 181
forecast of, 202
ARIMA process
definition, 180
forecasting, 198-203
seasonal (see seasonal ARIMA models)
state-space representation of, 269
with missing observations, 286, 287
with regression, 214, 217
ARIMA(p, d, q) processwith
(=.5<d < .5) (seefractionaly
integrated ARMA process)
ARMA(1, 1) process, 55-57, 86, 91, 262
ACVF of, 89, 90
causal, 56, 86
invertible, 57, 86
noncausal, 56, 136
noninvertible, 57, 136
prediction of, 76
spectral density of, 134
state-space representation of, 262
ARMA(p, q) process
ACVF of, 88-94
coefficientsin AR representation, 86
coefficientsin MA representation, 85
causal, 85
definition, 83
estimation
Hannan-Rissanen, 156-157

innovations algorithm, 154-156
least squares, 161
maximum likelihood, 160
existence and uniqueness of, 85
invertible, 86
multivariate (see multivariate ARMA
processes)
order selection, 161, 169-174
prediction, 100-108
seasonal (see seasonal ARIMA models)
spectral density of, 132
state-space representation of, 268
with mean u, 84

asymptotic relative efficiency, 146
Australian red wine sales (WINE.TSM),

2, 23,188,192, 330

autocorrelation function (ACF)

definition, 16, 46

sample ACF, 19, 59
of absolute values, 362, 364366, 418
of squares, 362, 364-366, 418
approximate distribution of, 6061

of MA(q), 94

autocovariance function (ACVF)

basic properties of, 45
characterization of, 48
definition, 16, 45

nonnegative definite, 47

of ARMA processes, 88-94

of ARMA(1, 1) process, 89, 90
of AR(2) process, 91

of MA(q) process, 89

of MA(1) process, 17, 48
sample, 59-60

spectral representation of, 119
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autofit
for ARMA fitting, 137, 138, 161, 163,
191193, 215, 218, 343, 356, 403
for fractionally integrated ARMA, 363
autoregressive integrated moving-average
(see ARIMA process)
autoregressive moving-average (see
(ARMA process)
autoregressive polynomial, 83
autoregressive (AR(p)) process, 84
estimation of parameters
Burg, 147-148
maximum likelihood, 158, 162
with missing observations, 284
Yule-Walker, 139-147
large-sample distributions, 141
confidence intervals, 142
one-step prediction of, 68
order selection, 144, 169
minimum AICC model, 167
multivariate (see multivariate AR
models)
partial autocorrelation function of, 95
prediction of, 102
state-space representation, 267—268
subset models, 319
unit rootsin, 194
Yule-Walker equations, 137
autoregressive process of infinite order
(AR(c0)), 233

B

backward prediction errors, 147
backward shift operator, 29
bandwidth, 125
Bartlett's formula, 61
AR(1), 62
independent white noise, 61
MA(2), 61
multivariate, 238
Bayesian state-space model, 292—294
BEER.TSM, 221
best linear predictor, 46, 271
beta function, 316
beta-binomial distribution, 316
BIC criterion, 173
bilinear model, 348
binary process, 8
binomial distribution, 371

bispectral density, 347
bivariate normal distribution, 379
bivariate time series, 224
covariance matrix, 224
mean vector, 224
(weakly) stationary, 224
Box-Cox transformation, 188
Brownian motion, 359
Burg's algorithm, 147

C

CAR(1) process, 357
estimation of, 358
with threshold, 361
CARMA(p, g) process, 359
autocovariance function of, 361
mean of, 360
with thresholds, 361
Cauchy criterion, 393
causal
ARCH(1) process, 349, 350
ARMA process, 85
GARCH process, 354
multivariate ARMA process, 242
time-invariant linear filter, 129
chaotic deterministic sequence, 345-347
checking for normality, 38
chi-squared distribution, 371
classical decomposition, 23, 31, 188
Cochran and Orcutt procedure, 212
cointegration, 254255
cointegration vector, 254
conditional density, 375
conditional expectation, 376
confidence interval, 388-389
large-sampl e confidence region, 388
conjugate family of priors, 303
consistent estimator, 124
continuous distributions
chi-squared, 371
exponential, 370
gamma, 371
normal, 370
uniform, 370
continuous spectrum, 116
continuous-time ARMA process (see
CARMA(p, g) process)
continuous-time models, 357-361
CAR(1), 357

covariance function, 15 (see aso
autocovariance function)
covariance matrix, 376
factorization of, 377
properties of, 376
square root of, 377
cumulant, 347
kth-order, 347

D

delay parameter, 334
design matrix, 211
deterministic, 77
diagnostic checking, 164-167 (see aso
residuals)
difference operator
first-order, 29
with positivelag d, 33
with real lag d¢-.5, 361
differencing to generate stationary data,
188
atlagd, 33
Dirichlet kernel, 130
discrete distributions
binomial, 371
negative binomial, 372, 381
Poisson, 371
uniform, 371
discrete Fourier transform, 123
discrete spectral average (see spectral
density function)
distribution function, 369 (see al'so
continuous distributions and
discrete distributions)
properties of, 369
Dow-Jones Utilities Index (DOWJ.TSM)
143-145, 148, 153-154, 163, 202
Dow-Jones and All ordinaries Indices,
(DJAO2.TSM, DJAOPC2.TSM)
225-226, 248, 251
Durbin-Levinson agorithm, 69, 142

E

EM algorithm, 289-292

Monte Carlo (MCEM), 298
embedded discrete-time process, 359
error probabilities, 389-390

typel, 389

typell, 389
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estimation of missing values

inan ARIMA process, 287

inan AR(p) process, 288

in a state-space model, 286
estimation of the white noise variance

least squares, 161

maximum likelihood, 160

using Burg's algorithm, 148

using the Hannan-Rissanen a gorithm,

157

using the innovations agorithm, 155

using the Yule-Walker equations, 142
expectation, 373
exponential distribution, 370
exponential family models, 301-302
exponential smoothing, 27-28, 322

F

filter (seelinear filter)
Fisher information matrix, 387
forecasting, 63—77, 167-169 (see also
prediction)
forecasting ARIMA processes, 198-203
forecast function, 200-203
h-step predictor, 199
mean square error of, 200
forecast density, 293
forward prediction errors, 147
Fourier frequencies, 122
Fourier indices, 13
fractionally integrated ARMA process,
361
estimation of, 363
spectral density of, 363
Whittle likelihood approximation, 363
fractionally integrated white noise, 362
autocovariance of, 362
variance of, 362
frequency domain, 111

G

gamma distribution, 371

gamma function, 371

GARCH(p, ¢q) process, 352-357
ARMA model with GARCH noise, 356
fitting GARCH models, 353-356
Gaussian-driven, 354
generalizations, 356
regression with GARCH noise, 356

t-driven, 355
Gaussian likelihood
in time series context, 387
of a CAR(1) process, 359
of amultivariate AR process, 246
of an ARMA(p, ¢) process, 160
with missing observations, 284-285,
290
of GARCH model, 354
of regression with ARMA errors, 213
Gaussian linear process, 344
Gaussian time series, 380
Gauss-Markov theorem, 385
generalized distribution function, 115
generalized least squares (GLS)
estimation, 212, 386
generalized inverse, 272, 312
generalized state-space models
Bayesian, 292
filtering, 293
forecast density, 293
observation-driven, 299-311
parameter-driven, 292—299
prediction, 293
Gibbs phenomenon, 131
goals scored by England against
Scotland, 306-311
goodness of fit (see also tests of
randomness) based on ACF, 21

H

Hannan-Rissanen algorithm, 156

harmonic regression, 12-13

Hessian matrix, 161, 214

hidden process, 293

Holt-Winters algorithm, 322-326
seasonal, 326-328

hypothesis testing, 389-391
large-sampl e tests based on confidence

regions, 390-391

uniformly most powerful test, 390

independent random variables, 375
identification techniques, 187-193
for ARMA processes, 161, 169174,
189
for AR(p) processes, 141
for MA(q) processes, 152

for seasonal ARIMA processes, 206
iid noise, 8, 16
sample ACF of, 61
multivariate, 232
innovations, 82, 273
innovations algorithm, 7375, 150-151
fitted innovations MA (im) model, 151
multivariate, 246
input, 51
intervention analysis, 340-343
invertible
ARMA process, 86
multivariate ARMA process, 243
1t integral, 358
ITSM, 31, 32, 43, 44, 81, 87, 95, 188,
333, 337-339, 395421

J

joint distributions of atime series, 7
joint distribution of a random vector, 374

K

Kalman recursions
filtering, 271, 276
prediction, 271, 273
h-step, 274
smoothing, 271, 277
Kullback-Leibler discrepancy, 171
Kullback-Leibler index, 172

L

Lake Huron (LAKE.TSM), 10-11,
21-23, 63, 149-150, 155, 157, 163,
174, 193, 215-217, 291
latent process, 293
large-sampl e tests based on confidence
regions, 390-391
least squares estimation
for ARMA processes, 161
for regression model, 383-386
for transfer function models, 333-335
of trend, 10
likelihood function, 386 (see aso
Gaussian likelihood)
linear combination of sinusoids, 116
linear difference equations, 201
linear filter, 26, 42, 51
input, 51
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linear filter (cont.)
low-pass, 26, 130
moving-average, 31, 42
output, 51
simple moving-average, 129
linear process, 51, 232
ACVF of, 52
Gaussian, 344
multivariate, 232
linear regression (see regression)
local level model, 264
local linear trend model, 266
logistic equation, 345
long memory, 318, 362
long-memory model, 361-365

M

MA(1) process, 17
ACF of, 17, 48
estimation of missing values, 82
moment estimation, 145
noninvertible, 97
order selection, 152
PACF of, 110
sample ACF of, 61
spectral density of, 120
state-space representation of, 312
MA(g) (see moving average process)
MA (00), 51
multivariate, 233
martingal e difference sequence, 343
maximum likelihood estimation,
158-161, 386387
ARMA processes, 160
large-sample distribution of, 162
confidence regions for, 161
mean
of amultivariate time series, 224
estimation of, 234
of arandom variable, 373
of arandom vector, 376
estimation of, 58
sample, 57
large-sample properties of, 58
mean sguare convergence, 393-394
properties of, 394
measurement error, 98
memory shortening, 318
method of moments estimation, 96, 140

minimum AICC AR model, 167
mink trappings (APPH.TSM), 257
missing valuesin ARMA processes
estimation of, 286
likelihood calculation with, 284
mixture distribution, 372
Monte Carlo EM algorithm (MCEM),
298
moving average (MA(g)) process, 50
ACF of, 89
sample, 94
ACVF of, 89
estimation
confidence intervals, 152
Hannan-Rissanen, 156
innovations, 150-151
maximum likelihood, 160, 162
order selection, 151, 152
partial autocorrelation of, 96
unit rootsin, 196-198
multivariate AR process
estimation, 247—249
Burg’s algorithm, 248
maximum likelihood, 246247
Whittle's algorithm, 247
forecasting, 250254

error covariance matrix of prediction,

251
multivariate ARMA process, 241-244
causal, 242
covariance matrix function of, 244
estimation
maximum likelihood, 246247
invertible, 243
prediction, 244-246

error covariance matrix of prediction,

252
multivariate innovations algorithm, 246
multivariate normal distribution, 378
bivariate, 379-380
conditional distribution, 380
conditional expectation, 380
density function, 378
definition, 378
singular, 378
standardized, 378
multivariate time series, 223
covariance matrices of, 229, 230
mean vectors of, 229, 230
second-order properties of, 229-234

stationary, 230
multivariate white noise, 232
muskrat trappings (APPI.TSM), 257

N

negative binomia distribution, 372, 381
NILE.TSM, 363-365

NOISE.TSM, 334, 343

nonlinear models, 343-357
nonnegative definite matrix, 376
nonnegative definite function, 47
normal distribution, 370, 373

normal equations, 384

null hypothesis, 389

@)

observation equation, 260
of CARMA(p, ¢) moddl, 359
ordinary least squares (OLS) estimators,
211, 383-385
one-step predictors, 71, 273
order selection, 141, 161, 169-174
AIC, 171
AICC, 141, 161, 173, 191, 247, 407
BIC, 173, 408
consistent, 173
efficient, 173
FPE, 170-171
orthogonal increment process, 117
orthonormal set, 123
overdifferencing, 196
overdispersed, 306
overshorts (OSHORTS.TSM), 9699,
167,197, 215
structural model for, 98

P

partial autocorrelation function (PACF),
71, 94-96
estimation of, 95
of an AR(p) process, 95
of an MA(1) process, 96
sample, 95
periodogram, 123-127
approximate distribution of, 124
point estimate, 388
Poisson distribution, 371, 374
model, 302
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polynomial fitting, 28
population of USA (USPOPTSM), 6, 9,
30
portmanteau test for residual s (see tests
of randomness)
posterior distribution, 294
power function, 390
power steady model, 305
prediction of stationary processes (see
also recursive prediction)
AR(p) processes, 102
ARIMA processes, 198-203
ARMA processes, 100-108
based on infinite past, 75-77
best linear predictor, 46
Gaussian processes, 108
prediction bounds, 108
large-sample approximations, 107
MA(g) processes, 102
multivariate AR processes, 250-254
one-step predictors, 69
mean squared error of, 105
seasonal ARIMA processes, 208210
prediction operator, 67
properties of, 68
preliminary transformations, 187
prewhitening, 237
prior distribution, 294
probability density function (pdf), 370
probability generating function, 381
probability mass function (pmf), 370
purely nondeterministic, 78, 343

Q
q-dependent, 50
q-correlated, 50
qq plot, 38

R

R and S arrays, 180
random noise component, 23
random variable
continuous, 370
discrete, 370
randomly varying trend and seasonality
with noise, 267, 326
random vector, 374-377
covariance matrix of, 376
joint distribution of, 374

mean of, 376
probability density of, 375
random walk, 8, 17
simple symmetric, 9
with noise, 263, 274, 280
rational spectral density (see spectral
density function)
realization of atime series, 7
recursive prediction
Durbin-Levinson algorithm, 69, 245
Innovations algorithm, 71-75, 246
Kaman prediction (see Kalman
recursions)
multivariate processes
Durbin-Levinson algorithm, 245
innovations algorithm, 246
regression
with ARMA errors, 210-219
best linear unbiased estimator, 212
Cochrane and Orcutt procedure, 212
GLS estimation, 212
OL S estimation, 211
rejection region, 389
RES.TSM, 343
residuals, 35, 164
check for normality, 38, 167
graph of, 165
rescaled, 164
sample ACF of, 166
tests of randomness for, 166

S

sales with leading indicator (LS2.TSM,
SALES.TSM, LEAD.TSM), 228,
238-241, 248-249, 335, 338
sample
autocorrelation function, 16-21
MA(g), 94
of residuals, 166
autocovariance function, 19
covariance matrix, 19
mean, 19
large-sample properties of, 58
multivariate, 230
partial autocorrelation, 95
SARIMA (see seasonal ARIMA process)
seasonal adjustment, 6

seasonal ARIMA process, 203-210
forecasting, 208-210
mean squared error of, 209
maximum likelihood estimation, 206
seasonal component, 23, 301, 404
estimation of
method S1, 31
elimination of
method S2, 33
seat-belt legidation (SBL.TSM,
SBL2.TSM), 217-219, 341-343
second-order properties, 7
in frequency domain, 233
short memory, 318, 362
SIGNAL.TSM, 3
signal detection, 3
significance level, 390
size of atest, 390
smoothing
by elimination of high-frequency
components, 28
with amoving averagefilter, 25
exponential, 27-28, 323
the periodogram (see spectral density
estimation)
using asimple moving average, 129
spectral density estimation
discrete spectral average, 125
large-sampl e properties of, 126
rational, 132
spectral density function, 111-116
characterization of, 113-114
of an ARMA(1, 1), 134
of an ARMA process, 132
of an AR(1), 118-119
of an AR(2), 133
of an MA(1), 119-120
of white noise, 118
properties of, 112
rational, 132
spectral density matrix function, 233
spectral distribution function, 116
spectral representation
of an autocovariance function, 115
of acovariance matrix function, 233
of astationary multivariate time series,
233
of astationary time series, 117
Spencer’s 15-point moving average, 27,
12
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state equation, 260
of CARMA(p, ¢) moddl, 359
stable, 263
state-space model, 259-316
estimation for, 277-283
stable, 263
stationary, 263
with missing observations, 283-288
state-space representation, 261
causal AR(p), 267-268
causal ARMA(p, ¢q), 268
ARIMA(p, d, q), 269-271
stationarity
multivariate, 230
strict, 15, 52
weak, 15
steady-state solution, 275, 324
stochastic differential equation
first-order, 357
pth-order, 359
stochastic volatility, 349, 353, 355
stock market indices (STOCK7.TSM),
257, 367
strictly stationary series, 15, 49
properties of, 49
strikesin the U.S.A. (STRIKES.TSM), 6,
25, 28, 43, 110
structural time series models, 98, 263
level model, 263-265
local linear trend model, 265, 323
randomly varying trend and seasonality
with noise, 267, 326
estimation of, 277-286
seasonal series with noise, 266
sunspot numbers (SUNSPOTS.TSM), 81,
99, 127, 135, 174, 344, 356

T

testing for the independence of two
stationary time series, 237-241
test for normality, 38, 167

tests of randomness
based on sample ACF, 36
based on turning points, 36-37, 167
difference-sign test, 37, 167
Jarque-Bera normality test, 38, 167
minimum AICC AR moddl, 167
portmanteau tests, 36, 166, 352
Ljung-Box, 36, 167, 352
McLeod-Li, 36, 167, 352
rank test, 37-38, 167
third-order central moment, 347
third-order cumulant function, 347, 366
of linear process, 347, 360
threshold model, 348
AR(p), 349
time domain, 111
time-invariant linear filter (TLF),
127132
causal, 127
transfer function, 128
time series, 1, 6
continuous-time, 2
discrete-time, 1
Gaussian, 47
time series model, 7
time series of counts, 297299
transfer function, 129
transfer function model, 331-339
estimation of, 333-335
prediction of, 337-339
transformations, 23, 187-188
variance-stabilizing, 187
tree-ring widths (TRINGS.TSM), 367
trend component, 9-12
elimination of
in absence of seasonality, 23-30
by differencing, 29-30
estimation of
by elimination of high-frequency
components, 28
by exponential smoothing, 27—28

by least squares, 10

by polynomial fitting, 29

by smoothing with a moving average,
25,31

U

uniform distribution, 370, 371
discrete, 371
uniformly most powerful (UMP) test, 390
unit roots
augmented Dickey-Fuller test, 195
Dickey-Fuller test, 194
in autoregression, 194-196
in moving-averages, 196-198
likelihood ratio test, 197
locally best invariant unbiased (LBIU)
test, 198

\Y,

variance, 373
volatility, 349, 353, 355

w

weight function, 125
white noise, 16, 232, 405
multivariate, 232
spectral density of, 118
Whittle approximation to likelihood, 363
Wold decomposition, 77, 343

Y

Yule-Walker estimation (see also
autoregressive process and
multivariate AR process), 139

forg > 0,145

zoom buttons, 398
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